Revision History

<table>
<thead>
<tr>
<th>Document Number</th>
<th>Document Date</th>
<th>Software Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDUG</td>
<td>March 1, 2004</td>
<td>6.7</td>
</tr>
</tbody>
</table>

Legal Notices

FRx Software Corporation makes no representations or warranties with respect to the contents of this manual and specifically disclaims any implied warranties of merchantability or fitness for any particular purpose.

We welcome user comments and reserve the right to revise this publication and to make improvements or changes to the products and programs described in this publication at any time without notice.

Printed in the United States of America.

No part of this publication may be reproduced in any form without the prior written consent of FRx Software Corporation.

Copyright and Trademarks Notice

© Copyright 2004 by FRx Software Corporation. All rights reserved. Microsoft, FRx, instant!OLAP, and Drilldown Viewer are either registered trademarks or trademarks of Microsoft Corporation or FRx Software Corporation or their affiliates in the United States and/or other countries. All other registered trademarks and trademarks are property of their respective owners. FRx Software Corporation is a subsidiary of Microsoft Corporation.
Preface ........................................................................................................................... vii
   Who Should Read this Guide ...................................................................................... vii
   How this Guide is Organized ..................................................................................... vii
   What’s New in Report Designer 6.7 ........................................................................... viii
   Improved in FRx 6.7 ......................................................................................................... ix
   Available Product Documentation ............................................................................. x
   Other Documentation .................................................................................................... x
   Conventions Used in this Guide .................................................................................. xi
   How to Contact Us ....................................................................................................... xi
   Software Licensing ..................................................................................................... xi

Chapter 1: Welcome to FRx Report Designer ............................................................. 1
   Using This Guide ......................................................................................................... 3
      Keyboard Commands .................................................................................................. 3
      Mouse Commands ..................................................................................................... 3
      Typographical Conventions ..................................................................................... 3
      Note and Warning Messages ................................................................................... 4
   System Requirements ............................................................................................... 5
   Installing and Starting Report Designer ................................................................. 6
      Starting Report Designer .......................................................................................... 6
   Understanding Report Designer: An Overview ...................................................... 7
      Building Blocks ....................................................................................................... 7
      User Security ............................................................................................................ 9
      Report Specification Sets ....................................................................................... 9
      Presentation Quality Reports .................................................................................. 9
      FRx® DrillDown Viewer™ ....................................................................................... 10
      Account Codes ....................................................................................................... 10
   Getting Around in Report Designer ......................................................................... 12
      The Report Designer Control Panel ....................................................................... 12
      The Toolbar ............................................................................................................. 13
      Basic Report Designer Techniques and Keyboard Commands ............................. 14
      Record Control Boxes ............................................................................................ 19
   Defining Available Commands on Report Designer Menus .................................... 19
Contents

Adding Column Restrictions ................................................................. 164
Selecting a Reporting Unit .................................................................. 165
Formatting Multicurrency Reports ....................................................... 167
Account Filters .................................................................................... 169
Attribute Filters .................................................................................. 170
Restricting Columns to Specific Dates ............................................... 171
Justification ......................................................................................... 172
Adding the OLAP Description to the Column Layout ....................... 173
Customizing Transaction Detail Reports ............................................. 173
Creating Multiple Period Transaction Detail Reports ......................... 174
Creating Year-to-Date Transaction Detail Reports .............................. 175
Creating Debit/Credit Reports ............................................................ 175
Creating Tabular Reports .................................................................. 177

Chapter 6: Creating a Reporting Tree .................................................. 179
Understanding Reporting Trees .......................................................... 181
Reporting Unit Structure .................................................................... 181
Multiple Reporting Trees .................................................................... 182
Account Masks .................................................................................... 183
Account Mask Structure and Segments ................................................ 183
Reporting Tree Window ....................................................................... 187
Graphical Reporting Tree ..................................................................... 187
Reporting Tree Worksheet .................................................................... 188
Reporting Tree Menus and Toolbar Icon ............................................. 190
Reporting Tree Menus ......................................................................... 190
Reporting Tree Toolbar Icon ............................................................... 196
Understanding Building Reporting Trees .......................................... 197
Understanding Building Reporting Trees Automatically .................... 197
Understanding Building Reporting Trees Manually ............................ 203
Building Reporting Trees Manually .................................................... 205
Building a Reporting Tree with the Reporting Tree Worksheet ............. 205
Building a Reporting Tree with the Reporting Units Dialog Box ........... 206
Defining Parent-Child Relationships .................................................. 211
Verifying a Unit’s Parent Unit ............................................................. 212
Building Reporting Trees Automatically ............................................ 213
Adding Text and E-mail Links to a Reporting Tree ............................... 216
Adding Text to the Reporting Units in a Tree ....................................... 216
Adding E-mail Addresses to a Reporting Tree ..................................... 217
Securing Reporting Tree Units ............................................................ 221

Chapter 7: Understanding the Catalog of Reports ................................. 223
Catalog of Reports Window ................................................................. 224
Catalog of Reports Menu Bar ............................................................... 225
File Menu .......................................................................................... 225
Contents

XBRL Definitions .................................................................................................................. 318

Chapter 9: Using FRx Currency Translation ................................................................. 319
FRx Currency Translation: Overview .................................................................................. 320
Setting Up the FRx System for Currency Translation ....................................................... 322
Designing Currency Translation Reports ............................................................................ 323
  Activating DAX Currency Translation ........................................................................ 323
  Using Currency Translation Codes in a Row Format .................................................... 323
  Using Currency Translation in the Column Layout ....................................................... 326
  Using Currency Rate Subtype ID in Column Layouts .................................................... 327
Setting Currency Options in the Catalog of Reports ....................................................... 329

Appendix A: Answers to Common User Questions ......................................................... 332
Frequently Asked Questions (FAQs) ................................................................................ 333
  Incomplete Report Output .............................................................................................. 333
  Reports Using Reporting Tree with Overstated Numbers ........................................... 334
  External Worksheet Data Not Displaying ..................................................................... 335
  Changing Report Descriptions ...................................................................................... 336
  Specific Headings for Specific Column Layouts ......................................................... 336
  Balance Sheet: Totalling Rounded Numbers ............................................................... 336
  Restricting Income Statement Rounded Numbers in the Account Detail Report .......... 337
  Out of Balance Message when Drilling into Transaction Detail .................................... 337
  Restore a Deleted or Overwritten Row, Column, or Tree ........................................... 338
Error Messages ................................................................................................................... 339
  Building Block User Error ............................................................................................ 339
  Disk or Network Error ................................................................................................. 339
  Specification Set Database Security does not Match Current FRxSys32 Security Setting .......................................................................................................................... 341
FRx System Information .................................................................................................... 343
  Client Installation Types ............................................................................................... 343
  Moving FRx to a New Location or New Server ............................................................ 344
  Permissions Required for FRx Users ........................................................................... 347
  Maintaining FRx Data Files and Preventing Corruption .............................................. 348

Glossary ............................................................................................................................... 351

Index .................................................................................................................................. 360
Who Should Read this Guide

The purpose of this guide is to explain the functions, features, and capabilities of Microsoft® Business Solutions for Analytics–FRx®.

The guide includes:

- General information about the logic and workings of FRx® Report Designer to draw financial data from your general ledger.

Technical reference information that explains the purpose, function, and output result for every option in the product.

This guide is written for all users of Report Designer who create or run FRx financial reports.

How this Guide is Organized

This guide is organized into the following chapters:

- Chapter 1, “Welcome to FRx Report Designer”
- Chapter 2, “Creating Basic Reports with FRx Report Designer”
- Chapter 3, “Creating Row Formats”
- Chapter 4, “Linking to Other Sources of Information”
- Chapter 5, “Creating Column Layouts”
- Chapter 6, “Creating a Reporting Tree”
- Chapter 7, “Understanding the Catalog of Reports”
- Chapter 8, “Using Extensible Business Reporting Language (XBRL)”
- Chapter 9, “Using FRx Currency Translation”
What’s New in Report Designer 6.7

This version of the software includes the following new features.

- **Product name and logo**—We have introduced a new product name, logo and demonstration data that aligns the FRx product and FRx Software's ownership with one of the most recognizable brands in the industry—Microsoft Corporation. Through this association, existing customers and prospective buyers will know how we are evolving. While staying true to the trustworthy roots of our heritage, we are backed by the seasoned and insightful strength and vision shared by our parent company. And we will continue to reflect these ideals and live up to the standards set by our brand.

- **FRx® Report Manager**—Report Manager is a powerful optional module that makes it easy to pull together FRx reports with the other information end-users need to do their work, all delivered in one, comprehensive report book. It automates the time consuming and manual process of producing report books containing many different types of documents and files. Report Manager helps users present information in a manner that is logical, organized and relevant. Finally, Report Manager allows users to create report books with information specialized to the needs of each individual user, then streamlines the printing and distribution of the complete presentation. Report Manager allows:
  - Multiple output types including FRx® DrillDown Viewer™ files, Microsoft Office documents and other reports produced from diverse reporting packages to be packaged together for posting to a network or Web site, or for delivery via email or print.
  - Recipients to view all documents contained in a report book using an enhanced version of the DrillDown Viewer software.
  - Headers, footers and consecutive page numbering throughout the entire book.
  - Report generation locally or via the FRx® Report Server.

A useful document designed to help customers determine which User Guides to obtain is included with each product shipment. Additionally, all User Guides are included on the FRx 6.7 product CD.
Improved in FRx 6.7

**Microsoft Excel graphing via FRx® instant!OLAP® software**

instant!OLAP is now included in every edition, from FRx® Desktop through FRx® Enterprise. Additional functionality includes the ability for users to utilize the instant!OLAP software output format and export a report directly into a pivot table for automatic graphing in Excel.

**XBRL**

Remaining at the forefront of advances in Extensible Business Reporting Language (XBRL) technology, the support of the 1.0 taxonomy has been upgraded to the 2.0 standard. FRx Software understands the need for users to transfer complex, highly confidential corporate financial information to regulators, banks, investors and boards of directors using a trusted standard of financial communication. Because of this, we will continue to make advances in the XBRL compatibility of FRx, ensuring functional compliance as XBRL is further adopted by corporations and consumers of sensitive financial data.

**FRx® Currency Translation**

The Currency Translation module has been enhanced to allow for greater flexibility in the calculation of translation rates. There are now two ways to calculate monthly average rates. Additionally, annual average rates can be calculated, thereby streamlining the maintenance necessary for Column Layouts when creating FRx reports. Users can now translate individual layers that represent transactions while comparing the total amount in the historical rates table to the appropriate general ledger total. This ensures that all transactions have been accounted for when converting data at the appropriate historic rates. Finally, we have addressed several software modification requests to improve the Currency Translation product module as a whole.

**FRx® WebPort**

FRx® WebView has been consolidated into FRx WebPort to form a single product module that is available to all FRx users regardless of product edition or general ledger. Users can quickly publish Microsoft Word or Microsoft Excel documents with their FRx reports for easy access by others on a secure Intranet site.

**Stability and Performance**

Improvements to FRx 6.7 allow for faster report generation and quicker export of reports to the FRx DrillDown Viewer and printing options. Additionally, FRx has been upgraded to support Microsoft Access 2002 and changes have been made to the database access technology. These enhancements ensure a more stable environment. In addition, improvements to the way the general ledger index (G32 file) is built will reduce the likelihood of database corruption.
Available Product Documentation

The following documentation is available for this product.

- **FRx® 6.7 Installation and Configuration Guide**—This guide helps system installation personnel install FRx products through hands-on instructions.
- **FRx® Report Designer Getting Started Guide**—This guide helps new users understand how to set up and configure the Report Designer to work with their company's specific general ledger data.
- **FRx® Report Designer 6.7 User’s Guide**—This guide helps users apply the Report Designer components to design and generate reports.
- **FRx® Report Designer 6.7 Administrator’s Guide**—This guide helps FRx system administrators who set up and administer Report Designer and/or maintain the currency translation rates database.
- **FRx® DrillDown Viewer™ and FRx® Report Launcher 6.7 User’s Guide**—This guide helps users display, print, and export FRx financial reports to the FRx DrillDown Viewer, and launch reports from the FRx Report Launcher.
- **FRx® Report Server 6.7 User’s Guide**—This guide helps users manage reports running on FRx Report Server and use the schedule to create, revise, and manage report schedules and exceptions.
- **FRx® Report Manager 6.7 User’s Guide**—This guide helps users generate, display, print, subscribe to, export, save, and send reports that were created and saved using the Report Designer.
- **FRx® WebPort 6.7 User and Administrator’s Guide**—This guide helps authorized users send FRx report output to the FRx WebPort repository and view reports via a Web browser. It also helps WebPort administrators manage report files and folders and control user access to WebPort.
- **FRx 6.7 Sample Reports**—This guide provides users with examples of key reports using a demonstration database and Report Designer.

Other Documentation

Some components of the FRx product include online help that is installed with that component. The following online help volumes are available:

- **FRx® Report Designer Online Help**
- **FRx® DrillDown Viewer™ Online Help**
- **FRx® Report Launcher Online Help**
- **FRx® Report Server Online Help**
- **FRx® Report Manager Online Help**
- **FRx® WebPort Online Help**
Conventions Used in this Guide

The following conventions are used through this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Used in procedures to indicate an on-screen item, such as a button name.</td>
</tr>
<tr>
<td><em>Italics</em></td>
<td>Used to indicate emphasis.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td>Used to indicate a command, file name, or path.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Used to indicate information that supplements the main text.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>Used to indicate information about how to use the application in a different way.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>Used to indicate that a specific action or lack of a specific action could result in the loss of data.</td>
</tr>
<tr>
<td><strong>Warning</strong></td>
<td>Used to indicate that a specific action or lack of a specific action could result in physical harm to your computer or the server.</td>
</tr>
</tbody>
</table>

How to Contact Us

**Mailing Address:**
FRx Software Corporation
4700 South Syracuse Parkway, Suite 150
Denver, Colorado 80237

**Software Support Telephone:**
1-800-FRx-SOLV
(1-800-379-7658) Toll Free
(+1) 303-741-8000 Main

**Web Site:**
http://www.frxsoftware.com

**Email:**
Documentation: docu@frxsoft.com
Training: training@frxsoft.com
General information: info@frxsoft.com
Product suggestions: productsuggestions@frxsoft.com

Software Licensing

FRx software is licensed to our customers with specific configurations and capabilities for each installation. The software license controls the number of licensed concurrent users, expiration dates, and version-specific features available under the terms of your license agreement. Contact your reseller for more information about adding features under your FRx Software license agreement.
Welcome to FRx Report Designer

Chapter 1

Using This Guide ................. 3
System Requirements ............ 5
Installing and Starting Report Designer . . 6
Understanding Report Designer: An Overview7
Getting Around in Report Designer . . . 12
Defining Available Commands on Report Designer Menus . . . . . . . . 19

Welcome to Microsoft® Business Solutions for Analytics–FRx®.
FRx breaks traditional reporting constraints, allowing you to be more creative and productive when building financial reports from your general ledger.
FRx extends the power of your accounting system by simplifying and enhancing your financial and management reporting. FRx® Report Designer extracts information from your general ledger and optionally combines it with information from Lotus 1-2-3 or Microsoft® Excel spreadsheets. Then, it uses your customized report formats and your customized management reporting hierarchy to produce reports. These reports can be viewed, printed, sent as e-mail, or exported to a text or spreadsheet file.
Figure 1-1: Information Flow in FRx
Using This Guide

The following sections describe the conventions used throughout this User’s Guide.

- Keyboard Commands
- Mouse Commands
- Typographical Conventions
- Note and Warning Messages

Keyboard Commands

This guide uses the keyboard commands type, enter, select, and press.

- **Type** means to key in the data specified in the instruction.
- **Enter** means to key in the data and then press the ENTER key.
- **Select** means to mark menus and submenu options, highlight text, and choose items from drop-down list boxes.
- **Press** means to press a key or combination of keys on the keyboard.

If you need to press a combination of keys simultaneously, the keys are shown with a plus (+) between them. For example:

Ctrl+D means to press and hold the Ctrl key and then press D.

In some cases, you should press a key, release it, and then press another key. When this is the case, keys are shown with a comma (,) between them. For example:

Press Alt, F, N is the keyboard shortcut to open the File menu, and then choose New.

Sometimes, a key exists in more than one place on the keyboard. As a rule, it’s a good habit to use the keys to the left of the numeric keypad because you might want to turn on NumLock to enter numbers.

Mouse Commands

The mouse commands used in this guide include click, double-click, right-click, and select.

- **Click** means to click the left mouse button. In this User’s Guide, you click buttons, check boxes, and boxes within windows and dialog boxes.
- **Double-click** means to quickly click the mouse button twice without moving the mouse.
- **Right-click** means to click the right mouse button.
- **Select** means to mark menus and submenu options, highlight text, and choose items from drop-down list boxes.

Typographical Conventions

Within steps, bold type represents onscreen items (such as menus, boxes, and buttons) and information you type. For example:

In the **Description** box, type **Tabular Balance Sheet**.

Italic type indicates emphasis. For example:
This code defines the base row for columns that calculate a percentage of the base row.

**Note and Warning Messages**

Notes and warnings indicate additional information. They are indicated by the following formats:

<table>
<thead>
<tr>
<th>Note</th>
<th>This note indicates additional information in overview sections that may be important for you to know.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>This note indicates additional information in procedural steps that may be important for you to know.</td>
</tr>
<tr>
<td>Warning</td>
<td>This warning advises you to take or avoid a specific action in overview sections.</td>
</tr>
<tr>
<td><strong>Warning:</strong></td>
<td>This warning advises you to take or avoid a specific action in procedural steps.</td>
</tr>
</tbody>
</table>
System Requirements

Specification requirements for installing and running FRx are outlined in the System Requirements and Installation Guidelines included on your Microsoft® Business Solutions for Analytics–FRx® CD-ROM.
Installing and Starting Report Designer

The installation program displays several prompts used to configure Report Designer for your environment. For example, it displays a default directory and subdirectory where it installs FRx. See the System Requirements and Installation Guidelines on your Microsoft® Business Solutions for Analytics–FRx® CD-ROM for information about installing Report Designer.

You can override the default values during installation. For more information, see your FRx® Report Designer Getting Started Guide.

The README.TXT File

FRx is shipped with a Readme file that describes late-breaking information not described in this guide. You can open this text file from the FRx installation CD-ROM or, following installation, from the FRx 6.7 program folder.

Sample FRx Companies

FRx includes data and sample reports for two fictional companies: Fabrikam Works, Inc. (FW) and Fabrikam Works Canada, Inc. (FWC). For more information on how to use this demonstration data, open the READSAMP.PDF file located on the FRx installation CD-ROM.

Starting Report Designer

Report Designer must always be started from Windows.

To start Report Designer from Windows

1. Click Start, point to Programs, then point to FRx 6.7, and click the Report Designer icon to display the Select a Company to Work With dialog box.
2. Select one of the FRx sample companies, FW or FWC, and click OK.
Understanding Report Designer: An Overview

In Report Designer, you keep the design of your reports completely separate from your general ledger. As a result, you can easily change a report without modifying your accounting system’s general ledger.

As you use Report Designer, you will see that every part of the system has been designed with flexibility in mind. There are many options available and many different ways of achieving the desired results. You can use the Report Designer default settings to quickly generate reports or you can customize your reports and change the settings throughout Report Designer.

This section contains information and instructions on:

- Building Blocks
- User Security
- Report Specification Sets
- Presentation Quality Reports
- FRx\textsuperscript{®} DrillDown Viewer\textsuperscript{TM}
- Account Codes

Building Blocks

The design philosophy behind Report Designer is simple: break everything down to the smallest possible component, and then mix and match components as needed.

With this building block approach, you can easily combine text, amounts, calculations, and summarization in an unlimited fashion. This approach increases your ability to produce the reports you need. Equally important, it encourages creativity by making it easy to look at your operations in different ways.

The individual building blocks of a report work something like a three-dimensional spreadsheet, but with more power.

- **Row formats.** These are the descriptive lines (for example, salaries or sales) on a report.

![Row Formats](image)

- **Column layouts.** These are the actual monetary amounts and calculations, plus reporting periods and book codes.

![Column Layouts](image)
• Reporting trees. These are similar to an organizational chart. It contains individual reporting units that represent each box in the chart. These units can be either individual departments from the general ledger or higher-level units that summarize data from other reporting units.

The following sample report illustrates how the building blocks are combined to create a report.

Figure 1-2: Sample Report

• Catalog of Reports. FRx reports are stored in the Catalog of Reports. Each catalog entry is made up of the row, column, and (optional) tree that define the report. Once these elements are entered, a report can be run.

In the Catalog of Reports, you also specify the type of report you want to print:

- Financial reports
- Account detail reports
- Transaction detail reports
Any combination of these report types
You can report on a summary, company-wide basis or on selected units from a reporting tree. The resulting report is customized in accordance with the row format and column layout you use.

**User Security**
When the optional FRx security is activated, a system administrator can limit individual users and/or groups of users to specific items within FRx. The FRx security system works in addition to security in the underlying accounting system.

**Report Specification Sets**
All FRx report specifications (row formats, column layouts, reporting trees, and catalogs) are stored in relational databases called specification sets. In client/server environments, it is helpful to store the report specification sets on the network so multiple users can access each company’s reports.

For more information see “Creating Specification Sets” in Chapter 2 of the FRx® Report Designer 6.7 Administrator’s Guide.

**Presentation Quality Reports**
Using the powerful print controls and formatting in FRx, you can produce presentation quality reports. Using FRx’s built-in print controls and formatting, you can:

- Use fonts, colors, shading, boxes, and lines in your reports
- Format individual rows and columns independently
- Format individual column headers, page headers, and footers
- Reduce, enlarge, or automatically adjust your page size
- Send reports via e-mail directly from the Report Designer or the DrillDown Viewer
- Generate groups of reports using the FRx® Report Launcher without opening Report Designer
Publish reports to a Web server

---

**Fabrikam Works, Inc.**
Tabular Balance Sheet
For the Five Months Ending May 31, 2004

<table>
<thead>
<tr>
<th>ASSETS</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash - Checking</td>
<td>$134,111.13</td>
<td></td>
</tr>
<tr>
<td>Cash - Money Market</td>
<td>46,751.00</td>
<td></td>
</tr>
<tr>
<td><strong>Total Cash</strong></td>
<td><strong>180,862.13</strong></td>
<td></td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>166,164.00</td>
<td></td>
</tr>
<tr>
<td>Allowance For Bad Debts</td>
<td>(2,184.00)</td>
<td></td>
</tr>
<tr>
<td>Intl Corp Receivable</td>
<td>271,213.00</td>
<td></td>
</tr>
<tr>
<td><strong>Net Accounts Receivable</strong></td>
<td><strong>435,193.00</strong></td>
<td></td>
</tr>
<tr>
<td>Total Inventories</td>
<td>779,028.00</td>
<td></td>
</tr>
<tr>
<td>Prepaid Assets</td>
<td>3,289.00</td>
<td></td>
</tr>
<tr>
<td><strong>Current Assets</strong></td>
<td><strong>1,398,370.13</strong></td>
<td></td>
</tr>
<tr>
<td>Leasehold Improvements</td>
<td>69,600.00</td>
<td></td>
</tr>
<tr>
<td>Office Furniture And Fixtures</td>
<td>34,500.00</td>
<td></td>
</tr>
<tr>
<td>Office Equipment</td>
<td>37,700.00</td>
<td></td>
</tr>
<tr>
<td>Less Accumulated Depreciation</td>
<td>(40,635.00)</td>
<td></td>
</tr>
<tr>
<td><strong>Net Fixed Assets</strong></td>
<td><strong>101,165.00</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Total Assets</strong></td>
<td><strong>$1,499,535.13</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LIABILITIES AND SHAREHOLDERS' EQUITY</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts Payable</td>
<td>$84,253.00</td>
<td></td>
</tr>
<tr>
<td>Accrued Liabilities</td>
<td>137,867.00</td>
<td></td>
</tr>
<tr>
<td><strong>Total Current Liabilities</strong></td>
<td><strong>222,120.00</strong></td>
<td></td>
</tr>
<tr>
<td>Leases Payable</td>
<td>10,100.00</td>
<td></td>
</tr>
<tr>
<td>Notes Payable</td>
<td>142,794.00</td>
<td></td>
</tr>
<tr>
<td><strong>Long-Term Liabilities</strong></td>
<td><strong>152,894.00</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Total Liabilities</strong></td>
<td><strong>375,014.00</strong></td>
<td></td>
</tr>
<tr>
<td>Capital Stock</td>
<td>50,000.00</td>
<td></td>
</tr>
<tr>
<td>Additional Paid-In Capital</td>
<td>500,269.00</td>
<td></td>
</tr>
<tr>
<td>Year-to Date Income</td>
<td>377,152.13</td>
<td></td>
</tr>
<tr>
<td>Retained Earnings</td>
<td>197,100.00</td>
<td></td>
</tr>
<tr>
<td><strong>Shareholders' Equity</strong></td>
<td><strong>1,124,521.13</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Liabilities and Equity</strong></td>
<td><strong>$1,499,535.13</strong></td>
<td></td>
</tr>
</tbody>
</table>

Figure 1-3: Tabular Balance Sheet

**FRx® DrillDown Viewer™**

With the standalone DrillDown Viewer, users in your company can look at FRx reports even if they do not have access to Report Designer. Using this program, users can select reporting units from the reporting tree and then view and print financial statements and underlying account and transaction detail reports.

You can also use DrillDown Viewer to send reports to other users with e-mail, delete reports, print reports, and export reports to a spreadsheet file with formulas. For more information about the DrillDown Viewer, refer to your FRx® DrillDown Viewer™ and FRx® Report Launcher 6.7 User’s Guide.

**Account Codes**

Although accounting systems typically treat general ledger codes as single indivisible units, Report Designer looks at account codes in a way that increases your reporting flexibility.
Most organizations have some type of structure that separates operations into different categories. A typical general ledger account code contains at least one account code segment that describes the type of account (for example, cash or sales). This segment of the general ledger code (sometimes referred to in accounting systems as the object code, main account, or primary account) is referred to as the *natural* account code segment in Report Designer.

The remainder of the full general ledger account code typically defines the department, division, location, area, task, project, and other categories within the overall structure of the organization. In Report Designer, these segments of the general ledger code are called the *responsibility* account code segments.

![Diagram of General Ledger Account Code](image)

Figure 1-4: General Ledger Account Code

**Note**

This distinction between the account’s natural and responsibility segments is critical to the successful use of FRx. Typically, users define the natural segment in a row format and the responsibility segments in a reporting tree. These codes are combined in various ways when reports are printed. When Report Designer’s automatic build process creates row formats and reporting trees, by default it separates the responsibility and natural portions of the account code.

Report Designer uses the concept of base year and base period rather than current year and current period. This allows you to design column layouts that are easily adapted to different reporting needs. If you used current period to print a report for the prior period (or any other period), you have to modify the column layout. By using the base concept, once you specify the base period in the column layout, all you need to do is tell Report Designer what base period to run the report for in the Catalog of Reports.

The base period in the Catalog of Reports usually defaults to the current period. So when you design column layouts, think of base period and year as the current period and year. Then, when you start printing reports, you can generate the same report with different base periods or years.
Getting Around in Report Designer

FRx is a Microsoft® Windows® application that takes full advantage of the Microsoft Windows 9x and Microsoft Windows XP environments. If you are not familiar with Windows menus, windows, buttons, multiple windows, and other Windows features, refer to your Windows documentation.

This section contains information and instructions on:

- The Report Designer Control Panel
- The Toolbar
- Basic Report Designer Techniques and Keyboard Commands
- Record Control Boxes

The Report Designer Control Panel

When you start the Report Designer and select a default company, its Control Panel appears on your screen.

![Report Designer Control Panel](image)

Figure 1-5: Report Designer Control Panel

This is the main Report Designer window. The three building blocks (Row Formats, Column Layouts, and Reporting Trees) are at the top level. Below these building blocks is the Catalog of Reports, which combines elements from each of the other building blocks.

From the main Report Designer window, you can access every Report Designer function. You can modify any report building block or the Catalog of Reports by using the mouse or arrow keys to select the appropriate portion of the Control Panel.

- To select any Report Designer building block (rows, columns and reporting trees) or the Catalog of Reports, click its icon. For more information about rows, columns, and reporting trees, see Chapter 3, “Creating Row Formats”; Chapter 4, “Linking to Other Sources of Information”; and Chapter 6, “Creating a Reporting Tree”.

- To access functions that relate to your Report Designer configuration and companies, use the commands on the Company menu. For more information on these functions,
see Chapter 2, Adding Company Information, in your *FRx® Report Designer 6.7 Administrator’s Guide*.

- To access system administrator functions, including security setup and maintenance, use the **Admin** menu commands. For more information on these functions, see Chapter 1, Performing Administrative Duties, in your *FRx® Report Designer 6.7 Administrator’s Guide*.

- To quickly get started setting up reports for your own company, see Chapter 2, “Creating Basic Reports with FRx Report Designer”.

**The Toolbar**

Each main window displays a toolbar below its menu bar. The following toolbar buttons are common to all main windows. Toolbar buttons specific to certain windows are explained in their appropriate chapters.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create" /></td>
<td>Creates a new row format, column layout, catalog, or reporting tree. Or, on the <strong>File</strong> menu, click <strong>New</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Opens an existing row format, column layout, catalog, or reporting tree. Or, on the <strong>File</strong> menu, click <strong>Open</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Saves the current row format, column layout, reporting tree, or catalog record. Or, on the <strong>File</strong> menu, click <strong>Save</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Prints the current row format, column layout, catalog, or reporting tree. Or, on the <strong>File</strong> menu, click <strong>Print</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Cuts the selected text to the Windows clipboard. Or, on the <strong>Edit</strong> menu, click <strong>Cut</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copies the selected text to the Windows clipboard. Or, on the <strong>Edit</strong> menu, click <strong>Copy</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Pastes the contents of the Windows clipboard to the cursor location. Or, on the <strong>Edit</strong> menu, click <strong>Paste</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Lock" /></td>
<td>Locks any Report Designer component (Row Format, Column Layout, Reporting Tree, or Catalog ID) against accidental changes.</td>
</tr>
<tr>
<td><img src="image" alt="Catalog" /></td>
<td>Opens the Catalog of Reports building block. When you select this toolbar button, the Catalog of Reports window opens. When you close this window, you return to the Report Designer <strong>Control Panel</strong>.</td>
</tr>
</tbody>
</table>

Table 1-1: Toolbar Buttons
Basic Report Designer Techniques and Keyboard Commands
You can use many the following keys and techniques throughout Report Designer.
- Accessing Help From Within Report Designer
- Using the Menus
- Navigating Through the Report Designer Windows
- Navigating Without a Mouse or Other Pointing Device
- Editing a Box (F2)
- Selecting Rows or Columns
- Displaying a List of Available Entries (F3)
- Using the Right Mouse Button

Accessing Help From Within Report Designer
- Press **F1** for help related to the current task.
- Or, on the **Help** menu, click **Contents**.
- Click the toolbar **Help** button.

Using the Menus

**To display a menu**
- Select one of the menus with the mouse pointer and click.
- Press the **Alt** key and the keyboard key that corresponds to its underlined letter. For example, to select the **File** menu, press **Alt+F**.

**To select a command from the menu**
- Click on the command.
- Press the keyboard key that corresponds to its underlined letter. For example, to select the **New** command from the **File** menu, press **N**.

**To exit the menu without making a selection**
- Press **Esc** twice or click in the main window outside the menu.

---

Note
---

Menus that are the same for all Report Designer windows are described in “Defining Available Commands on Report Designer Menus” on page 19. Menus used in specific Report Designer building blocks (Row Formats, Column Layouts, Reporting Trees or the Catalog of Reports), are described in the chapter for that building block.
Navigating Through the Report Designer Windows

- To open a building block without closing the current one, on the File menu, point to New, and click Column.

- To close an open building block, on the File menu, click Close.

- If you’re in a window, click Cancel to return to the main window. Or, to execute your selections, click OK.

- To exit Report Designer, on the File menu, click Exit.

Navigating Without a Mouse or Other Pointing Device

Every window has a Control-menu box to the left of the title bar.

- To access the Control-menu box for a window that has the focus (that is, a window from which you cannot access the main window), press and hold the Alt key, and then press the spacebar.

- To access the Control-menu box for a child window (that is a window from which you can access the main window), activate the window by selecting the title bar, press and hold the Alt key, and then press the Hyphen (-) key.

Editing a Box (F2)

You can use the F2 key to edit boxes in the Row Format, Column Layout, or Reporting Tree building blocks.

- Press F2 to edit the contents of a box.

- When you are editing, the system defaults to insert mode (if you type characters, they are inserted at the cursor position). To switch to typeover mode (typed characters replace existing characters), press the Insert key.

- If you are editing a box (after pressing the F2 key), press Esc to restore the original box contents.

Selecting Rows or Columns

You can select an entire row or column in your building blocks by highlighting it.

- To highlight a row with the keyboard, press and hold the Shift key while pressing the spacebar.

- To highlight a row with your mouse, click the box to the left of the Row Code cell.

- To highlight a column with the keyboard, press and hold the Ctrl key while pressing the spacebar.

- To highlight a column with the mouse, click the box at the top of the column.
Displaying a List of Available Entries (F3)

List boxes have a down arrow button on the right side. If you click this button, a list of available entries appears.

| Note | On some list boxes, such as those in the Column Layout window, the down arrow button appears only when you select the cell (move the cursor to that cell). |

There are four ways to display a list of available options:

- Click the down arrow button.
- Double-click on a cell that contains a down arrow button.
- Place your cursor in the cell and then press F3.
- Place your cursor in the cell, then on the Edit menu, click Zoom.

Using the Right Mouse Button

You can right-click to open a shortcut edit menu from any of the Report Designer building blocks. The following menu appears when you right-click from a row format, column layout, or reporting tree cell.

![Shortcut Edit Menu](image)

Figure 1-6: Shortcut Edit Menu

You can edit the box using one of the following options.

<table>
<thead>
<tr>
<th>Shortcut Menu Selection</th>
<th>Description and Steps</th>
</tr>
</thead>
</table>
| **Cut**                 | Use the Cut command to remove information from a building block cell:  
                          | 1 Highlight the information you want to cut.  
                          | 2 Right-click and select Cut. |
| **Copy**                | Use the Copy command to copy information from a building block cell:  
                          | 1 Highlight the information you want to copy.  
                          | 2 Right-click and select Copy. |

Table 1-2: Shortcut Edit Menu Selections
<table>
<thead>
<tr>
<th>Shortcut Menu Selection</th>
<th>Description and Steps</th>
</tr>
</thead>
</table>
| **Paste**               | Use the **Paste** command to paste information into a building block cell:  
1. Click the box in which you want to paste.  
2. Right-click and select **Paste**. |
| **Clear**               | Use the **Clear** command to clear information from a building block cell:  
1. Highlight the information that you want to clear.  
2. Right-click the cell, row, column, or unit.  
3. Select **Clear**. |
| **Find**                | Use the **Find** command to locate information contained in a building block cell:  
Refer to the instructions **To find text**, later in this chapter. |
| **Replace**             | Use the **Replace** command to locate and replace information in a building block box:  
Refer to the instructions **To replace text**, later in this chapter. |
| **Delete Row, Column, Unit** | Use the **Delete** command to delete an entire row, column, or reporting unit:  
1. Select the row, column, or unit that you want to delete and then right-click.  
2. From the menu, select **Delete Row, Delete Column**, or **Delete Unit**. |
| **Insert Row, Column, Unit** | Use the **Insert** command to insert an entire row, column, or reporting unit:  
1. To insert a row or unit, place your cursor in the cell directly below where you want to insert the row or unit.  
2. To insert a column, select the column directly before where you want to insert the new column.  
3. Right-click and select **Insert Row, Insert Column**, or **Insert Unit**.  
Report Designer inserts the row, column, or unit above the highlighted row, column, or unit. |

Table 1-2: Shortcut Edit Menu Selections (Continued)

**To find text**

1. Right-click in the building block you want to search.
2. Select **Find** to display the **Find** dialog box.

3. In the **Find What** box, type the text you are trying to locate.

4. Click **Find Next**.

5. To conduct a more specific search, select one or more options from the **Search Options** section of the dialog box.

   After locating the text, you can replace it with new text by clicking **Replace**.

**To replace text**

1. Right-click in the building block you want to search.

2. Select **Replace** to display the **Replace** dialog box.

3. In the **Find what** box, type the text you want to find.

4. In the **Replace with** box, enter the text you want to replace it with.

5. Click **Replace** to replace a single occurrence of the text or **Replace All** to replace all occurrences of the text.

**Display-only Boxes**

Display-only boxes show information that may be useful to you in the function you’re performing. The information in these boxes is for viewing only.

Figure 1-7: Display-only Box
Record Control Boxes

Some windows in FRx contain record control boxes. A record control box looks like the following picture.

<table>
<thead>
<tr>
<th>Record Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow Buttons</td>
<td>Click the far right or left arrow buttons to move to the first or last alphabetically sorted record in the series (for example, the last catalog). Click the inside arrow button to move to the previous or next record.</td>
</tr>
<tr>
<td>Find</td>
<td>Click Find to display a selection dialog box that lists all related records in alphabetical order. As you begin to type a record name into the Search box, the cursor moves to the first record that begins with the letters you typed. You can also select a record by clicking its name on the list.</td>
</tr>
<tr>
<td>New</td>
<td>Click New to enter a new record into Report Designer. In some cases, default values may be provided.</td>
</tr>
<tr>
<td>Clone</td>
<td>Click Clone to clear the form’s primary (unique) keys and retain all other information. You can use this button to copy information from an existing record to a new record.</td>
</tr>
<tr>
<td>Save</td>
<td>Click Save to save any modifications you’ve made to the current record.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click Delete to permanently delete the current record from Report Designer. You will be asked to confirm that you really want to delete the record.</td>
</tr>
</tbody>
</table>

Table 1-3: Record Control Box Selections

- The Toolbar
- Record Control Boxes

Defining Available Commands on Report Designer Menus

Each row format, column layout, reporting tree, and catalog window in Report Designer has a menu bar at the top of the window. Each menu system contains several menus. Some menu commands, such as those in the File menu, have many of the same commands for all Report Designer windows. Other menus are used in some Report Designer windows but not in others. For example, the Tree menu is only accessible from the Reporting Tree window.
This section describes the menus and options that are standard on all the Report Designer main windows. Menus that appear only in specific windows and building block options (for example, the Row Formats window) are discussed in their respective chapters.

Use this table as a quick reference list for using the standard menus.

<table>
<thead>
<tr>
<th>To</th>
<th>Select this menu and command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a new row, column, or tree</td>
<td>On the <strong>File</strong> menu, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Open an existing row, column, tree, or catalog ID</td>
<td>On the <strong>File</strong> menu, click <strong>Open</strong>.</td>
</tr>
<tr>
<td>Close an open window</td>
<td>On the <strong>File</strong> menu, click <strong>Close</strong>.</td>
</tr>
<tr>
<td>Close all open windows</td>
<td>On the <strong>File</strong> menu, click <strong>Close All</strong>.</td>
</tr>
<tr>
<td>Save the current file</td>
<td>On the <strong>File</strong> menu, click <strong>Save</strong> (or press Ctrl+S).</td>
</tr>
<tr>
<td>Save the current file with a new name</td>
<td>On the <strong>File</strong> menu, click <strong>Save As</strong> (or press Ctrl+A).</td>
</tr>
<tr>
<td>Change the printer setup</td>
<td>On the <strong>File</strong> menu, click <strong>Print Setup</strong>.</td>
</tr>
<tr>
<td>Repair your specification set or FRx system database</td>
<td>On the <strong>File</strong> menu, click <strong>Compact FRx Database</strong>.</td>
</tr>
<tr>
<td>Exit from Report Designer</td>
<td>On the <strong>File</strong> menu, click <strong>Exit</strong>.</td>
</tr>
<tr>
<td>View the company information</td>
<td>On the <strong>Company</strong> menu, click <strong>Information</strong>.</td>
</tr>
<tr>
<td>Change your default company</td>
<td>On the <strong>Company</strong> menu, click <strong>Select Default</strong>.</td>
</tr>
<tr>
<td>Edit the amount and date formatting</td>
<td>On the <strong>Company</strong> menu, click <strong>International Formats</strong>.</td>
</tr>
<tr>
<td>Edit specification sets</td>
<td>On the <strong>Company</strong> menu, click <strong>Specification Sets</strong>.</td>
</tr>
<tr>
<td>Turn on or turn off the toolbar</td>
<td>On the <strong>Options</strong> menu, click <strong>Tool Bar</strong>.</td>
</tr>
<tr>
<td>Turn on or turn off the status bar</td>
<td>On the <strong>Options</strong> menu, click <strong>Status Bar</strong>.</td>
</tr>
</tbody>
</table>

*Table 1-4: Report Designer Standard Menus*
### Turn on or turn off the edit bar
On the **Options** menu, click **Edit Bar**.

### Display the Report Designer Control Panel
On the **Window** menu, click **Control Panel** (or press **F6**).

### Display all open windows above and below one another
On the **Window** menu, click **Tile Horizontal**.

### Display all open windows next to one another
On the **Window** menu, click **Tile Vertical**.

### Display all open windows over one another
On the **Window** menu, click **Cascade**.

### Get help on Report Designer
On the **Help** menu, click **Contents**.

### Get help on a box in Report Designer
On the **Help** menu, click **Context Sensitive**.

### Find out the Report Designer release number and available windows system resources
On the **Help** menu, click **About**.

---

**Table 1-4: Report Designer Standard Menus (Continued)**
This chapter describes how to create a basic report in the FRx® Report Designer. In this chapter, you learn step-by-step how to build, save, and view a report.

To get up to speed quickly, read this chapter before using Report Designer. For examples of many specific types of reports, see FRx® 6.7 Sample Reports.

Although there are many features and options available in Report Designer, you do not need to understand all of them in order to produce excellent reports. Many users can significantly improve their reporting capabilities using just the basic features that are described in this chapter.

As you become more familiar with Microsoft® Business Solutions for Analytics–FRx®, you can take advantage of some of its more advanced features. At this point, refer to the remaining chapters in this guide for more detailed explanations of all the FRx features.

The material that follows is much easier to understand when you display Report Designer on your screen. So before you continue, make sure that FRx is installed and ready to go.
Creating a Company

When you first begin to use FRx, you must supply Report Designer with information that is specific to your individual company or companies.

To create a company

1. Start Report Designer to display the FRx Control Panel.

2. On the Company menu, click Information to display the Company Information dialog box.

The Company Information dialog box displays showing the first company information record.

3. Click the New icon to clear the boxes in the Company Information dialog box.

4. In the FRx company code box, type a unique code that describes this company and corresponds with your general ledger name.

Caution: FRx does not recognize the following symbols as valid company code characters: ' " | / : ? * <>.
5 In the **Company name** box, type a description that corresponds with your FRx Company name. This name also appears on your reports by default, so select and type your description with this in mind.

6 Click the **Accounting system** box and select your accounting system from the list.

7 Click the **FRx System Information** tab.

8 In the **Specification set** box, leave the **Default** option selected. If you previously created a specification set to work with your accounting system, you may select it here.

   **Note:** This is the database name where FRx stores a company’s report building blocks (the row formats, column layouts, reporting trees, and catalog IDs).

9 In the **Import and export path** box, do one of the following:
   - Leave the default IO_Data subdirectory.
   - Type a new path for imported or exported files.

   This path identifies where FRx stores and searches for the FRx® DrillDown Viewer™ (.frd, .frb, and .frz), XML, Microsoft® Excel (.xls), and Lotus 1-2-3 (.wk1) files.

10 In the **Amount and date format** box, do one of the following:
   - Select an international format from the list.
   - Leave this box blank to have FRx default to your computer’s setting.

   This setting applies only to this company and the reports associated with this company. You can override this setting for columns in the column layout window or for individual reporting units in a reporting tree.

11 In the **Functional currency** box, select a currency code from the list.

   Normally, you should set the functional currency to be the same as the base currency for your general ledger. This is the currency that is the starting point for all currency conversions.

12 The **Rates database path** box is used in conjunction with the FRx® Currency Translation function. See Chapter 9, “Using FRx Currency Translation” for more information.

13 In the **Period description** box, do one of the following:

<table>
<thead>
<tr>
<th>If your accounting periods</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are full months</td>
<td>Leave the default <strong>Month Ending.</strong></td>
</tr>
<tr>
<td><em>Are not</em> full months</td>
<td>Type <strong>Period Ending.</strong></td>
</tr>
</tbody>
</table>

   **Note:** This description is used on report headings.
In the **Plural Description** box, do one of the following:

<table>
<thead>
<tr>
<th>If your accounting periods</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are full months</td>
<td>Leave the default <strong>Months Ending</strong>.</td>
</tr>
<tr>
<td><em>Are not</em> full months</td>
<td>Type <strong>Periods Ending</strong>.</td>
</tr>
</tbody>
</table>

The text that you type in this box is used in your report headings. For example, if you type **Months Ending** in this box, the heading for a report generated for March 2004 will read **For the Months Ending March 31, 2004**.

15 Click the **System Specific Information** tab.

16 Refer to the *FRx*® *Report Designer Getting Started Guide* shipped with FRx to complete this tab.
Creating a Sample Report

The following pages topics illustrate how to create the sample income statement shown in Figure 2-1. This report is based on the Fabrikam Works sample data. Use the sample data to follow the steps and create the sample report yourself. Or, you can modify the instructions to use your own company, chart of accounts, and corporate structure.

![Figure 2-1: Income Statement](image)

<table>
<thead>
<tr>
<th></th>
<th>August</th>
<th>YTD</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Revenue</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales</td>
<td>$1,063,650</td>
<td>$7,966,746</td>
</tr>
<tr>
<td>Sales Returns</td>
<td>8,622</td>
<td>63,952</td>
</tr>
<tr>
<td>Sales Discounts</td>
<td>28,738</td>
<td>213,157</td>
</tr>
<tr>
<td><strong>Net Sales</strong></td>
<td>1,026,290</td>
<td>7,689,637</td>
</tr>
<tr>
<td>COGS</td>
<td>747,900</td>
<td>5,596,129</td>
</tr>
<tr>
<td><strong>Gross Margin</strong></td>
<td>278,390</td>
<td>2,063,508</td>
</tr>
</tbody>
</table>

**Operating Expenses**

<table>
<thead>
<tr>
<th>Expense</th>
<th>August</th>
<th>YTD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salary Expense</td>
<td>49,181</td>
<td>372,767</td>
</tr>
<tr>
<td>Officers Compensation</td>
<td>27,184</td>
<td>204,609</td>
</tr>
<tr>
<td>Depreciation Expense</td>
<td>4,855</td>
<td>38,840</td>
</tr>
<tr>
<td>Office Expense</td>
<td>4,135</td>
<td>31,028</td>
</tr>
<tr>
<td>Supplies Expense</td>
<td>730</td>
<td>5,698</td>
</tr>
<tr>
<td>Maintenance Expense</td>
<td>1,285</td>
<td>10,029</td>
</tr>
<tr>
<td>Rent Expense</td>
<td>10,449</td>
<td>78,203</td>
</tr>
<tr>
<td>Travel Expense</td>
<td>8,866</td>
<td>67,101</td>
</tr>
<tr>
<td>Advertising Expense</td>
<td>9,588</td>
<td>63,515</td>
</tr>
<tr>
<td>Commission Expense</td>
<td>16,233</td>
<td>139,142</td>
</tr>
<tr>
<td><strong>Total Operating Expenses</strong></td>
<td>132,499</td>
<td>1,040,922</td>
</tr>
</tbody>
</table>

**Income From Operations**

<table>
<thead>
<tr>
<th>Income From Operations</th>
<th>145,691</th>
<th>1,082,586</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interest Income(Expense)</td>
<td>(614)</td>
<td>(8,805)</td>
</tr>
</tbody>
</table>

**Income Before Income Taxes**

| Income Before Income Taxes | 145,277 | 1,075,781 |
|                           | 30,399  | 230,305   |

**Net Income**

| Net Income | $114,878 | $845,416 |

Figure 2-1: Income Statement
Building a Row Format from the Chart of Accounts

FRx is designed to be flexible and easy to use. One way it accomplishes this goal is to provide you with familiar interface features that you may already be using in Windows-based spreadsheet programs, such as Microsoft Excel.

The flexibility of Report Designer makes each row format useful in many different situations. Keep in mind that if you plan to use the same format for more than one department, you do not need to repeat this procedure for each department.

In this section, you learn how to build a new row format by automatically pulling data from the FabrikamWorks, Inc. sample database. After you build this row format, the row format contains row codes that identify each row, row description, general ledger code, and other information extracted from the FabrikamWorks chart of accounts.

To build a row format

1. From the FRx Control Panel, on the Company menu, click Select Default to display the Select Default Company dialog box.

2. In the Select Default Company dialog box, select FW.

3. Click OK to return to the FRx Control Panel.

4. On the File menu, point to New, and then click Row.

   Note: The row format name at the top of the window is Untitled 1, which means you are working with a new, unsaved file.

5. On the Edit menu, click Add Rows from Chart of Accounts to display the Add Rows From Chart of Accounts dialog box.

For information about using the natural account code segment, see “Account Codes” on page 10 in Chapter 1.
6 Then do the following:
   - In the first **Account Range Start** box, type **4100**.
   - In the first **Account Range End** box, type **5500**.

   **Note:** When you type a segment, Report Designer pulls only the unique codes for that segment into the row format. For example, the natural segment 4100 can be included in hundreds of general ledger accounts, but appears only one time in the row format.

7 The **Starting row code** box automatically defaults to row 100. This default displays Row 100 as the first row when you open the Row Format window.

8 The **Increment each row by** box automatically defaults to 30. This default increments each row code in the Row Format window by 30. For example, the first row is numbered 100, the second row is numbered 130, and so on.

9 Click **OK** to display the accounts 4100 to 5500 in the Row Format window.

### Tip:
Do not try to create a format that contains all of the general ledger account and subaccount combinations in your company. Report Designer works with many small row formats and then uses the reporting tree and other techniques to run reports for multiple departments. If your selection results in more than a few hundred report rows, break the format down into smaller sections of the report.
Modifying a Row Format

This section describes the steps to format report rows for a sample income statement including:

- Revenue Rows
- Operating Expenses Rows
- Income Rows

Revenue Rows

The Row Codes 25-259 used below in Figure 2-2 represent formatted rows for a sample income statement. The revenue rows in this sample income statement include Revenue description, Sales, Net Sales, Cost of Goods Sold (COGS), Gross Margin, and rows to create a separation from expenses.

![Figure 2-2: Accounts in Row Formats Window, Row Codes 25–259](image)

Adding a Revenue Description

You can modify the sample row format you created in “Building a Row Format from the Chart of Accounts” on page 27 to include additional rows, and then designate the rows as Revenue using the DES format code. You can add Revenue report rows in the row format window, with rows displayed. The revenue Row Codes 25-75 in Figure 2-2 are based on the following instructions.

---

Note

The row codes that you create in the sample report could be different than those shown in Figure 2-2.
To add revenue description report rows

1. Look at the top of the sample row format (Row Code 100) you created in the previous section.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>109</td>
<td>Sales</td>
<td>C</td>
<td>4103</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Sales (Elimination)</td>
<td>C</td>
<td>4109</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>111</td>
<td>Sales Returns</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. From row 100, select three rows.
3. On the Edit menu, click Insert Row to add three new rows.
4. Do the following:

<table>
<thead>
<tr>
<th>In</th>
<th>Do this</th>
</tr>
</thead>
</table>
| The first new row | 1. Click the Fmt Code column, select DES from the list.  
2. Click OK to return to the Row Format window. |
| The second new row | Click the Description column, and in the edit bar, type Revenue. |
| The third new row | 1. Click the Fmt Code column and select DES from the list.  
2. Click OK to return to the Row Format window. |

You have now added a Revenue heading and spacing around your heading using the DES (Description) format code.

Modifying Sales Report Rows

You can make changes to column values, change row codes, and add or delete rows. The Sales Row Codes 100-199 in Figure 2-2 on page 29 were modified using the following instructions.
To modify sales report rows

1. Go to the Sales row in your sample row format.

   In our example, this row is **Row Code 100**.

2. Click the **Link to General Ledger** column.

3. Then, in the edit bar, change 4100 to **410?–(4109)**.

   **Note:** In row **100**, a **C** appears in the Norm Bal column. This reverses the sign of the normal balance credit account and makes it appear as a positive amount on the report.

4. Select the Sales (Elimination) row.

5. On the Edit menu, click **Delete Row**.
   This removes the elimination row from the report.

6. Starting with the COGS row, select three rows.

7. On the Edit menu, click **Insert Row** to add three new rows.

8. In the row following the Sales Discounts row, click the Fmt Code column and select **---** Fmt Code from the list.
   This places an underline beneath the Sales Discounts row.

9. Review your formatted Sales row.

   ![Row Format Table]

   In our example, this row is **Row Code 100**.

Adding a Net Sales Row that Includes a Formula

You can modify a row to include net sales by changing the format code to **TOT** (total) and adding a formula to calculate net sales. The **Net Sales Row Code 206** in Figure 2-2 on page 29 was added using the following instructions.
To add a net sales row that includes a formula

1. Go to the row following the underline format you created for Sales Discounts.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C Fmt Code</th>
<th>D Related Rates/Rows/Unit</th>
<th>E Norm Col</th>
<th>F Pct Col</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>55</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>Revenue</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Sales</td>
<td>C</td>
<td>4107 (4119)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Sales Returns</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>190</td>
<td>Sales Discounts</td>
<td></td>
<td>4206</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>206</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In our sample row format, this is **Row Code 206**.

2. Click the **Fmt Code** column and select **TOT** from the list.

   Report Designer calculates a total when you select this code.

3. Click the **Related Rates/Rows/Unit** column and type the row codes for the following formula:

   \(<Sales\ row\ code>- (minus) <Sales Returns\ row\ code>- (minus) <Sales Discount\ row\ code>\).

   In our sample row format, the net sales formula is **100-160-190**.

4. Review your formatted Net Sales row.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C Fmt Code</th>
<th>D Related Rates/Rows/Unit</th>
<th>E Norm Col</th>
<th>F Pct Col</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>Sales</td>
<td>C</td>
<td>4107 (4119)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Sales Returns</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>190</td>
<td>Sales Discounts</td>
<td></td>
<td>4206</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>206</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Modifying COGS Report Rows**

You can apply the formatting features you used in the previous sections to modify the COGS report rows. The **COGS Report Codes 213-231** in Figure 2-2 on page 29 were modified using the following instructions.
To modify COGS report rows

1 Go to the row following the Net Sales row.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C Fmt Code</th>
<th>D Related Rates/Rows/Unit</th>
<th>E Name Edit</th>
<th>F Print Col</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>Revenue</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Sales</td>
<td>C</td>
<td>4107 (4110)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Sales Returns</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>180</td>
<td>Sales Discounts</td>
<td></td>
<td>4500</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>Net Sales</td>
<td>TOT</td>
<td>1001-100150</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>210</td>
<td>COGS</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>COGS (Elimination)</td>
<td></td>
<td>4500</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>230</td>
<td>Salary Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In our example, this is Row Code 213.

2 Click in the Fmt Code column and select DES from the list.

3 In the COGS row, click the Link to General Ledger column, and in the edit bar, change 4500 to 450? -(4509). The wildcard (?) tells Report Designer to include all natural accounts from 4500 to 4509.

4 Select the COGS (Elimination) row.

5 On the Edit menu, click Delete Row.

6 Starting with the Salary Expense row, select seven rows.

7 On the Edit menu, click Insert Row to add seven new rows.

8 In the row following COGS, select the -- Fmt Code.

9 Review your formatted COGS rows.

Adding a Gross Margin Row that Includes a Formula

You can include a formula in the Related Rates/Rows/Unit column that calculates the gross margin by adding the Net Sales row and the COGS row together. The Gross Margin Row Code 238 in Figure 2-2 on page 29 was added based on the following instructions.
To add a gross margin row that includes a formula

1. Go to the row following the underline format row for COGS.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C Fmt Code</th>
<th>D Related Rates/Rows/Unit</th>
<th>E Norm Bal</th>
<th>F Pmt On</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>59</td>
<td>Revenue</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Sales</td>
<td>C</td>
<td></td>
<td>410</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Sales Returns</td>
<td></td>
<td></td>
<td>4110</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>190</td>
<td>Sales Discounts</td>
<td></td>
<td></td>
<td>4250</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>195</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Net Sales</td>
<td>TOT</td>
<td></td>
<td>100160190</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>223</td>
<td>COGS</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>225</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In our example, this is **Row Code 238**.

2. Click the **Description** column, and in the edit bar, type **Gross Margin**.

3. Click the **Fmt Code** column and select **TOT** from the list.

4. In the **Related Rates/Rows/Unit** column, type the row codes for the following formula:

   `<Net Sales row code>- (minus) <COGS row code>`.

   In our sample row format, the gross margin row formula is **206-220**.

5. In the row following the **Gross Margin** row, click the **Fmt Code** column and select **---** from the list.

   This inserts an underline under the previous row.


<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C Fmt Code</th>
<th>D Related Rates/Rows/Unit</th>
<th>E Norm Bal</th>
<th>F Pmt On</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>225</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>223</td>
<td>COGS</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>225</td>
<td>Gross Margin</td>
<td>TOT</td>
<td></td>
<td>206220</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>225</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Separating Revenue Rows from Operating Expenses Rows**

You can separate the Revenue portion of the sample income statement from operating expenses using row formatting options. The **Separate Revenue from Expense Row Codes 252 to 259** in Figure 2-2 on page 29 are based on the following instructions.
To separate revenue rows from operating expenses rows

1. Go to the row following the underline format row for **Gross Margin**.

   ![Screenshot of report with row codes and formats]

   In our example, this is **Row Code 252**.

2. Click the **Fmt Code** column and select **DES** from the list.

3. In the next row, repeat step 2.

4. Review your formatting to separate revenue from operating expense rows.

   ![Screenshot of report with formatted data]
Operating Expenses Rows

Now that the revenue portion of your income statement is formatted, you are ready to modify the Operating Expenses rows in your sample row format. Row Codes 226-565, shown below in Figure 2-3, represented formatted expense rows.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C Fmt Code</th>
<th>D Related Rates/Rates Unit</th>
<th>E Norm Bal</th>
<th>F Print Ctrl</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>266</td>
<td>Operating Expenses</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>267</td>
<td>Salary Expense</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>270</td>
<td>Office Expense</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>272</td>
<td>Maintenance Expense</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>273</td>
<td>Rent Expense</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>276</td>
<td>Travel Expense</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>277</td>
<td>Advertising Expense</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>278</td>
<td>Commission Expense</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>279</td>
<td>Total Operating Expenses</td>
<td>TOT</td>
<td>200100.50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>280</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 2-3: Accounts in Row Formats Window, Row Codes 266–565.

Note: The row codes that you create in the sample report could be different than those shown in this example.

Adding Operating Expenses Row

As with Revenue you can modify the sample row format to designate a row as Operating Expenses using the DES format code. The Operating Expenses Row Codes 266 and 273 in Figure 2-3 are based on the following instructions.

To add Operating Expenses row

1. Go to the row following the revenue separating rows.
2. Click the Description column.
3. In the edit bar, type Operating Expenses.
4. Click the Fmt Code column and select DES from the list.

In our example, this is Row Code 266.
Review your formatted Operating Expenses row.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C Fmt Code</th>
<th>D Related Profit/Round Unit</th>
<th>E Nominal</th>
<th>F Print Unit</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>261</td>
<td>Operating Expenses</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>273</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Modifying the Expenses Report Rows

You can accept expense rows as they are or apply modifications with features that you used in the previous sections. The Expenses Row Codes 280 to 555 in Figure 2-3 on page 36 were modified based on the following instructions.

To modify the expenses report rows

1. Go to the expense rows in your sample row format.

2. Leave the following rows as they are: Salary Expense, Officers Comp, Depreciation Expense, Office Expense, Supplies Expense - Service, Maintenance Expense, Rent Expense, Travel Expense, and Advertising Expense.

3. In the Commissions Expense row, click the Link to General Ledger column.

4. Then, in the edit bar, change 5400 to 54?? to include all natural accounts beginning with 54 into this report row.

5. Starting with the Income Tax Expense row, select five rows.

6. On the Edit menu, click Insert Row.

7. In the next row below Commissions Expense, click the --- Fmt Code column and select --- Fmt Code from the list.
8 Review your formatted expense rows.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>Code</th>
<th>D Related Rates/Rows/Unit</th>
<th>E Norm Bul</th>
<th>F Print Cnt</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>266</td>
<td>Operating Expenses</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>273</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>280</td>
<td>Salary Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>310</td>
<td>Officers Comp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>340</td>
<td>Depreciation Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>370</td>
<td>Office Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Supplies Expense - Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>430</td>
<td>Maintenance Expense - Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>460</td>
<td>Rent Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>480</td>
<td>Travel Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>520</td>
<td>Advertising Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>550</td>
<td>Commission Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>556</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Adding a Total Operating Expenses Row using a Formula

You can include a formula in the Related Rates/Rows/Unit column that calculates the total operating expenses. The **Total Operating Exp Row Code 560** shown in Figure 2-3 on page 36 is based on the following instructions.

**To add a Total Operating Expenses row using a formula**

1 Go to the row following the underline format row for Commissions Expense.

In our example, this is **Row Code 560**.

2 Click the Description column.

3 Then, in the edit bar, type **Total Operating Expenses**.

4 Click the Fmt Code column, and select **TOT** from the list.

5 Click the Related Rates/Rows/Unit column

6 In the edit bar, use the formula row code range:

   `<Salary Expense row code> TO <Commissions Expense row code>`.

   In our example row format, the total operating expense formula is **280 TO 550**.

7 In the next row, click the Fmt Code column, and select **--- Fmt Code** from the list. This places an underline beneath the Total Operating Expenses row in your report.
8 Review your formatted Total Operating Expenses rows.

<table>
<thead>
<tr>
<th>Row Code</th>
<th>Description</th>
<th>C Code</th>
<th>D Related Rates/Rows/Unit</th>
<th>E Normal</th>
<th>F Pivot Dr</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>394</td>
<td>Operating Expenses</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>395</td>
<td>Salary Expense</td>
<td></td>
<td></td>
<td>9800</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>310</td>
<td>Officers Compensation</td>
<td></td>
<td></td>
<td>9650</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>340</td>
<td>Depreciation Expense</td>
<td></td>
<td></td>
<td>5150</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>370</td>
<td>Office Expense</td>
<td></td>
<td></td>
<td>5200</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Supplies Expense</td>
<td></td>
<td></td>
<td>5250</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>350</td>
<td>Maintenance Expense</td>
<td></td>
<td></td>
<td>5240</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>450</td>
<td>Rent Expense</td>
<td></td>
<td></td>
<td>5250</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>480</td>
<td>Travel Expense</td>
<td></td>
<td></td>
<td>5900</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>510</td>
<td>Advertising Expense</td>
<td></td>
<td></td>
<td>5390</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>520</td>
<td>Commission Expense</td>
<td></td>
<td></td>
<td>5417</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>565</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>560</td>
<td>Total Operating Expenses</td>
<td>TOT</td>
<td>201 TO 560</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Income Rows**

After modifying the revenue and operating expenses rows in your sample row format, you can complete your row format with income categories. **Row Codes 570-640**, shown in Figure 2-4, represent formatted income rows.

**Adding an Income from Operations Row using a Formula**

You can include a formula in the **Related Rates/Rows/Unit** column that calculates the income from operations. The **Income from Operations** report row 570 in Figure 2-4 was added using the following instructions.

1. Go to the row following the underline format row for Total Operating Expenses.

   ![Total Operating Expenses Row](image)

   In our example, this is **Row Code 570**.

2. Click the **Description** column, and in the edit bar, type **Income From Operations**.

3. Click the **Fmt Code** column and select **TOT** from the list.

4. Click the **Related Rates/Rows/Unit** column.

---

**Note**

The row codes in the sample report that you create could be different than those shown in this example.
5 Then, in the edit bar, use the formula \(<\text{Gross Margin row code}>-(\text{minus})<\text{Total Operating Expenses row code}>\) to calculate income from operations.

In our example, row format, the formula is \(238-560\).

6 In the row following the \text{Income From Operations} row, click the Fmt Code column and select --- Fmt Code from the list.

This places an underline beneath the Income From Operations row.

7 Review your formatted Income From Operations rows.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>574</td>
<td>Income From Operations</td>
<td>101</td>
<td>---</td>
<td>238.560</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>575</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Adding Interest Income Rows

You can insert and modify income rows by applying formatting features you have used in the above sections. The \text{Interest Income Row Codes 575 to 578} in Figure 2-4 are based on the following instructions.

To add interest income rows

1 Go to the Income Tax Expense row.

In our example, this is Row Code 580.

2 Starting with this \text{Income Tax Expense} row, select three rows.

3 On the Edit menu, click Insert Row to insert three new rows.

4 In the first inserted row, click the Description column, and in the edit bar, type \text{Interest Income (Expense)}.

5 Click the Norm Bal column and select C from the list.

6 Click In the Link to General Ledger column, and in the edit bar, type \(5650+7000\).

7 In the next row, click the Fmt Code column and select --- Fmt Code from the list.

This places an underline beneath the Interest Income (Expense) row.

8 Review your formatted Interest Income (Expense) rows.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>574</td>
<td>Income From Operations</td>
<td>101</td>
<td>---</td>
<td>238.560</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>575</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>576</td>
<td>Interest Income(Expense)</td>
<td>5650 +7000</td>
<td>C</td>
<td>5650 +7000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Adding an Income Before Income Taxes Row using a Formula

You can include a formula in the Related Rates/Rows/Unit column that calculates the income before income taxes. The \text{Income Before Income Taxes Row Code 579} in Figure 2-4 on page 39 is based on the following instructions.
To add an Income before Income Taxes row using a formula

1. Go to the row following the underline format row for Interest Income (Expense).

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>567</td>
<td>Income From Operations</td>
<td>TOT</td>
<td>238,950</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>565</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>577</td>
<td>Interest Income (Expense)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>575</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>579</td>
<td>Income Before Income Taxes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>566</td>
<td>Income Tax Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>560</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>560</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In our sample format, this is Row Code 579.

2. Click the Description column.

3. Then, in the edit bar, type Income Before Income Taxes.

4. Click the Fmt Code column and select TOT from the list.

5. Click the Related Rates/Rows/Unit column.

6. Then, in the edit bar, use the row code range formula: `<Income From Operations row code>` TO `<Interest Income row code>` to calculate income before taxes. In our example, we used the formula 570 TO 578.

7. Leave the Income Tax Expense row as is.

8. In the next row, click the Fmt Code column and select --- Fmt Code from the list. This places an underline beneath the Income Tax Expense row.


Adding a Net Income Row using a Formula

You can include a formula in the Related Rates/Rows/Unit column that calculates net income. The Net Income report row 640 in Figure 2-4 on page 39 is based on the following instructions.

To add a net income row using a formula

1. Go to the row following the underline format row for Income Tax Expense.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>567</td>
<td>Income From Operations</td>
<td>TOT</td>
<td>238,950</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>565</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>577</td>
<td>Interest Income (Expense)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>575</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>579</td>
<td>Income Before Income Taxes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>566</td>
<td>Income Tax Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>560</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>560</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>560</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In our example, this is Row Code 640.

1. Click the Description column, and in the edit bar, type Net Income.

2. Click the Fmt Code column and select TOT from the list.
3 Click the Related Rates/Rows/Unit column.

4 In the edit bar, type the following formula: `<Income Before Income Taxes row code> - (minus) <Income Tax Expense row code>.

In our example row format, we used the formula 580-610.

5 Click the Print Ctrl column, and in the edit bar, type CS to include a currency symbol for this row.

6 Review your formatted Net Income row.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C Frt Code</th>
<th>D Related Rates/Rows/Unit</th>
<th>E Norm Ctrl</th>
<th>F Print Ctrl</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>570</td>
<td>Income From Operations</td>
<td>10T</td>
<td>204 560</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>575</td>
<td>Interest Income(Expense)</td>
<td></td>
<td>--</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>579</td>
<td>Income Before Income Taxes</td>
<td>10T</td>
<td>570 To 577</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>550</td>
<td>Income Tax Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>610</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>540</td>
<td>Net Income</td>
<td>10T</td>
<td>59 580</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Saving Your Row Format File

After you have built and modified a new row format, you can save the file to use as your sample report. You can now use this same format for more than one department with Report Designer. The flexibility of Report Designer uses each row format for more than one situation. Report Designer also uses the reporting tree and other techniques to run reports for multiple departments. See “To view an existing tree” on page 48.

To save your Row Format file

1. Review your completed row format for the sample income statement.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>R Description</th>
<th>F Print Code</th>
<th>D Related Rules/Rows/Cells</th>
<th>E Num Ball</th>
<th>F Print CH</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>Revenue</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Sales</td>
<td>C</td>
<td>4107 (4109)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Sales Returns</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>180</td>
<td>Sales Discounts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>206</td>
<td>Net Sales</td>
<td>TOT</td>
<td>100100159</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>213</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>COGS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>221</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>228</td>
<td>Gross Margin</td>
<td>TOT</td>
<td>218229</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>245</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>252</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>259</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>266</td>
<td>Operating Expenses</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>273</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>280</td>
<td>Salary Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>290</td>
<td>Officers Comp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>340</td>
<td>Depreciation Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>370</td>
<td>Office Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Supplies Expense - Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>430</td>
<td>Maintenance Expense - Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>440</td>
<td>Rent Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>450</td>
<td>Travel Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>520</td>
<td>Advertising Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>550</td>
<td>Commission Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>595</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>660</td>
<td>Total Operating Expenses</td>
<td>TOT</td>
<td>20310 350</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>665</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>670</td>
<td>Income From Operations</td>
<td>TOT</td>
<td>238560</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>675</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>677</td>
<td>Interest Income (Expense)</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>678</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>679</td>
<td>Income Before Income Taxes</td>
<td>TOT</td>
<td>57910 577</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>680</td>
<td>Income Tax Expense</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>685</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>690</td>
<td>Net Income</td>
<td>TOT</td>
<td>679600</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. On the File menu, click Save to display the Row Format dialog box.

3. In the Row Format dialog box do the following:
   - In the Name box, type a unique name for the row format.
   - In the Description box, type a description for the row format.
4 Click **OK** to save the file and return to the Row Format window.
Creating a Column Layout

You can define the layout of your report columns. The information in a column layout is combined with the information in a row format (and any reporting tree information), and is stored in the Catalog of Reports.

To create a column layout

1. On the Report Designer Control Panel window, click **Column Layouts** to display the **Open Column** dialog box.

2. Click **New** to display a blank Column Layout window.

3. In the first **Column Headers** row, in column B, double-click to display the **Header Options** dialog box.

4. Click **Insert Code** to display the **Select Column Heading** dialog box.

5. Select **@Month**.

6. Click **OK** to accept and return to the **Header Options** dialog box.
7 In the **Headers Options** dialog box, click **OK** to return to the Column Layout window.

```
<table>
<thead>
<tr>
<th>Column Headers</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@Month</td>
<td></td>
<td>YTD</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

8 In the Column Headers first row, in column **C**, type **YTD**.

9 In the Column Detail **Type** row, double-click column **A** to display the **Zoom (Select the Type of Column)** box.

```
Select the Type of Column

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESC</td>
<td>GL</td>
<td>GL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Book Code/Attribute Category</td>
<td>ACTUAL</td>
<td>ACTUAL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fiscal Year</td>
<td>BASE</td>
<td>BASE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Period Code</td>
<td>BASE</td>
<td>BASE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current YTD</td>
<td>CUR</td>
<td>YTD</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column Width</td>
<td>(a)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extra Sources</td>
<td>(b)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special Column Format</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field Control</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column Restrictions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reporting Unit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Currency Code</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Currency Display</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Currency Rate Subtype</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account Filter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Missing Filter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Justification</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ODL/Description</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

10 Select **DESC** from the list and click **OK** to return to the Column Layout window. This places your row format descriptions in this column.

11 In the Column Detail **Column Width** row, double-click column **A**, and in the edit bar, type **40**. This makes the first column 40 characters wide.

12 In the Column Detail **TYPE** row, double-click column **B** to display the **Zoom (Select the Type of Column)** box.
13 Select GL from the list, and click OK to return to the Column Layout window. Report Designer inserts the following default values:

- **Actual or Budget** cell: ACTUAL
- **Fiscal Year** cell: BASE
- **Period Code** cell: BASE
- **Current Per/YTD** cell: CUR

14 In the Column Detail TYPE row, double-click column C to display the the **Zoom (Select the Type of Column)** box.

15 Select GL from the list, and click OK to return to the Column Layout window.

16 In the Column Detail **Current Per/YTD** row, double-click column C to display the **Zoom (Select the Amount to Use)** box.

```plaintext
Note: Multiple book codes or YTD codes are not supported at the transaction level in Report Designer.
```

17 Select **YTD** and click OK to return to the Column Layout window.

18 On the **File** menu, click **Save** to display the **Column Layout** dialog box.

19 In the **Column Layout** dialog box do the following:
   - In the **Name** box, type a unique name for the new column layout.
   - In the **Description** box, type a description for the column layout.

20 Click **OK** to save the file and return to the Column Layout window.
Working with Reporting Trees

The reporting tree is a visual representation of departments, branch offices, and profit centers within your company. You can automatically build a reporting tree from information in your chart of accounts. For additional information on reporting trees, including how to add additional text or e-mail addresses, see Chapter 6, “Creating a Reporting Tree”.

This section contains information and instructions on:
- Viewing an Existing Tree
- Creating a New Reporting Tree

Viewing an Existing Tree

To view an existing tree

1. On the FRx Control Panel, click Reporting Trees to display the Open Tree dialog box.

2. Select any sample reporting tree.

3. Click OK to display the reporting tree in the Reporting Tree window.

The tree structure displays graphically to the left of the window with the worksheet to the right. This design makes the reporting tree hierarchy easy to see while working on the reporting tree detail.
4 Repeat step 2 for other reporting trees to familiarize yourself with the manner in which trees display in Report Designer.

5 When you are finished reviewing the tree, on the File menu, click Close.

Related Topics
Creating a New Reporting Tree

Creating a New Reporting Tree

Now that you have seen a sample reporting tree, you can create a new reporting tree based on the Fabrikam Works, Inc. sample database.

To create a new reporting tree

1 From the FRx Control Panel window, on the File menu, point to New, and then click Tree to display a blank Reporting Tree window.

2 On the Edit menu, click Add Reporting Units from Chart of Accts to display the Add Reporting Units from Chart of Accounts dialog box.

The account segment uses hooks for its Natural Segment.

Tip: You can use the Add Reporting Units from Chart of Accounts dialog box to define the account segments that you want FRx to include from your chart of accounts. Each account segment is presented in an edit box. By default, the natural segment contains hook characters (&).

3 In the Add Reporting Units from Chart of Accounts dialog box, do the following:

<table>
<thead>
<tr>
<th>Under</th>
<th>Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment Ranges, in the first row</td>
<td>1 In the From Acct box, type 1100.</td>
</tr>
<tr>
<td></td>
<td>2 In the To Acct edit box, type 2200.</td>
</tr>
<tr>
<td>Segment Ranges, in the second row</td>
<td>1 In the From Acct edit box, type 001</td>
</tr>
<tr>
<td></td>
<td>2 In the To Acct edit box, type 004.</td>
</tr>
</tbody>
</table>
4 Click OK to build a new reporting tree from the Chart of Accounts and display it in the worksheet.

5 On the File menu, click Save to display the Reporting Tree dialog box.

6 In the Reporting Tree dialog box do the following:
   - In the Name box, type a unique name for the new reporting tree.
   - In the Description box, type a description for the reporting tree.

7 Click OK to save the reporting tree and return to the Reporting Tree Window.
Creating a New Catalog ID

In the Catalog of Reports, you bring together your row format, column layout, and any reporting tree, and then assign it a catalog ID name.

To create a catalog ID

1. From the Report Designer Control Panel window, on the **File** menu, click **Catalog of Reports** to display the **Select Catalog for Display** dialog box.

   ![Select Catalog for Display](image)

2. Click **New** to open the Catalog of Reports window with the default settings.

   ![Catalog of Reports](image)

3. In the **Catalog ID** box, type a code to describe this sample report. For example, type **IncStmt**.

   ![Catalog ID](image)

   **Note:** The **Catalog ID** is a user-defined name. The name can be up to 16 characters in length, but cannot contain any of the following invalid naming characters: `* \ / : ? * < >`. 
4 In the **Company** box, click the arrow to display the **Select a Company for this Record** dialog box.

![Select a Company for this Record dialog box](image)

5 Select **FW** from the list and click **OK** to return to the Catalog of Reports window.

6 In the **Detail Level** list box, select one of the following detail level reports:

<table>
<thead>
<tr>
<th>Select</th>
<th>To create</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Report</td>
<td>A high-level summary report</td>
</tr>
<tr>
<td>Account Only</td>
<td>A report that contains only account detail balances</td>
</tr>
<tr>
<td>Financial &amp; Account</td>
<td>Two reports: a high-level summary and an account detail</td>
</tr>
<tr>
<td>Transaction Only</td>
<td>A report that contains transaction details</td>
</tr>
<tr>
<td>Financial &amp; Transaction</td>
<td>Two reports: a high-level summary and a transaction detail</td>
</tr>
</tbody>
</table>

7 In the **Provisional** list box, select one of the following:

<table>
<thead>
<tr>
<th>Select</th>
<th>To include</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Posted Balances Only</td>
<td>Only transactions and balances posted in the general ledger</td>
</tr>
<tr>
<td>Provisional: Posted + Unposted Activity</td>
<td>All transactions and balances entered and posted in the general ledger</td>
</tr>
<tr>
<td>Include Unposted Activity Only</td>
<td>Only transactions entered but not yet posted in the general ledger</td>
</tr>
</tbody>
</table>
8 Click the **Report Date** arrow to display the **Periods and Dates** dialog box.

![Periods and Dates dialog box]

9 In the **Base Year** box, type **2003**.

10 Click **OK** to confirm and return to the Catalog of Reports window.

**Note:** For more information about the Report Date, see “Specifying Report Periods and Dates” on page 233.

11 Click the **Building Blocks** tab.

![Building Blocks tab]

12 In the **Row Format** box, click the arrow to display the **Choose a Row Format** box.

![Choose a Row Format]

13 Select the row format you created (or the sample row format, **IncStmt**) and click **OK**.
14 In the **Column Layout** box, click the arrow to display the **Choose a Column Layout** box.

![Choose a Column Layout](image1)

15 Then, do one of the following:
   - Select the column layout that you created
   - Select **Curr_YTD** (The sample column layout.)

16 Click **OK**.

17 Under **Reporting Tree**, select the **Use Reporting Tree** check box.

   **Note:** For the Income Statement sample report you do not need a reporting tree. To create a report without a reporting tree, leave the **Use Reporting Tree** check box blank.

18 In the **Reporting Tree** box, click the arrow to display the **Choose a Reporting Tree** box.

![Choose a Reporting Tree](image2)

19 Select the reporting tree you created or **FabrkWrkA** (the sample reporting tree) and click **OK**.

20 Click **Save**.
Generating and Viewing a Report

When you generate this sample report, it processes using the FRx default settings from the Output, Page Options, and Report Options tabs.

To generate the report

1. Click the Generate Report icon or Press F9 to display the Select Reporting Unit(s) to Print dialog box.

   **Note:** If you did not use a reporting tree, the Report Designer begins processing your report and displays it in the DrillDown Viewer as shown after step 3.

2. In the Select Reporting Unit(s) to Print dialog box, do one of the following:
   - Press the Ctrl key and select the units that you want to include.
   - Click Mark All.
3 Click **OK** to process the report and display it in the DrillDown Viewer.

![Income Statement](image)

4 To view additional information, you can do the following:

<table>
<thead>
<tr>
<th>To View</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>A report row broken out by reporting units, from the current reporting unit</td>
<td>Double-click a report row.</td>
</tr>
<tr>
<td>Other reporting units, from the reporting tree</td>
<td>On the reporting tree, double-click a the reporting unit.</td>
</tr>
</tbody>
</table>

**Note**  
Completing Your Setup

Congratulations! You know how to create report in the Report Designer. Now, you can finish editing your row format, or create a new row format or reporting tree as necessary. For more information, see the following chapters and guides.

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row formats</td>
<td>Chapter 3, “Creating Row Formats.”</td>
</tr>
<tr>
<td>Linking</td>
<td>Chapter 4, “Linking to Other Sources of Information”</td>
</tr>
<tr>
<td>Column layouts</td>
<td>Chapter 5, “Creating Column Layouts.”</td>
</tr>
<tr>
<td>Reporting trees</td>
<td>Chapter 6, “Creating a Reporting Tree.”</td>
</tr>
<tr>
<td>Reports</td>
<td>Chapter 7, “Understanding the Catalog of Reports.”</td>
</tr>
<tr>
<td>Companies, international formats</td>
<td>FRx® Report Designer 6.7 Administrator’s Guide.</td>
</tr>
<tr>
<td>FRx Administration and Security</td>
<td>FRx® Report Designer 6.7 Administrator’s Guide.</td>
</tr>
<tr>
<td>FRx Report Manager</td>
<td>FRx® Report Manager 6.7 User’s Guide</td>
</tr>
<tr>
<td>FRx WebPort</td>
<td>FRx® WebPort 6.7 User and Administrator’s Guide</td>
</tr>
</tbody>
</table>

Table 2-1: FRx Related Chapters and Guides
Creating Row Formats

Chapter 3

A row format is a template that specifies the structure of each line in an FRx report. For example, row formats specify:

- Descriptive rows or lines in a report (for example, Cash and Total Revenue)
- All totaling and inter-row calculations
- The general ledger codes (or links to row formats or external spreadsheets)

This chapter explains how to build row formats and use the features of this FRx® Report Designer building block.

Row Format Menu Functions ............ 59
Row Format Toolbar ..................... 66
Account Code Segments ................. 67
Building a Row Format .................. 68
Modifying Row Formats ................. 72
Totaling and Calculations ............... 87
General Ledger Account Codes .......... 95
Assigning Currency Codes .............. 112
Automatic Rounding for Balance Sheets113
Row Format Menu Functions

The menu functions described in this chapter are specific to the Row Format window. For information about menus that appear in all FRx main windows, see “Defining Available Commands on Report Designer Menus” on page 19.

This section contains information and instructions on the:

- File Menu
- Edit Menu
- Format Menu
- Link Menu

File Menu

The following are File menu commands and are specific to the row format building block.

![File Menu](image)

Figure 3-1: Row Format: File Menu

<table>
<thead>
<tr>
<th>File Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Renames the row and description.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a row, column, tree, or catalog.</td>
</tr>
<tr>
<td>Print Row Format</td>
<td>Prints the row format.</td>
</tr>
</tbody>
</table>

Table 3-1: File Menu Options for Row Format
**Edit Menu**

The Edit menu provides you with the standard Windows functions such as copy and paste as well as specific Report Designer functions.

<table>
<thead>
<tr>
<th>Cut</th>
<th>Ctrl+X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Replace</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Add Rows from Chart of Accounts</td>
<td></td>
</tr>
<tr>
<td>Renumber Rows...</td>
<td></td>
</tr>
<tr>
<td>Description...</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Rounding Adjustments...</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Account Sets</td>
<td></td>
</tr>
<tr>
<td>Delete Row</td>
<td></td>
</tr>
<tr>
<td>Insert Row</td>
<td></td>
</tr>
<tr>
<td>Zoom...</td>
<td>F3</td>
</tr>
</tbody>
</table>

Figure 3-2: Row Format: Edit Menu

<table>
<thead>
<tr>
<th>File Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cut (Ctrl+X)</strong></td>
<td>Removes the selection from the current location and moves it to the Microsoft® Windows® clipboard.</td>
</tr>
<tr>
<td><strong>Copy (Ctrl+C)</strong></td>
<td>Copies the current selection to the Windows clipboard.</td>
</tr>
<tr>
<td><strong>Paste (Ctrl+V)</strong></td>
<td>Copies the contents of the Windows clipboard to the cursor position. If the clipboard is empty, this command is unavailable and appears dimmed. You can use the Paste function to paste copied information from other Windows-based applications, or from other FRx worksheets, into this worksheet.</td>
</tr>
<tr>
<td><strong>Clear</strong></td>
<td>Clears (blanks out) all selected cells.</td>
</tr>
<tr>
<td><strong>Find (Ctrl+F)</strong></td>
<td>Locates information contained in the row format.</td>
</tr>
<tr>
<td><strong>Replace (Ctrl+R)</strong></td>
<td>Locates and replaces information contained in the row format.</td>
</tr>
<tr>
<td><strong>Add Rows from Chart of Accounts</strong></td>
<td>This command allows you to create a new row format (with general ledger accounts) using data from your current chart of accounts. A selected subset of general ledger account information is transferred to the new row format. For more information about using this command, see “Building a Row Format From the Chart of Accounts” on page 68.</td>
</tr>
</tbody>
</table>

Table 3-2:
Chapter 3: Creating Row Formats–Row Format Menu Functions

For more details and instructions on the commands outlined in the above table, review the following topics:

- Cut (Ctrl+X)
- Find (Ctrl+F)
- Replace (Ctrl+R)
- Renumber Rows
- Description (Ctrl+D)
- Delete Row
- Insert Row

### Cut (Ctrl+X)

Removes the selection from the current location and moves it to the Microsoft® Windows® clipboard:

1. Select the cell you want to cut.
2. On the **Edit** menu, click **Cut**.
   - The text disappears from the cell.
3. Paste the selection from the Microsoft® Windows® clipboard to another cell in FRx or to another Windows application.

<table>
<thead>
<tr>
<th>File Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renumber Rows</td>
<td>Allows you to define starting row codes and a number by which to increment the row codes that follow.</td>
</tr>
<tr>
<td>Description (Ctrl+D)</td>
<td>Opens a dialog box where you can edit a row format description.</td>
</tr>
<tr>
<td>Rounding Adjustments</td>
<td>See “Automatic Rounding for Balance Sheets” on page 113.</td>
</tr>
<tr>
<td>Account Sets</td>
<td>With FRx, you can create an account set by assigning a name to a group of accounts. Then, you can use this account set name in multiple row formats. See “Account Sets” on page 102.</td>
</tr>
<tr>
<td>Delete Row</td>
<td>This command deletes one or more rows.</td>
</tr>
<tr>
<td>Insert Row</td>
<td>This command inserts one or more new rows.</td>
</tr>
<tr>
<td>Zoom (F3)</td>
<td>Opens a box-specific window of valid values. Same as double-clicking on a cell.</td>
</tr>
</tbody>
</table>
Find (Ctrl+F)

To find text

1. Click Find to open the Find dialog box.

   ![Find Dialog Box]

   1. In the Find What box, enter the text you want to locate.
   2. Click Find Next.
   3. To conduct a more specific search, select one or more options from the Search Options section of the dialog box.

Replace (Ctrl+R)

To replace text

1. In the Find what box, enter the text you want to find.
2. Click Replace to open the Replace dialog box.

   ![Replace Dialog Box]

3. In the Replace with box, enter the text you want to replace it with.
4. Click Replace to replace a single occurrence of the text or Replace All to replace all occurrences of the text.

Renumber Rows

This command allows you to define starting row codes and a number by which to increment the row codes that follow. Blank row codes and label row codes are not affected by renumbering.

![Renumber Rows Dialog Box]

Figure 3-3: Renumber Rows Dialog Box
**Description (Ctrl+D)**

This opens a dialog box where you can edit a row format description.

![Row Format Dialog Box](image)

Figure 3-4: Row Format Dialog Box

The **Name** and **Specification set** boxes are display only. You cannot access or change them.

Enter the text you want to describe the row format in the **Description** box; you can use upper- and lower-case letters, numbers, and spaces.

**Note** You must save the row format in order to save the description change.

**Delete Row**

**To delete a row**
1. Click the gray box to the left of the row code to be deleted.
2. Select the **Delete Row** command.

**To delete one or more consecutive rows**
1. Highlight the rows’ gray boxes.
2. Select the **Delete Row** command. A window asks you to confirm the deletion.

**Insert Row**

**To insert a row**
1. Click the gray box to the left of the row code of the row following where you want the new row.
2. Select the **Insert Row** command.

**To insert more than one row**
1. Highlight the gray boxes of the number of rows to be inserted.
2. Select the **Insert Row** command.

When you insert a new row, FRx assigns a new row code number. This number is typically halfway between the number in the row code above and the number of the row code below the newly added row. For example, a row inserted between rows 130 and 160 might be assigned a row code of 145.
Format Menu

Use the Format menu to control the font styles and column width in a report.

![Font Styles... Column Width...]

Figure 3-5: Row Format: Format Menu

Font Styles

Use this command to create and edit different font styles and shading for your report. You can apply fonts globally or to a specific row within a report.

To create or edit a font style before using it

1. On the Format menu, click Font Styles to display the Font Styles dialog box.
2. Choose from the following options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Create a new font style | 1. Click New.  
                        | 2. In the Font Style Name box, enter a name for the new style.         |
| Edit an existing font style | 1. Click Find.  
                                | 2. In the Select Font Style dialog box, select the font that you want to edit and click OK. |

3. Choose from the following options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Apply a font, font style, or size | 1. Click Font.  
                                | 2. Make your selections and click OK.                               |
| Apply shading to the style | 1. Click Shading.  
                                | 2. Select or define the background color that you want to use and click OK. |

4. Click Save.
5. Click Close.
Column Width

This command opens the Column Width dialog box. Use this box to specify the width of a column on screen as well as to hide or unhide it.

![Column Width Dialog Box](image)

You can also change the width of FRx columns with the mouse, using the same technique as in Windows-based spreadsheets like Microsoft Excel. Drag the column edge until the column is the size you want it to be.

To modify the column width when printing the report, you need to adjust it in the column layout. For more information, see “Column Width” on page 157.

To change the width of a column in the row format

1. Type a new number in the Column Width box.
2. Click OK.

You may wish to hide one or more columns so that they are not visible on the worksheet.

To hide one or more columns

1. Select the columns.
2. On the Format menu, click Column Width... to display the Column Width dialog box.
3. Click Hide.
4. Click OK.

To unhide all hidden columns

Click Unhide in the Column Width dialog box.

Link Menu

Although most row formats contain only general ledger account codes as the source of information, any row format can also contain links to other FRx row formats, to other fiscal years, to XBRL taxonomy files, or to Lotus 1-2-3 or Microsoft Excel spreadsheets. Any format can contain links to several different sources.

The Open Link Window command opens the Links dialog box. For more information about linking, see Chapter 4.
# Row Format Toolbar

The Row Format window has a set of toolbar buttons that display below the menus. Common toolbar buttons are explained in “Getting Around in Report Designer” on page 12 in Chapter 1. The following toolbar buttons are exclusive to the Row Format window.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Link Icon]</td>
<td>Opens the <strong>Links</strong> dialog box. This has the same effect as selecting <strong>Open Link Window</strong> from the <strong>Links</strong> menu. For more information, see “Link Menu” on page 65.</td>
</tr>
</tbody>
</table>
| ![Font Style Icon] | Applies a font style to one or more consecutive rows:  
1. Select the **Description** cell (column B).  
2. Click the **Font Style** box to see a list of font styles.  
To edit or add a new font style, open the **Font Styles** dialog box by selecting **Font Styles** from the **Format** menu. For detailed information about creating and editing font styles, see “Font Styles” on page 64. |

Table 3-3: Row Format Toolbar Buttons
Chapter 3: Creating Row Formats–Account Code Segments

Account Code Segments

The full account code refers to all the segments that exist within the chart of accounts structure. The full account code can be broken down into the natural (or main) account code segment and the responsibility account code segments.

The natural or main account code segment is the most fundamental element of the full account code in your general ledger. The natural account segment represents the primary purpose of the account, such as sales, travel expense, and cash. Most organizations create their full account codes with multiple responsibility segments that build on the same natural account segment.

The responsibility account code segments typically represent responsibilities, such as location, division, department, area, task, project, product, and other categories within the overall structure of the organization. Responsibility account segments include all of the general ledger segments except the natural account segment.

Although a row format can contain any portion of the full account code, the most flexible row format contains only the natural account segment. With this type of row format, you can use many different column layouts and reporting trees. A row format used without a reporting tree (when generating the report) requires the row format to contain the natural account segment or the full account code. When you define a report that includes a row format containing just the natural account segment and a column layout, FRx creates a financial report that defines natural account segment information summarized for the entire organization.

However, you may at times want to generate multiple financial reports, one for each of your responsibility segment values (such as locations, divisions, and departments). By having your reporting tree focus on the responsibility segments of the full account code, you get more flexibility when pulling information from the general ledger.

The reporting tree identifies not only each of the responsibility segments’ values that you would like to report on, but also the relationship of each responsibility segment to the other responsibility segments within your organization. Reports that use a reporting tree combine the general ledger account code information in the row format with the account code information contained in the tree to create multiple financial reports. For more detailed information on reporting trees, see “Creating a Reporting Tree” on page 179.
Building a Row Format

Although FRx supports up to 8000 general ledger rows, we suggest designing your row format as a high-level summary (500 rows or less), using the techniques outlined in the following sections. This makes creating and maintaining your row formats easy and lets you produce detailed reports that display all account information.

You create row formats in two ways:

- Manually, by entering the row information into the Row Format window
- Automatically, by building basic formats directly from your general ledger chart of accounts as described in the following sections

This section contains information and instructions on:

- Building a Row Format From the Chart of Accounts
- Defining the Account Segments in a Row Format
- Opening a Row Format

Building a Row Format From the Chart of Accounts

A master row format contains every unique natural account from all departments. This format may contain many more accounts than a single department uses. By default, FRx suppresses printing any row without a corresponding balance in the general ledger. This allows you to use the master format for all departments, but still generate custom reports for each department.

When you build a row format from the chart of accounts, FRx examines your entire chart of accounts or the account range you specify. FRx then creates a master format with the account code segment you specified in the row format. The selected account code segment is typically the natural account code segment.

To build a master row format

1. On the File menu, point to New, and then click Row to open an untitled Row Format window.
2 On the Edit menu, click Add Rows from Chart of Accounts to display the Add Rows From Chart of Accounts dialog box.

The Description boxes contain descriptions for the segments of your account code. These descriptions vary according to how the account code was set up in the general ledger.

The Account Mask determines which account segments are stored in the row format. (If you use a reporting tree, the account mask also determines which account segments are pulled from the reporting tree.)

- The # symbol tells FRx to not include that character in the row build process.
- The & (hook) symbol tells FRx to include that character in the row format.

Note: The # and & symbols work on a character-by-character basis, although you typically use the same symbol within a segment.

The default mask, defined from your general ledger, has & symbols in the natural segment and # symbols in the responsibility segments.

3 To create a master format, accept the default mask by clicking OK.

Note: Keep in mind that if you plan to use the same format for more than one department, you don’t need to repeat this procedure for each department.

**Defining the Account Segments in a Row Format**

To define the account segments in a row format

1 On the File menu, point to New, and then click Row to open an untitled Row Format window.

2 On the Edit menu, Add Rows from Chart of Accounts to display the Add Rows From Chart of Accounts dialog box.

3 Select & symbols for every account position that is to be transferred to the row format. You can also click the All &@@ button to change all the ### symbols within a segment to &@@.
4 If you want to include a specific range of accounts, enter the beginning account number in the **Account Range Start** and the ending account number in the **Account Range End** boxes.

If you want to include all the general ledger codes for the selected segment, leave these boxes blank.

**Note:** You do not need to enter the entire account in the **Account Range Start** and **Account Range End** boxes. For example, if you want to limit a format to natural codes 4100 to 5400, enter these codes under the **Natural account code** box.

5 Enter values in the **Starting row code** and **Increment each row by** boxes.

This tells FRx the row code for the first row in the new row format and the spacing between numbers. By accepting the default settings, the first row code will be 100, followed by rows incremented by 30. For example, 100, 130, 160, 190, 220, and so on.

**Note:** Don’t try to create a row format that contains all general ledger account combinations in the company. Report Designer works best with many small row formats and uses the reporting tree and other techniques to run reports for multiple departments. If your selection results in more than a few hundred report rows, you should break the format down into smaller sections of the report using the account range feature, described in the next section.
6 Click **OK** to build the row format.

After the build is complete, the row format window appears showing row codes that identify each row, row descriptions, and general ledger account codes. The following figure shows the asset accounts in a master row format.

<table>
<thead>
<tr>
<th>A Max Code</th>
<th>B Description</th>
<th>C C Code</th>
<th>D Related (\text{Rate/Row}) Column | E Total Bal</th>
<th>F First Col</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Cash-Checking</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>Money Market (Short-Term)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Accounts Receivable</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>190</td>
<td>Allowance for Bad Debt</td>
<td>C</td>
<td>1250</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Due from FWC</td>
<td></td>
<td></td>
<td>1300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>230</td>
<td>Due from FWC (Elimination)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>300</td>
<td>Inventories - Sales</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>310</td>
<td>Inventories - Sales (Elimination)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>340</td>
<td>Inventory Supplies</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>370</td>
<td>Prepaid Other</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Leasehold Improvements</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>410</td>
<td>Accum. Depr. - Lease Improvnts</td>
<td>C</td>
<td>1505</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>415</td>
<td>Office Furniture &amp; Fixtures</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>420</td>
<td>Accum. Depr. - Other &amp; Fixtures</td>
<td>C</td>
<td>1520</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>Office Equipment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>505</td>
<td>Accum. Depr. - Office Equip</td>
<td>C</td>
<td>1540</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>510</td>
<td>Accounts Payable</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>530</td>
<td>Leases Payable</td>
<td>C</td>
<td>2100</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Note

If your account code includes spaces as part of the account structure, FRx inserts an underscore (\_) character in place of the space by default. If you want to substitute another character for the underscore, you need to change it in the **FRx System Preferences** dialog box. For more information, see the *FRx® Report Designer 6.7 Administrator’s Guide*.

A row format built from the chart of accounts provides a base to which you can add:

- Totals
- Calculations
- Formatting

**Opening a Row Format**

**To open a new Row Format**

1. From the FRx **Control Panel**, select the **Row Formats** building block.
2. Select one of the following options:
   - Select a row format from the **Open Row** dialog box and click **OK**.
   - Click **New** to create a new row format.
Modifying Row Formats

Each column in the row format contains specific codes, links, text, general ledger data, or other information that can be modified to control the way the row generates output in the resulting FRx report. The topics in this section describe the functions, features, and available options for each column in the row format.

This section contains information and instructions on the:
- Row Code Column
- Description Column
- Fmt Code Column
- Related Rates/Rows/Unit Column
- Normal Balance Column
- Print Control Column
- G Column
- Link Column

Row Code Column

The numbers or labels in the Row Code column identify each row in the worksheet. You use the row code in calculations and totals, when formatting, and to link to other row formats.

A row code is required for rows that are referred to by other rows (such as totals). You can mix numeric, alphanumeric, and blank row codes within a row format.

The row code can be any number or a descriptive label that identifies that row. A label:
- Can be any combination of numbers and letters up to 16 characters
- Must begin with an alphabetic character (a to z).
- Can use the underscore (_) character, but no other special characters can be used

These are examples of valid row codes: 320, TL_NET_INCOME and TL_NET_94.

To renumber your row codes, select the Edit menu, and click Renumber Rows to renumber numeric codes.

You can renumber in row formats that combine row code numbers with row code labels. FRx renumbers row codes that begin with numbers (for example, 130, 246), and skips renumbering of any row codes that begin with letters (for example, INCOME_93, TP0693).

Note

When you renumber row codes, FRx automatically updates TOT and CAL references. For example, if the range of rows in a TOT row is 100 to 160 and you renumber starting with 90, the starting TOT range changes to 90 instead of 100.
Description Column

Enter the description exactly as it should print on a report. You define the width of the description column in the column layout (particularly important when entering a long description, which might be cut off on a generated report). For more information about column layouts, see “Creating Column Layouts” on page 137.

To identify the reporting unit when you generate reports for multiple units in a reporting tree, type the @UNIT code in the Description cell. When you generate the report, FRx inserts the reporting unit’s Title/Description. For information about reporting trees and reporting units, see “Creating a Reporting Tree” on page 179.

You can include an Additional Text code for additional text entries from a reporting tree in a row format. Enter the Additional Text code in the format @UNITT[#], where [#] is the additional text entry number for the reporting unit. For example, @UNITT4 specifies the fourth additional text entry for the reporting unit. When the report is generated, the report row will display the additional text.

For more information about creating additional text entries in a reporting tree, see “Adding Text to the Reporting Units in a Tree” on page 216.

To use additional text in the row format

1. From the Row Format window, select the Description cell of the row in which you want to add the Additional Text code. (Insert rows, if necessary.)
2. Select from the following options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply a font style to the additional text</td>
<td>Click the Font Style arrow and select a font style from the list.</td>
</tr>
</tbody>
</table>
| Restrict the additional text to a specific reporting unit | 1 Select the Related Rates/Rows/Unit cell of the additional text row.  
2 Click the Related Rates/Rows/Unit arrow to open the Select Tree for Lookup dialog box.  
3 Double-click the reporting tree you want to use.  
4 When the Select a Reporting Unit for Restriction dialog box appears, double-click the reporting unit to which the row is to be restricted. |

3. On the File menu, click Save to save the row format.
4  Type @UNITT[#], substituting the unit text number for [#].

**Note:** For example, @UNITT4 specifies the fourth additional text entry for the reporting unit from Column Z of the tree.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>Fmt Code</th>
<th>Related Rates/Rows/Unit</th>
<th>E Name</th>
<th>F Percent</th>
<th>G Column</th>
<th>H Unit to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>136</td>
<td>Type=2</td>
<td>LINET</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>186</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>255</td>
<td>@UNITT4</td>
<td>UNIT=FACTRAN WORKS INC &quot;DENVER&quot; &quot;SALES-DEKKEN&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Cash</td>
<td>B,C,D,E,H</td>
<td>1179</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Payables</td>
<td>C</td>
<td>2777</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>260</td>
<td>Type=1</td>
<td>LINET</td>
<td>220</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>290</td>
<td>Net Sales</td>
<td>C</td>
<td>6171-64279-61900</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>320</td>
<td>Cost of Goods Sold</td>
<td></td>
<td>4571-44859</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>370</td>
<td></td>
<td>LINET</td>
<td>210</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Gross Profit</td>
<td>TOT</td>
<td>310-340</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Operating Expenses</td>
<td>TOT</td>
<td>(5000 to 5400)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Provision for Taxes</td>
<td></td>
<td>9500</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5  Select from the following options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply a font style to the additional text</td>
<td>Click the <strong>Font Style</strong> arrow and select a font style from the list.</td>
</tr>
</tbody>
</table>
| Restrict the additional text to a specific reporting unit | 1  Select the **Related Rates/Rows/Unit** cell of the additional text row.  
|                                                   | 2  Click the **Related Rates/Rows/Unit** arrow to open the **Select Tree for Lookup** dialog box.  
|                                                   | 3  Double-click the reporting tree you want to use.  
|                                                   | 4  When the **Select a Reporting Unit for Restriction** dialog box appears, double-click the reporting unit to which the row is to be restricted.  |

**Fmt Code Column**

Format codes control the content of a row. Every row is interpreted as a general ledger detail row unless a code is present in the **Fmt Code** column. Double-click the **Fmt Code** column to display a list of available codes.

**TOT**

This code allows you to use simple mathematical operands (+ or -) between amounts or row codes that you specify in the **Related Rates/Rows/Unit** column. For more information about this format code, see “Totaling and Calculations” on page 87.
**CAL**

This code allows you to use complex mathematical operands (+, -, *, /, and IF/THEN/ELSE statements) between amounts or row codes that you specify in the Related Rates/Rows/Unit column. For more information on calculations, see “Formula Totaling (CAL)” on page 88.

**DES**

The **DES** code inserts headings and blank lines in reports. For example, row 95 in the following figure uses the **DES** code to insert a blank line. Row 98 uses **DES** to insert the description “Revenue.”

---

**Note**

If a report contains title rows and underscore rows where all detail rows have been suppressed (because of zero balances, for example), you can suppress the printing of format rows using the Related Rates/Rows/Unit column. For more information, see “Relating a Format Row to an Amount Row” on page 82.

---

**LFT, RGT, CEN**

These codes align the row format Description column information on the left, right, or center of the report line, regardless of its placement in the column layout.

**CBR**

The **CBR** (Change Base Row) code defines the base row for columns that calculate a percentage of or multiply by the base row for each row in the report. You can have multiple **CBRs** in a row format such as one with net sales, one with gross sales, and one with total expenses. Usually, the **CBR** is used to create a percentage for accounts compared to a total line. For example, you could compare accounts like salary percentages and manager salaries as a percentage of net sales.

Enter the allocation base row code in the Related Rates/Rows/Unit column. This base row is used for the calculation and remains in effect until another **CBR** row is defined.

The following figures illustrate the **CBR** format code. In the row format, the **CBR** code is in row 45. The **Related Rates/Rows/Unit** column of row 45 shows row 140, which is the Net Sales row.

The calculation formula in column **C** is B/BASE and a special format mask. This tells FRx to divide the amount in column **B** by the amount in column **B** of the base row (row 140) and to put the result in column **C** of that row. The result is that each amount in column **C** is the amount in column **B** expressed as a percentage of net sales. Similarly, each amount in column **E** is the amount in column **D** expressed as a percentage of net sales.
Chapter 3: Creating Row Formats–Modifying Row Formats

The format code CBR (row 45) calculates a percentage of the base row for each row in the report. The base row is identified in the Related Rates/Rows/Unit column (row 140, the Net Sales row, in this example). The Net Sales row is used for percent calculations until another CBR row is defined. See the following column layout.

B/BASE tells FRx to divide the amount in column B by the base row (row 140 in the above row format) and to put the result in column C of that row.

This is the special format mask; using this format, the numbers in this report display as a percentage with one decimal point and negative numbers are in parentheses.

For more information, refer to your FRx® DrillDown Viewer™ and FRx® Report Launcher 6.7 User’s Guide.

PB

This code is used for reports that contain both a balance sheet and an income statement. The code:

- Starts a new report page.
- Tells FRx the page is a balance sheet (or supporting schedule to the balance sheet).
- Places the title from the Description column (in this row) into the report heading. To activate this feature, you must also use the @ROW option in the report header (in the Catalog of Reports). For more information, see “Understanding the Catalog of Reports” on page 223.
- Suppresses printing of all columns other than the BS column when the column layout contains multiple amount columns and the BS option is selected in the Print Control section of one column in the column layout. This allows a report to contain both a multi-column income statement (for example, Current Period & Year to Date) and a
single-column balance sheet (for example, Year to Date only). For more information, see “Creating Column Layouts” on page 137.

**Note**
Use the Balance Sheet/Income Statement distinction only if your report includes both a Balance Sheet and an Income Statement and if the column display should be different for each type of report.

**PI**
This code starts a new page for an income statement. It functions like the PB code, except that it tells FRx the page is an income statement. You can use this code to force a page break in any report.

All columns from the column layout print in an income statement, including any columns that use a BS (Balance Sheet column) print control code.

---

This code places a single line under all amount columns. You can also suppress the line for certain columns if required (for example, percent columns). For more information, see “Adding Column Restrictions” on page 164.

**Note**
If a report contains title rows and underscore rows where all detail rows have been suppressed (because of zero balances, for example), you can suppress the printing of format rows using the Related Rates/Rows/Unit column. For more information, see “Relating a Format Row to an Amount Row” on page 82.

```==
This code places a double line under all amount columns.
```

**LNE**
This code prints a line across the entire page. After choosing this Fmt Code option, you can also enter one of the following line descriptions in the Description column:

- Type = 1: thin line (default)
- Type = 2: thick line
- Type = 3: dotted line
- Type = 4: two lines, thick line followed by thin line
- Type = 5: two lines: thin line followed by thick line

**Note:** Because of the way that lines are defined in HTML, only single line types 1, 2, and 3 are supported for reports that are output in HTML formats, including DrillDown Viewer Enhanced XML (.frd) and Standard XML (.xml) files, when viewed in FRx WebPort.
Chapter 3: Creating Row Formats–Modifying Row Formats

The following figure illustrates a row format with line types 1 and 2. Following this is the report that this row format creates. Note the thick line (type 2) above the reporting unit (Consolidated) and the thin lines (type 1) below Payables and Cost of Goods Sold.

<table>
<thead>
<tr>
<th>A</th>
<th>Plan Code</th>
<th>B</th>
<th>Description</th>
<th>C</th>
<th>First Code</th>
<th>D</th>
<th>Format</th>
<th>E</th>
<th>Notes</th>
<th>F</th>
<th>Print</th>
<th>G</th>
<th>Column</th>
<th>H</th>
<th>Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>Type=2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DES</td>
</tr>
<tr>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>LNE</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DES</td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>Cash</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>@UNIT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1177</td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Payables</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2777 (2008)</td>
<td></td>
</tr>
<tr>
<td>190</td>
<td>Type=1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>220</td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Net Sales</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4177 (4077) (4107)</td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Cost of Goods Sold</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4007 (4007)</td>
<td></td>
</tr>
<tr>
<td>280</td>
<td>Type=1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>220</td>
<td></td>
</tr>
<tr>
<td>290</td>
<td>Gross Profit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TOT</td>
<td>200</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>200</td>
</tr>
<tr>
<td>340</td>
<td>Operating Expenses</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(5001 TO 5400)</td>
<td></td>
</tr>
<tr>
<td>440</td>
<td>Provision for Taxes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5500</td>
<td></td>
</tr>
<tr>
<td>480</td>
<td>Other Income (Expenses)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5017 (?????)</td>
<td></td>
</tr>
<tr>
<td>490</td>
<td>Net Income</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TOT</td>
<td>3101.460-3201.400</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>310</td>
</tr>
<tr>
<td>510</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DES</td>
<td></td>
</tr>
</tbody>
</table>

Figure 3-9: Formatting Examples in Row Format Window

Sample FRx Report
For the Three Months Ending March 31, 2002
(Dollars in Thousands)

<table>
<thead>
<tr>
<th>Monthly Activity</th>
<th>Year To Date</th>
<th>Year To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>February</td>
<td>March</td>
</tr>
<tr>
<td>Consolidated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cash</td>
<td>$2,471</td>
<td>$2,623</td>
</tr>
<tr>
<td>Payables</td>
<td>(9,360)</td>
<td>(1,154)</td>
</tr>
<tr>
<td>Cost of Goods Sold</td>
<td>311,722</td>
<td>318,268</td>
</tr>
<tr>
<td>Gross Profit</td>
<td>139,585</td>
<td>135,693</td>
</tr>
<tr>
<td>Operating Expenses</td>
<td>161,944</td>
<td>169,374</td>
</tr>
<tr>
<td>Provision for Taxes</td>
<td>6,910</td>
<td>7,012</td>
</tr>
<tr>
<td>Other Income (Expenses)</td>
<td>(352)</td>
<td>(339)</td>
</tr>
<tr>
<td>Net Income</td>
<td>18,679</td>
<td>18,958</td>
</tr>
</tbody>
</table>

Figure 3-10: Sample Report with Examples of Line Type

BXB and BXC
These codes indicate the beginning and end of a box. FRx draws a box around the report rows that begin with the BXB row and end with the BXC row.

REM
This code indicates that the row is a remark row only and is not printed on the report. Use REM in the row format to explain your formatting techniques.

SORT and ASORT
These codes sort expenses or revenues, sequence an actual or budget variance report by the largest variance, or sort the row descriptions alphabetically.

The SORT code sorts the report in ascending or descending order based on the value in a selected column.

To use the SORT code
1 Select the SORT format code.
2 Enter the range of rows to be sorted in the Related Rates/Rows/Unit column.

3 Enter the column letter to be used for the sort in the Column column.

The report is sorted in ascending order by default. For descending order, enter a negative sign (-) before the column letter.

The ASORT code sorts the report by the absolute value of the value in the selected column. In other words, the sign of the value is ignored in the sort. This format code shows values sequenced by the magnitude of the variance, whether positive or negative.

To use the ASORT code

1 Select the ASORT format code.

2 Enter the range of rows to be sorted in the Related Rates/Rows/Unit column.

3 Enter the column letter to be used for the sort in the Column column.

The report is sorted in ascending order by default. For descending order, enter a negative sign (-) before the column letter.

Note: Do not include formatting or total rows in a sort calculation. If you include format or total rows, FRx sorts these rows along with the general ledger rows.
The row format in the following figure demonstrates the use of the **SORT** and **ASORT** format codes. Following this is the report that this row format creates.

```plaintext
<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C First Code</th>
<th>D Related Rates/Row ID</th>
<th>E Name End</th>
<th>F Real Off</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>Sorted by Monthly Variance in Ascending Order</td>
<td>12.0</td>
<td>128.10.173</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>140</td>
<td>Sales</td>
<td>C</td>
<td>1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>Salary Expense</td>
<td>D</td>
<td>5000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Rent Expense</td>
<td>E</td>
<td>2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>Travel Expense</td>
<td>F</td>
<td>2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Sorted by YTD Absolute Variance in Descending Order</td>
<td>500</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>440</td>
<td>Sales</td>
<td>C</td>
<td>1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>Salary Expense</td>
<td>D</td>
<td>5000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>520</td>
<td>Rent Expense</td>
<td>E</td>
<td>2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>540</td>
<td>Travel Expense</td>
<td>F</td>
<td>2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>560</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Figure 3-11: SORT and ASORT in Row Format Window**

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C First Code</th>
<th>D Related Rates/Row ID</th>
<th>E Name End</th>
<th>F Real Off</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>120</td>
<td>Sorted by Monthly Variance in Ascending Order</td>
<td>12.0</td>
<td>128.10.173</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>140</td>
<td>Sales</td>
<td>C</td>
<td>1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>Salary Expense</td>
<td>D</td>
<td>5000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Rent Expense</td>
<td>E</td>
<td>2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>Travel Expense</td>
<td>F</td>
<td>2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Sorted by YTD Absolute Variance in Descending Order</td>
<td>500</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>440</td>
<td>Sales</td>
<td>C</td>
<td>1000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>Salary Expense</td>
<td>D</td>
<td>5000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>520</td>
<td>Rent Expense</td>
<td>E</td>
<td>2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>540</td>
<td>Travel Expense</td>
<td>F</td>
<td>2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>560</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 3-12: Sorted Sample Report**

**Note**

Use the following format codes with the separately-licensed FRx® Currency Translation module. Your software license determines if Currency Translation is available with your installation. Contact your vendor for more information about currency conversion licensing.

**CCHIST**

This code tells FRx to perform currency conversion using the historical rate from the currency translation table. The historical rate is commonly used for rows that show non-monetary assets, such as fixed assets, inventory, or capital stock. When you use the **CCHIST** row code, you must also select a **Historical Rate ID** as the related rate in Column D of the row.

**CCAVG**

This code tells FRx to perform currency conversion using the average exchange rate from the currency translation table. The average rate is commonly used for income rows in the report. When you use the **CCAVG** row code, you must also select an average type (**AVGDAILY**, **AVGWEEKLY**, or **AVGMONTHLY**) as the related rate in Column D of the row.

**CCSPOT**

This code tells FRx to perform currency translation using the spot (current) exchange rate from the currency translation table. The spot rate is commonly used for cash accounts.
CCX

This code suppresses any currency conversion for this row and remains in effect until a different currency code is encountered.

**Related Rates/Rows/Unit Column**

This column can:

- Tell FRx that a description or underline row is linked to an amount row. Consequently, the title and underscore prints only when the related amount does. For more information, see “Relating a Format Row to an Amount Row” on page 82.
- Define the rows to include in a calculation when using a TOT or CAL format code. For more information, see “Totaling and Calculations” on page 87.
- Restrict a row to a specific reporting unit. For more information, see “Restricting a Row to a Reporting Unit” on page 81.
- Tell FRx which Historical Rate ID to use as the related rate when using the CCHIST format code, or which type of average to calculate (daily, weekly, monthly, etc.) when using the CCAVG format code.
- Define the rows to sort when using with the SORT or ASORT format code.
- Define the base row for calculations when using the CBR format code.

You can design a single row format to use with all responsibility segments, such as locations, divisions, and departments, in your organization. FRx allows you to build a reporting tree to define all of the different detail and summary responsibility segments, which are referred to as reporting units.

However, you may sometimes want to designate a row in a report to apply to a specific reporting unit in your reporting tree. For example, you may want to create an individual row that details the total operating expenses for a specific department. To do this, zoom in the Related Rates/Rows/Unit cell of the row format and select both a reporting tree and reporting unit. FRx restricts this row to this specific reporting unit.

**Note**

Restricting a row to a specific reporting unit is particularly important when the full account code is used in a row format. When you use the full account code, the amount is reported to every unit in the reporting tree with the potential for significant duplication of the amount as it is rolled up in the tree. To avoid duplication, restrict the row to a reporting unit.

**Restricting a Row to a Reporting Unit**

To restrict a row to a reporting unit

1. In the Related Rates/Rows/Unit column, double-click to open the Select Tree for Lookup dialog box.
2. Double-click the reporting tree you want to use.
3 When the Select a Reporting Unit for Restriction dialog box appears, double-click the reporting unit to which the row is to be restricted.

The reporting unit that you select appears in the Related Rates/Rows/Unit column.

FRx uses the following rules to roll up amounts to parent units in a reporting tree:

- Reporting units that use an account mask in the reporting tree, corresponds with the row amount in the reporting unit report. The units do not duplicate that amount in the parent unit report.
- Reporting units that do not use an account mask in the reporting tree (that is, parent units), corresponds with the row amount in the child unit report and roll up the amount to the specified parent unit. If the parent unit has five child units, the row appears five times (once for each child unit) in the parent report.
- Reporting units that include the full account code restrict based on the preceding rule. Therefore, when you restrict rows that include a full account code to a unit containing an account mask, FRx includes the row amount without duplication for that unit and its parent units.

Note: If a parent unit also uses a general ledger account template, the account is pulled into the parent unit, thus causing a duplication of data.

4 Enter a general ledger code in the Link to General Ledger column.

Relating a Format Row to an Amount Row

To relate a format row to an amount row

When you build a row format, you can define format rows, or non-amount rows, by using Fmt Codes such as DES, LFT, RGT, CEN, ---, and ===.

To avoid printing titles or underscores when no amounts are present, relate the format rows to corresponding amount rows. To relate a formatting row to an amount row, enter the row code from the amount row in the Related Rates/Rows/Unit column of the formatting row.

Figure 3-13 shows a row format that relates rows 150 and 170 to the amount in row 160. If there is no value to display in row 160, then FRx suppresses rows 150 and 170.

Figure 3-13: Relating Rows in Row Format Window

Here’s another example. Suppose you enter a row for the descriptive title Operating Expenses, followed by a list of expense accounts and a total row for those expense accounts. If you run a report for a department with no operating expense accounts (and you have suppressed printing zero balance accounts in the catalog of reports), the title “Operating Expenses” appears on the report without any supporting amount entries.
To avoid this problem, enter the row code for the Total Operating Expenses amount row in the Related Rates/Rows/Unit cell of the Operating Expenses descriptive row. The Operating Expenses title will not appear when the operating expense total is zero. Use the same technique for underscores and other format-only rows.

### Normal Balance Column

If you want to reverse the sign of a row or if the normal balance of an account is a credit, enter a $C$ in the Norm Bal column. When general ledger amounts pull in to a row format, FRx reverses the sign on all credit balance accounts. When FRx converts these accounts it removes the debit/credit characteristic from all amounts and makes totaling very straightforward. For example, to calculate net income, you simply subtract expenses from income.

Totaled and calculated rows typically are not affected by a $C$ code unless you select the XCR print control option in the related column layout. By selecting XCR in the column layout, you reverse the sign of any row that contains a $C$ in the Norm Bal column. This is especially important when you want to show all unfavorable variances as negative amounts. If a totaled or calculated number displays the wrong sign, add a $C$ to the Norm Bal column in the row format to reverse the sign. For more information on the column layout Print Control, see “Print Control Codes” on page 158.

### Print Control Column

The row format Print Ctrl column controls print formatting features of the current row. These print control codes apply to amount rows only.

- **NP**
  - Indicates a non-printing row. This row is not printed on the report, but can be used in all calculations.

- **CS**
  - Includes a currency sign (for example, $) on all amount columns, except percentage columns which never receive a currency sign. (On the Company menu, click International Formats to set up the currency formats.)

- **XD**
  - Suppresses display of accounts on account or transaction detail reports. This feature is useful when a row includes multiple accounts that should not be listed in the account detail or transaction detail report.

- **X0**
  - Suppresses display of the row if all amounts are zero. This is meaningful only when the suppress zero balance option is not selected in the catalog of reports.

- **B0**
  - Leaves zero columns blank.

- **DR**
  - Displays the debit amounts of the accounts for the selected period.
CR
Displays the credit amounts of the accounts for the selected period.

XR
Suppresses rollup of amounts from a child to the parent unit.

Note
You can use several codes in the same row. To do so, separate the codes with commas or select them with the mouse.

SR
Suppresses a column from being rounded.
G Column

Use this column to create a tabular balance sheet (see Figure 3-14) or to restrict a row to certain report columns. You can designate a particular report column to contain a row amount by entering the column letter (for example, A, B, C) in the Column. This code applies only to the selected row. You also use this column with the SORT or ASORT format codes. For more information on sorting column values, see “SORT and ASORT” on page 78.

![Figure 3-14: Tabular Balance Sheet](image)

**Fabrikam Works, Inc.**
Tabular Balance Sheet
For the Five Months Ending May 31, 2004

<table>
<thead>
<tr>
<th>ASSETS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash - Checking</td>
<td>$134,111.13</td>
</tr>
<tr>
<td>Cash - Money Market</td>
<td>46,751.00</td>
</tr>
<tr>
<td>Total Cash</td>
<td>180,862.13</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>166,164.00</td>
</tr>
<tr>
<td>Allowance For Bad Debts</td>
<td>(2,184.00)</td>
</tr>
<tr>
<td>Intl Corp Receivable</td>
<td>271,213.00</td>
</tr>
<tr>
<td>Net Accounts Receivable</td>
<td>435,193.00</td>
</tr>
<tr>
<td>Total Inventories</td>
<td>770,038.00</td>
</tr>
<tr>
<td>Prepaid Assets</td>
<td>2,289.00</td>
</tr>
<tr>
<td><strong>Current Assets</strong></td>
<td>1,398,370.13</td>
</tr>
<tr>
<td>Leasehold Improvements</td>
<td>34,500.00</td>
</tr>
<tr>
<td>Office Furniture And Fixtures</td>
<td>37,700.00</td>
</tr>
<tr>
<td>Office Equipment</td>
<td>37,700.00</td>
</tr>
<tr>
<td>Less Accumulated Depreciation</td>
<td>(40,635.00)</td>
</tr>
<tr>
<td><strong>Net Fixed Assets</strong></td>
<td>101,165.00</td>
</tr>
<tr>
<td><strong>Total Assets</strong></td>
<td>$1,499,535.13</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LIABILITIES AND SHAREHOLDERS' EQUITY</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts Payable</td>
<td>884,253.00</td>
</tr>
<tr>
<td>Accrued Liabilities</td>
<td>137,867.00</td>
</tr>
<tr>
<td><strong>Total Current Liabilities</strong></td>
<td>222,120.00</td>
</tr>
<tr>
<td>Leases Payable</td>
<td>10,100.00</td>
</tr>
<tr>
<td>Notes Payable</td>
<td>142,794.00</td>
</tr>
<tr>
<td><strong>Long-Term Liabilities</strong></td>
<td>152,894.00</td>
</tr>
<tr>
<td><strong>Total Liabilities</strong></td>
<td>375,014.00</td>
</tr>
<tr>
<td>Capital Stock</td>
<td>50,000.00</td>
</tr>
<tr>
<td>Additional Paid-In Capital</td>
<td>590,269.00</td>
</tr>
<tr>
<td>Year-to-Date Income</td>
<td>377,152.13</td>
</tr>
<tr>
<td>Retained Earnings</td>
<td>197,100.00</td>
</tr>
<tr>
<td><strong>Shareholders’ Equity</strong></td>
<td>1,124,521.13</td>
</tr>
<tr>
<td><strong>Liabilities and Equity</strong></td>
<td>$1,499,535.13</td>
</tr>
</tbody>
</table>

Figure 3-14: Tabular Balance Sheet

**Link Column**

This column identifies the sources for the numbers that make up the row. The amounts in this column contain general ledger account codes.

Normally, the amounts in this column contain general ledger account codes, but you can also link to:

- Other row formats
- XBRL taxonomy
Microsoft® Excel or Lotus 1-2-3 worksheet

<table>
<thead>
<tr>
<th>When this link type is selected</th>
<th>The description on the Link column changes to</th>
</tr>
</thead>
<tbody>
<tr>
<td>GL (all years)</td>
<td>Link to General Ledger</td>
</tr>
<tr>
<td>GL (specific year)</td>
<td>Link to General Ledger Year = GL Year</td>
</tr>
<tr>
<td>Row Format</td>
<td>Link to Row Format</td>
</tr>
<tr>
<td>External Worksheet</td>
<td>Link to Worksheet</td>
</tr>
<tr>
<td>GL + Worksheet</td>
<td>Link to GL + Worksheet</td>
</tr>
<tr>
<td>XBRL Taxonomy</td>
<td>XBRL Taxonomy us-gaap-ci-2003-07-07.xsd</td>
</tr>
</tbody>
</table>

The column description changes depending on the type of link used.

For information about entering general ledger account codes, see “General Ledger Account Codes” on page 95.

For information about linking to row formats and spreadsheets, see “Linking to Other Sources of Information” on page 115.
Totaling and Calculations

This section contains information and instructions on:

- Standard Totaling (TOT)
- Formula Totaling (CAL)
- Point and Click Totaling for TOT and CAL rows

### Standard Totaling (TOT)

The totaling (TOT) format code adds or subtracts amounts in other rows. A total formula can contain any combination of ranges and individual row codes up to 256 characters. See Figure 3-15 for examples of total formulas in the Related Rates/Rows/Unit column. With the TOT format code, you can do the following:

- Enter individual row codes separated by a plus (+) or minus (-) sign, as in row 610.
- Enter descriptive row codes separated by a plus (+) or minus (-) sign. For example, a TOT statement might look like LIABILITIES+EQUITY (see row 566).
- Enter a range of row codes separated by the word TO (see row 548).
- Combine ranges and individual row codes.

![Figure 3-15: Standard Totaling in Row Format Window](image)

You can pull in rows from anywhere in the current row format, regardless of their location or inclusion in another total. Total rows or detail rows can be used in any combination.

**Note**

All TOT rows that fall within the range are automatically excluded. This allows you to create a grand total by specifying the entire range of rows regardless of any intermediate subtotals. The exception to this is if the TOT is in the first row of the range.
Formula Totaling (CAL)

Whereas the TOT format code is oriented toward traditional financial reporting, the calculation (CAL) format code is similar to a spreadsheet formula. Using CAL, you can perform calculations that involve individual cells, multiplication and division, or absolute amounts (actual numbers included in the formula).

To use the CAL format code, enter CAL as the Fmt Code and place a formula in the Related Rates/Rows/Unit column. The formula can include numbers and operators (+, -, / and *) and parentheses ( ) in any combination.

Indicating All or Specific Columns

When you enter a row code, you must also enter either a column letter (for example, A120 for column A, row code 120), or use the @ character to indicate all columns (for example, @120 for all columns, row 120).

Any number that doesn’t have a column letter or @ character is assumed to be a real number. See the following figure for examples of these rules.

- In a row, the number of row codes and parentheses is limited to 256 characters. For example, the formula in row 480 is a valid formula.
- If you reference a row with a label row code, you must separate the column letter from the label with a period (.). See row 680.
- The @ character does not require the period separator. See row 720.

Modifying a Number in Selected Columns

The CAL format can be very helpful when you need to modify a number in one column of a particular row, but not affect other columns in the report.

The following figure illustrates calculations that place the row calculation results into specific report columns.

To perform a calculation on all report (GL) columns, you do not need to enter any column assignment. For example, if you enter @130*.75, FRx multiplies each column in row 130 by .75, and places the result in the current row. See row 190.
To restrict a formula to certain columns, enter the column letter followed by an equal (=) sign and the formula. If you enter B=@130*.75, the calculation is performed only on column B, as shown in row 220.

You can specify multiple columns as shown in row 250. When you use @ with specific column placement, the @ relates to the restricting column. Row 250 translates to the following:

\[
\begin{align*}
A &= (A100/A130) \cdot 0.75 \\
B &= (B100/B130) \cdot 0.75 \\
C &= (C100/C130) \cdot 0.75 
\end{align*}
\]

You can enter ranges, as shown in row 280.

Multiple column formulas can be entered in one row if they are separated by commas, as shown in row 310.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C False Code</th>
<th>D Related Rate/Row/Cell</th>
<th>U V in General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>130</td>
<td>Salary Expense</td>
<td>500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>Office Expense</td>
<td>530</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Calculation applied to all report columns</td>
<td>G130/75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Calculation completed on columns B only</td>
<td>G130/75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Calculation completed on columns A, B, and C</td>
<td>A100+B100+C100/130</td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Calculation completed on a range of columns</td>
<td>A100+C100/130</td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Multiple calculation applied to specific columns</td>
<td>A100/B100+C100/130</td>
<td></td>
<td></td>
</tr>
<tr>
<td>310</td>
<td>Multiple calculation applied to specific columns</td>
<td>A100/B100+C100/130</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3-17: Calculation Applied to Specific Report Columns

Creating Multiple Description Columns

You can use the CAL format code to create reports with multiple descriptions like the side-by-side balance sheet that follows.

<table>
<thead>
<tr>
<th>Fabrikam Works, Inc.</th>
<th>Side by Side Balance Sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSETS</td>
<td>Liabilities and Shareholders’ Equity</td>
</tr>
<tr>
<td>Cash – Checking</td>
<td>$109,267</td>
</tr>
<tr>
<td>Cash – Money Market</td>
<td>46,518</td>
</tr>
<tr>
<td>Total Cash</td>
<td>155,785</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>162,906</td>
</tr>
<tr>
<td>Allowance For Bad Debts</td>
<td>(2,742)</td>
</tr>
<tr>
<td>Int’l Corp Receivable</td>
<td>268,528</td>
</tr>
<tr>
<td>Net Accounts Receivable</td>
<td>429,292</td>
</tr>
<tr>
<td>Total Inventories</td>
<td>698,075</td>
</tr>
<tr>
<td>Prepaid Assets</td>
<td>3,462</td>
</tr>
<tr>
<td>Current Assets</td>
<td>1,286,614</td>
</tr>
<tr>
<td>Leasehold Improvements</td>
<td>69,600</td>
</tr>
<tr>
<td>Office Furniture And Fixtures</td>
<td>34,500</td>
</tr>
<tr>
<td>Office Equipment</td>
<td>37,700</td>
</tr>
<tr>
<td>Less Accumulated Depreciation</td>
<td>(35,780)</td>
</tr>
<tr>
<td>Net Fixed Assets</td>
<td>106,020</td>
</tr>
<tr>
<td>Total Assets</td>
<td>$1,392,634</td>
</tr>
<tr>
<td>Liabilities And Equity</td>
<td>$1,392,634</td>
</tr>
</tbody>
</table>

Figure 3-18: Side-By-Side Balance Sheet

The following windows show portions of the row format used to create the side-by-side balance sheet. Rows 130 to 280 and 1030 to 1180 pull information from the general ledger, but the NP Print Control code prevents them from printing.

Rows 1870 to 2020 demonstrate how to use the CAL format code to format the information from the non-printing rows. For example, row 1930 is interpreted as follows:
Place the results of columns A and B from row 190 (Cash - Checking) into columns A and B of the current row.

Place the results of columns A and B from row 1090 (Accounts Payable) into columns C and D of the current row.

These two sets of rows pull data from the general ledger. The NP Print Control code keeps these rows from printing in the report.

These rows use the CAL format code to pull the information from the non-printing rows into the side-by-side report.

Using CAL Codes

CAL codes must be on rows that do not include links to general ledger. However, you can place CAL codes on consecutive rows, suppress printing of those rows, and use the TOT command to combine them for report purposes. Refer to rows 340 to 400 in the following figure as an example.
Special Amount Formatting

You can specify the exact print format for a CAL result by adding special amount formatting at the end of a formula. This amount formatting is used regardless of what is entered in the Catalog of Reports window or the International Formats dialog box.

In the following figure, Row 160 shows how to divide the amount in B100 by the amount in C130 and print the result with three decimal places.

![Figure 3-21: Amount Formatting in Row Format Window](image)

Note: If a format is specified, it overrides any rounding selected for the report. For more information about formats, see “Formatting Tab” on page 261 and “Entering International Amount and Date Formats” in your FRx® Report Designer 6.7 Administrator’s Guide.

Entering IF/THEN/ELSE Statements

IF/THEN/ELSE statements can be added to any calculation that is valid for use with the CAL format. Enter IF/THEN/ELSE calculation formulas in the Related Rates/Rows/Unit cell using the following format:

\[
\text{IF } \langle \text{true/false statement} \rangle \text{ THEN } \langle \text{formula} \rangle \text{ ELSE } \langle \text{formula} \rangle
\]

The ELSE <formula> is optional.

IF Statements

The statement following IF can be any statement that can be evaluated as true or false. This can be a simple evaluation:

\[
\text{IF } A200>0
\]

It can be a complex statement containing multiple expressions:

\[
\text{IF } A200>10000 \text{ OR } ((A340/B1200)*2 <1200)
\]

THEN and ELSE Formulas

The THEN and ELSE formulas can be any valid calculation from the simplest value assignments to complex formulas. Note the formulas in the following window.

\[
\text{IF } A200>0 \text{ THEN } A=B200
\]

- This statement specifies that IF the value in column A of row 200 is greater than zero, THEN place the value from column B row 200 into column A of the current row. See row 300.
In this statement you can also use the @ character in either true/false evaluations or in the formula to represent all columns. For example, the formula described in the IF/THEN statement above placed a value in one column of the current row.

- In row 400, the value from B200 is placed in every column of the current row.
- In row 500, the value from each column in row 200 is placed in the corresponding column in the current row.
- With the formula in row 600, you instruct FRx to evaluate each column in row 200, and if greater than 0, place its value in the same column in the current row.

<table>
<thead>
<tr>
<th>A</th>
<th>Row Code</th>
<th>B Description</th>
<th>C First Code</th>
<th>D Related Rates/Rows/Unit</th>
<th>E Row Unit</th>
<th>F Perm Col</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Salary Expense</td>
<td>50000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>Officers Comp</td>
<td>50000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>300</td>
<td>One Column</td>
<td>CAL IF A200&gt;0 THEN A200</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>Every Column</td>
<td>CAL IF A200&gt;0 THEN B200</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>Corresponding Column</td>
<td>CAL IF A200&gt;0 THEN @200</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>600</td>
<td>Evaluate Each Column</td>
<td>CAL IF A200&gt;0 THEN @200</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>700</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Using @UNIT**

restrict a row to only a single reporting unit. To accomplish this, you specify the restriction in a row containing a Calculation (CAL) format code. The resulting amount is not rolled up to a higher-level unit.

The calculation row can also refer to a general ledger row, as described in the following example. The calculation is recorded in the Related Rates/Rows/Unit cell of the row format as with the general ledger-type restriction. It requires the use of a conditional calculation beginning with IF @UNIT, such as:

**IF @UNIT(SALES) THEN @100, ELSE 0**

This calculation places the amount from Row 100 in each column of the report, but only for the Sales unit. If there were multiple units named “sales,” the amount displays in each of those units.

Additionally, row 100 could be a general ledger row with a full account code and further be defined as non-printing. This prevents that amount from appearing in all units in the tree. You could also limit the amount to a single column of the report by using a column letter reference rather than the @ sign in front of the row code number.

You can specify a unit in a calculation-type restriction in one of three ways. See the examples in Figure 3-23.

- Enter a unit code to include those units that match. For example, IF @UNIT(SALES) allows the calculation for any unit named SALES, even if there were several SALES units within the tree. See row 130.
- Enter the company and unit code to restrict the calculation to SALES units in the ACME company only. See row 160.
Enter the full hierarchy code from the reporting tree to restrict the calculation to a specific unit. See row 190.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Net Sales</td>
<td>CAL</td>
<td>[UNIT({SALES})] THEN @100'2</td>
</tr>
<tr>
<td>130</td>
<td>Any Sales Unit</td>
<td>@UNIT</td>
<td>[UNIT({SALES})] THEN @100'2</td>
</tr>
<tr>
<td>160</td>
<td>Any Sales Unit for ACME</td>
<td>CAL</td>
<td>[UNIT({SUMMARY+ACME}+{WEST COAST}+{SALES})] THEN @100'2</td>
</tr>
<tr>
<td>190</td>
<td>Class H-Code</td>
<td>CAL</td>
<td>[UNIT({} ] [UNIT({SUMMARY+ACME}+{WEST COAST}+{SALES})] THEN @100'2</td>
</tr>
</tbody>
</table>

Figure 3-23: @UNIT in Row Format Window

You can double-click the Related Rates/Rows/Unit cell to access a list of reporting trees. Once you select a reporting tree, you will see a list of reporting units from that tree. Select the reporting unit you want, then complete the calculation formula.

**Point and Click Totaling for TOT and CAL rows**

With point and click totaling, you can select a consecutive or non-consecutive number of rows and have FRx automatically insert the range of rows in a TOT or CAL row for you. You use the arrow keys or your mouse to highlight the rows that you want to include in your formulas.

**To create a formula using point and click totaling**

1. From the TOT or CAL row, click the Related Rates/Rows/Unit column.
2. Click the Σ (sum) button from the toolbar.
   - By default, FRx selects the group of cells immediately above the selected TOT or CAL row to the preceding TOT or CAL row.
3. Use your arrow keys to highlight the first row that you want to use in your calculation.
4. Press the operand key that you want to use.
   - **Note:** You can add or subtract the row values in a TOT row. You can add, subtract, multiply, or divide the row values in a CAL row.
5. Highlight the next row that you want to appear in the calculation.
6. Repeat steps 3-5 for each row that you want to include in the formula.
7. When you are finished, review your formula and choose from the following options:
   - If you want to accept the formula, press **Enter**.
   - If you want to revert to the original formula, press **Esc**.

You can select a range of rows using point and click totaling. To do this, click your mouse anywhere in the beginning row and drag it to select the range that you want to include in the formula. You can also use your arrow keys in combination with the **Shift** key to alter the range.

**To select a range**

1. From the TOT or CAL row, click the Related Rates/Rows/Unit cell.
2. Click the Σ (sum) button from the toolbar.
   - By default, FRx selects the group of cells immediately above the selected TOT or CAL row to the preceding TOT or CAL row.
Chapter 3: Creating Row Formats–Totaling and Calculations

3  Accept the default range or hold down the Shift key and press the arrow keys to select a range, or using your mouse, click and hold to highlight the range of rows.

Note: If you manually type a range in the Related Rates/Rows/Unit column of a CAL row, add the @ symbol before each row code. Otherwise, FRx interprets the row codes as real numbers.

4  When you are finished, review your formula and choose from the following options:
   • If you want to accept the formula, press Enter.
   • If you want to revert to the original formula, press Esc.

Note: While the formula cell remains bordered, you can press the Esc key and revert to the previous formula.
General Ledger Account Codes

The Link to General Ledger column is where you specify the general ledger account codes to include in each row of a report. This section includes information and instructions on:

- Zero Balance Accounts
- Defining an Account Code
- Defining Only the Natural Code
- Defining the Full Account Code
- Entering General Ledger Codes
- Using Wildcards and Ranges
- Linking to Account Types
- Account Sets
- Using Account Modifiers
- Restricting Rows with Book Codes
- Using Account Attributes and Transaction Attributes in Rows

Zero Balance Accounts

By default, FRx suppresses the printing of any row that does not have a corresponding general ledger balance. This allows you to define all natural account code segments in your report row format and then use that one row format with any of your departments.

Defining an Account Code

In the Link to General Ledger cell, you can enter a general ledger account using the natural account code segment, full account code, or a combination of the natural segment and one or more responsibility segments.

Note

If your account code includes spaces as part of the account structure, FRx inserts an underscore (_) character in place of the space by default. If you want to change the underscore character, you need to change it in the System Preferences dialog box. For more information, see your FRx® Report Designer 6.7 Administrator’s Guide.

Defining Only the Natural Code

The most flexible row format is one that contains only the natural segment of the account code. For example, you could use the natural account code segment 6010 as the advertising expense code for all of your departments. Then you could define 6010 in the report row format and specify the associated responsibility segments in the reporting units of the reporting tree.
The full account code is created when FRx combines the row format with the reporting tree at report creation time.

**Definition the Full Account Code**

If you define the full account code, your row format options narrow sharply. For example, if you use the entire account code to generate detailed departmental reports, higher-level reports may not be possible.

If you enter the full account code in the row format, that account will always be used when you generate reports. The row format looks elsewhere for responsibility segments only when there are no responsibility segments entered in the account code definition in the row format. However, you can link data from one row format to another to create summary reports.

You can combine the full account code with natural segments in a single row format. This technique can be helpful when you want to use the account template in the reporting tree for most accounts, but also include accounts from other responsibility segments, such as divisions or departments. It’s also helpful for generating company-wide information (such as total sales revenue) in one row, and then calculating the proportion of department total to company total.

When you use a full account code that has wildcard characters for each position outside of the natural code, you include all accounts with that natural segment for the entire company.

**Note**

Any row with the full account code is included in every unit of your reporting tree, regardless of any responsibility segments that may be contained in the tree. This can cause dramatic overstatement of amounts in summary unit reports.

There are two ways to avoid this problem. You can restrict that row to a particular reporting unit. See “Restricting a Row to a Reporting Unit” on page 81. You can also use the XR (suppress rollup) print control code. See “Print Control Column” on page 83.

![Figure 3-24: Full Account Code in Row Format Window](image)
**Entering General Ledger Codes**

**To enter general ledger codes**

1. Double-click in the **Link to General Ledger** column to display the **GL Account Links** dialog box.

![GL Account Links dialog box](image)

2. Double-click a cell in the **From Account (range) -or- Individual Account or Account Set** column.

   The **Select General Ledger Account** dialog box appears. From this dialog box you can view or search for all the accounts or account sets in your general ledger.

3. In the **Search** box, type the first digits of an account code.

![Select General Ledger Account dialog box](image)

4. Select an account and click **OK**.

5. When you are finished creating the link, click **OK**.

   If you have specific questions about any option or box in the **GL Account Links** dialog box, please review the following sections.

**To zoom on an account segment in a row format**

1. From a row format, double-click the **Link to General Ledger** cell.

2. Click the **Account Code** option.
3 Double-click the **Acct Segment** cell to display the **Select a Segment for zooming** dialog box.

4 In the **Select a Segment for zooming** dialog box, select an account segment and click **OK**.

5 Double-click a cell in the **From Account (range) -or- Individual Account or Account Set** column to display the **Select General Ledger Account** dialog box. The displayed list is filtered by the account segment you specified.

6 In the **From Account (range) -or- Individual Account or Account Set** cell, type or select an account and click **OK**.

7 Click **OK** to return to the Row Format window.

### Using Wildcards and Ranges

#### Entering Wildcards

When you enter either natural or full account codes into the **GL Account Links** dialog box, you can place a wildcard, which is the question mark (?) symbol, in any position of the account code. FRx pulls all account codes for the defined numbers without regard for the wildcard numbers. For example, if the row format contains only the natural segments (assuming a four-character natural code), entering **6???** in a row instructs FRx to include all accounts whose natural code begins with a 6.

**Note**

You only add hooks (&) in row formats when you are using the **Add Rows from Chart of Accounts** feature. For more information, see “Building a Row Format” on page 68.

#### Entering an Account Range

If you want a row to contain amounts from a range of general ledger accounts, you can enter an account range.

**To enter an account range**

1 Double click the **Link to General Ledger** column.
2 Enter the beginning account number in the **From Account (range) or Individual Account or Account Set** cell of the **GL Account Links** dialog box.
3. Enter the ending account number in the **To Account (range)** box.
   The entry that appears in the **Formula** box (at the top of the **GL Account Links** dialog box) might look like this, for example:

   ```
   +(6100 TO 6900)
   ```

   This tells FRx to pull data from account 6100 through account 6900 inclusively into the row amount.

### Entering Ranges Using a Multi-segment Account Code

When entering a range using a full account code, the range comparison is done on a segment-by-segment basis. For example, the range 5000-1000-00 TO 6000-2000-00 includes only accounts that match each segment. In this case, the first segment must be between 5000 and 6000, the second segment must be between 1000 and 2000, and the last segment must be 00.

For example, the account 5100-1100-01 would not be included in the report because the last segment is out of range.

### Using Operators in Accounts

You can add or subtract accounts from other accounts using plus (+) and minus (-) signs.

**To use operators in accounts**

1. Double click the **Link to General Ledger** column.
2. In the **Op +/-** box of the **GL Account Links** dialog box, click the box until the operator that you want to use appears.
3. In the **From Account (range) -or- Individual Account or Account Set** box, enter or select an account number.

The following table shows the acceptable formats to add and subtract general ledger codes.

<table>
<thead>
<tr>
<th>To</th>
<th>Use this format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add full account codes</td>
<td>1205-2000-000+1205-2100-000</td>
</tr>
<tr>
<td>Add partial account codes</td>
<td>1205+1210</td>
</tr>
<tr>
<td>Add wildcard accounts</td>
<td>120?+11??</td>
</tr>
<tr>
<td>Add a range of full account codes</td>
<td>+(1205-1000-000 TO 1205-2000-000)</td>
</tr>
<tr>
<td>Add a range of partial account codes</td>
<td>+(1200 TO 1205)</td>
</tr>
</tbody>
</table>

*Table 3-5: Acceptable Formats for Adding and Subtracting Account Codes*
Although you can edit the accounts in the regular worksheet edit box, use the **GL Account Links** dialog box to apply the correct formatting to your account links. Any of the accounts can include wildcard (?) characters.

### Table 3-5: Acceptable Formats for Adding and Subtracting Account Codes (Continued)

<table>
<thead>
<tr>
<th>To (or Subtract)</th>
<th>Use this format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a range of wildcard accounts</td>
<td>+(120? TO 130?)</td>
</tr>
<tr>
<td>Subtract a full account code</td>
<td>1205-2100-000-(1205-2000-000)</td>
</tr>
<tr>
<td>Subtract a partial account code</td>
<td>1210-(1205)</td>
</tr>
<tr>
<td>Subtract a wildcard account</td>
<td>1100-(120?)</td>
</tr>
<tr>
<td>Subtract a range of full account codes</td>
<td>-(1205-1000-000 TO 1205-2000-000)</td>
</tr>
<tr>
<td>Subtract a range of partial account codes</td>
<td>-(1200 TO 1205)</td>
</tr>
<tr>
<td>Subtract a range of wildcard accounts</td>
<td>-(120? TO 130?)</td>
</tr>
</tbody>
</table>

**Note**

If you want to subtract accounts, you must put parentheses around those accounts. For example, if you enter 450?-(4509) you are telling FRx to subtract account 4509 from any account that starts with 450.

The **GL Account Links** dialog box demonstrates how to enter accounts 450? minus account 4509.
**Acct Segment**

Specify the type of account segment (Full or Natural), or a specific account segment of your general ledger to filter the displayed list in the From Account (range) -or- Individual Account or Account Set cell.

**Combining Accounts with Ranges**

Specific accounts, ranges of accounts, and wildcards can be combined in a row. The following example assumes a four-character natural code:

6210+6220+(6420 TO 7999)-(71??)

**Linking to Account Types**

Account types are category or group names defined in your general ledger that combine or relate various account codes. For example, the account type Assets might include all the cash accounts as well as accounts receivable. Using account types helps reduce report maintenance and shows a “big picture” perspective.

To link to an account type

1. From the row that you want to link, double-click the Link to General Ledger cell.
2. In the GL Account Links dialog box, the Account Code option is selected by default; select Account Type.

**Note:** When you select Account Type, the GL Account Links dialog box displays specific account type fields.

3. Double-click an Account Type cell.
Chapter 3: Creating Row Formats–General Ledger Account Codes

4 The Select General Ledger Account dialog box displays the available account types from your general ledger; select an account type and click OK. The account type displays in the Account Type cell and in the Formula.

5 In the GL Account Links dialog box, click OK. The Link to General Ledger cell displays the new account type link.

FRx follows the account type link with the symbols /A

Account Sets

You can create an Account Set by assigning a name to a group of accounts. Then, you can use this account set name in multiple row formats. When a change to your general ledger requires the Account Set to change, you can make changes to that set in one place only. For example, if you frequently indicate a range of accounts to link to your general ledger, such as accounts 5100 to 5600, you might assign this range the Account Set name Travel and Entertainment.

After creating an Account Set, you can select that set as your general ledger link. You can also group existing account sets together into other account sets; this is called nesting account sets. For example, after creating the Travel and Entertainment account set, you might create a new account set called Selling Expenses. This set could contain the Travel and Entertainment set and other associated accounts.

This section contains information and instructions on:

- Creating an Account Set from the Link to General Ledger Column
- Creating an Account Set Using the Edit Menu
- Linking an Account Set to Your General Ledger
- Editing an Account Set

Creating an Account Set from the Link to General Ledger Column

To create an account set from the Link to General Ledger column

1 Double-click the General Ledger column to open the GL Account Links dialog box.
2 Create a link to your general ledger. (For step-by-step instructions, please refer to “Entering General Ledger Codes” on page 97.)
3 Click the **Save As** button under the **Account Sets** options to display the **Save As Account Set** dialog box.

![Save As Account Set Dialog Box](image)

4 Type a name and description for the account set, and then click **OK**.
When you return to the **GL Account Links** dialog box, you see the word **SET** followed by the account set name in parentheses. For example, `+SET(Expense)`.

![GL Account Links Dialog Box](image)

### Creating an Account Set Using the Edit Menu

To create an account set using the Edit menu or right-click

1 On the **Edit** menu, click **Account Sets** or right-click and select **Account Sets** to display the **Account Sets** dialog box.

![Account Sets Dialog Box](image)

If there are existing account sets, click **New** after the **Account Sets** dialog box appears.

2 Create a link to your general ledger. (For step-by-step instructions, please see “Entering General Ledger Codes” on page 97.)

3 Select **Yes** from the **Acct Set** cell box by clicking on it.

4 Click the **Account Set Name** box and type a name for the account set.
The account set name you enter here will appear in the **Link to General Ledger** column of the Row Format window.
Chapter 3: Creating Row Formats–General Ledger Account Codes

5 If you want to add an alternate name or more detailed description for the account set, click the Description box and type a name or description in this optional box. The description you type here appears in the Description column of the Row Format window.

6 From the Account Sets control box, click Save.

7 When you are finished creating the account set, click Close.

Once you create your account set, you need to link it to your general ledger.

**Linking an Account Set to Your General Ledger**

To link an account set to your general ledger

1 Double-click the Link to General Ledger column to open the GL Account Links dialog box.

2 Click the Acct Set box to change the account set indicator to Yes.

3 Double-click a cell in the From Account (range) -or- Individual Account or Account Set column.

4 In the Select Account Set dialog box, select an account set and click OK. The selected account set appears in the Link to General Ledger column and the account set description appears in the Description column.

If changes occur to your account structure, you need to edit your existing account sets.

**Editing an Account Set**

To edit an account set

1 Click to highlight the account set name.

2 From the Account Sets buttons, click Edit to display the GL Account Links dialog box.

3 Make the changes to the account set.

4 When you are finished making changes, click Save in the Account Sets record control box.

5 Click Close.

6 Click OK.

**Using Account Modifiers**

Typically, when you select a specific account, FRx combines the account with the fiscal years, periods, and other information that you specify in the column layout. However, you might need to use different information (such as different fiscal periods) for specific rows. By adding account modifiers, which apply to every account in the row, you can change the nature or use of the specified accounts.
To use Account Modifiers

1. From the GL Account Links dialog box, click the Row Modifier arrow to display the Row Modifier dialog box.

2. From the Row Modifier dialog box, click the Account Modifier arrow to display the Select an Account Modifier zoom box.

3. To print a beginning balance for an account, select /BB. For example, if you entered 1420 in the From Account (range) -or- Individual Account or Account Set box and /BB in the Account Modifier box, the link to general ledger displays this:

   1420, /BB

   When you generate the report, the balance at the beginning of the period displays in the Current Period column, while the balance for the beginning of the year displays in the Year-to-Date column.

4. To specify a different period for every column in a row, place a slash (/) character in the Account Modifier box (for example, /1 or /-3). If your column layout adjusts for each period by the modifier amount, and you want your reports to generate and adjust by period, you need to add this account modifier.

   For example, using /1 as the account modifier pulls data for period 10 in a column layout that is currently pulling data for period 11. This applies to this row only.

5. To change Curr (current) to YTD (or vice versa) for every column in a row, enter C or Y.
For example, the following row format and report figures use the \( /Y \) account modifier to stack year-to-date balances below current balances.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>CURRENT PERIOD ACTIVITY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>B0</td>
<td>E1</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>B0-E</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>B0-E</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>120</td>
<td>Returns &amp; Discounts</td>
<td>C</td>
<td>NY</td>
<td>(410-1-110)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>Sales</td>
<td>107</td>
<td>200-250</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>140</td>
<td>Cost of Goods Sold</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>Gross Profit</td>
<td>107</td>
<td>200-110</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Total Units Sold</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>170</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>180</td>
<td>Year-to-Date Activity</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>190</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The \( /Y \) account modifier stacks the year-to-date balances below current balances in the report below.

**Figure 3-27: Row Format Window with Year-to-Date Account Modifier**

The following report illustrates the use of the \( /Y \) format code.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>Fabrikam Works, Inc.</td>
<td></td>
</tr>
<tr>
<td>210</td>
<td>Gross Profit Per Unit Sold</td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>For the Month Ending June 30, 2004</td>
<td></td>
</tr>
<tr>
<td>230</td>
<td>Denver</td>
<td>San Francisco</td>
</tr>
<tr>
<td>240</td>
<td>Retail</td>
<td>Wholesale</td>
</tr>
<tr>
<td>250</td>
<td>CURRENT PERIOD ACTIVITY</td>
<td></td>
</tr>
<tr>
<td>260</td>
<td>Sales</td>
<td>$135,293</td>
</tr>
<tr>
<td>270</td>
<td>Cost of Goods Sold</td>
<td>105,698</td>
</tr>
<tr>
<td>280</td>
<td>Gross Profit</td>
<td>29,595</td>
</tr>
<tr>
<td>290</td>
<td>Total Units Sold</td>
<td>25,230</td>
</tr>
<tr>
<td>300</td>
<td>Gross Profit / Unit Sold</td>
<td>1.173</td>
</tr>
<tr>
<td>310</td>
<td>YEAR TO DATE ACTIVITY</td>
<td></td>
</tr>
<tr>
<td>320</td>
<td>Sales</td>
<td>$764,830</td>
</tr>
<tr>
<td>330</td>
<td>Cost of Goods Sold</td>
<td>599,164</td>
</tr>
<tr>
<td>340</td>
<td>Gross Profit</td>
<td>167,666</td>
</tr>
<tr>
<td>350</td>
<td>Total Units Sold</td>
<td>147,715</td>
</tr>
<tr>
<td>360</td>
<td>Gross Profit / Unit Sold</td>
<td>1.136</td>
</tr>
</tbody>
</table>

The year-to-date totals appear below the Current Period Activity.

**Figure 3-28: Year-to-Date Balances Below Current Balances**

**Combining Account Modifiers**

You can combine the period offset account modifier with the current and year-to-date account modifiers. For example, if you use the code \( /C-2 \), FRx uses the current balance for the period that is two periods earlier than the period specified in the column layout. However, if you use the code \( /Y-1 \), FRx forces each column balance to use the year-to-date balance one period earlier than the other rows.
Figure 3-29 shows the effect of various account modifiers.

![Figure 3-29: Report Displaying Results of Account Modifiers](image)

### Restricting Rows with Book Codes

You can limit a row to an existing book code. However, you must have created a column layout that includes at least one GL-type column with a book code. In order for your reports to restrict the correct data, you must associate the restricted row format with the appropriate column layout in the report catalog.

**Note**

Any book code restriction you enter in a row will override those selected in the column layout for that row only.

You can select a book code restriction from the **GL Account Links** dialog box, or if you know the book code, add it directly into the **Link to General Ledger** column.

**To add a book code restriction using the GL Account Links dialog box**

1. Double-click the **Link to General Ledger** column to open the **GL Account Links** dialog box.

![GL Account Links](image)
2 From the **GL Account Links** dialog box, click the **Row Modifier** arrow to display the **Row Modifier** dialog box.

![Row Modifier Dialog Box](image)

3 From the **Row Modifier** dialog box, click the **Account Modifier** arrow and select `/B` to override the book code in the column layout.

4 Click the **Book Code** arrow and select the book code restriction you want to use for the row.

   **Note:** You only can specify one book code restriction per row.

5 When you are finished, click **OK**.

6 Click **OK** to accept your changes and to exit the **GL Account Links** dialog box.

**To add a book code restriction directly into the Link to General Ledger column**

1 Open the row format that will contain the book code restriction.

2 Locate the general ledger row you want to restrict.

3 Click in the **Link to General Ledger** column for the row and type the following text into the cell, substituting the correct book code for `<BookCode>` (including angle brackets):

   `/B:<BookCode>`

   **Note:** You only can specify one book code restriction per row.

---

**Using Account Attributes and Transaction Attributes in Rows**

Some accounting systems support account attributes and transaction attributes in the general ledger. These attributes function like a virtual account segment and can carry additional information about the account or transaction such as account ID, batch ID, postal codes, or other attributes of the account or transaction.

If your accounting system supports attributes, you can use account attributes or transaction attributes as row modifiers in the Link to General Ledger detail of the row format.

For information about using account attributes and transaction attributes in the column layout, see the column types **A_ATTR** and **T_ATTR** under “Specifying Column Types” on page 148. For information about using attribute filters in the column layout, see “Attribute Filters” on page 170.
To add account or transaction attributes using the GL Account Links dialog box

1. Double-click the Link to General Ledger column to display the GL Account Links dialog box.

![GL Account Links dialog box](image)

2. From the GL Account Links dialog box, click the Row Modifier arrow to display the Row Modifier dialog box.

![Row Modifier dialog box](image)

3. From the Attributes section of the Row Modifier dialog box, double-click the cell in the Type column to display the Select Attribute Type dialog box.

![Select Attribute Type dialog box](image)

4. From the Select Attribute Type dialog box, select an attribute type, then click OK.
5 From the **Row Modifier** dialog box, double-click the cell in the **Category** column to display the **Select Attribute Category** dialog box.

![Select Attribute Category Dialog Box](image)

**Note:** The attribute categories displayed in the list will depend on your accounting system and the attribute type you selected in the previous step.

6 From the **Select Attribute Category** dialog box, select an attribute category, then click **OK**.

7 From the **Row Modifier** dialog box, double-click the cell in the **From** column to display the **Select Attribute Value** dialog box.

![Select Attribute Value Dialog Box](image)

**Note:** The attribute values displayed in the list will depend on your accounting system and the attribute category you selected in the previous step. Some attribute categories, such as date or amount, may not display a list of values. You can type the date or amount values in the **From** and **To** cells to define the range of attribute values.

8 From the **Select Attribute Value** dialog box, select the beginning attribute value in the range, then click **OK**.

9 From the **Row Modifier** dialog box, double-click the cell in the **To** column to display the **Select Attribute Value** dialog box.

10 From the **Select Attribute Value** dialog box, select the ending attribute value in the range, then click **OK**.
11 From the **Row Modifier** dialog box, click **OK**.

The **GL Account Links** dialog box appears, with the account or transaction attributes in the Row Modifier box and displayed in the Formula box.

From the **GL Account Links** dialog box, click **OK** to return your selections to the Row Format window.
Assigning Currency Codes

For international reporting, you can assign currencies in the row format and the column layout. For the best performance, we recommend that you assign the currency codes in the column layout. Currency codes in the row format override the column layout currency code selections. These currency overrides provide additional flexibility but may decrease the performance of FRx. For more information on assigning currency codes in the column layout, see “Formatting Multicurrency Reports” on page 167.

To assign currencies in the row format

1. On the File menu, point to Open, and then click Row.
2. In the Open Row dialog box, double-click the row format that you want to assign currencies to.
3. Find the row that you want to assign a different currency and click the Link to General Ledger cell of that row.
   The account codes and formula used for this row appear in the edit bar.
4. In the edit bar, click the end of the formula and enter the following text:
   \{CURRENCY_CODE\}
   Replacing CURRENCY_CODE with a specific currency code or ? to include all currency codes that exist for the accounts.

<table>
<thead>
<tr>
<th>A</th>
<th>B Description</th>
<th>C First Code</th>
<th>D Related Rate/Price Unit</th>
<th>E Norm Bal</th>
<th>F Form Dtl</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td><strong>ASSETS</strong></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Cash - Checking</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Cash - Money Market</td>
<td>1110</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td></td>
<td>1110</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Total Cash</td>
<td>TOT</td>
<td>190 TO 250</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td></td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Repeat steps 3 and 4 for each row that you want to assign a different currency.
Automatic Rounding for Balance Sheets

When amounts are rounded to whole dollars, thousands, or millions, totals may be out of balance. Refer to the following table to see how rows are rounded.

<table>
<thead>
<tr>
<th>Row Code</th>
<th>Amounts without rounding</th>
<th>Amount with rounding to whole thousands</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>3,600</td>
<td>4</td>
</tr>
<tr>
<td>200</td>
<td>3,700</td>
<td>4</td>
</tr>
<tr>
<td>TOTAL</td>
<td>7,300</td>
<td>8</td>
</tr>
</tbody>
</table>

Table 3-6: Rounding in Balance Sheets

In Table 3-6, the total of rows 100 and 200 differ when rounding is turned on. When you use the rounding option in a balance sheet report, you can use the row format rounding adjustment feature. This feature balances balance sheets when you select report rounding in the Catalog of Reports window.

Using the rounding adjustment feature, you identify specific row codes in the **Rounding Adjustment** dialog box that FRx uses to adjust the report balance. These row codes must be linked directly to your general ledger. In other words, the row must have an account code in its **Link to General Ledger** column. Do not reference a description, calculated, or totaled row.

To adjust rounding in balance sheet reports

1. Open the row format you want to adjust.
2. On the **Edit** menu, click **Rounding Adjustments** to display the **Rounding Adjustments** dialog box.

3. In the **Rounding Adjustment row** box, enter the row code that you want adjusted to balance the balance sheet.

   **Note:** You can enter descriptive (for example, TOTAL_ASSETS) or numeric (for example, 110) row codes in this dialog box. However, the row codes that you enter must be valid row codes in order for the rounding adjustment to work.

4. In the **Total Assets row** box, enter the Total Assets row code.
5. In the **Total Liabilities & Equity row** box, enter the Total Liabilities and Equity row code.
6 In the **Adjustment Amount Limit** box, enter the limit (expressed as a positive whole number) that you want to place on automatic adjustments. FRx compares this amount with the absolute value of the actual rounding difference.

When you generate your report, if the **Rounding Adjustment row** value decreases or increases beyond the defined **Adjustment Amount Limit**, a message appears.

**Note**: FRx applies the adjustment limit based on the **Rounding of Amounts** option that you select in the Catalog of Reports. For example, if you select to round your report to thousands and enter 2 in the **Adjustment Amount Limit**, FRx displays a warning message when the **Rounding Adjustment row** value increases or decreases by more than $2,000.

7 Click **OK**.

The amounts in your balance sheet will balance even when rounding is turned on.

For additional information on rounding, refer to “Rounding of Amounts” on page 263.
Linking increases reporting flexibility by allowing you to link to other sources of information within the same row format or across multiple row formats. You can link to several sources of information in your reports including:

- General ledger accounts
- Other row formats
- External worksheets like Lotus 1-2-3 or Microsoft® Excel
- Year-to-year changes in account codes

This chapter includes complete instructions for creating these links.
You can create a row format that pulls information from another row format, and that format, in turn, uses general ledger accounts to draw data from your accounting system. When used in conjunction with a reporting tree, linking allows each unit in the tree to use a different row format. This means that each unit can pull in different account code structures or data sources (general ledger or external worksheet), as well as different report presentations (summary versus detail or unique fonts).

Reports can be summarized and displayed in unlimited ways. Using the reporting tree, you can stack reports up to nine levels deep.

In addition to linking to other row formats and external worksheets, you can also define links to other fiscal years. This is particularly useful for generating comparative reports when your general ledger coding conventions have changed from year to year.

This section contains information and instructions on:

- Creating Summary Reports Using Row Links
- Establishing Links
- Linking to External Worksheets

**Creating Summary Reports Using Row Links**

One of the greatest strengths of FRx® Report Designer is its ability to summarize data from one row format to another. This allows you to create detailed reports directly from the account data in your general ledger, and then combine or summarize this detail in different summary reports.

You can create a master row format, and then use it as a source for other reports. Row linking reduces the setup and maintenance time for detail and summary level reports. For example, you can:

1. Create a master row format that links to the general ledger.
2. Create a new row format for a balance sheet and income statement linked to the master row format.
3. Create a row format for a summarized balance sheet linked to the detail balance sheet.
Figure 4-1 illustrates these general ledger, detail balance sheet-income statement, and summary balance sheet links.

Figure 4-1: Creating Summary Reports Using Links

This section contains information and instructions on:

- Natural Row Format
- DetlBSIS Row Format
- SummryBS Row Format
- Column Layout
- Reporting Tree
### Natural Row Format

The Natural row format shown in Figure 4-2 links to the asset accounts in the general ledger.

<table>
<thead>
<tr>
<th>A Row Code</th>
<th>B Description</th>
<th>C Fmt Code</th>
<th>D Related Rows/Format Unit</th>
<th>E Nom Bal</th>
<th>F Print Ctrl</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>Cash-Checking</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Money Market (Short-Term)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Money Market (Long-Term)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Accounts Receivable</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Allowance for Bad Debt</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Due from FWC</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Inventory</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Inventory (Elimination)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Inventory Supplies</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Prepaid Other</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Leasehold Improvements</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Accum. Depr. - Lease Improvements</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Office Furniture &amp; Fixtures</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Accum. Depr. - OF&amp;F</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Office Equipment</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Accum. Depr. - Office Equip</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>110</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-2: Asset Accounts in Natural Row Format

### DetlBSIS Row Format

The DetlBSIS row format links to the Natural row format. The following figure shows how asset account balances from row codes 100 to 799 of the Natural row format are incorporated into the assets portion of the detailed balance sheet. The link is established by selecting the row format option in the Link Type box in the Links dialog box.

In the following figure, row 100 in the DetlBSIS row format links to rows 100 to 199 of the Natural row format. Report Designer adds the values that were accumulated in rows 100 to 199 in the Natural row format and places the total in row 280 of the DetlBSIS row format.

When you use the Row Fmt Codes PB (New Page - Balance Sheet), you must use the Column Layout Print Control option BS (Column is Balance Sheet Column in Mixed IS/BS Report) under the YTD Column so the balance sheet prints correctly.

Amount information is being pulled from the NATURAL row format.

These rows link to ranges of rows, adding the values and placing them here.

Figure 4-3: Detailed Balance Sheet Data in DetlBSIS Row Format
**SummryBS Row Format**

The SummryBS row format for the summary balance sheet links to the DetailBSIS row format, again using the row format option in the Link Type box in the Links dialog box.

In the following figure, row 100 of the SummryBS row format has the same value as row 490 of the DetlBSIS row format.

![Figure 4-4: Summary Balance Sheet Data in SummaryBS Row Format](image)

**Column Layout**

All three reports must use the same column layout such as the Cur_YTD Column Layout shown in Figure 4-5.

![Figure 4-5: Current Year-to-date Column Layouts Window](image)

In addition, the DetlBSIS row format, requires that you use the Print Control Option BS (Column is Balance Sheet Column in Mixed IS/BS Report) under the YTD Column. This option is required because the DetlBSIS row format uses the PB (Page Break) as a format code. Using these two codes tells Report Designer to print the consolidated Balance Sheet.
## Reporting Tree

All three reports can use a reporting tree like the one shown in Figure 4-6.

![Figure 4-6: Row Linking in Reporting Trees Window](image)

Note the following important points about the reporting tree:

- The account mask is used only in the lowest level of the tree because the Natural unit code is the only one that uses a row format (Natural) that draws information from the general ledger.
- The hierarchy of reporting units in the reporting tree must match the links within the row formats.
- The middle unit in the tree (Detail B/S & I/S) uses the DetlBSIS row format, which is linked to the Natural row format. That is, this unit gets information from the Natural row format rather than from the general ledger.
- The highest unit in the tree (Summary B/S) uses the SummryBS row format, which is linked to the DetlBSIS row format. This unit gets information from the DetlBSIS row format rather than from the general ledger.

If the reporting units in the tree are not matched properly to the row formats, you may get the following error message.

![Figure 4-7: Report Designer Reporting Engine Error Message](image)

When you generate the report from the Catalog of Reports using the row format, column layout, and reporting tree, you get three separate reports while only accessing the general ledger once. See Figure 4-1 on page 117.
Establishing Links

All links are defined from the Row Format window. Most row formats that use general ledger account codes are created by automatic transfer from the chart of accounts. You can also create a new row format by selecting New from the File menu. In both cases, Report Designer automatically creates a link to the general ledger by default. You can have a maximum of 19 link columns within a row format.

To create links in the Row Format window, you use the Links dialog box shown in Figure 4-8.

![Figure 4-8: Links Dialog Box](image)

In the Link Type box, you select the type of link to create, such as row format, external worksheet, or XBRL. For more information on linking to worksheets, see “Using a Combined Worksheet Link” on page 128, and “Using a Separate Worksheet Link” on page 130.

Use the General Ledger Year box to create multiple general ledger link columns to the appropriate year. General ledger link columns are useful when creating year-to-year comparative reports and the general ledger account coding changes from one year to the next. Report Designer uses this link for that fiscal year, as well as any earlier years, unless there is already a link for an earlier year.

This section contains information and instructions on:

- Creating Row Formatting Links
- Linking Rows to a Summary Report
Creating Row Formatting Links

To create links

1. From the FRx Control Panel, open a row format or select a new one.

2. On the Link menu, click Open Link Window to display the Links dialog box.

   **Note:** You can also open the Links dialog box by clicking the Link Form icon or double-clicking the Link to General Ledger column heading.

3. Click the Link Type arrow and select one of the following links:
   - General Ledger (Link Type G)
   - Row Format (Link Type R)
   - External Worksheet (for example, Lotus 1-2-3 or Microsoft Excel) (Link Type W)
   - GL + WorkSheet (Link Type B)
   - XBRL Taxonomy Files (Link Type X)

   **Note:** Report Designer can import Microsoft Excel .xls files and Lotus .wks, .wk1, or .wk3 files.

4. In the Link Name box, accept the name assigned by Report Designer or type another name to identify the link. (Report Designer assigns names sequentially, for example, GL1, ROW1, GL2, ROW2.)
Then, use one of the following options:

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>You selected <strong>General Ledger</strong> in the <strong>Link Type</strong> box</td>
<td>Go to step 6.</td>
</tr>
<tr>
<td>You selected <strong>Row Format</strong> in the <strong>Link Type</strong> box</td>
<td>Click the <strong>Source Row Format</strong> arrow and select a row format for the link.</td>
</tr>
<tr>
<td>You selected <strong>External Worksheet</strong> in the <strong>Link Type</strong> box</td>
<td>Go to step 6.</td>
</tr>
<tr>
<td>You selected <strong>GL + Worksheet</strong> in the <strong>Link Type</strong> box</td>
<td>Click the <strong>Worksheet File Name</strong> arrow and type or select the worksheet name.</td>
</tr>
</tbody>
</table>
| You selected **XBRL** in the **Link Type** box                       | Click the **XBRL Taxonomy Files** arrow and type or select the XBRL file.  
For more information, see “Using Extensible Business Reporting Language (XBRL)” on page 305. |

In the **Optional Description** box, as needed, type a description of the link.  
This information appears in the **Link** column header description.

If you selected a general ledger link, use one of the following options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a year-to-year general ledger link</td>
<td>In the <strong>General Ledger Year</strong> box type a year.</td>
</tr>
<tr>
<td>Use the same account codes for all years</td>
<td>Leave the <strong>General Ledger Year</strong> box blank.</td>
</tr>
</tbody>
</table>

Click **Save** to save the new link information.

As needed, you can click **Delete** to delete the currently displayed link, **New** to create a new link, or **Find** to select another link to edit.

Click **Close** to close the **Links** dialog box.

**Linking Rows to a Summary Report**

To link rows to a summary report

1. Create the necessary row formats, as described under “Creating Row Formatting Links” on page 122.
2 From the FRx Control Panel, on the File menu, open a tree.

3 In the Row Format column (I) of the reporting tree, select the row format to use for the link.

   **Note:** If you specify a row format for one branch of the tree, you must specify a row format for all branches in the tree.

4 To link specific rows from the row format to the summary report, type the row codes in the reporting tree Row Link column (Q).

   When you type the row codes, specify a range of row codes (100 TO 300) or individual rows (100+120-130) but not both.

5 Click Save to link your rows.

6 In the Catalog of Reports Building Blocks tab, select the Use row format(s) and Worksheet Links from Reporting Tree check box for this report.

**Linking to External Worksheets**

Report Designer lets you extend your financial reporting capabilities with Microsoft Excel or Lotus 1-2-3. You can import data from one of these programs and combine that data with data from your general ledger. For example, you can import budget figures from a worksheet and then create a report that compares actual figures from the general ledger to the budget figures from the worksheet.

External worksheet data can be accessed in two ways: a combined worksheet link, or a separate worksheet link.

- The easiest method, a combined worksheet link, combines external worksheet cell references in the same link column as your general ledger account codes. When you do this, some rows in a given column of your report contain general ledger information while other rows in that same column contain worksheet data. This is the preferred method when you are importing limited amounts of data (such as work hours, headcount, or units sold) and when associating the data with a particular unit in the reporting tree is not required.

- You can use a separate worksheet link to access multiple rows and columns of worksheet data and associate one or more external worksheets with one or more reporting units in the reporting tree. You create a special column in the row format that links to the worksheet cell addresses, and then add the worksheet file names to the reporting tree.

   **Note** Linking to spreadsheets that have identical layouts reduces the number of link columns required in the row format and reduces maintenance time.

This section contains information and instructions on:

- Referencing External Worksheet Cells
Identifying Individual Worksheet Cells

Automatic Matching of Worksheet Columns to the Current Period

Using a Combined Worksheet Link

Using a Separate Worksheet Link

Referencing External Worksheet Cells

Because the column layout is defined separately from the row format, you must determine which Report Designer columns receive the worksheet data. You should have a copy of the column layout you will use as well as the referenced worksheet in the row format.

Note

Report Designer columns that accept external worksheet data are those identified in the column layout as GL or WKS. If you place a worksheet cell in a CALC, DESC, or FILL column, the value is ignored.

When referring a particular worksheet in a workbook, be sure the worksheet name is at least two characters, for example, [workbook.xls]AA.

When referring to a worksheet cell address, use the column letter and row number reference, such as C10 (column C, row 10). Report Designer does not support range labels. When referring to a specific sheet in a Lotus worksheet, use the sheet letter in addition to the column letter and row number reference. For example, use A:C10, where A: represents the sheet letter.

Identifying Individual Worksheet Cells

In the row format, you can specify a series of worksheet cell addresses to place data in specific columns. Depending upon how your worksheet is organized, specify these addresses using one of the following methods:

- Direct reference
- Value placement
- Direct column placement

Direct Reference

The most direct way to reference a cell from an external worksheet is to type @WKS, followed by the column code to receive the cell followed by an equal sign (=)
and the worksheet cell itself. The cell references must be enclosed in parentheses. See “Format Conventions” on page 129 for examples.

For example, to place the information contained in cell B10 of your worksheet into column D of your report, your link would be

@WKS (D=B10).

You can also place external worksheet cells in several Report Designer columns by typing multiple Report Designer column/worksheet cell references, like this:

@WKS (D=B10, E=B11, F=B12)

**Value Placement**

This method allows you to type a list of cell addresses that are automatically placed into valid columns (GL or WKS columns) and skip any invalid columns. Simply specify cell addresses separated by spaces. For example, the amounts corresponding to the cell addresses in the list

A12  A13  B23  C118

are placed into the first columns that are GL or WKS columns.

**Direct Column Placement (Common Method)**

Use this method if your worksheet is arranged exactly like your proposed Report Designer report. Specify the column to receive data by listing worksheet cells separated by commas. For example, assume you are using a Report Designer column layout that has six columns: columns A through F, where C is a Description column and E is a Calculation column. To place four worksheet cells into the remaining columns, you would type the cell addresses as:

A12, A13,, B23,, C118

Note the extra commas in the above list. Each comma corresponds to a Report Designer column. In the example, the cells match up like this:

<table>
<thead>
<tr>
<th>Report Designer Column</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet Cell</td>
<td>A12</td>
<td>A13</td>
<td>-</td>
<td>B23</td>
<td>-</td>
<td>C118</td>
</tr>
</tbody>
</table>

**Note**

After you code the worksheet cell addresses into a row format, try not to insert or delete rows or columns in the external worksheet. If you do, the worksheet cell reference changes and your Report Designer links will be incorrect.
Automatic Matching of Worksheet Columns to the Current Period

Use one of the following methods to link to worksheets that cover multiple reporting periods:

- Column Period Offset (CPO)
- Row Period Offset (RPO)

Column Period Offset (CPO)

If the worksheet you are linking to has multiple columns that represent different periods (such as a worksheet with a 12-month detailed budget forecast), you can use the `/CPO` (Column Period Offset) switch. This tells Report Designer to match the accounting periods in the column layout with the appropriate columns in the worksheet. You can use this technique with either worksheet link method.

To use the `/CPO` switch, type the cell address that points one column to the left of the first period (column) in the worksheet for the given row; then, add the `/CPO` switch at the end of the cell address.

Example of Linking to Multiple Columns with `/CPO` Switch

The worksheet shown in Figure 4-9 is used to link to a row format in Figure 4-10 to create a Gross Profit Per Unit report. This worksheet has monthly statistics in columns B through M.

![Figure 4-9: Worksheet with Monthly Statistics](image)

Row 430 in Figure 4-10 shows how to use the `/CPO` switch to link the columns from the worksheet.

![Figure 4-10: Column Period Offset in Row Format Window](image)
When you run a report for period 1, Report Designer uses the values in column **B** of the worksheet (January); for period 2, the values in column **C** of the worksheet (February), and so forth.

Notice that all cells referenced (A7, A6, etc.) are one column to the left of the actual amounts you would like brought into your report.

**Note** If more than one worksheet cell is referenced, the `/CPO` (or `/RPO` - discussed on the following page) is only displayed once, at the end of the worksheet cell listing. See row 430 in Figure 4-10 as an example.

**Row Period Offset (RPO)**

If the worksheet you are linking to has multiple rows that represent different periods, you can use the `/RPO` (Row Period Offset) switch to match the column layout accounting periods with the appropriate worksheet rows. You can use this technique with either worksheet link method. To use the `/RPO` switch, enter the cell address that points one row above the first period (row) in the worksheet for a given column; then, add the `/RPO` switch at the end of the cell address.

**Using Multiple WKS Columns**

If you use either the `/CPO` or `/RPO` switch and you specify multiple **WKS** columns in the column layout, Report Designer matches an external worksheet column with each **WKS** column. In this case, you must place a value in the period cell of each **WKS** column. You can use a specific period (such as 6) or a relative period (such as B+2).

For more information on adding a value to the period cell, see “Period Code” on page 152.

**Using a Combined Worksheet Link**

You can include the worksheet cell references in the **Link to General Ledger** column of the row format if you:

- Need to import only limited amounts of worksheet data from a single file
- Do not need to use a reporting tree

To include worksheet cell addresses in the same link as your general ledger codes, you must first change the link type.

**To change the link type**

1. From the row format worksheet **Link** menu, select **Open Link Window** or click the **Link Form** icon in the toolbar to display the **Links** dialog box.
In the **Link Type** box, change **General Ledger** to **GL + Worksheet**.

Accept the Report Designer default value in the **Link Name** box, or if you would like to use your own link naming system, type a new name.

In the **Worksheet File Name** box, click the arrow.

In the **Worksheet File** dialog box, type or select the worksheet to use and click **Open**.

To specify a specific worksheet, select one of the following options:

<table>
<thead>
<tr>
<th>To Specify a Worksheet</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>within a Microsoft Excel workbook</td>
<td>Type the workbook name in brackets followed by the worksheet name, for example: <code>[COMPBUDG.XLS]DENVER</code></td>
</tr>
<tr>
<td>within a Lotus 1-2-3 WK1 spreadsheet</td>
<td>Type the spreadsheet name in brackets followed by the sheet letter.</td>
</tr>
</tbody>
</table>

**Note:** Report Designer imports only the first sheet in a Lotus 1-2-3 WK3 spreadsheet. To select a different sheet, save the sheet as a separate WK3 file.

If you type a file without a full path, Report Designer uses the path defined for the default **IO_Data** directory in the **Company Information** dialog box. The file name appears by default in the **Link to GL + Worksheet** header description.

In the **Optional Description** box, you can type a description of the link.

Click **Save**.

Click **Close**.

**Entering Worksheet Cell Addresses**

Type the worksheet cell address in the **Link to GL + Worksheet** column along with the `@WKS(x=)` worksheet formula indicator, for example:

`@WKS (B=A12,C=A13,D=A14)`

The row format shown in Figure 4-10 on page 127 illustrates how to use a combined worksheet link.

- Row 370 calculates gross profit.
- Row 430 imports total units sold from the worksheet shown previously.
- Row 490 calculates gross profit per unit sold by dividing row 370 by row 430.

**Format Conventions**

Take these rules into consideration when you use the combined link method:

- Always specify the worksheet file name in the row format link.
- Always begin the cell reference with the `@WKS` worksheet indicator; this tells Report Designer that this is a reference to an external worksheet and *not* a general ledger account.
Always enclose the cell reference in parentheses ( ).

- Type a specific Report Designer column letter before the cell address to ensure proper placement of the data in your report.

- If you do not use commas or column references in the formula, Report Designer uses the value placement method and places the worksheet data in consecutive GL or WKS columns. Any text or calculation columns are skipped.

The following table describes which reference method uses which format.

<table>
<thead>
<tr>
<th>For this reference method</th>
<th>Use this format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct</td>
<td>@WKS (B=B5)</td>
</tr>
<tr>
<td></td>
<td>@WKS (B=B5, C=C5, D=D5)</td>
</tr>
<tr>
<td></td>
<td>@WKS (B=B5 C=C5 D=D5)</td>
</tr>
<tr>
<td>Direct Column Placement</td>
<td>@WKS (B5, C5, D5)</td>
</tr>
<tr>
<td>(Comma Method)</td>
<td>(The Comma Method brings data into the first three Report Designer columns)</td>
</tr>
<tr>
<td>Value Placement Method</td>
<td>@WKS (B5 C5 D5)</td>
</tr>
</tbody>
</table>

Table 4-1: Format Conventions in Column Layouts Windows

Some examples of incorrect formatting include:

<table>
<thead>
<tr>
<th>Incorrect format</th>
<th>Reason for error</th>
</tr>
</thead>
<tbody>
<tr>
<td>B=B5</td>
<td>Missing @WKS; change format to @WKS (B=B5).</td>
</tr>
<tr>
<td>@WKS B=B5</td>
<td>Missing parentheses; change format to @WKS (B=B5).</td>
</tr>
</tbody>
</table>

Table 4-2: Examples of Incorrect Formats in Column Layouts Windows

For more information on the column placement methods, see “Identifying Individual Worksheet Cells” on page 125.

**Using a Separate Worksheet Link**

If you have large amounts of worksheet data in multiple worksheets for different units of your company, create a separate link column that contains only the worksheet cell addresses. This method (described in the following section) requires that you use a reporting tree.

This section contains information and instructions on:

- Defining the Link Type
- Entering Worksheet Cell Addresses
Chapter 4: Linking to Other Sources of Information–Linking to External Worksheets

- Identifying the Worksheet in the Reporting Tree
- Setting Up the Catalog ID

**Defining the Link Type**

This method requires that you create a new row format **Link** column.

**To define a separate worksheet link**

1. In the row format worksheet **Link** menu, select **Open Link Window** or click the **Link Form** icon to display the **Links** dialog box.

![Links dialog box]

2. Click **New** to create a new link.

3. In the **Link Type** box, change **General Ledger** to **External Worksheet**.

4. Accept the Report Designer default value in the **Link Name** box, or if you would like to use your own link naming system, enter another name.

5. In the **Optional Description** box, you can optionally type a description of the link. This description displays in the row format **Link** column description and in the reporting tree **Ext Link** column.

6. Click **Save**.

7. Click **Close**.

**Entering Worksheet Cell Addresses**

The steps for entering worksheet cell addresses for a separate link are the same as those discussed in “Entering Worksheet Cell Addresses” on page 129 with one exception. When you use a **Link to Worksheet** column, you do not need to enter @WKS before the cell references because the column refers only to a worksheet.
### Example of Separate Worksheet Linking

The budget forecast worksheets for San Francisco, Denver, and Corporate Headquarters shown in Figure 4-11, Figure 4-12, and Figure 4-13 are linked to the row format in Figure 4-14 to report total compensation expenses.

#### Figure 4-11: Budget Forecast for San Francisco

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fabrikam Works, Inc.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Budget Forecast: San Francisco</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
<td>Apr</td>
<td>May</td>
<td>Jun</td>
<td>Jul</td>
<td>Aug</td>
<td>Sep</td>
<td>Oct</td>
<td>Nov</td>
<td>Dec</td>
</tr>
<tr>
<td>4</td>
<td>Salaries &amp; Wages</td>
<td>250,000</td>
<td>255,000</td>
<td>260,000</td>
<td>265,000</td>
<td>270,000</td>
<td>275,000</td>
<td>280,000</td>
<td>285,000</td>
<td>290,000</td>
<td>295,000</td>
<td>300,000</td>
<td>305,000</td>
</tr>
<tr>
<td>5</td>
<td>Sales Commission</td>
<td>10,000</td>
<td>11,000</td>
<td>12,000</td>
<td>13,000</td>
<td>14,000</td>
<td>15,000</td>
<td>16,000</td>
<td>17,000</td>
<td>18,000</td>
<td>19,000</td>
<td>20,000</td>
<td>21,000</td>
</tr>
<tr>
<td>6</td>
<td>Sales Returns</td>
<td>5,000</td>
<td>5,500</td>
<td>6,000</td>
<td>6,500</td>
<td>7,000</td>
<td>7,500</td>
<td>8,000</td>
<td>8,500</td>
<td>9,000</td>
<td>9,500</td>
<td>10,000</td>
<td>10,500</td>
</tr>
<tr>
<td>7</td>
<td>Sales Discounts</td>
<td>2,000</td>
<td>2,200</td>
<td>2,400</td>
<td>2,600</td>
<td>2,800</td>
<td>3,000</td>
<td>3,200</td>
<td>3,400</td>
<td>3,600</td>
<td>3,800</td>
<td>4,000</td>
<td>4,200</td>
</tr>
<tr>
<td>8</td>
<td>Other G&amp;A Expense</td>
<td>1,000</td>
<td>1,100</td>
<td>1,200</td>
<td>1,300</td>
<td>1,400</td>
<td>1,500</td>
<td>1,600</td>
<td>1,700</td>
<td>1,800</td>
<td>1,900</td>
<td>2,000</td>
<td>2,100</td>
</tr>
</tbody>
</table>

#### Figure 4-12: Budget Forecast for Denver

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fabrikam Works, Inc.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Budget Forecast: Denver</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
<td>Apr</td>
<td>May</td>
<td>Jun</td>
<td>Jul</td>
<td>Aug</td>
<td>Sep</td>
<td>Oct</td>
<td>Nov</td>
<td>Dec</td>
</tr>
<tr>
<td>4</td>
<td>Salaries &amp; Wages</td>
<td>250,000</td>
<td>255,000</td>
<td>260,000</td>
<td>265,000</td>
<td>270,000</td>
<td>275,000</td>
<td>280,000</td>
<td>285,000</td>
<td>290,000</td>
<td>295,000</td>
<td>300,000</td>
<td>305,000</td>
</tr>
<tr>
<td>5</td>
<td>Sales Commission</td>
<td>10,000</td>
<td>11,000</td>
<td>12,000</td>
<td>13,000</td>
<td>14,000</td>
<td>15,000</td>
<td>16,000</td>
<td>17,000</td>
<td>18,000</td>
<td>19,000</td>
<td>20,000</td>
<td>21,000</td>
</tr>
<tr>
<td>6</td>
<td>Sales Returns</td>
<td>5,000</td>
<td>5,500</td>
<td>6,000</td>
<td>6,500</td>
<td>7,000</td>
<td>7,500</td>
<td>8,000</td>
<td>8,500</td>
<td>9,000</td>
<td>9,500</td>
<td>10,000</td>
<td>10,500</td>
</tr>
<tr>
<td>7</td>
<td>Sales Discounts</td>
<td>2,000</td>
<td>2,200</td>
<td>2,400</td>
<td>2,600</td>
<td>2,800</td>
<td>3,000</td>
<td>3,200</td>
<td>3,400</td>
<td>3,600</td>
<td>3,800</td>
<td>4,000</td>
<td>4,200</td>
</tr>
<tr>
<td>8</td>
<td>Other G&amp;A Expense</td>
<td>1,000</td>
<td>1,100</td>
<td>1,200</td>
<td>1,300</td>
<td>1,400</td>
<td>1,500</td>
<td>1,600</td>
<td>1,700</td>
<td>1,800</td>
<td>1,900</td>
<td>2,000</td>
<td>2,100</td>
</tr>
</tbody>
</table>

#### Figure 4-13: Budget Forecast for Corporate Headquarters

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fabrikam Works, Inc.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Budget Forecast: Corporate Headquarters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
<td>Apr</td>
<td>May</td>
<td>Jun</td>
<td>Jul</td>
<td>Aug</td>
<td>Sep</td>
<td>Oct</td>
<td>Nov</td>
<td>Dec</td>
</tr>
<tr>
<td>4</td>
<td>Salaries &amp; Wages</td>
<td>250,000</td>
<td>255,000</td>
<td>260,000</td>
<td>265,000</td>
<td>270,000</td>
<td>275,000</td>
<td>280,000</td>
<td>285,000</td>
<td>290,000</td>
<td>295,000</td>
<td>300,000</td>
<td>305,000</td>
</tr>
<tr>
<td>5</td>
<td>Sales Commission</td>
<td>10,000</td>
<td>11,000</td>
<td>12,000</td>
<td>13,000</td>
<td>14,000</td>
<td>15,000</td>
<td>16,000</td>
<td>17,000</td>
<td>18,000</td>
<td>19,000</td>
<td>20,000</td>
<td>21,000</td>
</tr>
<tr>
<td>6</td>
<td>Sales Returns</td>
<td>5,000</td>
<td>5,500</td>
<td>6,000</td>
<td>6,500</td>
<td>7,000</td>
<td>7,500</td>
<td>8,000</td>
<td>8,500</td>
<td>9,000</td>
<td>9,500</td>
<td>10,000</td>
<td>10,500</td>
</tr>
<tr>
<td>7</td>
<td>Sales Discounts</td>
<td>2,000</td>
<td>2,200</td>
<td>2,400</td>
<td>2,600</td>
<td>2,800</td>
<td>3,000</td>
<td>3,200</td>
<td>3,400</td>
<td>3,600</td>
<td>3,800</td>
<td>4,000</td>
<td>4,200</td>
</tr>
<tr>
<td>8</td>
<td>Other G&amp;A Expense</td>
<td>1,000</td>
<td>1,100</td>
<td>1,200</td>
<td>1,300</td>
<td>1,400</td>
<td>1,500</td>
<td>1,600</td>
<td>1,700</td>
<td>1,800</td>
<td>1,900</td>
<td>2,000</td>
<td>2,100</td>
</tr>
</tbody>
</table>
Chapter 4: Linking to Other Sources of Information–Linking to External Worksheets

Figure 4-14 shows the row format that links the San Francisco, Denver, and Corporate Headquarters worksheets.

<table>
<thead>
<tr>
<th>A</th>
<th>Description</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>140</td>
<td>Gross Sales</td>
<td>4107</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>Returns</td>
<td>4110</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>Discounts</td>
<td>4250</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>160</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Sales</td>
<td>100+120+160</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>260</td>
<td>Cost of Goods Sold</td>
<td>4507</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>260</td>
<td>-</td>
<td>310</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>340</td>
<td>Gross Profit</td>
<td>310</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>370</td>
<td>Compensation Expense</td>
<td>5000</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>460</td>
<td>Other G&amp;A Expense</td>
<td>520</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>460</td>
<td>Depreciation</td>
<td>510</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>490</td>
<td>Office Expense</td>
<td>520</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>520</td>
<td>Supplies</td>
<td>5225</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>550</td>
<td>Maintenance</td>
<td>5240</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>560</td>
<td>Rent</td>
<td>5250</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>610</td>
<td>Travel</td>
<td>5900</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>540</td>
<td>Advertising</td>
<td>5800</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>670</td>
<td>Other G&amp;A Expense</td>
<td>750</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>730</td>
<td>Total Other G&amp;A Expense</td>
<td>750</td>
<td>SF</td>
<td>AK/PO</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-14: Row Format Linked with San Francisco, Denver, and Corporate Worksheets

In this row format, column I links with both the San Francisco and Denver worksheets and column J links with the Corporate worksheet. In the previous figures, row 370 (Compensation Expense) in the row format links to row 15 (Total Comp) in the San Francisco and Denver worksheets and row 5 (Officers’ Comp) in the Corporate worksheet. The San Francisco and Denver spreadsheets each require only one link since they have identical layouts. The Corporate spreadsheet requires a separate Link column because it has a different layout.

**Identifying the Worksheet in the Reporting Tree**

Once you have created a Link to Worksheet column in the row format and specified the cells that are included in the report, you must identify the linked column and external worksheet in a reporting tree. An external worksheet can be imported into any unit in the tree.

**To identify the worksheet link in the reporting tree**

1. In the FRx Control Panel, click the Reporting Trees icon to display the Open Tree dialog box.

2. In the Open Tree dialog box, select the reporting tree to edit.
3 Click the reporting unit that imports your worksheet data, and then press F8 (or click Tree Form on the toolbar) to open the Reporting Units dialog box.

4 Under Optional Row Formats and Links, click the Row Format Name arrow to display the Choose a Row Format dialog box.

5 In the Choose a Row Format dialog box, select the row format with the worksheet link information and click OK.

6 Click the Wks Link arrow to display the Links for: dialog box.

7 Select the worksheet link and click OK.
8 Click the **Wks File Name** arrow to display the **Select Import File** dialog box.

![Select Import File dialog box]

9 In the **Select Import File** dialog box, type or select the worksheet file to import into this unit and click **Open**.

10 To specify a specific worksheet, select one of the following options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify a worksheet within a Microsoft Excel workbook</td>
<td>Type the workbook name in brackets followed by the worksheet name, for example: <strong>[COMPBUDG.XLS]DENVER</strong></td>
</tr>
<tr>
<td>To specify a sheet within a Lotus 1-2-3 WK1 spreadsheet</td>
<td>Type the spreadsheet name in brackets followed by the sheet letter.</td>
</tr>
</tbody>
</table>

**Note:** Report Designer imports only the first sheet in a Lotus 1-2-3 WK3 spreadsheet. To select a different sheet, save the sheet as a separate WK3 file.

If you type a file without a full path, Report Designer uses the path defined for the default **IO_Data** directory in the **Company Information** dialog box. The file name appears by default in the **Link to GL + Worksheet** header description.

11 Repeat steps 3 through 10 for every reporting unit that you want to receive worksheet data. Make sure that the worksheet file names are entered in the corresponding unit of the reporting tree to prevent incorrect data in your report.
12 In the **Reporting Units** dialog box, click **OK** to accept your changes and return to the Reporting Tree window.

**Note:** Remember to specify a row format for each reporting unit.

The worksheets are referenced in Ext File (T) and Ext Link (W) columns of the reporting tree.

### Setting Up the Catalog ID

After you create the reporting tree, you can set up and generate your report.

**To set up the Catalog ID**

1. From the FRx Control Panel, open the Catalog of Reports.

2. From the Catalog of Reports window, select the **Use Row Format from Reporting Tree** check box (in the **Row Format** section). This tells Report Designer to pull the row formats (and worksheet file names) from the reporting tree.

3. Generate your report.

**Note**

If you do not specify a row format for each reporting unit in the tree, then Report Designer uses the identified row format (that appears dimmed in the **Row Format** box) for those units by default.
In the column layout, you define the contents of your report columns, any calculations specific to your columns, and column headings within your report. The information in a column layout is combined with the information in a row format (and optionally, with reporting tree information) that you specify and store in the catalog of reports. Each column layout that you create can be combined with one or more row formats.

A column layout can contain up to 255 separate columns such as descriptive text, general ledger or worksheet amounts, and calculations.

FRx® Report Designer uses the same spreadsheet technique for column layouts as for row formats. Enter columns across the page as you want them to appear on your reports.
Opening the Column Layout Window

You can either create a new column layout and start building it from scratch, or you may prefer to open an existing column layout (such as one you previously created or those created using sample data) and modify the information in the column to create new column layouts.

Report Designer supports up to 255 columns within one column format. For example, columns A through Z are followed by columns AA through AZ, and so forth.

To start a new column layout

1. On the File menu, point to New, and then click Column to display a blank Column Layout window.

To open an existing column layout

1. From the FRx Control Panel, click the Column Layouts icon to display a list of available column layouts in the Open Column dialog box.
2 Double-click a column layout to display the Column Layout window.

<table>
<thead>
<tr>
<th>Column Header</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type (GL, Calc, etc.) DESC</td>
</tr>
<tr>
<td>Book Code/Attribute Category</td>
</tr>
<tr>
<td>Fiscal Year</td>
</tr>
<tr>
<td>Project Code</td>
</tr>
<tr>
<td>Current Fiscal Yr</td>
</tr>
<tr>
<td>Column Formula</td>
</tr>
<tr>
<td>Column Width</td>
</tr>
<tr>
<td>Extra Source Before Cell</td>
</tr>
<tr>
<td>Special Format Model</td>
</tr>
<tr>
<td>Print Options</td>
</tr>
<tr>
<td>Column Specifications</td>
</tr>
<tr>
<td>Reporting Unit</td>
</tr>
<tr>
<td>Currency Code</td>
</tr>
<tr>
<td>Currency Display</td>
</tr>
<tr>
<td>Current Base Sub-type</td>
</tr>
<tr>
<td>Account Title</td>
</tr>
<tr>
<td>Attribute Title</td>
</tr>
<tr>
<td>Data Basis</td>
</tr>
<tr>
<td>End Date</td>
</tr>
<tr>
<td>Justification</td>
</tr>
<tr>
<td>OLAP Descriptions</td>
</tr>
</tbody>
</table>

The column layout you selected displays in the window.
Column Layout Menu Functions

Within the Column Layout window, the File and Edit menus provide you with additional functions.

This section contains information and instructions on the:

- File Menu
- Edit Menu

Note

The menus described in this chapter are specific to the Column Layout window. For information about menus that appear in all Report Designer main windows, see “Defining Available Commands on Report Designer Menus” on page 19.

File Menu

The following is the column layout File menu.

![Column Layout File Menu](image)

Figure 5-1: Column Layout File Menu

The options that are specific to column layouts are defined in the following table.

<table>
<thead>
<tr>
<th>File Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Renames the column and description.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a row, column, or tree.</td>
</tr>
<tr>
<td>Print Column Layout</td>
<td>Prints the column layout.</td>
</tr>
</tbody>
</table>

Table 5-1: Menu Options for Column Layout
Edit Menu

The options that are specific to column layouts are defined in the following table.

<table>
<thead>
<tr>
<th>Edit Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Use to edit a column layout description. You can use upper- and lower-case letters, numbers, and spaces. The <strong>Name</strong> and <strong>Specification Set</strong> boxes are display-only boxes. You cannot access or change them. <strong>Note:</strong> You must save the column layout in order to save the description change.</td>
</tr>
<tr>
<td>Delete Column</td>
<td>Deletes one or more columns as described in the steps following this table.</td>
</tr>
<tr>
<td>Insert Column</td>
<td>Inserts one or more new columns as described in the steps following this table.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Opens a box-specific dialog box of valid values. To display a zoom list, click the cell arrow or to use the keyboard, move the pointer to the cell and press <strong>F3</strong>.</td>
</tr>
</tbody>
</table>

Table 5-2: Edit Menu Options for Column Layout

Delete Column

To delete one or more columns, do the following:

1. Click the gray box at the top of the column you want to delete.
2. Select **Delete Column**.

To delete one or more consecutive columns, highlight the columns and select the **Delete Column** command.

A window asks you to confirm the deletion.
**Insert Column**

To insert one or more new columns, do the following:

1. Click the gray box at the top of the column after which you want to insert a new column.

2. Select **Insert Column**.
   
   To insert more than one column, highlight the number of columns to be inserted and select the **Insert Column** command.

   Report Designer adds the columns.
Adding Column Headers

Use the **Column Headers** portion of the Column Layout window to enter headers for that column. Enter each column header exactly as you want it to appear at the top of your column on the printed report. By default, Report Designer centers and underlines the description over the column.

The default width of a **Description** column is 30 characters, while the default width of an **Amount** column—including cents, commas, and parentheses—is 14 characters. To accommodate long headers, Report Designer allows up to 20 rows of column headers.

The column headers are different and separate from the report headers that you define in the Catalog of Reports window. The column headers apply to each column of data in your report. The report headers apply to the entire report.

This section contains information and instructions on:
- Creating Typical Headers
- Creating Dynamic (Conditional) Headers

Creating Typical Headers

Double-click a cell in the **Column Headers** row to display the **Header Options** dialog box (shown in Figure 5-3) and then define your column headers.

![Header Options Dialog Box](image)

Figure 5-3: Headers Options Dialog Box

When you use the **Header Options** dialog box, you see the following selections.

- **Cell text**
  Type text in this box or click **Insert Code** to select special codes.

- **Insert Code**
  Use one of the following codes listed in Table 5-3 to specify variable information (such as date or period number) in any header. You can combine more than one variable code in the same cell. Since codes rely on the calendar information from the **Column Detail** section, codes only work with **GL**, **WKS**, or **CALC** columns. When
you use these code for **CALC** columns, you must complete the **Base Year** or **Period** fields.

<table>
<thead>
<tr>
<th>Header Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>@Month</strong></td>
<td>This code prints the name of the current month in the heading. The name appears in upper- and lower-case unless you enter the code, in upper-case, as <strong>@MONTH</strong> , in which case the month appears in all caps. The name of the month abbreviates to the first three characters in your report if you chose to round the amounts to thousands, millions, or billions or if you set the column width to less than nine characters. Otherwise, the month displays by default in the full name format.</td>
</tr>
<tr>
<td><strong>@PER</strong></td>
<td>This code prints the numeric form of the fiscal period identified for that column. If the column spans multiple periods, the last period in the range prints.</td>
</tr>
<tr>
<td><strong>@PERDESC</strong></td>
<td>This code prints the fiscal period description identified in the general ledger.</td>
</tr>
<tr>
<td><strong>@YR</strong></td>
<td>This code prints the column’s fiscal year in numeric form.</td>
</tr>
<tr>
<td><strong>@EDATE</strong></td>
<td>This code prints the column ending date in the <strong>Short Date</strong> format, as specified in the <strong>Amount &amp; Date Format</strong> box of the <strong>Company Information</strong> dialog box. For more information about setting the short date format, see “Entering and Editing Company Information” in your <strong>FRx® Report Designer 6.7 Administrator’s Guide</strong>.</td>
</tr>
<tr>
<td><strong>@SDATE</strong></td>
<td>This code prints the column start date in the <strong>Short Date</strong> format specified, as in the <strong>Amount &amp; Date Format</strong> box of the <strong>Company Information</strong> dialog box. For more information about setting the short date format, see “Entering and Editing Company Information” in your <strong>FRx® Report Designer 6.7 Administrator’s Guide</strong>.</td>
</tr>
<tr>
<td><strong>@MON</strong></td>
<td>This code prints the abbreviated month for the selected fiscal period. The abbreviation can appear in either upper- or lower-case; edit the code to reflect the desired case. For example, if you generate a report for the fiscal period ending in February and you use <strong>@MON</strong> as the column header, the header displays as FEB; if you use <strong>@Mon</strong> the header displays as Feb.</td>
</tr>
</tbody>
</table>

Table 5-3: Column Header Codes
Chapter 5: Creating Column Layouts—Adding Column Headers

- **Font styles**
  Use this box to apply a different font style to your column header. For more information about formatting font styles, see “Font Styles” on page 260 of Chapter 7.

- **Format options**
  Use this option for underlining text or adding a box around the header text.

- **Spread from/To**
  Use these boxes to define the columns over which you want to center the text. Enter the beginning column letter in the **Spread From** box and the ending column letter in the **To** box. Report Designer centers the text over this range of columns.

- **Justification**
  Use these options to align your headers in the column or spread.

**To create column headers**

1. Double-click the cell over the column that you want to describe to display the **Header Options** dialog box.

2. In the **Cell text** box, do one of the following
   - Type the appropriate text.
   - Click **Insert Code** and select the appropriate the code. See Table 5-3 on page 144 for detailed code descriptions.

3. Click the **Font Styles** arrow, and then double-click the font style to use for the column header.

4. To apply font styles across columns (for example, columns B to G), do the following:
   - Select the header rows for the columns.
   - Then, on the Column Layout window toolbar, click the **Font Styles** drop-down box on the toolbar.
   - Select the style.

5. In the **Spread from** box, type the beginning column letter; and in the **To** box, type the ending column letter.
   Report Designer centers the text over this range of columns.

**To use multiple header codes**

1. Click **Insert Code**.
2. Select a code from the list.
3. Click **OK**.
4. Click **Insert Code** again and select another code from the list.
You also can mix codes with text. For example, if you enter

**Period @PER-@YR from @SDATE to @EDATE**, it results in a printed heading that looks like this:

**Period 1-02 from 01/01/02 to 01/31/02**

### Creating Dynamic (Conditional) Headers

You can create a report in which the column header changes dynamically. For example, if you use the conditional options (*P>B*, *P<B*, and so forth), you can design header options to reflect these changes by using the base period column as a starting or ending point for a header. For example, enter **A TO BASE** to center column **A**'s header over the column that corresponds to the base period at report generation time. The following are examples using **Y**, where **Y** is the last column in your column layout.

- BASE TO Y
- BASE+1 to Y

The column layout in Figure 5-4 uses a base period column to illustrate dynamic headings.

![Figure 5-4: Dynamic Headings in Column Layout Window](image)

For a description of conditional columns, see “Print Control for Conditional Columns” on page 162.

The following figure shows these dynamic headings as they appear in the resulting report.

![Figure 5-5: Dynamic Headings in FRx Report](image)
Adding Column Detail

The remaining rows in the Column Layout window are called **Column Detail** rows. These rows define detail column information such as:

- Column type (for example, general ledger, spreadsheet, or calculations)
- Book Code (for example, actual or budget)
- Fiscal year and period
- Period or year-to-date balances
- Calculation Formulas
- Currency Display
- Special Formatting and Print Control
- Transaction Start and End Dates

Figure 5-6 displays and describes the **Column Detail** rows.

Figure 5-6: Column Detail Rows

![Diagram of Column Detail Rows]

**Note**

If you prefer to use keyboard commands instead of the mouse, you can press **Alt+Page Down** to move from the column header rows to the column detail rows. Use **Alt+Page Up** to move from the column detail rows to the column header rows.

This section contains information and instructions on:

- Specifying Column Types
- Defining General Ledger Columns
- Adding Calculation Formulas
- Adding Special Formatting Options
Specifying Column Types

The first Column Detail row is for specifying the column type. Double-click the cell in the Column Detail row to display the **Select the Type of Column** dialog box shown in Figure 5-7, and then select a column type.

![Figure 5-7: Column Type Dialog Box](image)

The following list describes each column type.

- **GL**
  Select the **GL** code to display data from the general ledger. A GL column can also display external worksheet data when you use a **Link to GL + Worksheet** or **Link to Worksheet** column in the row format.

  When you select **GL**, this places four default settings in the next four cells.

![Figure 5-8: Column Detail for TYPE: GL](image)

  You can change these default settings as needed.
CALC
Select this code to display the result of a simple or complex calculation. See “Adding Calculation Formulas” on page 155.

DESC
Select this code to place the row description you entered in the row format. Although this column is frequently the first one on the report, it can be placed anywhere.

ROW
Select this code to display the individual row codes from the Row Code column in the row format.

ACCT
Select this code to display the general ledger account codes that apply to each row. For account and transaction detail reports, the full account code prints. For financial reports (and high-level reports that may be a combination of several accounts), the GL link from the row format (for example, 1100 TO 1200) prints.

FILL
Select this code to fill the cell with a character that is enclosed in single quotes. If you don’t enter a character, Report Designer leaves the column blank. For example, to fill a column with periods (...), enter FILL ".".

WKS
Select this code to display data pulled from an external worksheet (for example, Lotus 1-2-3 or Microsoft® Excel).

A_ATTR
Select this code to display the Account Attribute in the column. The account attribute must apply to a single full account, and extracts underlying account information from the general ledger, such as account ID, State, or Zipcode. The Account Attribute function must be supported by your accounting system. For information about using the Account Attribute in the row format, see “Using Account Attributes and Transaction Attributes in Rows” on page 108.

When you select A_ATTR as the column type, specify the Attribute Category in the Book Code/Attribute Category detail row of the column layout.

T_ATTR
Select this code to display the Transaction Attribute in the column. Transaction attributes could include information such as the transaction Batch ID number. The Transaction Attribute function extracts attribute data from the general ledger, and must be supported by your accounting system. For information about using the Transaction Attribute in the row format, see “Using Account Attributes and Transaction Attributes in Rows” on page 108.

When you select T_ATTR as the column type, specify the Attribute Category in the Book Code/Attribute Category detail row of the column layout.

XBRL_TAG
Select this code to display the XBRL element tag found in the row format for a report that you output as an .frd file (DrillDown Viewer Enhanced XML). The XBRL_TAG is not passed from the column layout to the XBRL instance document.
Chapter 5: Creating Column Layouts—Adding Column Detail

- **Transaction Detail Codes**
  Use the transaction detail codes for presenting appropriate detail in a transaction detail report. By specifying a value in the column **TYPE** cell, you can create a column layout for a transaction detail report that contains a separate column for each type of transaction information. These codes are always used in conjunction with **GL** columns. You can include both a current and year-to-date GL column to create transaction detail reports. Figure 5-9 shows examples of Transaction Detail Codes.

![Figure 5-9: Transaction Detail in Column Layout Window](image)

The codes that display in the **TYPE** selection window do not necessarily apply to all accounting systems. Your *FRx® Report Designer Getting Started Guide* contains information about types specific to your accounting system. If you select a type that is not valid with your accounting system, the column appears blank in the report. For more information about creating transaction detail reports, see “Customizing Transaction Detail Reports” on page 173.

**To specify a Column Type**

1. On the Column Layout window, double-click the **Type** Column Detail cell for the column to display the **Select the Type of Column** dialog box.
2. Select a column type.
3. Click **OK** to return to the Column Layout window.

**Defining General Ledger Columns**

The next four categories under **Column Detail** define general ledger columns (defined as **GL** in the **TYPE** cell) as shown in Figure 5-10.
These column detail rows include:

- Book Code/Attribute Category
- Fiscal Year
- Period Code
- Current Per/YTD

**Book Code/Attribute Category**

The Book Code/Attribute Category column detail gives you a choice of actual, budget, and non-financial (statistical) options as shown in Figure 5-11. A column layout can contain multiple actual, budget, and statistical columns for displaying different periods (current or year-to-date) and amounts.

The list that appears reflects the actual, budget, and statistical (non-financial) options that have been established in your general ledger. For more information about actual and budget amounts available from your general ledger, see the *FRx® Report Designer Getting Started Guide*.

**To specify a Book Code/Attribute Category**

1. On the Column Layout window, double-click the **Book Code/Attribute Category** cell for the column to display the **Select a Book Code** dialog box.
2. Select a book code.
3. Click **OK** to return to the Column Layout window.

**Fiscal Year**

Use the Fiscal Year column detail to specify a fiscal year. Type **BASE** to use the base year specified at report generation time. To use other years, specify the number of years relative to the base year (using + or -). Report Designer supports up to 10 years of historical data. For example, to specify:

- the prior year, type **BASE-1** or **-1**
● the seventh prior year, type **BASE-7**

● the year after the base year, type **BASE+1**

You can also double-click the Fiscal Year cell and select from a list of options as shown in Figure 5-12, but you may need to edit the resulting entry.

![Figure 5-12: Fiscal Year Options](image)

Thus, if you select **BASE-#**, you must change the # to the appropriate number of years before the base year. Although not recommended, you can hard code a fiscal year by entering the four-digit year.

**Period Code**

Use a base period code to indicate the fiscal periods to include in this column. Review the following types of period options you can use for column detail.

- **Actual Period #**
  Type the period number. This is an easy method, but should be used sparingly (for example, when you want to present a 12-period report with a column for each period).

- **Relative Period #**
  For regular reporting you should always use a relative period (see the next two options) so you don’t have to change the column layout every period.

  Type the period number relative to the base period (specified when generating the report) using the + and - signs. For the period just prior to the base period, type **BASE-1** or **-1**; for two periods before use **BASE-2**, and so on. To specify the base period, use **BASE**.

- **Range of Periods**
  Type a range of periods using **TO** (the standard Report Designer range indicator). You can use this with either absolute period numbers (for example, periods 3 TO 6) or with the relative periods (for example, -3 TO -1). This last example specifies a range of periods from 3 periods before the base period to 1 period before the base period. To actually include the base period in such a range, use **B** or **BASE** to represent the base,
(for example -3 TO BASE). You can also specify a range which spans the base period (for example -3 TO +2).

You can also double-click the Period Code cell and select from a list of period options as show in Figure 5-13, but you may need to edit the resulting entry.

![Select the Period(s) for This Column](image)

**Figure 5-13: Period Options**

For example, if you select BASE-#, you must change # to the appropriate number of periods before the base period.

- **Transaction Detail Reports**
  
  Type the period range in this period cell to include year-to-date transaction details in a column (or any range other than the current period). See “Customizing Transaction Detail Reports” on page 173.

---

**Note**

Although you can go beyond fiscal year boundaries in any of the period specifications, Report Designer does *not* allow you to mix years within a range of periods. For example, if you specify periods -5 TO BASE (representing the past 6 periods) and run the report with a base period of 2, the report will not work properly. If you run it with a base period of 6, it will work properly.

You can access different years by using separate ranges in separate columns in the same report. For example, if the base period is 3, you can use the ranges (-2 TO BASE) and (-5 TO -3) because a year boundary isn’t crossed within a range. If you regularly cross year boundaries, avoid using ranges. Instead, use a column for each relative period and print the total. Suppress printing of the other columns in the Print Control cell.

---

**Current Per/YTD**

Use the Current Per/YTD column detail to display period or year-to-date amounts.
To Specify a Current Period/YTD Amount

1. On the Column Layout window, double-click the Current Per/YTD cell for the column to display the Select the Amount to Use dialog box.

   ![Select the Amount to Use dialog box]

2. Select one of the following options:
   - **CUR** to cause the column to reflect current period activity.
     This type of column does not include beginning balances.
   - **YTD** to cause the column to reflect year-to-date amounts.
     This type of column includes beginning balances.
   - **CUR/BB** to reflect the beginning balance for the specified period.
   - **YTD/BB** to reflect the beginning balance for the specified year.

3. Click **OK** to return to the Column Layout window.

   The Column Layout window displays sample current and year-to-date periods.

   - The **CUR** code causes this column to reflect current period activity.
   - The **YTD/BB** code causes this column to reflect the beginning balance for the base year.
   - The **YTD** code causes this column to reflect year-to-date amounts.

---

**Caution:** If you run a report to the Transaction level with two YTD columns, you will get an Out of Balance message. Running two YTD columns is not supported in Report Designer.
Adding Calculation Formulas

When the amounts in a column are the result of a calculation, you must enter **CALC** in the **TYPE** cell and type the formula in the **Calc Formula** cell on the Column Layout window. You can add, subtract, multiply, or divide columns. You can also perform any type of complex calculation including IF/THEN/ELSE statements within the formula.

Add, Subtract

To add or subtract amounts in the columns, specify the column letter and the plus (+) and/or minus (-) sign. For example: **A+B** or **A-B+C**.

You can also use the **TO** separator to add a range of consecutive columns; for example: **A TO D**.

The following Column Layout window displays a Calculation column and formula.

![Figure 5-14: Calculating Amounts in Column Layout Window](image)

Column calculations can refer to any other column, including subsequent columns. Report Designer resolves the dependent columns first. If a column refers to another column that in turn refers back to the current column, a circular reference error results.

Multiply, Divide

To multiply and divide columns, type the column letters in the order in which they should be computed, separating each with the appropriate operator (* for multiplication, / for division). For example, if you type **B*D**, you are instructing Report Designer to multiply column B by column D.

You can also refer to a specific report cell by typing a column letter and a row code. For example, if you type **B100**, this refers to column B, row code 100.
You may want to divide an entire column by a specific report cell amount from the same column. For example, if you type B/B100, you are instructing Report Designer to divide the entire column B by the value in column B, row code 100.

**Note**

This calculation will be incorrect if you change the report’s calculation priority to **Calculate Columns First** on the **Report Options Advanced** tab in the Catalog of Reports.

Use a special format mask to format the number as a percentage. For more information, see “Special Format Mask” on page 157.

**Complex Calculations**

A complex calculation can contain any combination of cell references, operators, and values. For example, to compute an average of columns A and B, you type: \((A+B)/2\)

There is no limit to the number of nested parentheses you can use as shown in the example \((A+((B+C/2)+(C*.8)/2))+(F TO H)\).

**Multiply or Divide by Base Row**

You can create a column that displays all the values in a specified column as a percentage of base number. This feature provides a method to show relationships between rows, such as a percent of sales or percent of total expenses row.

To multiply or divide each row in a specific column by a base row, type the column to be used in the calculation and *BASE or /BASE (for example, type C*BASE or C/BASE).

When you use a base row calculation, make sure that each row format used with this column layout contains at least one row with a CBR (Change Base Row) format code. The CBR code identifies the row used in the calculation.

**To multiply or divide by base row**

1. Open the related Row Format window.
2. In the **Fmt Code** cell of a row above the rows that are to use the calculation, enter CBR.
3. In the **Related Rates/Rows/Unit** cell, enter the row code for the base row to be used as the denominator.
4. Return to the Column Layout window and create a **CALC** column.
5. In the **Calc Formula** box, type the letter of the column to use in the calculation followed by the operator and the word BASE (for example, type B/BASE).

When you do this, every number in column B is divided by the number in the specified base row, and the resulting percentage is placed in the calculation column.

**Note:** Use a special format mask to format the number as a percentage. For more information, see “Special Format Mask” on page 157.
IF/THEN/ELSE Statements

IF/THEN/ELSE statements allow any calculation to be conditional upon the results of any other column. You can refer to other columns, but not to a report cell in the IF statement; thus, any calculation must be applied to the entire column.

Type the calculation in the Calc Formula section of the column that receives the results of the calculation.

Note: You cannot place the results of a calculation in any other column; they must be in the column that contains the formula.

For example, the formula “IF B>100 THEN B ELSE C*1.25” translates to: If the amount in column B is greater than 100, place the value from column B in the CALC column. If the value is not greater than 100, multiply the value in column C by 1.25 and place the result in the CALC column.

IF is always followed by a logic statement which evaluates to true or false. The formula used for both the THEN and ELSE clauses can contain references to any number of columns and may be as complex as needed, including multiple nested calculations. For example:

IF (statement) THEN H+(G*((C+D+E-F)/.25))

Adding Special Formatting Options

The following column detail rows apply special formatting to selected columns. Although some of the Print Control and Column Restrictions options are specific to GL columns, most options apply to all column types.

Column Width

Use this option to specify the number of characters to use for the width of this column on the printed report. Column width is particularly important for Amount (CALC, WKS, and GL), Desc- and Fill-type columns. If the column width isn’t specified here, Report Designer uses the default widths of 30 characters for the description columns, 14 characters (including cents, commas, and parentheses) for Amount columns, and 10 characters for a Fill-type column.

Extra Spaces Before Column

You can use this option to separate groups of columns or to add a few spaces before the description (so the description column is indented from the left-justified titles in the report). The default number of spaces between each column is two, as defined in the Formatting tab in the Report Options tab in the Catalog of Reports. To change the default, enter the number of extra spaces to be placed in front of a given column.

Special Format Mask

Use a special format mask to assign decimal, currency, and percentage formatting to your column amounts.
To assign a special format mask to your column amounts

1. In the column you want to assign the mask, double-click the **Special Format Mask** cell in the **Column Detail** section to display the **Select a Format** dialog box.

2. Select a format and click **OK**.

3. Make any modifications to the special format mask in the **Edit Bar**.

   **Note:** For example, a mask of #,####, will round to thousands.

When you generate your report, this format is used for this column. If no format is entered, the default format identified in the **Amount & Date Format** of the **Company Information** dialog box is used.

If you defined special formats in a row calculation and in the column, the row formatting overrides the column formatting. For more information about format masking, see “Amount Formatting” in Chapter 2 of your FRx® Report Designer 6.7 Administrator’s Guide.

**Print Control Codes**

The Print Control codes allow you the option of adjusting the display or printing characteristics of the column. To select a print option, use the following dialog box.

---

### Print Control Codes

- **NP:** Don’t Print this column (but use in calculations)
- **BS:** Coll Table Bottom Row in Balanced Sheet Report
- **CO:** Change Sign in Coll if Normal Balance of Row = CR
- **SR:** Suppress Rounding
- **P:B:** Period is LESS than Base Period
- **P>B:** Period is GREATER than Base Per
- **P=E:** Period is EQUAL to Base Per
- **P<e:** Period is LESS or EQUAL to Base Per
- **P=:** Period is GREATER or EQUAL to Base Per

---

Figure 5-15: Special Print Control Options
The following table describes each regular print control code:

<table>
<thead>
<tr>
<th>Print Control Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NP</td>
<td>Select this code if the amounts in this column are part of a calculation only and should not be printed in the report. When you use a non-printing column in a calculation, you need to directly refer to that column in the formula if you want to include it. For example, in the following calculation, the non-printing column C is included: ( B+C+D ) However, the non-printing column C is not included in the following calculation: B TO D</td>
</tr>
<tr>
<td>BS</td>
<td>Select this code to indicate a column as a <strong>Balance Sheet</strong> column to be printed on a combined Balance Sheet/Income Statement Report. Since the same column layout is used for both the balance sheet and the income statement, this code is required to identify the columns that apply to the balance sheet.</td>
</tr>
<tr>
<td>XCR</td>
<td>Select this code to create a budget or comparative report where an unfavorable variance is always negative (such as a revenue shortfall or expense overrun), apply the XCR code to a CALC column. Select this code to reverse the sign of a CALC column amount if the normal balance of a given row is a credit (identified by a “C” in the Norm Bal column of the row format). <strong>Note:</strong> Make sure that you code the appropriate rows (in the row format) in the Norm Bal column with a “C” for TOT and CAL rows that normally carry a credit balance.</td>
</tr>
<tr>
<td>X0</td>
<td>Select this code to suppress a GL column if all amounts are blanks/zeros.</td>
</tr>
<tr>
<td>SR</td>
<td>Select this code to suppress a column from being rounded.</td>
</tr>
<tr>
<td>P&lt;B</td>
<td>Select this code to display this column only if the period is less than the base period.</td>
</tr>
<tr>
<td>P&gt;B</td>
<td>Select this code to display this column only if the period is greater than the base period.</td>
</tr>
<tr>
<td>P=B</td>
<td>Select this code to display this column only if the period is equal to the base period.</td>
</tr>
<tr>
<td>P&lt;=B</td>
<td>Select this code to display this column only if the period is less than or equal to the base period.</td>
</tr>
</tbody>
</table>

*Table 5-4: Print Control Codes*
<table>
<thead>
<tr>
<th>Print Control Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P&gt;=B</td>
<td>Select this code to display this column only if the period is greater than or equal to the base period.</td>
</tr>
</tbody>
</table>

Table 5-4: Print Control Codes (Continued)
Refer to the following figures for examples of a column layout that uses the \textbf{XCR} code, a corresponding row format with credit signs reversed, and the resulting report.

\begin{table}[h]
\centering
\begin{tabular}{|c|c|c|c|c|c|}
\hline
\textbf{Column Headers} & A & B & C & D & E \\
\hline
\textbf{Column Detail} & \text{Column ID} & \text{Description} & \text{Calc Code} & \text{Calc} & \text{Calc} \\
\hline
\text{Calc Code} & \text{ACT} & \text{CALC} & \text{CALC} & \text{CALC} & \\
\hline
\text{ACTUAL} & \text{Budget} & \% Variance & \% Variance & & \\
\hline
\text{CALC} & \text{FORM} & \text{CALC} & \text{CALC} & & \\
\hline
\end{tabular}
\end{table}

The \textbf{XCR} print control reverses the sign of the calculation. See the corresponding report.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{figure5-16.png}
\caption{Reversing Credit Value in Column Layout Window}
\end{figure}

Notice the \textbf{C} codes in the Norm Bal column. This instructs Report Designer to reverse the amount signs in XCR columns.

\begin{table}[h]
\centering
\begin{tabular}{|c|c|c|c|c|c|}
\hline
\textbf{A - Row Code} & \textbf{B - Description} & \textbf{C - Field Code} & \textbf{D - Related} & \textbf{E - Field} & \textbf{F - Field} & \textbf{G - Column} & \textbf{H - Link to General Ledger} \\
\hline
110 & \textbf{Net Revenue} & DES & C & (410) & 4250 & & \\
\hline
130 & \text{COGS} & -- & 4501 & & & & \\
\hline
140 & \text{Gross Profit} & TOT & 100-190 & C & & & \\
\hline
250 & \text{Operating Expenses} & DES & & & & & \\
\hline
\end{tabular}
\end{table}

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{figure5-17.png}
\caption{Row Format with Credits Reversed in Normal Balance}
\end{figure}
When exporting reports to an Excel via OLE format, do not select the Export Formulas option. If you accidently select this option, Microsoft Excel will ignore reversed credit values and your reports may be unfavorable.

To add Print Control codes

1. Double-click the Print Control cell in the column to display the Select Special Print Control Options dialog box.

2. Select one or more codes for special printing characteristics.

Print Control for Conditional Columns

When you use the conditional column options, any column can be displayed or omitted based on whether the column’s fiscal period falls before or after the base period on the report.

For example, this feature allows you to create a report that displays 12 different periods in which actual amounts print for the base period and all prior periods. Budget amounts (or forecast amounts from an external spreadsheet) display for all future periods.

Such a report dynamically derives the correct data for the actual or budget (or forecast) amounts based on the base period for which the report is run.

Use the following dialog box to select a print option for Conditional columns.

---

**Note**

To create a report that displays 12 different periods, use the Conditional Column feature. This allows you to dynamically derive the correct data for actual or budget amounts based on the base period for which the report is run. For example, you can create a report that shows actual amounts for the base period and all prior periods, while budget amounts display for future periods. This feature is particularly useful for financial reporting where data can dynamically change based on the base period selected.
The following column layout is an example of a column layout with print selections for conditional columns.

![Column Layout Window Diagram](image)

These columns print only when the base period is 2 or less. These columns print only when the base period is greater than 2.

**Figure 5-20: Conditional Columns in Column Layout Window**

Figure 5-20, when the base period is 3, then actual amounts print for periods 1 to 3, and budget amounts (or forecast amounts from an external spreadsheet) print for periods 4 to 12.

**To set up a conditional report**

1. Create a column layout with two columns for each period. The first column contains actual amounts, and the second contains budget amounts.

2. For the actual column, in the **Print Control** row, enter the conditional operator \( P<=B \).

3. For the budget column, in the **Print Control** row, enter the conditional operator \( P>B \).

**Note:** When a column is suppressed by a conditional option, it is not included in any calculations.

4. Click **OK** to return to the Column Layout window.

You can also add a total column that totals all of the periods in the year. However, if you specify a range of columns in the total, Report Designer includes only columns that are actually displayed.
Adding Column Restrictions

Use the following selections to restrict certain types of data to display within a column.

![Figure 5-21: Column Restriction Selections](image)

The following table describes each column restriction selection.

<table>
<thead>
<tr>
<th>Column Restriction Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SU</td>
<td>If an underscore or double underscore (--- or ===) command is entered in the row format, selecting <strong>SU</strong> in a column suppresses the underscore for that column only. For example, you might not want to underline amounts that are the result of a percentage calculation.</td>
</tr>
<tr>
<td>ST</td>
<td>Suppresses totals and shows only details in this column (for example, in statistical columns).</td>
</tr>
<tr>
<td>SD</td>
<td>Suppresses details and shows only <strong>TOT</strong> rows (from the row format) in this column.</td>
</tr>
<tr>
<td>DR</td>
<td>Restricts the amounts in the column to debit amounts.</td>
</tr>
<tr>
<td>CR</td>
<td>Restricts the amounts in the column to credit amounts.</td>
</tr>
<tr>
<td>ADJ</td>
<td>Restricts the amounts in the column to period adjustment amounts (if available).</td>
</tr>
<tr>
<td>XAD</td>
<td>Restricts the amounts in the column to exclude the period adjustment amounts (if available).</td>
</tr>
<tr>
<td>PT</td>
<td>Restricts the amounts in the column to include <em>posted</em> transactions only.</td>
</tr>
<tr>
<td>UPT</td>
<td>Restricts the amounts in the column to include <em>unposted</em> transactions only (if available).</td>
</tr>
</tbody>
</table>

Table 5-5: Column Restriction Codes
To add Column Restrictions

1. Double-click the **Column Restrictions** cell.
2. Select a code for special printing characteristics.
   You can use multiple codes within a single column if necessary.

   **Note:** A **Column Restriction** code overrides any conflicting setting assigned in the **Row Format**.

3. Click **OK** to return to the Column Layout window.

**Selecting a Reporting Unit**

If the column type is **GL**, select a tree and reporting unit code in this cell to restrict a column to a specific reporting unit. Make your selections using the **Select Tree for Lookup** dialog box shown in Figure 5-22.

![Select Tree for Lookup Dialog Box](image)

Figure 5-22: Select Tree for Lookup Dialog Box

This feature is useful when information is applicable only to a certain unit or when you want to display reporting units side-by-side, such as in departmental side-by-side comparison reporting.

**To select a Reporting Unit from a list**

1. Double-click the **Reporting Unit** cell to display a list of trees.
2. Select a tree to use in conjunction with this column layout.
3. When the list of reporting units appears, select a unit from the list.
4 Return to the Column Layout window.

Your column layout displays the use of reporting units and restrictions.

**Note:** If you enter a reporting unit in the column layout, be sure to use the same tree when this column layout is used in a report. If you do not, the units from the tree may not match and the columns will be blank on the report.
Formatting Multicurrency Reports

When creating multiple currency reports, you can use three functions in your column layout:

- Currency Code
- Currency Display
- Currency Rate Subtype ID

The **Currency Code** allows you to restrict a column to a specific currency. The **Currency Display** allows you to specify whether the originating currency amount or a converted “functional” amount displays in the report. Using the **NAT Currency Display** in combination with the **Currency Code** prints the natural (originating) currency amount. The **FUNCT Currency Display** prints the amount converted to the functional currency (or home currency) for that company.

### Note

When DAX Currency Translation is active, both the **Currency Code** and the **Currency Display** selection lists display the three-letter **ISO** Currency codes.

If your accounting system supports more than one exchange rate per currency, the **Currency Rate Subtype ID** code allows Report Designer to read the appropriate information from the general ledger. This code can be used in conjunction with a currency display code in GL columns or in columns with transaction code TCURX.

**Currency Code**

**To restrict the column to transactions originating in a specific currency**

1. Double-click the **Currency Code** cell to open the **Currency Key** dialog box.

   ![Currency Key Dialog Box]

2. Select a currency from the list as defined in your general ledger.
3. Click **OK** to return to the Column Layout window.
Currency Display

To show the selected currency in its original form or a converted amount

1. Double-click the Currency Display cell to display the Currency Type to Display dialog box.

2. As needed, select a currency to display the conversion:
   - **NAT** to display the amount in originating (natural) currency
   - **FUNCT** to display the amount converted to functional (base) currency for this company
   - **Other** to display other reporting currencies (if available)

3. Click OK to return to the Column Layout window.

Example of Combining Currency Code with Currency Display

For example, if you use the BP Currency Code with the NAT Currency Display, the amounts in the local or natural currency amount display in your report. If you use the BP Currency Code with the FUNCT (or default) Currency Display, the amounts converted to the home or primary reporting currency (for example, US $) will display.

When you combine the following Currency Display with the Currency Code, you receive the following report results (assumes USD is the functional currency).

<table>
<thead>
<tr>
<th>Currency Display</th>
<th>Currency Code</th>
<th>Report Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAT</td>
<td>YEN</td>
<td>Y6,000</td>
</tr>
<tr>
<td>FUNCT</td>
<td>YEN</td>
<td>$60*</td>
</tr>
<tr>
<td>FUNCT</td>
<td>Blank</td>
<td>$2,310**</td>
</tr>
<tr>
<td>NAT</td>
<td>USD</td>
<td>$2,250</td>
</tr>
</tbody>
</table>

Table 5-6: Currency Display and Currency Code Combination with US$ as the Functional Currency

* Current conversion rate at approximately 100 yen per dollar.
**FUNCT** Currency Display with Blank Currency Code displays the sum of transactions originated in USD and YEN, shown in US $.

**Currency Rate Subtype ID**

If your accounting system supports more than one exchange rate per currency, the Currency Rate Subtype ID code allows Report Designer to read the appropriate information from the general ledger. This code can be used in conjunction with a currency display code in GL columns or in columns with transaction code TCURX.

To use a currency rate subtype ID in a GL or TCURX column layout

1. Double-click the Currency Display cell in a GL or TCURX column to display the Currency Type to Display dialog box.
2. Select a currency code from the list and click OK.
3. In the Currency Rate Subtype ID cell, type the ID.
4. Click Save.

**Account Filters**

For columns whose TYPE is GL, the Account Filter cell can restrict a column to specific general ledger accounts. The account filter may contain one or more accounts that are the exact length of the full account code of the current company. The filter is applied regardless of whether a tree is used.

You can use wildcard characters (?) in any (or all) positions. When you specify multiple accounts, place a comma between accounts:

```
????-1200-???, ?????-1100-???
```

**Note**

To enter an account filter, double-click to open the GL Account Links dialog box. Then either enter an account number or double-click to open the Select General Ledger Account dialog box. Always enter the same number of characters as in the full account mask or the column will be blank when the report runs.
Using Account Filters with Reporting Units

The **Account Filter** cell can work either in place of or in conjunction with the **Reporting Unit** cell, which restricts a column to a specific reporting unit. For example, the **Reporting Unit** cell can restrict the column to a certain department, Retail; whereas the **Account Filter** cell can further restrict the column to specific accounts (4???-????-001 Sales for Retail) within a department.

<table>
<thead>
<tr>
<th>Column Headers</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column Detail</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type (GL, Cols)</td>
<td>GL</td>
<td>GL</td>
<td>CALC</td>
<td>DESC</td>
<td>GL</td>
<td>GL</td>
<td>CALC</td>
<td></td>
</tr>
<tr>
<td>Split Code/Attrib. Category</td>
<td>ACTUAL</td>
<td>ACTUAL</td>
<td>ACTUAL</td>
<td>ACTUAL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fiscal Year</td>
<td>BASE</td>
<td>BASE</td>
<td>BASE</td>
<td>BASE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Period/Code</td>
<td>BASE</td>
<td>BASE</td>
<td>BASE</td>
<td>BASE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column Filters</td>
<td>YTD</td>
<td>YTD</td>
<td>YTD</td>
<td>YTD</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cell Formula</td>
<td>A+B</td>
<td>A+B</td>
<td>A+B</td>
<td>A+B</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 5-23: Account Filters in Column Layout Window

**Attribute Filters**

The **Attribute Filter** cell works in conjunction with the **A_ATTR** or **T_ATTR** column types and **Attribute Categories**. Attributes work like virtual account segments, and must be supported by your accounting system. For information about using account attributes and transaction attributes in the row format, see “Using Account Attributes and Transaction Attributes in Rows” on page 108.

The **Attribute Filter** cell restricts data in the **GL** columns to specific values or ranges that apply to **Account Attribute** or **Transaction Attribute** categories. When you select **A_ATTR** or **T_ATTR** as the column type, and assign an attribute category in the **Attribute Category** row, you can use the **Attribute Filter** row in **GL** columns to restrict accounts that will be included in the report.
Chapter 5: Creating Column Layouts—Adding Column Detail

Figure 5-24 shows the **Account Attribute** with the category **Zipcode** in column F. The **Attribute Filter** in the GL type column F specifies the range of values to include in the report.

<table>
<thead>
<tr>
<th>Column Headers</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>GL Acct</td>
<td>Apply Date</td>
<td>Doc ID</td>
<td>Activity</td>
<td>Region</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Restricting Columns to Specific Dates**

The **Start Date** and **End Date** cells restrict data in GL columns to specific dates. This technique is useful for daily or weekly sales reporting, cash analysis needs, and other date-sensitive reports. You can type a date using the day of the month or a full date.

**Day of Month**

You can enter either a day number or a range of days. The day number refers to the number of days after the start of the fiscal period, not the actual calendar date. For a period beginning on May 15, day 1 = May 15, day 2 = May 16, and so on.

**To add a single day**

1. Type the day of the fiscal period in the **Start Date** cell. For example:
   12

   Using a single day includes only the transactions entered on that date in this column. For example, the day defined in the previous step includes only day 12 of the fiscal period.

**To add a range of days**

1. Type the beginning day of the fiscal period range in the **Start Date** cell. For example:
   12

2. Type the ending day of the fiscal period range in the **End Date** cell. For example:
   18

   Using a day range includes all the transactions entered during this range in this column. For example, the day range defined in the previous steps begins 12 days and ends 18 days into the fiscal period. Report Designer uses the month and year specified in the **Fiscal Year** and **Period Code** cells for the column.
Full Date

You can type a date or a date range. We recommend that you key in the date in the MM/DD/YYYY format. However, you also can type the date in the MM/DD/YY format. If you type a two-digit year value that is greater than 30, Report Designer assigns it a 1900 century date. If you type a year value that is less than or equal to 30, Report Designer assigns it a 2000 century date.

To enter a single date

Type a start date in the Start Date cell (for example, 03/04/2002)

Using a single date includes only the transactions entered on that date in this column. For example, the date defined in the previous step includes only March 4, 2002.

To enter a range of dates

1. Type a start date in the Start Date cell (for example, 12/04/2002)
2. Type an end date in the End Date cell (for example, 01/15/2004)

Using a range of dates includes all the transactions entered during this date range in this column. For example, the date range defined in the previous steps begins December 4, 2002 and ends January 15, 2004.

Note: Any date or date range specified in the full date format overrides any period and year for the Fiscal Year and Period Code for this column.

Justification

The Justification cell formats the Description column based on your selection. This option only affects the column descriptions and not the actual values.

To apply Justification formatting to a Description column

1. Double-click the Justification cell in a Description column to display the Select Justification dialog box.

2. Select one of the following options:
   - General Justification—Applies any formatting you set up in the row format for the Description column.
   - Left Justification—Left justifies your column descriptions.
   - Center Justification—Centers your column descriptions.
   - Right Justification—Right justifies your column descriptions.
3. Click OK to return to the Column Layout window.
Adding the OLAP Description to the Column Layout

If you intend to send report output to an OLAP cube using FRx® Instant!OLAP®, you need to include an **OLAP Description** in the Column Layout. The OLAP Description consists of the **Period/Year Description** and the **Book Code Description**. These description elements, along with the row format description and the reporting unit, identify a unique data cell in the OLAP cube. The **OLAP Description** row is available only for column types **GL**, **WKS**, or **CALC**.

You can type directly into the **OLAP Description** cell in the Column Layout or you can double-click in the cell and type into the **OLAP Descriptions** dialog box. The **OLAP Descriptions** dialog box is the recommended entry method.

You do not need to enter an OLAP description unless you are sending report output to an OLAP cube.

**To add the OLAP Description to column layouts**

1. From the **Column Layout** window, scroll down to the **OLAP Description** row.
2. For column types **GL**, **CALC**, or **WKS**, double-click the column cell in the **OLAP Descriptions** row to display the **OLAP Descriptions** dialog box.

![OLAP Descriptions dialog box](image)

**Note:** If you try to type an OLAP description into a column type other than **GL**, **CALC**, or **WKS**, the program displays an error message and clears the **OLAP Description** cell.

3. In the **Period/Year Description** box, type your period/year description.
4. In the **Book Code Description** box, type your book code description.
5. Click **OK** to return to the Column Layout window.

**Note:** Do not use the semicolon (;) character in the period/year description or book code description. The semicolon is reserved as a field separator character.

Customizing Transaction Detail Reports

If you plan to generate a transaction detail report, first create a customized column layout specifically for that type of report. Several of the column layouts included with Report Designer use the following displayed column types.
The available transaction detail TYPE codes vary depending on your general ledger. The following dialog box displays all the possible transaction detail options.

![Select the Type of Column Dialog Box](image)

**Figure 5-25: Select the Type of Column Dialog Box**

When you set up the column layout for your transaction detail reports, you should normally include at least one column for the general ledger current period amounts (CUR) and at least one column for the general ledger year-to-date amounts (YTD). The transaction amounts appear in the CUR column and period balances in the YTD column. You can also include any of the transaction detail codes that are specific to your accounting system. See the FRx® Report Designer Getting Started Guide for more information.

Remember, when you generate your transaction detail report you must select either the Transaction Only or Financial & Transaction option in the Detail Level box of the Catalog of Reports window.

**Note**

Transaction detail accounts with a zero balance and no period activity are suppressed in your reports unless the Display Rows With No Amounts option is selected in the Formatting tab within the Report Options tab of the Catalog of Reports.

This section contains information and instructions on:

- Creating Multiple Period Transaction Detail Reports
- Creating Year-to-Date Transaction Detail Reports
- Creating Debit/Credit Reports

**Creating Multiple Period Transaction Detail Reports**

Report Designer enters transaction detail amounts only in current columns (CUR) in the Current Per/YTD cell. If you want a report to cover more than one period, enter the period range in the Period Code cell of the CUR column. For example, to run a report covering the last three periods enter a Period Code of BASE-2 TO BASE in the CUR column.
Creating Year-to-Date Transaction Detail Reports

To run a transaction detail report for the entire year, type 1 TO BASE in the **Period Code** cell of the *CUR* column and BASE in the *YTD* column as shown in the following example.

![Figure 5-26: Year-to-Date Transaction Detail Column Layout](image)

**Creating Debit/Credit Reports**

To create reports that categorize transactions by debit and credit, you must have two *CUR* columns for the debits and credits and a *YTD* column for the period totals. Enter the debit code (DR) in the **Column Restriction** cell of one of the *CUR* columns and the credit code (CR) in the other. See the following example.

![Figure 5-27: Debit and Credit Report Column Layout](image)

**Note**

Transaction reports spanning multiple fiscal years are not supported for most GL interfaces.
As with other transaction reports, if you want to display details for multiple periods, enter a range (for example, 1 TO BASE) in the Period Code cell.

**Note**  
Using a **Column Restriction** code overrides any conflicting setting assigned in the row format.
Creating Tabular Reports

You can design a report with the amounts from one period extended across the page (into multiple print columns). Using multiple display columns can emphasize particular totals.

To create a tabular report

1. Create a column layout similar to the following example.

   ![Example of Column Layout for Creating a Tabular Report](image)

2. In the row format, you must enter the column that you want the result to be displayed in. Do this by placing the column letter in the column restriction column (column G).

Example of Column Layout for Creating a Tabular Report

In the following row format, notice the detail information (for Current Assets and Net Fixed Assets) in column B, the total format code (TOT) in column C (rows 625 and 850), and the formula for combined total assets in column D (row 910).

![Row Format Example](image)
When you generate the balance sheet report based on the column layout, the Balance Sheet displays as shown in Figure 5-28.

<table>
<thead>
<tr>
<th>Fabrikam Works, Inc.</th>
<th>Tabular Balance Sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For the Five Months Ending May 31, 2002</strong></td>
<td></td>
</tr>
</tbody>
</table>

**ASSETS**

<table>
<thead>
<tr>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash - Checking</td>
<td>$134,111.13</td>
</tr>
<tr>
<td>Cash - Money Market</td>
<td>48,751.00</td>
</tr>
<tr>
<td>Total Cash</td>
<td><strong>180,862.13</strong></td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>166,164.00</td>
</tr>
<tr>
<td>Allowance For Bad Debts</td>
<td>(2,184.00)</td>
</tr>
<tr>
<td>Intl Corp Receivable</td>
<td>271,213.00</td>
</tr>
<tr>
<td><strong>Net Accounts Receivable</strong></td>
<td><strong>435,193.00</strong></td>
</tr>
<tr>
<td>Total Inventories</td>
<td>779,826.00</td>
</tr>
<tr>
<td>Prepaid Assets</td>
<td>2,289.00</td>
</tr>
<tr>
<td><strong>Current Assets</strong></td>
<td><strong>1,398,370.13</strong></td>
</tr>
<tr>
<td>Leasehold Improvements</td>
<td>69,600.00</td>
</tr>
<tr>
<td>Office Furniture And Fixtures</td>
<td>34,500.00</td>
</tr>
<tr>
<td>Office Equipment</td>
<td>37,700.00</td>
</tr>
<tr>
<td>Less Accumulated Depreciation</td>
<td>(40,635.00)</td>
</tr>
<tr>
<td><strong>Net Fixed Assets</strong></td>
<td><strong>101,165.00</strong></td>
</tr>
<tr>
<td><strong>Total Assets</strong></td>
<td><strong>$1,499,535.13</strong></td>
</tr>
</tbody>
</table>

**LIABILITIES AND SHAREHOLDERS' EQUITY**

<table>
<thead>
<tr>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts Payable</td>
<td>$84,253.00</td>
</tr>
<tr>
<td>Accrued Liabilities</td>
<td>137,887.00</td>
</tr>
<tr>
<td><strong>Total Current Liabilities</strong></td>
<td><strong>222,140.00</strong></td>
</tr>
<tr>
<td>Leases Payable</td>
<td>15,100.00</td>
</tr>
<tr>
<td>Notes Payable</td>
<td>142,794.00</td>
</tr>
<tr>
<td><strong>Long-Term Liabilities</strong></td>
<td><strong>152,927.00</strong></td>
</tr>
<tr>
<td><strong>Total Liabilities</strong></td>
<td><strong>375,014.00</strong></td>
</tr>
<tr>
<td>Capital Stock</td>
<td>50,000.00</td>
</tr>
<tr>
<td>Additional Paid In Capital</td>
<td>500,269.00</td>
</tr>
<tr>
<td>Year-to Date Income</td>
<td>377,152.13</td>
</tr>
<tr>
<td>Retained Earnings</td>
<td>197,100.00</td>
</tr>
<tr>
<td><strong>Shareholders' Equity</strong></td>
<td><strong>1,124,521.13</strong></td>
</tr>
<tr>
<td><strong>Liabilities and Equity</strong></td>
<td><strong>$1,499,535.13</strong></td>
</tr>
</tbody>
</table>

Figure 5-28: Tabular Balance Sheet
Creating a Reporting Tree

Chapter 6

The Reporting Tree function is the key to the power and flexibility of FRx® Report Designer. Although the row format and column layout are essential components in the design and functionality of financial reports, it is the reporting tree that magnifies the power of those components.
Although you can create financial reports without the aid of the reporting tree, you will be using only a fraction of the capabilities of FRx. The reporting tree allows you to model a very sophisticated reporting structure and view your organization in many different ways with the click of a button. Some companies may have very complex corporate hierarchies that require hundreds of tree units, as well as other hierarchies that require much fewer tree units.
Understanding Reporting Trees

Most organizations have a hierarchical structure in which departments (or other business units) report to one or more higher-level units. In a traditional organization chart, the lower units (boxes) on the chart typically report up to increasingly higher units.

FRx uses the term “reporting unit” for each of the boxes in an organizational chart. A reporting unit can be an individual department from the general ledger, or it can be a higher-level (summary) unit that combines information from other reporting units. Each reporting unit represents an individual report that contains rows from a row format and columns from a column layout.

The reporting tree contains a group of reporting units. FRx allows you to easily add or change reporting units without requiring a change to the general ledger.

This section contains information and instructions on:
- Reporting Unit Structure
- Multiple Reporting Trees
- Account Masks
- Account Mask Structure and Segments

Reporting Unit Structure

Reporting units are categorized as detail units (which draw information directly from the general ledger or from an external worksheet) and summary units (which summarize data from lower level units).

An FRx reporting tree consists of parent reporting units and child reporting units.

Parent reporting units are summary units that pull summarized information from the detail units. Summary units can be both a detail unit and a summary unit; that is, they can draw information from lower units as well as draw directly from the general ledger or an external spreadsheet. Thus, a parent unit can, in turn, be a child of a higher parent unit.

Child reporting units can be detail units that pull information directly from the general ledger or a spreadsheet, or they can be intermediate summary units (parent to lower units and child to higher summary units).
Following is a flowchart showing the parent and child reporting units, and their hierarchical relationship, for the Fabrikam Works, Inc. Summary reporting tree.

![Flowchart: Fabrikam Works, Inc. Summary Reporting Tree](image)

Figure 6-1: Flowchart: Fabrikam Works, Inc. Summary Reporting Tree

Note the following reporting unit structure in the previous figure:

- In this example, the Denver Office reporting unit is parent to the Sales and Service divisions (Denver).
- The Sales division is both a child of the Denver office and a parent to the Retail and Wholesale departments.
- The lowest level detail reporting units (Retail, Wholesale, Lab and Studio) represent departments in the general ledger.
- The higher level (summary) units simply roll up (summarize) information from the department (detail) units.

**Multiple Reporting Trees**

Since you may have more than one way of looking at your company, FRx allows you to create an unlimited number of different reporting trees. Each tree is completely independent so it can contain any combination of departments and summary units.

By simply rearranging the structure among the reporting units, you can create immensely different trees. This allows you to use the same row format and column layout with each reporting tree, and print a totally different financial report layout within minutes.

For example, the following figure is basically the same reporting tree as the one shown previously, but with the reporting structure changed to develop an organizational structure by business function instead of by location. These two trees demonstrate different perspectives of company operations.
If you create several such trees, you can print a series of financial statements each month that analyze and present your company’s operations in a wide variety of useful ways.

**Account Masks**

When creating a reporting tree, the same row format can be used repeatedly, whether you are generating a departmental income statement or a consolidated summary income statement. FRx delivers this tremendous versatility by separating the responsibility segments of the account structure from the natural segment.

Because the row format defines only a portion of the account structure, it must work together with the reporting tree, where the remainder of the account is handled. This is accomplished through the use of an account mask, which uses symbols to identify for FRx what part of the chart of accounts is located in the row format versus the reporting tree.

The Account Mask determines the amount of detail information that should be drawn from the general ledger. Each reporting unit must be either a child unit that has an account mask to draw data from the general ledger or a parent unit with detail information rolling up to it from a lower unit.

**Account Mask Structure and Segments**

Typically, detail units have a general ledger account mask. Summary units often summarize data from their child units, so they usually do not need a mask. However, any unit in the reporting tree can contain an account mask and draw data directly from the general ledger.
Chapter 6: Creating a Reporting Tree—Understanding Reporting Trees

For example, the account mask for Fabrikam Works, Inc. is shown in the following figure.

![Account Mask Example](image)

The number of symbols (+, &, ?) in the reporting tree must match the number of characters or digits in the row format. For example, a row format might have seven digits in the Link to General Ledger column, representing the natural segment plus a responsibility segment. In this case, there would have to be seven hooks (&&&&&&) in the reporting tree representing the natural and responsibility information.

**Account Mask Example**

In the following figure, you can view the account mask for the Sales-Denver reporting unit in the Fabrikam Works, Inc. reporting tree.

![Account Masks in Reporting Tree Window](image)
FRx created this account mask (&&&&-1100-???) when building the reporting tree, and now displays it in the Acct Mask column for the Sales-Denver reporting unit.

The specific account mask for Sales-Denver reporting unit (&&&&-1100-???) was created by FRx from the account mask entered (&&&&-++++-???) when building the reporting tree. The plus signs (+) in the Location/Division position of the original account mask instruct FRx to create a unit in the tree for each location/division in the general ledger, including the Sales-Denver reporting unit. FRx then assigns a specific account mask to each reporting unit and replaces the plus signs (+) with the location/division codes from the general ledger.

For more information illustrating the effect that plus signs (+), hooks (&), and wildcards (?) have on specific account masks, see Table 6-8, “Original Account Masks and Specific Account Masks,” on page 201.

The first segment of the account mask for the Sales-Denver reporting unit (&&&&-1100-???) is the natural account code. The natural account code is depicted by four hooks represented by the ampersand (&) character. These hooks correspond to the four digits in the Link to General Ledger column of the row format shown in Figure 6-5.

<table>
<thead>
<tr>
<th>A Row Cod</th>
<th>B Description</th>
<th>C First Code</th>
<th>D Related Rules/Rows/Unit</th>
<th>E Num Col</th>
<th>F Print Col</th>
<th>G Column</th>
<th>H Link to General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>Revenue</td>
<td>BBA</td>
<td>310</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>Sales</td>
<td>DES</td>
<td>C</td>
<td>4102</td>
<td>4100</td>
<td>4200</td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Sales Returns</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>Sales Discounts</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>310</td>
<td>Net Sales</td>
<td>TOT</td>
<td>190:200:250</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>320</td>
<td>COGS</td>
<td>DES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>460</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>430</td>
<td>Gross Margin</td>
<td>TOT</td>
<td>310:370</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>450</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The four hooks (&&&&) in the account mask for Sales-Denver reporting unit relate to these four digits.

Figure 6-5: Row Format with GL Link

The second segment of the Sales-Denver reporting unit mask (&&&&-1100-???) is 1100. This segment represents the location and the division, where 1 = Denver (location) and 100 = Sales (division).
Finally, in the third (department) segment of the account mask (&&&&-1100-???), wildcards are listed for the Sales and Service (department) reporting units. Wildcards in this segment instruct FRx to avoid building details into the tree from the row format. The hooks (&) in the natural segment already point to general ledger links in the row format that will pull in detailed information from the account(s) listed in the **Link to General Ledger** column. If you do not restrict the row with these wildcards, the tree pulls in the same data for every unit. This results in summary units that contain duplicate and incorrect totals.

**Note**
If you used a full account code in your row format, you may also need to use a reporting unit restriction in the same row to prevent pulling duplicate data for reporting units.
Reporting Tree Window

When you open a reporting tree, it displays in the Reporting Tree window as a graphical tree on the window’s left side and as a worksheet on the right side. When you point to a reporting unit on one side of the window, it is also selected on the other side.

Use the Reporting Tree window to view the hierarchy of parent/child reporting units and the account masks for reporting units.

This section contains information and instructions on the:

- Graphical Reporting Tree
- Reporting Tree Worksheet

Graphical Reporting Tree

The graphical tree (on the left side of the Reporting Tree window) shows reporting units on “tree branches” that help you to easily visualize the parent/child unit hierarchy relationship.

You can use the Reporting Tree Format menu to control the appearance of your graphical tree with different outline styles. For example, when you select the Tree Lines, Picture, and Text outline style option, tree icons display to the left of each unit and indicate whether the reporting unit is a parent unit or a detail unit.

<table>
<thead>
<tr>
<th>Tree Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏡</td>
<td>This symbol indicates parent units that have units reporting to them.</td>
</tr>
<tr>
<td>📄</td>
<td>This symbol indicates detail units.</td>
</tr>
</tbody>
</table>

Table 6-1: Reporting Tree Icons

Other outline views include or exclude indentations and connecting lines. For more information on selecting an outline view for your graphical tree, see “Format Menu” on page 193.

You may also find it helpful to expand or collapse the graphical reporting tree for different views of the hierarchy. For information on how to expand or collapse the graphical tree, see step 4 in “To view a reporting tree” on page 188.
The following figure shows the graphical reporting tree for Fabrikam Works, Inc. This graphical tree shows the report hierarchy, and the relationship between each parent and child reporting unit.

![Graphical Reporting Tree](image)

**Figure 6-6: Graphical Reporting Tree**

In this example, the graphical reporting tree shows that the **Corporate** reporting unit is parent to the **Corp-Detail** reporting unit. The **Denver** and **San Francisco** reporting units are parents to the **Sales** and **Service** child units. All three of these parent reporting units (**Corporate**, **Denver**, and **San Francisco**) are child units to the **Fabrikam Works** parent.

**Reporting Tree Worksheet**

You can also view parent and child reporting units, and their order, in the Reporting Tree worksheet (located on the right side of the Reporting Tree window).

![Reporting Tree Worksheet](image)

**Figure 6-7: Reporting Tree Worksheet**

The worksheet displays each reporting unit in a separate row in the order of the reporting tree hierarchy. With its easy-to-read column format, you can also view the account mask (typically, for detail units), any additional text, and other information about the reporting unit. Essentially, the worksheet contains all the information that is also in the **Reporting Units** dialog box for an individual reporting unit. However, the Reporting Tree worksheet gives you the advantage of viewing all the reporting units together.

For more information on the **Reporting Units** dialog box, see “Building a Reporting Tree with the Reporting Units Dialog Box” on page 206.

**To view a reporting tree**

You can view both the reporting tree worksheet and graphical reporting tree in the **Reporting Tree** window.
1. From the FRx Control Panel, click the **Reporting Trees** icon to display the **Open Tree** dialog box.

   ![Open Tree dialog box](image)

2. Select a tree from the list and click **OK** to display it in the Reporting Tree window.

   ![Graphical and Worksheet Reporting Trees](image)

   The tree displays showing the parent and child reporting units in a graphical reporting tree on the left and in a worksheet reporting tree on the right.

3. On the graphical tree to the left, view the hierarchy relationship of the parent and child reporting units.

4. To expand and collapse a branch of the tree, do one of the following:
   - On the graphical tree, double-click a parent unit. Parent units are identified by yellow folders in the graphical tree display.
   - On the **Tree** menu, select **Expand Branch** or **Collapse Branch**.

   **Note:** Branches are collapsed or expanded for viewing purposes only. These branches (or units) will still appear in the final generated report.

5. On the worksheet tree to the right, view the reporting units and account masks.

6. On the **File** menu, click **Close** to close the reporting tree window.
Reporting Tree Menus and Toolbar Icon

FRx provides you with menus and a toolbar icon to help you get around in the Reporting Tree window and give you easy access to reporting tree commands.

The menus and toolbar icon described in this section are specific to the Reporting Tree window. For information about menus that appear in all FRx main windows, see “Defining Available Commands on Report Designer Menus” on page 19. Common toolbar buttons are explained in “The Toolbar” on page 13.

This section contains information and instructions on:
- Reporting Tree Menus
- Reporting Tree Toolbar Icon

Reporting Tree Menus

The Reporting Tree window includes the following menus with specific reporting tree functions that you will find helpful when working with reporting trees:
- File Menu
- Edit Menu
- Format Menu
- Tree Menu

Descriptions of the menu commands for each of these reporting tree menus are listed in the tables that follow.

File Menu

The File menu is shown in the following figure.

![Figure 6-8: Reporting Tree File Menu](image-url)
Menu commands for the **File** menu include common functions within the reporting tree, such as renaming, deleting, printing, and so on.

<table>
<thead>
<tr>
<th>File Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Opens the <strong>Rename Tree</strong> dialog box that allows you to rename the tree.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a row, column, tree, or catalog.</td>
</tr>
<tr>
<td>Print Reporting Tree</td>
<td>Opens the <strong>Print Tree</strong> dialog box, where you can then select either <strong>Worksheet View</strong> (to print the worksheet) or <strong>Tree Listing</strong> (to print the tree).</td>
</tr>
</tbody>
</table>

Table 6-2: Reporting Tree File Menu Commands

**Edit Menu**

The **Edit** menu is shown in the following figure.

![Edit menu commands](image)

Figure 6-9: Reporting Trees: Edit Menu

You can use the following **Edit** menu commands to perform edits within the reporting tree.

<table>
<thead>
<tr>
<th>Edit Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Removes the selection from the current location and moves it to the Microsoft® Windows® clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the current selection to the Windows clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Copies the contents of the Windows clipboard to the cursor position. If the clipboard is empty, this command is unavailable (dimmed). You can use the Paste function to paste information copied from other Windows applications, or from other FRx worksheets, into this worksheet.</td>
</tr>
<tr>
<td>Clear</td>
<td>Clears (makes blank) all selected cells.</td>
</tr>
</tbody>
</table>

Table 6-3: Reporting Tree Edit Menu Commands
<table>
<thead>
<tr>
<th><strong>Edit Menu Command</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Find (Ctrl + F)</strong></td>
<td>Opens the Find dialog box so that you can locate information contained in the worksheet.</td>
</tr>
<tr>
<td><strong>Replace (Ctrl + R)</strong></td>
<td>Opens the Replace dialog box so that you can locate and replace information contained in the worksheet.</td>
</tr>
<tr>
<td><strong>Add Reporting Units from Chart of Accts</strong></td>
<td>Opens the Add Reporting Units from Chart of Accounts dialog box. Use this to create a new reporting tree using current chart of accounts data. For more information about this command, see “Understanding Building Reporting Trees Automatically” on page 197.</td>
</tr>
<tr>
<td><strong>Description (Ctrl + D)</strong></td>
<td>Opens a dialog box where you can edit a reporting tree description. In the Description box, type the text you want to describe the reporting tree. You can use upper- and lower-case letters, numbers, and spaces.</td>
</tr>
<tr>
<td></td>
<td>The Specification Set and Name boxes are display-only boxes. You cannot access or change them.</td>
</tr>
<tr>
<td><strong>Note:</strong> You must save the reporting tree in order to save the description change.</td>
<td></td>
</tr>
<tr>
<td><strong>Delete Unit</strong></td>
<td>Deletes the reporting unit at the current cursor position.</td>
</tr>
<tr>
<td></td>
<td>Click the gray box in front of the row you want to delete, and then click Delete Unit.</td>
</tr>
<tr>
<td></td>
<td>You can then confirm the deletion in the confirmation window.</td>
</tr>
<tr>
<td><strong>Insert Unit</strong></td>
<td>Inserts a new reporting unit at the current cursor position.</td>
</tr>
<tr>
<td></td>
<td>Click the gray box in front of the reporting unit before which you want to insert a new reporting unit, and then click Insert Unit or an existing tree.</td>
</tr>
<tr>
<td><strong>Note:</strong> You cannot insert a row on the first (summary) row.</td>
<td></td>
</tr>
<tr>
<td><strong>Zoom (F3)</strong></td>
<td>In cells that support this function, pens a dialog box with a list of valid values to select from; displays dimmed if this function is unavailable.</td>
</tr>
</tbody>
</table>

*Table 6-3: Reporting Tree Edit Menu Commands (Continued)*
Format Menu

The Format menu is shown in the following figure.

![Format Menu](image)

Figure 6-10: Reporting Tree: Format Menu

You can use the following Format menu commands to adjust column widths in the reporting tree worksheet, and to control the appearance of the graphical reporting tree.

<table>
<thead>
<tr>
<th>Format Menu Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| Column Width        | Opens the Column Width dialog box. Use this box to specify the width of a column as well as to hide or unhide columns, as follows:  
  - To change the column’s width, type a new number in the Column Width box.  
  - To hide one or more columns so that they are not visible on the worksheet, select the columns and click Hide.  
  - To unhide all hidden columns, click Unhide.  
  Note: You can also change the width of FRx columns with the mouse, using the same technique as in Windows-based spreadsheets like Microsoft® Excel. Click and drag the column edge until the column is the size you want it to be. |
| Outline Style       | Controls the appearance of the graphical tree on the left side of the Reporting Tree window. When you point to this Format menu command, you can select from one of the following outline styles:  
  - Tree Lines and Text  
  - Tree Lines, Picture and Text  
  - Pictures and Text  
  - Plus/Minus, Picture and Text  
  The selected command has a check mark in front of it. |
| Tree Lines and Text | Shows the tree with the names of reporting units. Connecting lines show the relationships among the units; child units are indented from the left. |

Table 6-4: Reporting Tree Format Menu Commands
Chapter 6: Creating a Reporting Tree– Reporting Tree Menus and Toolbar Icon

### Tree Menu

Use the **Tree** menu, shown in the following figure, to make changes to the graphical tree and display reporting unit information from the graphical tree. You can also use the **Tree** menu to “freeze” or “unfreeze” the **Description** column in the reporting tree worksheet.

![Tree Menu](image)

**Figure 6-11: Reporting Tree: Tree Menu**

<table>
<thead>
<tr>
<th>Format Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tree Lines, Picture and Text</strong></td>
<td>Shows the tree with the names of reporting units, indentations, connecting lines, and a descriptive symbol in front of each unit.</td>
</tr>
<tr>
<td><img src="image" alt="This symbol" /></td>
<td>This symbol indicates parent units that have units reporting to them.</td>
</tr>
<tr>
<td><img src="image" alt="This symbol" /></td>
<td>This symbol indicates detail units.</td>
</tr>
<tr>
<td><strong>Pictures and Text</strong></td>
<td>Shows the tree with names of reporting units, indentations, and symbols, but with no connecting lines.</td>
</tr>
<tr>
<td><strong>Plus/Minus, Picture and Text</strong></td>
<td>Shows the tree with names of reporting units, indentations, and symbols, but with no connecting lines. Additionally, it identifies each branch with a plus (+) or minus (-) sign. The plus sign indicates that there are levels that can be expanded below this branch; the minus sign indicates that any levels that exist below this branch have been expanded.</td>
</tr>
</tbody>
</table>

Table 6-4: Reporting Tree Format Menu Commands (Continued)
On the graphical tree or worksheet, select a reporting unit (or branch, if applicable) and click one of the following Tree menu commands.

<table>
<thead>
<tr>
<th>Tree Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Form</td>
<td>Opens the Reporting Units dialog box, displaying the selected reporting unit information. Use this dialog box to enter, delete, or change information about the selected reporting unit. For more information about the boxes in the Reporting Units dialog box, see “Understanding Building Reporting Trees Manually” on page 203.</td>
</tr>
<tr>
<td>Promote Unit</td>
<td>Promotes the selected unit in the reporting tree to the next highest level.</td>
</tr>
<tr>
<td>Demote Unit</td>
<td>Demotes the selected unit in the reporting tree to the next lowest level.</td>
</tr>
<tr>
<td>Expand All</td>
<td>Expands all of the tree’s detail.</td>
</tr>
<tr>
<td>Expand Branch</td>
<td>Expands a selected branch by one level in the reporting tree to show additional detail. The unit’s child units display. If there are multiple levels in the branch, they expand by an additional level each time you execute this command.</td>
</tr>
<tr>
<td>Collapse Branch</td>
<td>Collapses a selected branch by one level in the reporting tree. The unit’s child units disappear. If there are multiple levels in the branch, they collapse by an additional level each time you execute this command.</td>
</tr>
</tbody>
</table>

Table 6-5: (Reporting Tree) Tree Menu Commands - Graphical Tree Unit Selected
Additionally, the **Tree** menu contains command options that do not require you to select a reporting unit on the reporting tree.

<table>
<thead>
<tr>
<th>Tree Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Expand All</strong></td>
<td>Expands all of the tree’s detail.</td>
</tr>
<tr>
<td><strong>Freeze at Description</strong></td>
<td>“Freezes” or “unfreezes” the Description column at the left of the reporting tree worksheet. When the worksheet is frozen, the Description column remains at the left side regardless of how many columns you scroll through to the right. This command is a toggle. When <strong>Freeze at Description</strong> is active, the menu item displays a √ next to it. To clear it, click <strong>Freeze at Description</strong> again, until the √ disappears.</td>
</tr>
</tbody>
</table>

### Table 6-6: (Reporting Tree) Tree Menu Commands - Options

#### Reporting Tree Toolbar Icon

The Reporting Tree window has a toolbar icon (**Tree Form**) specific to the reporting trees. Other common tool bar icons are explained in “Defining Available Commands on Report Designer Menus” on page 19.

<table>
<thead>
<tr>
<th>Toolbar Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Tree Form Icon" /></td>
<td>The <strong>Tree Form</strong> icon opens the <strong>Reporting Units</strong> dialog box. This has the same effect as pressing <strong>F8</strong> or selecting <strong>View Form</strong> from the <strong>Tree</strong> menu.</td>
</tr>
</tbody>
</table>

### Table 6-7: Reporting Tree Toolbar Icon
Understanding Building Reporting Trees

Before you build any reporting trees, you will first need to determine the various reporting structures your company will require.

The best approach is to carefully consider how you have set up your general ledger account structure. Once you have done that, you need to draw an organizational chart of your company. Use your current general ledger departments, projects, and so on as the lowest detail level. Add to these as many boxes as you need to show higher-level divisions or regions. Remember that each box represents a potential reporting unit in any of your reporting trees.

This master organizational chart will help you visually to create reporting tree flowcharts that group together various boxes (reporting units) to create a reporting tree.

You also will need to consider the best way to build your trees. With FRx, you can create trees using an automated build process or you can create them manually. It is important to understand both methods before designing your trees.

This section contains information and instructions on:

- Understanding Building Reporting Trees Automatically
- Understanding Building Reporting Trees Manually

Understanding Building Reporting Trees Automatically

FRx can assist you in building your reporting tree with its automated build capabilities. Before you begin you will need to understand how to use the Add Reporting Units from Chart of Accounts dialog box. We will look at some examples to show you how to complete the boxes and use the icons. Additionally, we will take a close look at the account masks entered in this window.
The following figure provides descriptions of each section in the **Add Reporting Units from Chart of Accounts** dialog box.

These boxes define how to build your reporting tree by making changes to the account mask.

The **Combine** icon changes the size of any of the displayed segments.

The **Split** icon (Cleaver), can split the segment characters.

The **Segment Hierarchy** box displays the segments graphically. You can move the segments to change their reporting order.

The **Segment Ranges** boxes can be used to specify a range of codes within each segment.

**Figure 6-12: Add Reporting Units from Chart of Accounts Dialog Box**

The appearance of this dialog box changes when you make different modifications to its options and boxes. You can make the following modifications:

- Limit the location or division
- Limit the department
- Reverse the segment hierarchy of the tree
- Split the segments into more functional components
- Combine different segments

To understand these modifications more thoroughly, take a look at some of the following examples.
Example 1 - Limited Account Ranges by Location and Department

In the dialog box pictured in Figure 6-13, we have limited the account ranges by location and department.

Figure 6-13: Limiting Accounts in Reporting Tree by Segment Range

Figure 6-14 shows the resulting regional reporting tree for Fabrikam Works.

Figure 6-14: Reporting Tree with Specific Locations and Departments
Example 2 - Splitting the Account Mask and Changing the Hierarchy

In this example, we have split the account mask and changed the hierarchy of the segments. Figure 6-15 shows how we first used the Split icon (cleaver) to separate the location away from the segment. Second, we dragged the New Segment to the top of the graphical segment hierarchy. Last, we used the Segment Range boxes to limit the account segment ranges and departments.

![Figure 6-15: Splitting off the Location and Limiting Segments](image)

The resulting functional reporting tree, sorted by location, is shown in Figure 6-16.

![Figure 6-16: Functional Reporting Tree by Location](image)

Account masks can be included in building a tree automatically. To learn more about account masks and symbols review the following topics:

**Including an Account Mask when Building a Tree Automatically**

The account mask is built with the following segments: the natural account code, followed by the location, the divisions, and the departments. The number of positions within a segment varies with the actual number of characters or digits in the general ledger.
The symbols (+, &, ?) in the account mask tell FRx the amount of information to be drawn from the general ledger, as detailed in the row format, versus the information to be drawn from the reporting tree.

For information on specific account masks that are applied to reporting units when you create the reporting tree, see “Account Mask Structure and Segments” on page 183.

**Account Mask Symbols**

Before you can create an account mask, you must understand the symbols used and what each symbol tells FRx when creating a reporting tree.

- **Plus signs (+)** tell FRx to create units in the reporting tree based on the detail for that particular segment. Another way to think of this is that a “+” indicates that you would like the option of displaying or viewing separate financial statements for each unit in this segment. For example, plus signs in the Location/Division tell FRx to create a unit in the tree for each location/division in the general ledger. By default, FRx places a “+” in all responsibility (or non-natural) account segments.

- **Hooks (&)** tell FRx to go to the row format for this segment. Hooks are typically used for the natural account segment of the account mask, although hook symbols can be used anywhere in the account mask.

**Note**

You must enter the same number of hooks as the number of characters or digits in the row format. The position of the hooks in the account segment need not be identical to the character or digit position in the row format. For example, the row format might have digits in the natural account segment and the first position of the third segment (location). In the row format, the digits are entered sequentially.

- **Wildcards (?)** instruct FRx to avoid building the details into the tree for that segment. Unlike the plus sign, a wildcard indicates that you would not like the option of displaying or viewing separate financial statements for this segment.

The following table illustrates the effect that plus signs (+), hooks (&), and wildcards (?) have when reporting trees are built for Fabrikam Works, Inc.

<table>
<thead>
<tr>
<th>When you use this account mask...</th>
<th>For these reporting units...</th>
<th>FRx creates these specific account masks...</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp; &amp;&amp; &amp; ++++ +++</td>
<td>Corporate</td>
<td>&amp; &amp;&amp; &amp;-0000-000</td>
</tr>
<tr>
<td></td>
<td>Denver Corporate</td>
<td>&amp; &amp;&amp; &amp;-1000-000</td>
</tr>
<tr>
<td></td>
<td>Denver Sales -Retail</td>
<td>&amp; &amp;&amp; &amp;-1100-001</td>
</tr>
<tr>
<td></td>
<td>Denver Sales- Wholesale</td>
<td>&amp; &amp;&amp; &amp;-1100-002</td>
</tr>
<tr>
<td></td>
<td>Denver Sales Inter-Company</td>
<td>&amp; &amp;&amp; &amp;-1100-012</td>
</tr>
<tr>
<td></td>
<td>Denver Service- Lab</td>
<td>&amp; &amp;&amp; &amp;-1200-003</td>
</tr>
</tbody>
</table>

Table 6-8: Original Account Masks and Specific Account Masks
<table>
<thead>
<tr>
<th>When you use this account mask...</th>
<th>For these reporting units...</th>
<th>FRx creates these specific account masks...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Denver Service - Studio</td>
<td>&amp; &amp; &amp; &amp;-1200-004</td>
<td></td>
</tr>
<tr>
<td>San Francisco Corporate</td>
<td>&amp; &amp; &amp; &amp;-2000-000</td>
<td></td>
</tr>
<tr>
<td>San Francisco Sales - Retail</td>
<td>&amp; &amp; &amp; &amp;-2100-001</td>
<td></td>
</tr>
<tr>
<td>San Francisco Sales - Wholesale</td>
<td>&amp; &amp; &amp; &amp;-2100-002</td>
<td></td>
</tr>
<tr>
<td>San Francisco Sales - Inter-Company</td>
<td>&amp; &amp; &amp; &amp;-2100-012</td>
<td></td>
</tr>
<tr>
<td>San Francisco Service- Lab</td>
<td>&amp; &amp; &amp; &amp;-2200-003</td>
<td></td>
</tr>
<tr>
<td>San Francisco Service - Studio</td>
<td>&amp; &amp; &amp; &amp;-2200-004</td>
<td></td>
</tr>
</tbody>
</table>
| & & & & ++++ ???                 | Corporate                   | & & & &-0000-???
| Denver Corporate                | & & & &-1000-???
| Denver Sales                    | & & & &-1100-???
| Denver Service                  | & & & &-1200-???
| San Francisco Corporate          | & & & &-2000-???
| San Francisco Sales              | & & & &-2100-???
| San Francisco Service            | & & & &-2200-???
| & & & & ????? +++               | Corporate                   | & & & &-?????-000
| Retail                          | & & & &-?????-001           |                                         |
| Wholesale                       | & & & &-?????-002           |                                         |
| Lab                             | & & & &-?????-003           |                                         |
| Studio                          | & & & &-?????-004           |                                         |
| Inter-Company                   | & & & &-?????-012           |                                         |
| & & & & ????? ????              | All Locations, Divisions, and Departments | & & & &-?????-???

Table 6-8: Original Account Masks and Specific Account Masks (Continued)
The following topic describes building a reporting tree manually. You will find it helpful to review the following section whether you decide to build a reporting tree with the automatic build capabilities or whether you decide to build the reporting tree manually. Additionally, you will find the manual build information helpful for when you want to refine or edit a reporting tree that you have built automatically.

When you are ready to start building a reporting tree automatically, go to “Building Reporting Trees Automatically” on page 213 for step-by-step instructions.

**Understanding Building Reporting Trees Manually**

This section contains information you will need to understand building a reporting tree manually. You will also use this information to further refine or edit a reporting tree that you have built automatically from the general ledger chart of accounts.

You can build a reporting tree manually using the **Reporting Units** dialog box or using the **Reporting Tree** worksheet.

When you use the **Reporting Units** dialog box, you add one reporting unit at a time in a new (blank) **Reporting Units** dialog box.

When you use the **Reporting Tree** worksheet, you can add a new reporting unit to the **Reporting Tree** window where you can also see the information for the previous units you have entered. The **Reporting Tree** worksheet also makes it easier for you to add similar information for the new units.

You can use either the **Reporting Units** dialog box or the **Reporting Tree** worksheet to refine or edit reporting units, including reporting trees and reporting units created from the automatic build capabilities.

When you build a reporting tree manually, you need to also define the parent-child relationships for the units in the reporting tree. The following topics give you information that you will need to do this.

After you have built a reporting tree manually, you must define the parent-child relationships for the tree’s reporting structure. The easiest way to do this is to define all of the lowest-level child units, and then define each successive level of parent units. You can then link each parent to its appropriate children.

**Note**

The parent-child relationships are already defined for you if you build a reporting tree using the procedures described in “Building Reporting Trees Automatically” on page 213. You need to define these relationships only if you used the method described in “Building Reporting Trees Manually” on page 205.

**Detail and Summary Hierarchy Combinations**

The most common type of reporting tree is composed of parent units that pull summarized information from the detail units and child units that contain detail units of account information. However, many detail/summary hierarchy combinations can be created. A child unit can be both a child to the higher unit as well as a parent to a lower unit. See “Reporting Unit Structure” on page 181 for more information on the reporting unit structure.
You can create this parent/child hierarchy structure by moving individual reporting units or an entire branch (parent unit and all child units) to higher or lower levels on the graphical tree. This is called promoting and demoting units. Promoting a unit moves it to a higher level in the tree. Demoting a unit moves a unit to a lower level. When you build a tree manually, you can promote and demote reporting units using a drag-and-drop operation or using the Tree menu. See “To promote and demote reporting units with drag and drop” on page 211 or “To promote and demote reporting units with the Tree menu” on page 212 for the appropriate instructions.

**Reporting Units Window**

You can also define a unit as a parent unit or assign a child to a specific parent unit on the Reporting Units window. See “To assign parent/child relationships in the Reporting Units dialog box” on page 212.

After completing the tree reporting structure, you can verify that parent units have been selected for each child. For specific instructions on verifying parent units, see “To verify a unit’s parent unit” on page 212.

When you are ready to start building a reporting tree manually, continue to the following section, “Building Reporting Trees Manually” on page 205.
Building Reporting Trees Manually

You can build the reporting tree manually in the Reporting Tree worksheet, as shown below. Or, you can build a reporting tree manually using the Reporting Units dialog box. See “To build a reporting tree using the Reporting Units dialog box” on page 206. You can also use the Reporting Units dialog box or the worksheet in the Reporting Tree window to refine or edit an existing reporting tree.

This section contains information and instructions on:

- Building a Reporting Tree with the Reporting Tree Worksheet
- Building a Reporting Tree with the Reporting Units Dialog Box
- Defining Parent-Child Relationships
- Verifying a Unit’s Parent Unit

Building a Reporting Tree with the Reporting Tree Worksheet

To build a reporting tree using the Reporting Tree worksheet

1. Do one of the following:

<table>
<thead>
<tr>
<th>If you are</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building a new reporting tree</td>
<td>On the FRx File menu, point to New, and click Tree to display a blank Reporting Tree window.</td>
</tr>
<tr>
<td>Refining or editing an existing reporting tree</td>
<td>1. Do one of the following to display the Open Tree dialog box:</td>
</tr>
<tr>
<td></td>
<td>- From the FRx Control Panel, click the Reporting Trees icon</td>
</tr>
<tr>
<td></td>
<td>- On the File menu, point to Open..., and click Tree...</td>
</tr>
<tr>
<td></td>
<td>2. Select a tree from the list to display it in the Reporting Tree window.</td>
</tr>
</tbody>
</table>

2. In the worksheet on the right of the Reporting Tree window, enter the information for each reporting unit on a separate row and in the appropriate column.

Starting with step 3, use the steps and information listed in the “To build a reporting tree using the Reporting Units dialog box” section to help you complete the worksheet.

The boxes in the Reporting Tree worksheet are essentially the same as the boxes in the Reporting Units dialog box shown in the instructions. When the labels that identify these boxes differ between the worksheet and the Reporting Units dialog box, the worksheet label is in parentheses after the dialog box label.

Note: To speed the entry of information that is the same for some or all units, you can use Copy and Paste commands on the Edit menu.
After you build a new reporting tree (or make changes to an existing one) in the worksheet, you will need to define parent units. See “Defining Parent-Child Relationships” on page 211.

**Building a Reporting Tree with the Reporting Units Dialog Box**

Before you begin, make sure that you have reviewed the entire “Understanding Building Reporting Trees” topic, including the information on building trees automatically and the information on building a tree manually. See “Understanding Building Reporting Trees” on page 197.

The following instructions guide you through the process of manually building a reporting tree. This section also contains information you’ll need to further refine or edit a reporting tree that you have previously built.

---

**Note**

You need to specify at least one detail unit when you build a reporting tree. You cannot build a reporting tree consisting of only parent units.

---

The following steps refer to the **Reporting Units** dialog box. The boxes in the Reporting Tree worksheet are essentially the same as the boxes in this dialog box. When the labels that identify these boxes differ between the worksheet and the Reporting Units dialog box, the worksheet label is in parentheses after the dialog box label.

**To build a reporting tree using the Reporting Units dialog box**

1. Do one of the following:

<table>
<thead>
<tr>
<th>If you are</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building a new reporting tree</td>
<td>On the FRx <strong>File</strong> menu, point to <strong>New</strong>, and click <strong>Tree</strong> to display a blank <strong>Reporting Tree</strong> window.</td>
</tr>
</tbody>
</table>
| Refining or editing an existing reporting tree | 1. From the FRx Control Panel, click the **Reporting Trees** icon to display the **Open Tree** dialog box.  
2. Select a tree from the list to display it in the **Reporting Tree** window.  
3. On the graphical tree, select the reporting unit to edit. |

---
2 Do one of the following to display the Reporting Units dialog box:

- Click the Tree Form icon.
- On the Tree menu, select View Form.

A blank dialog box displays if you are building a new reporting tree. If you are working with an existing reporting tree, the information for the reporting unit you selected in step 1 displays in the dialog box.

3 Do one of the following:

<table>
<thead>
<tr>
<th>If you are</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building a new reporting tree</td>
<td>Complete steps 4–21.</td>
</tr>
</tbody>
</table>
| Refining or editing an existing reporting tree | 1 Complete the following steps as needed to refine or edit your reporting tree.  
2 Click OK to save the changes in the reporting tree. |

4 In the Unit Code box, enter a code (maximum 16 characters) to identify this reporting unit in the graphical reporting tree. For ease of use, establish a coding system that is consistent and easily understood by users.

**Note:** You can select the @RUNIT code in report headers and footers to display the unit code in the report. See “Reporting Unit Selection” on page 269.

5 In the % Allocation to Parent box, enter a percentage of this unit to be allocated (rolled up) to its parent unit. You can type the percentage with or without a decimal point. For example, type either .25 or 25 for a 25% rollup to the parent.

**Note:** If you use a percentage that is less than 1%, you must select the Allow Rollup <1% option in the Catalog of Reports. The Allow Rollup <1% option is located under Report Options on the Tree Options tab.
The percentage you enter here applies to each row of the row format before it is added to the parent report. For example, if a child unit is to be divided evenly between two departments, the amounts in each row would be multiplied by 50% before being added to the department report.

**Note:** A reporting unit cannot have two parents. To do this, you would need to create another reporting unit with the same account mask to roll up the additional 50%.

6 In the **Company** box, select one of the following:

<table>
<thead>
<tr>
<th>To create a reporting tree for</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>One particular company</td>
<td>Select the company code from the list.</td>
</tr>
</tbody>
</table>
| Multiple companies with similar account coding | Select @ANY from the list so that this tree can be used for all companies.  
  **Note:** If you use @ANY, FRx pulls the company information from the Catalog of Reports. Typically, the @ANY company is set for the top (summary) level of the tree, only. All child branches have a company assigned to them. |
| Consolidated reporting        | Select the appropriate company code for each unit from the list to include in the reporting tree.  
  This directs FRx to the appropriate location and format of general ledger data for that company.  
  **Note:** This information is defined in the Company Information dialog box available from the Company menu. |

7 In the **Title/Desc** box, type an appropriate title for this reporting unit to display in selection windows for reporting units.

**Note:** The reporting unit title also displays in the report header or footer if you enter @TITLE as a code under Page Options, on the Header/Footers tab in the Catalog of Reports. It also displays in the report row description if you enter @UNIT in the row format description box.

8 In the **Informal Desc** box, type an optional informal description to be used for reference purposes only. It is not displayed in any window listings or printed on any reports.
9 If you are entering a detail unit (one that pulls data from the general ledger, a row format, or an external worksheet), in the **Account Mask (Acct Mask)** box, you **must** type an account mask using the following account mask character types:

- **Hook (\&),** represented by the ampersand character, to go to the row format account codes at report generation time.
- **Wild card (\?),** represented by the question mark, to avoid building any specific detail unit into the tree.

You can also place an account mask in a summary unit (for example, for expenses directly related to that unit):

**Note:** If you place an account mask on a summary unit, accounts that are used in parent units should not be used in child units, because this would cause amounts to be duplicated.

See Figure 6-4, “Account Masks in Reporting Tree Window,” on page 184 for an example account mask structure.

10 Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply a format style relating to specific reporting unit amounts</td>
<td>In the <strong>Int'l Format</strong> box, select a format style from the list.</td>
</tr>
<tr>
<td>Keep the format specified for the unit’s company (as indicated in the <strong>Company</strong> box)</td>
<td>Leave the <strong>Int'l Format</strong> box blank.</td>
</tr>
</tbody>
</table>

For more information on using international formats, refer to your *FRx® Report Designer 6.7 Administrator’s Guide.*

11 To begin the report for this reporting unit on a new page, do the following:

- Select **Page Break Before Unit.**
- In the Catalog of Reports, on the **Tree Options** tab, select the Report Options **Use Reporting Tree** to use whatever page breaks you defined in the reporting tree.

12 In the **Optional Row Formats and Links** section (shown below), you can enter information that specifies the unit’s links to the general ledger, external spreadsheet, or row format.

**Note:** For more information, see “Linking to External Worksheets” on page 124.
13 If you entered a row format, use the **GL or Row Links** box to select a link (in the row format) for this reporting unit.

Use this box when you have multiple links of the same type in the row format.

**Note:** Entering a GL link is optional and should be avoided unless you have a specific reason for doing so. FRx automatically determines which link to use in each report. Entering a link here overrides that selection process.

For example, if you have multiple general ledger links for different years, FRx determines the link used for each year. If a link is specified here, FRx does not attempt that year-matching process.

14 If the selected row format has more than one link, click the **Wks Link** arrow to display a list of worksheet links in the row format and select the appropriate link to use for this reporting unit.

15 If a separate link to an external worksheet has been established in the row format, specify the Lotus 1-2-3 or Microsoft Excel file to be imported into this unit in the **Wks File Name (Ext File)** box.

16 To specify a worksheet, do one of the following:

<table>
<thead>
<tr>
<th>To specify a Worksheet</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet within a Microsoft Excel workbook</td>
<td>Type the name of the workbook in brackets followed by the worksheet name. For example: type <strong>[COMPbudg.XLS]DENVER</strong></td>
</tr>
<tr>
<td>Sheet within a Lotus 1-2-3 WK1 spreadsheet</td>
<td>Type the name of the spreadsheet in brackets followed by the sheet letter. <strong>Note:</strong> FRx imports only the first sheet in a Lotus 1-2-3 WK3 spreadsheet. To select a different sheet, save the sheet as a separate WK3 file.</td>
</tr>
</tbody>
</table>

**Note:** If you enter a file without a full path, FRx uses the path defined for the default IO_Data directory in the **Company Information** dialog box. An external worksheet can be imported into any unit in the reporting tree.

17 Click **OK** to add the reporting unit to the tree and return to the **Reporting Tree** window.

18 Repeat steps 2–19 for each unit record until you have added all of the detail units for your reporting tree.

Continue to the next section, “Defining Parent-Child Relationships” on page 211, to define the parent-child relationships in this reporting tree.
Defining Parent-Child Relationships

Follow these instructions only if you build a reporting tree manually. The parent-child relationships are already defined for you if you build a reporting tree using the procedures described in “Building Reporting Trees Automatically” on page 213.

After you build a reporting tree manually, you must define the parent-child relationship of the reporting unit. You can do this by promoting and demoting reporting units on the graphical reporting tree using one of the following methods:

- **The drag and drop operation** - See “To promote and demote reporting units with drag and drop” on page 211.

- **The Tree menu** - See “To promote and demote reporting units with the Tree menu” on page 212.

You can also use the Reporting Units dialog box to assign a child unit to a parent unit, or designate a unit as the parent unit. See “To assign parent/child relationships in the Reporting Units dialog box” on page 212 for instructions.

For more information on defining parent units, see “Defining Parent-Child Relationships” on page 211.

After you defined the parent-child relationship, you can verify the parent unit for a specific reporting unit. See “To verify a unit’s parent unit” on page 212 for instructions.

This section contains information and instructions on:

- Promoting and Demoting Reporting Units with Drag and Drop
- Promoting and Demoting Reporting Units with the Tree Menu
- Assigning Parent/Child Relationships in the Reporting Units Dialog Box

Promoting and Demoting Reporting Units with Drag and Drop

To promote and demote reporting units with drag and drop

You can rearrange the organizational structure of the reporting tree by dragging and dropping a reporting unit into a new position. When you drag a reporting unit, the pointer’s graphic icon changes to indicate the current position of the reporting unit. The different graphic icons of the tree pointer are shown in the following table.

<table>
<thead>
<tr>
<th>Reporting tree pointer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon 1]</td>
<td>Use this pointer to make the selected unit a child of the targeted unit.</td>
</tr>
<tr>
<td>![Icon 2]</td>
<td>Use this pointer to make the selected unit a child of the targeted unit.</td>
</tr>
</tbody>
</table>

Table 6-9: Reporting Tree Pointer

1. In the **Reporting Tree** window, on the graphical tree, click a reporting unit.
2. Drag and drop the unit to a new position.
Promoting and Demoting Reporting Units with the Tree Menu

To promote and demote reporting units with the Tree menu

1. In the Reporting Tree window, on the graphical tree, click a reporting unit.
2. On the Reporting Tree menu, select one of the following:

<table>
<thead>
<tr>
<th>To move the unit one level</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Higher in the tree</td>
<td>Promote Unit</td>
</tr>
<tr>
<td>Lower in the tree</td>
<td>Demote Unit</td>
</tr>
</tbody>
</table>

Assigning Parent/Child Relationships in the Reporting Units Dialog Box

To assign parent/child relationships in the Reporting Units dialog box

You can assign a child unit to a parent unit, or designate a unit as the parent unit, using the Reporting Units dialog box.

1. From the Reporting Tree window, click the Tree Form icon to display the Reporting Units dialog box.
2. Use the Unit Code arrows to select the child unit.
3. In the Parent Unit box, click the arrow to display the list of reporting units and select a unit to designate as the parent unit.
4. Click OK to apply the selection and return to the Reporting Tree window.

For more information, see “Reporting Tree Toolbar Icon” on page 196.

For more information on defining parent units, see “Defining Parent-Child Relationships” on page 211.

After you defined the parent-child relationship, you can verify the parent unit for a specific reporting unit. See “To verify a unit’s parent unit” on page 212.

Verifying a Unit’s Parent Unit

To verify a unit’s parent unit

After you complete the reporting tree structure, you can verify that the parent units have been selected for each child using the Reporting Units dialog box.

1. In the Reporting Tree window, select a child unit.
2. Do one of the following to display the Reporting Units dialog box:
   - Press the F8 key.
   - Click the Tree Form icon.
   - On the Tree menu, click View Form.
3. In the Parent Unit box, view the parent unit for the child unit.
Building Reporting Trees Automatically

Before you begin, make sure that you have reviewed the entire “Understanding Building Reporting Trees” topic, including the information on building trees automatically and the information on building trees manually. See “Understanding Building Reporting Trees” on page 197.

After you create a new reporting tree in the Reporting Tree window, you can add reporting units to the reporting tree automatically using the Add Reporting Units from Chart of Account dialog box. You can use this dialog box to:

- Add reporting units from the Chart of Accounts.
- Define the account mask.
- Define other reporting unit hierarchies and ranges

You can also refine or edit a reporting tree that you have built automatically using the Reporting Units dialog box or the Reporting Tree worksheet. See “Building Reporting Trees Manually” on page 205.

The following instructions will help you complete each of the tasks necessary for building a new tree automatically.

To build a reporting tree automatically

The following steps show you how to build a reporting tree automatically. You may find it helpful to refer back to “Understanding Building Reporting Trees Automatically” on page 197, as needed, while completing these steps.

1. On the FRx File menu, point to New, and click Tree to open a blank reporting tree worksheet.

2. On the Reporting Tree Edit menu, click Add Reporting Units from Chart of Accts to display the Add Reporting Units from Chart of Accounts dialog box.
3 Under **Reporting Account Segmentation**, in the **Natural** segment box, type a hook (&) for each number in the natural account segment to tell FRx to go to the row format.

For example, use &amp;&amp; for a four-digit natural account segment.

4 Under **Reporting Account Segmentation**, in each segment box, type an account mask using one of the following account mask character types.

<table>
<thead>
<tr>
<th>Account mask character type</th>
<th>Tells FRx to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plus sign (+)</td>
<td>Create a unit in the tree for this segment information in the general ledger.</td>
</tr>
<tr>
<td><strong>Note:</strong> By default, FRx places a + (plus sign) in the all of the responsibility (or non-natural) account segments.</td>
<td></td>
</tr>
<tr>
<td>Hook (&amp;), represented by the ampersand character</td>
<td>Go to the row format for the this segment information.</td>
</tr>
<tr>
<td>Wild card (?), represented by the question mark</td>
<td>Avoid building details into the tree for this segment information.</td>
</tr>
</tbody>
</table>

5 To change the size of any of the displayed segments, click **Combine**, and then click the segment separator. Otherwise, go to step 7.

6 With the segment separator selected, use the double arrows to re-size the box.

7 To split a segment (such as location/division), click **Split**, and then click the part of the segment where you want to split the characters to create a new segment.

8 To change the hierarchy of the segments in the **Segment Hierarchy** box, click the segment you want to move, and drag it to the segment to which it should report.

**Note:** This is where you define how segments report to each other and define ranges, if desired, for each segment.

9 To specify a range of account numbers to bring to the new reporting tree, in the **Segment Hierarchy** box, select the segment for which you want to define ranges and complete steps 10-11. Otherwise, go to step 12.

**Note:** When you select the segment in the **Segment Hierarchy** box, the cursor moves to the **From Acct** box for that segment.

10 In the **From Acct** box for that segment, type the first account number in the range, and press the **TAB** key to move the cursor to the **To Acct** box.

11 In the **To Acct** box, type the last account number you want to use for this segment.
In the **Segment Hierarchy** box, select a segment, and under **Get Unit Name from**, select one of the following:

<table>
<thead>
<tr>
<th>Get Unit Name option</th>
<th>To assign the tree segment as</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Segment Description</strong></td>
<td>Descriptive name based on your general ledger</td>
</tr>
<tr>
<td></td>
<td>segment information.</td>
</tr>
<tr>
<td><strong>Segment Code</strong></td>
<td>Short name as the actual account code segment</td>
</tr>
<tr>
<td></td>
<td>value.</td>
</tr>
</tbody>
</table>

For each segment in the **Segment Hierarchy** box, repeat steps 4-12.

When you have defined your account segments, hierarchies, and ranges the way you want them brought in to the new reporting tree from the chart of accounts, click **OK** to build a reporting tree and display it in the **Reporting Tree** worksheet.

When you are through editing the new tree’s reporting units, on the Reporting Tree **File** menu, click **Save** to save the new tree.
Adding Text and E-mail Links to a Reporting Tree

After you build a reporting tree, either manually or automatically, you can add text entries or an e-mail link to the reporting units in the tree. The following section, “To add additional text to the reporting units in a tree” shows you how to add text entries. See “To add e-mail addresses to a reporting tree” on page 217 when you want to add any e-mail links.

This section contains information and instructions on:

- Adding Text to the Reporting Units in a Tree
- Adding E-mail Addresses to a Reporting Tree

Adding Text to the Reporting Units in a Tree

You can create up to ten additional text entries for each reporting unit in a reporting tree. Each additional text entry can have a maximum length of 255 characters.

Once you have created the additional text entries in the reporting tree, you can add the additional text entries to the row format or to the header/footer section in reports. For more information about adding additional text to row formats, see “To use additional text in the row format” on page 73. For information about adding additional text to the headers and footers in reports, see “Including Additional Text in a Report” on page 284.

To add additional text to the reporting units in a tree

1. In the Reporting Tree window, select the Reporting Unit row to which you want to add text.
2. Scroll to the right in the worksheet, and then click in the Additional Text cell for the reporting unit.
3. Click the Additional Text arrow to display the Additional Text dialog box.
4 In the **Additional Text** dialog box, you can do the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Add additional text to a reporting unit | 1 In the first blank row, type the text (up to 255 characters).  
2 To add additional text entries for this reporting unit, in a new blank row, type the text.  
3 Click **OK**. |
| Remove a text entry for a reporting unit | 1 Select the entry to remove.  
2 Click **Clear**. |
| Close the **Additional Text** dialog box without saving changes | Click **Cancel**. |

**Note:** The **Additional Text** box has ten rows available for text entries. You can include two entries in an **Additional Text** box separated by a semicolon (;). For example, in the first **Additional Text** box, type *Adjusted after acquisition*();*Unadjusted*. 
To use a semicolon as a character in the text entry, enclose the semicolon in single quotes (";").

**Adding E-mail Addresses to a Reporting Tree**

You can enter e-mail recipients in the Reporting Tree window, in the Catalog of Reports, or both. E-mail addresses must be set up in the reporting tree in order to make the **Use Tree** or **Combined Catalog and Tree** options available from the Catalog of Reports. Selecting a combined catalog and tree e-mail security sends users in the catalog an e-mailed file containing only the units available to them in the tree. For more information about selecting the **Use Tree** e-mail option from the Catalog of Reports, see “Enable E-mail Options” on page 254.

**To add e-mail addresses to a reporting tree**

1 From the FRx **Control Panel**, click the **Reporting Trees** icon to display the **Open Tree** dialog box.

![Open Tree Dialog Box](image)

2 Select a reporting tree.
Click **OK** to display the reporting tree in the **Reporting Tree** window.

On the graphical tree, select a reporting unit. The corresponding row in the worksheet to the right becomes highlighted.

In the worksheet, scroll to the right to display the **Security/E-Mail** column.

In the selected reporting unit row, click the **Security/E-Mail** arrow to display the **Tree Unit Security and E-mail** dialog box.

To include lower level (child) reporting units in the e-mail recipient’s view of the report, select the **Add to children** check box.
To add users to the **Access Granted** list box, do one of the following:

<table>
<thead>
<tr>
<th>To add</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users from the e-mail address books</td>
<td>1  In the <strong>Tree Unit Security and E-mail</strong> dialog box, click <strong>E-mail</strong> to display the <strong>e-mail address book</strong> dialog box.</td>
</tr>
<tr>
<td></td>
<td>2  In the <strong>Show Names from the</strong> box, select an address book from the list to display a list of user e-mail addresses.</td>
</tr>
<tr>
<td></td>
<td>3  In the e-mail address list on the left, select a user’s e-mail address from the list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To select multiple e-mail user addresses, press the <strong>Ctrl</strong> key and select each e-mail address to include.</td>
</tr>
<tr>
<td></td>
<td>4  Click <strong>To-&gt;</strong> to add the e-mail addresses for the selected users to the list on the right.</td>
</tr>
<tr>
<td></td>
<td>5  Click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

| Users from the **FRx Users** list           | **Note:** The FRx Users list is available only when FRx Security is active. User profiles must include an e-mail address for this selection to work correctly. See your **FRx® Report Designer 6.7 Administrator’s Guide** for details. |
|                                             | 1  In the **Tree Unit Security and E-mail** dialog box, click **FRx Users** to display the **Select a User** dialog box.            |
|                                             | 2  Select the user names to include from the list.                                                                               |
|                                             | **Note:** To select multiple user names, press the **Ctrl** key and select each user to include.                                 |
|                                             | 3  Click **OK**.                                                                                                                   |
To remove a user (or group) from the Access Granted list, do the following:

<table>
<thead>
<tr>
<th>To remove</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specific users (or group)</td>
<td>1 In the Access Granted list box, select the user e-mail address to remove.  &lt;br&gt;<strong>Note:</strong> To select multiple user e-mail addresses, press the <strong>Ctrl</strong> key and select each e-mail address to remove.  &lt;br&gt;2 Click <strong>Remove</strong>.</td>
</tr>
<tr>
<td><em>All</em> users and clear the entire list</td>
<td>Click <strong>Remove All</strong>.</td>
</tr>
</tbody>
</table>

9 To remove a user (or group) from the Access Granted list, do the following:

<table>
<thead>
<tr>
<th>To add</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users from the <strong>FRx Groups</strong> list</td>
<td><strong>Note:</strong> The FRx Groups list is available only when FRx Security is active. User profiles for all members of the group must include the individual e-mail addresses for this selection to work correctly. See your <em>FRx® Report Designer 6.7 Administrator’s Guide</em> for details.  &lt;br&gt;1 In the Tree Unit Security and E-mail dialog box, click <strong>FRx Groups</strong> to display the Select a Group dialog box.  &lt;br&gt;2 Select the group names to include from the list.  &lt;br&gt;<strong>Note:</strong> To select multiple user names, press the <strong>Ctrl</strong> key and select each user to include.  &lt;br&gt;3 Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Individual users</td>
<td>1 In the Add Individual Users box, type the e-mail address of the user.  &lt;br&gt;2 Click <strong>Add</strong>.</td>
</tr>
</tbody>
</table>
Securing Reporting Tree Units

When FRx security is active, you can restrict access to individual reporting units with the tree from the **Security/E-Mail** column in the reporting tree worksheet. Only those users and groups who have been granted access can view the report detail for the secured reporting units in the resulting FRx reports.

**To secure reporting tree units**

1. Open a reporting tree in Report Designer.
2. Select the reporting unit to secure in the graphical reporting tree or select the reporting unit row in the worksheet.
   
   The selected reporting unit row is highlighted. This helps you follow the row as you scroll right to display column P.
3. Double-click the **Security/E-Mail** cell (column P) in the selected row to open the **Tree Security and E-mail** dialog box.
Select from the following options:

<table>
<thead>
<tr>
<th>To grant access to</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Specific FRx users       | 1 Click FRx Users to open the **Select a User** dialog box.  
2 Select the user ID and user name row from the list.  
3 Click **OK** to add the selected user to the Access Granted list.  
4 Repeat steps 1 to 4 to add other users. |
| Members of FRx groups    | 1 Click FRx Groups to open the **Select Group** dialog box.  
2 Select the group ID and group name row from the list.  
3 Click **OK** to add the selected group to the Access Granted list.  
4 Repeat steps 1 to 4 to add other groups. |

**Note:** You may grant access to both users and groups in the same reporting unit **Security/E-Mail** cell.

To remove a user (or group) from the **Access Granted** list, do the following:

<table>
<thead>
<tr>
<th>To remove</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Specific users (or group)     | 1 In the **Access Granted** list box, select the user e-mail address to remove.  
2 Click **Remove**.                                                                                                                   |
| *All* users and clear the entire list | **Click Remove All.**                                                                                                                                                                                      |

6 Click **OK**.

7 On the Reporting Tree **File** menu, click **Save** to save the tree.
From the Catalog of Reports window, you combine your row format, column layout, and reporting tree building blocks to create a report. In this window, you give the new report a catalog ID name; fine-tune its formatting; and then view, print, or export it as a file that can be read by Microsoft® Excel or Lotus 1-2-3.

This chapter explains:

- Each option and tab in the Catalog of Reports window.
- How to create, generate, chain, and clone reports.
Catalog of Reports Window

When you open the Catalog of Reports, the Catalog of Reports window displays as shown in Figure 7-1.

![Catalog of Reports Window](image)

Figure 7-1: Catalog of Reports Window

The main elements of the Catalog of Reports window are:

- Catalog of Reports Menu Bar
- Catalog of Reports Toolbar
- Catalog Identification
- Tabs for Building and Formatting Reports
Catalog of Reports Menu Bar

The Catalog of Reports includes the following menus with unique Catalog of Report functions:

- File Menu
- Edit Menu
- Catalog Menu
- Window Menu

File Menu

The Catalog of Reports File menu includes the typical windows options as well as page and print setup and report generation selections as shown in Figure 7-2.

![Figure 7-2: Catalog of Reports File Menu](image)

The File menu contains the following report-specific commands.

<table>
<thead>
<tr>
<th>File Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Setup...</td>
<td>Changes the page setup of your report.</td>
</tr>
<tr>
<td>Generate...</td>
<td>Generates your reports and sets or changes your default report output. See “Generating a Report” on page 277.</td>
</tr>
<tr>
<td>Print Catalog... (Ctrl+P)</td>
<td>Prints selected catalog information. See “Printing Catalog Information” on page 280.</td>
</tr>
</tbody>
</table>

Table 7-1: Catalog of Reports File Menu Commands
### Edit Menu

The Catalog of Reports **Edit** menu, shown in Figure 7-3, allows you to edit the building blocks of your report: the row format, column layout, and reporting tree.

![Figure 7-3: Catalog of Reports Edit Menu](image)

**Note** Cut, Copy, Paste, and Clear are not available from the **Edit** menu when the Catalog of Reports is open.

The Catalog of Reports **Edit** menu contains the following commands.

<table>
<thead>
<tr>
<th>Edit Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font Styles...</strong></td>
<td>Applies different font styles and shading to your report. You can apply fonts globally or to a specific row, column, or report heading. With the variety of font options available, you can create customized reports to present your financial data with style. See “Font Styles” on page 260.</td>
</tr>
<tr>
<td><strong>Row Format</strong></td>
<td>Opens the row format used for the open catalog ID.</td>
</tr>
<tr>
<td><strong>Column Layout</strong></td>
<td>Opens the column layout used for the open catalog ID.</td>
</tr>
<tr>
<td><strong>Reporting Tree</strong></td>
<td>Opens the reporting tree used for the open catalog ID.</td>
</tr>
<tr>
<td><strong>Zoom...</strong> (F3)</td>
<td>Displays the <strong>Select Catalog for Display</strong> dialog box, and a list of Catalog IDs to select from.</td>
</tr>
</tbody>
</table>

*Table 7-2: Catalog of Reports Edit Menu Commands*

### Catalog Menu

The **Catalog** menu, as shown in Figure 7-4, corresponds to the tab options in the Catalog of Reports window that you use to build and format your reports.

![Figure 7-4: Catalog of Reports Catalog Menu](image)
The **Catalog** menu allows you to display and access the following tabs and menu selections in the Catalog of Reports window.

<table>
<thead>
<tr>
<th>Catalog Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Building Blocks</strong></td>
<td>Displays the <strong>Building Block</strong> tab.</td>
</tr>
</tbody>
</table>
| **Output**, and then click **Output Options**. | Displays the commands:  
- **Output Options** to display options for the report output.  
- **E-mail** to display the **E-mail Options** tab.  
- **Web Publishing** to display the **Web Publishing** tab. |
| **Schedules** | Displays the **Scheduler** dialog box.  
This command is only available if the FRx® Report Server is available and running. |
| **Page Options** | Displays the commands:  
- **Page Setup** to display the **Page Setup** tab.  
- **Headers/Footers** to display the **Headers / Footers** tab. |
| **Report Options** | Displays the commands:  
- **Formatting** to display the **Formatting** tab.  
- **Account/Transaction Detail**... to display the **Acct/Trans** tab.  
- **Tree Options** to display the **Tree Options** tab.  
- **Advanced** to display the **Advanced** tab.  
- **Currency Translation** to display the **Currency Translation** tab. |
| **Use Defaults** | Replaces the settings with the catalog ID’s default settings |

**Table 7-3: Catalog Menu Commands**

**Window Menu**

The Catalog of Reports **Window** menu, as shown in Figure 7-5, allows you to access the Report Server and Scheduler.

![Figure 7-5: Catalog of Reports Window Menu](image-url)
The **Window** menu includes the following commands in the Catalog of Reports.

<table>
<thead>
<tr>
<th>Window Menu Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Report Server Status** | Displays the **Report Server Status** dialog box where you can check the status of a report.  
For additional information on this dialog box, see your *FRx® Report Server 6.7 User’s Guide*.  
**Note:** This option is unavailable (dimmed) if you have not purchased or installed this software component. |
| **Scheduler** | Displays the **Scheduler** dialog box where you can check the status of a report’s schedule.  
For more information on this command, see your *FRx® Report Server 6.7 User’s Guide*.  
**Note:** This option is unavailable (dimmed) if you have not purchased or installed the Report Server application component. |

Table 7-4: Window Menu Commands
Catalog of Reports Toolbar

The Catalog of Reports window displays some additional buttons not located on the main toolbar. For main toolbar button descriptions, see “The Toolbar” on page 13 of this guide.

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Opens the row format that is associated with the currently displayed Catalog ID. For more information, see “Edit Menu” on page 226.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Opens the column layout that is associated with the currently displayed Catalog ID. For more information, see “Edit Menu” on page 226.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Opens the reporting tree that is associated with the currently displayed Catalog ID. For more information, see “Edit Menu” on page 226.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Opens the row format, column layout, and reporting tree that are associated with the currently displayed Catalog ID.</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Opens FRx® DrillDown Viewer™ if a report has already been generated to DrillDown Viewer for the currently displayed Catalog ID.</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Opens Report Scheduler only if you installed Report Server. <strong>Note:</strong> Scheduler is a Report Server feature. This option is unavailable (dimmed) if you have not purchased or installed the Report Server software component.</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Generates the selected report. If you installed Report Server, FRx sends your report to the Report Server queue by default. If Report Server is not installed, all reports process locally on your workstation. For more information on Report Server, see your FRx® Report Server 6.7 User’s Guide. To set the default or change the report processing location, from the File menu, choose Generate... and in the Generate Report dialog box, set the default value. <strong>Note:</strong> When you generate a report for one of the sample companies (Fabrikam Works, Inc. or Fabrikam Works Canada), FRx processes the report locally by default.</td>
</tr>
</tbody>
</table>

Table 7-5: Catalog of Reports Toolbar Selections

---

**Note** For main toolbar button descriptions, see “The Toolbar” on page 13 of this guide.
Catalog Identification

Use the Catalog of Reports window to identify, date, build, and format your reports.

The top portion of the Catalog of Reports window is used for report identification, periods, and dates.

This section contains information and instructions on:

- Identifying a New Report
- Specifying Report Periods and Dates
- Tabs for Building and Formatting Reports

Identifying a New Report

The top portion of the Catalog of Reports window is used for report identification. The following list describes the catalog and company options you use to identify a report.

- **Catalog ID**
  Use to create a unique Catalog ID name.

- **Catalog ID Description**
  Use for a catalog description.

- **Company**
  FRx uses the accounting calendar information (fiscal year and periods) from the company you select to generate a report. If you select the company code `@ANY`, FRx uses the current default company.

For more information on creating a new company, see your FRx® Report Designer 6.7 Administrator’s Guide.
To identify a new report

1. Open the Catalog of Reports window.

2. In the Catalog ID box, type a unique Catalog ID name, up to 16 characters in length.  
   **Caution:** FRx does *not* recognize the following symbols as valid Catalog ID characters: ' " | / \ : ? * < > .

3. In the Catalog ID Description box type a catalog description, which can be up to 50 characters in length.

4. In the Company box, use your default company or select a different company from the drop-down list and click OK.
   **Note:** If you choose the @ANY Company, the report runs for the default company or the companies identified in the associated reporting tree.

5. The Company Description box automatically displays a description based on your company selection.
From the **Detail Level** drop-down list box, select one of the following report detail levels:

<table>
<thead>
<tr>
<th>To</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a high-level summary report</td>
<td><strong>Financial Report</strong></td>
</tr>
<tr>
<td>Create a report that contains only account detail balances</td>
<td><strong>Account Only</strong></td>
</tr>
<tr>
<td>Create a report that contains a high-level summary as well as</td>
<td><strong>Financial &amp; Account</strong></td>
</tr>
<tr>
<td>account details</td>
<td></td>
</tr>
<tr>
<td>Create a report that contains only transaction details</td>
<td><strong>Transaction Only</strong></td>
</tr>
<tr>
<td>Create a report that contains a high-level summary as well as</td>
<td><strong>Financial &amp; Transaction</strong></td>
</tr>
<tr>
<td>transaction details</td>
<td></td>
</tr>
<tr>
<td>To view and drill into the Account detail information</td>
<td><strong>Account Only or Financial &amp; Account</strong></td>
</tr>
<tr>
<td>To view transaction details or both account and transaction</td>
<td><strong>Transaction Only or Financial &amp; Transaction</strong></td>
</tr>
<tr>
<td>detail</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** When you print a report, the difference between an **Account Only** report and a **Financial & Account** report becomes significant. If you select the **Financial & Account** detail level, FRx prints both a summary financial report and an account detail report. When you select the **Account Only** detail level, only the account detail report prints.
7 From the **Provisional** drop-down list box, select one of the following balance options to include in your report:

<table>
<thead>
<tr>
<th>To</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include only transactions and balances posted in your general ledger</td>
<td><strong>Use Posted Balances Only</strong></td>
</tr>
<tr>
<td>Include all transactions and balances entered and posted in your general ledger</td>
<td><strong>Provisional: Posted + Unposted Activity</strong></td>
</tr>
<tr>
<td>Include only transactions entered but not yet posted in your general ledger</td>
<td><strong>Include Unposted Activity Only</strong></td>
</tr>
</tbody>
</table>

**Note:** FRx can create reports based on posted balances or reports that include amounts from unposted balances for creating provisional (pro-forma) reports.

### Specifying Report Periods and Dates

Use the **Periods and Dates** box shown in Figure 7-7 to indicate the base period, base year, and date for your report.

![Figure 7-7: Periods and Dates](image)

The following period and date selections are available to you:

- **Base Period**
  
  Changes to the base period are not saved with the catalog ID. To save the base period, you must assign a default base period in the **Default Base Period** box. The **Default Base Period** box determines the initial setting in the **Base Period** box.

  Although you can hard code period numbers in the column layout, a column layout typically refers to the base period that you set here. Usually in the column layout, you set the period relative to the base period and then define that specific period here in the Catalog of Reports. If you choose to enter a specific period number in the column layout, that number overrides this base period setting.

- **Base Year**
  
  Enter the fiscal year that you want the report to use. You can save a base period and year with the report. For more information, see “**Default Base Period**” on page 234.
Chapter 7: Understanding the Catalog of Reports–Catalog Identification

- **Rebuild FRx GL Indexes**
  Select this check box to rebuild the local GL index before processing the report.

- **Period Covered**
  This box automatically combines the Base Period in text form with the **Period Description** or **Plural Description** (used for multiple periods) from the **Company Information** dialog box. For more information on the **Company Information** settings, see your FRx® Report Designer 6.7 Administrator’s Guide.

  You can manually edit this text as needed; however, your changes are not saved when you save your report.

  The description in this box appears in the report headers by default. Use the @TXTPER and @TXTP+D codes in the **Headers / Footers** tab to include the **Period Covered** description in your report. For more information about using period descriptions in the headers and footers, see the Headers / Footers Tab on page 258.

- **Report Date**
  This description changes based on your previous report date selections. This description appears in the report headers by default.

  This description is used in the @TXTDATE and @TXTP+D codes in the **Headers / Footers** tab. For more information about using report dates in the headers and footers, see the Headers / Footers Tab on page 258.

- **Default Base Period**
  This setting determines the initial settings for the **Base Year** and **Base Period**. This is the only setting that is saved with the catalog ID. To change a setting, click the **Default Base Period** box and select one of the following from the list:

<table>
<thead>
<tr>
<th>Default Period List</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sys</td>
<td>Defines the base period as the current system period</td>
</tr>
<tr>
<td></td>
<td>FRx uses the computer’s <strong>Regional Settings</strong> to determine the current system date and then applies this date to the accounting system’s current period settings to define the current system period. For example, if the current system date is 8/21/00 and there are 12 monthly periods in the accounting system, the current system period ends on 8/31/00.</td>
</tr>
<tr>
<td>S-1</td>
<td>Defines the base period as one period before the current system period</td>
</tr>
<tr>
<td></td>
<td>S-2 Defines the base period as two periods before the current system period</td>
</tr>
<tr>
<td>S+1</td>
<td>Define the base period as one period after the current system period</td>
</tr>
</tbody>
</table>

  **Table 7-6: Selections for Default Base Period**
### Default Period List

<table>
<thead>
<tr>
<th>Default Period List</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUR</td>
<td>Defines the base period as the current processing period as defined in the general ledger</td>
</tr>
<tr>
<td>C-1</td>
<td>Defines the base period as one period prior to the current general ledger period</td>
</tr>
<tr>
<td>C-2</td>
<td>Defines the base period as two periods prior to the current general ledger period</td>
</tr>
<tr>
<td>C+1</td>
<td>Defines the base period as one period after the current general ledger period</td>
</tr>
<tr>
<td>01</td>
<td>To hard code a specific period number</td>
</tr>
</tbody>
</table>

Table 7-6: Selections for Default Base Period (Continued)

### To identify report periods and dates

1. Click the arrow to the right of the **Report Date** box to display the **Periods and Dates** dialog box.

2. In the **Base Period** box, type the fiscal base period number for the report to use. To save a base period and year with the report, see the **Default Base Period** on page 234, which discusses the Default Base Period settings.

3. Select the **Rebuild FRx GL Indexes** check box to rebuild the local GL index before processing the report.

4. In the **Period Covered** box, edit the text as needed.

5. In the **Report Date** box, edit the text as needed.

6. To change the Default Base Period, click the **Default Base Period** box and select one from the list.
   
   To edit these codes, select a code and change the period number to reflect the appropriate base period. For example, to specify the base period as five periods prior to the current general ledger period, click the **Default Base Period** arrow, select **C-1**, and manually change the setting to **C-5**.

7. Click **OK** to populate the **Report Date** box in the Catalog of Reports window. FRx calculates a date using the information you entered in the **Periods and Dates** dialog box.
Tabs for Building and Formatting Reports

The tabs in the Catalog of Reports window contains options that build and format your reports. Some Catalog of Reports subtabs, such as Web Publishing and Currency Translation, are only available if your FRx installation includes these separately licensed functions. Your FRx windows could vary somewhat from the complete set of examples and descriptions included in this guide.

The following table describes each main tab and associated subtab available from the Catalog of Reports window.

<table>
<thead>
<tr>
<th>Main Tab</th>
<th>Subtab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building Blocks</td>
<td>None</td>
</tr>
<tr>
<td>Output</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Output Options</strong>—Use this tab to specify the type of report output. For example, you could print the report or export it as a Microsoft Excel file.</td>
</tr>
<tr>
<td></td>
<td><strong>E-mail Options</strong>—Use this tab to indicate the distribution list and file distribution method for automatically e-mailing reports.</td>
</tr>
<tr>
<td></td>
<td><strong>Web Publishing</strong>—Authorized users can use this tab to send the report to the FRx® WebPort.</td>
</tr>
<tr>
<td>Page Options</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Page Setup</strong>—Use this tab to specify your report page layout.</td>
</tr>
<tr>
<td></td>
<td><strong>Headers / Footers</strong> tabs—Use this tab to specify your report headers and footers.</td>
</tr>
<tr>
<td>Report Options</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Formatting</strong>—Use this tab to control rounding and formatting of amounts at the report level.</td>
</tr>
<tr>
<td></td>
<td><strong>Acct/Tran Detail</strong>—Use this tab to select options for displaying account and transaction details in reports.</td>
</tr>
<tr>
<td></td>
<td><strong>Tree Options</strong>—Use this tab to specify the reporting units included in a report.</td>
</tr>
<tr>
<td></td>
<td><strong>Advanced</strong>—Use this tab to set roll up basis, calculation and processing priority, and exception reporting for a report.</td>
</tr>
<tr>
<td></td>
<td><strong>Currency Translation</strong>—Use this tab to establish conversion options for currency reporting.</td>
</tr>
</tbody>
</table>

Table 7-7: Tabs for Building and Formatting Reports
Building Blocks Tab

Use the row format, column layout, and reporting tree options under the **Building Blocks** tab to build your report.

This section contains information and instructions on:

- Selecting Row Formats
- Selecting Column Layouts
- Selecting a Reporting Tree

**Selecting Row Formats**

**Row Format Options**

Use the following options for the row format:

- **Row Format**
  
  Use to select a row format for your report. For more information on row formats, see Chapter 3, “Creating Row Formats.”

- **Effective Dates**
  
  This option changes the report presentation based on a specific point in time. To assign multiple row formats to the report tied to an effective date or report period, select this option. When the report is generated, FRx selects the row format using the **Report Date** information.
Use Row Format(s) and Worksheet Links from Reporting Tree

If in the reporting tree you specify the row formats or worksheets for your report to use, select this option. If you do not select this check box, FRx uses the row format selected previously in the Row Format box for every unit in the reporting tree.

**Note:** If you select this option and every reporting unit does not reference a row format, then FRx uses the identified row format (that appears dimmed in the Row Format box) for those units by default.

For more information on reporting trees and assigning row formats and worksheets in the reporting tree, see “Understanding Building Reporting Trees Manually” on page 203.

**To select a row format**

1. Click the arrow to the right of the **Row Format** box to display the **Choose a Row Format** dialog box.

2. Select a row format and click **OK** to return to the **Catalog of Reports** window.

   The **Row Format** list box automatically displays a Description

3. Then, click the **Effective Dates** check box, located on the right side of the **Row Format Description**, to display the **Effective Dates** dialog box.
4 In the **Effective Dates** dialog box, select one of the following:
   - **Use Period Numbers** to make a row format effective as of a selected period.
   - **Use Dates** to make a row format effective as of a selected date.

5 Double-click the **Format Name** box to display the **Choose a Row Format** dialog box.

6 Select a row format and click **OK**.

7 Double-click the **Date Period** or **Starting Date** box, and enter the period number or date for the selected row format.
   The row format goes into effect as of the date or period you select.

8 Repeat steps 5-7 for each row format that you want to include.

   **Note:** If you run the report for a period or date that is not covered in the **Effective Dates** list, the report will run using the row format that was originally selected (displayed as dimmed in the Row Format box).

9 Click **OK** to return the Catalog of Reports window.

### Selecting Column Layouts

#### Column Layout Options

Use the following options for the column layout:

- **Column Layout**
  Use to select a column layout for your report. For more information on column layouts, see Chapter 5, “Creating Column Layouts.”

- **Effective Dates**
  This option changes the report presentation based on a specific point in time. To assign multiple column layouts to the report tied to an effective date or report period, select this option. When the report is generated, FRx selects the column layout using the **Report Date** information.

### To select a column layout

1 Click the arrow to the right of the **Column Layout** box to display the **Choose a Column Layout** dialog box.

2 In the **Choose a Column Layout** dialog box, select a column layout and click **OK**.
   The **Column Layout** list box automatically displays a description.
3 Then, select the **Effective Dates check box**, located on the right side of the Column Layout Description, to display the **Effective Dates** dialog box.

4 In the **Effective Dates** dialog box, select one of the following:
   - **Use Period Numbers** to make a row format effective as of a selected period.
   - **Use Dates** to make a row format effective as of a selected date.

5 Double-click the **Format Name** box to display the **Choose a Column Layout** dialog box.

6 Select a column layout and click **OK**.

7 Double-click the **Date Period** or **Starting Date** box, and enter the period number or date for the selected row format.
   The row format goes into effect as of the date or period you select.

8 Repeat steps 5-7 for each column layout that you want to include.

   **Note:** If you run the report for a period or date that is not covered in the **Effective Dates** list, the report will run using the row format that was originally selected (displayed as dimmed in the Row Format box).

9 Click **OK** to return the Catalog of Reports window.

**Selecting a Reporting Tree**

**Reporting Tree Options**

Use the Reporting Tree options to include a reporting tree in your report. However, you do not need a reporting tree to create a report. If you decide not to use a reporting tree, the row format of your report must use natural account segments, full account codes, or some combination thereof.

Use the following options for the reporting tree:

- **Reporting Tree**
  Select to include a reporting tree in your report. For more information on reporting trees, see Chapter 6, “Creating a Reporting Tree.”
Chapter 7: Understanding the Catalog of Reports–Building Blocks Tab

- **Effective Dates**
  Use the Effective Dates option to change the report presentation based on a specific point in time. To assign multiple reporting trees to the report tied to an effective date or report period, select this option. When the report is generated, FRx selects the reporting tree using the **Report Date** information.

- **Starting Unit**
  The Starting Unit option for reporting trees allows you to select the levels down from the starting unit in the Tree Options tab.

  **Note:** Selecting the **Starting Unit** limits which branches of the tree appear when you generate the report. To run the report for the entire tree, click **None** in the **Units for Tree** selection box to remove this **Starting Unit**.

**To select a reporting tree**

1. Select the **Use Reporting Tree** check box.
2. Click the **Reporting Tree** arrow to display the **Choose a Reporting Tree** dialog box.

   ![Choose a Reporting Tree](image)

3. In the **Choose a Reporting Tree** dialog box, select a reporting tree and click **OK**. The **Reporting Tree** list box automatically displays a description.
4. Then, select the **Effective Dates check box**, located on the right side of the Reporting Tree Description box, to display the **Effective Dates** dialog box.
5 In the **Effective Dates** dialog box, select one of the following:
   - **Use Period Numbers** to make a row format effective as of a selected period.
   - **Use Dates** to make a row format effective as of a selected date.

6 Double-click the **Format Name** box to display the **Choose a Reporting Tree** dialog box.

7 Select a reporting tree and click **OK**.

8 Double-click the **Date Period** or **Starting Date** box, and enter the period number or date for the selected row format.
   The row format goes into effect as of the date or period you select.

9 Repeat steps 6-8 for each reporting tree that you want to include.

10 Click **OK** to return to the Catalog of Reports window.

11 To specify a starting unit, click the **Starting Unit** arrow to display the **Units for Tree** dialog box.

12 In the **Units for Tree** dialog box, select the starting reporting unit and click **OK**.

   **Note:** Leave this box blank to generate the entire reporting tree. For more information on the **Tree Options** tab, see “Tree Options Tab” on page 269.
Output Tab

Use the **Output** tab to change your report output. Within the **Output** tab are three subtabs, the **Output Options** tab, the **E-mail Options** tab, and the **Web Publishing** tab. Use these tabs to change your report output, to specify e-mail options, or to publish a report to a Web repository.

![Output Options Tab in the Catalog of Reports](image)

This section contains information and instructions on:

- Selecting Report Output Options
- E-mailing Reports
- Publishing Reports to the Web
Selecting Report Output Options

Use the **Output Options** tab to select the following specific report output options and settings:

**Report Output Options**

Use to select a report output method.

To select your report output method, use the **Output** drop-down list shown in Figure 7-10.

![Output Options List](image)

Figure 7-10: Output Options List

The descriptions and usages of these options are described below.

- **Printer**
  Use to print a report to your default printer.

- **FRx DrillDown Viewer (Enhanced XML)**
  Use this default setting to send a report to the DrillDown Viewer for viewing on a computer running Microsoft® Windows® 2000 and Windows XP. When you select this option, FRx saves this file with an .frd extension by default. (The default path where FRx stores the file is determined by the **Import/Export Path** selected in the **Company Information** dialog box.)

  When you open the file in the DrillDown Viewer, you can view your report on screen, print it, export it to other applications, send it via e-mail, and save it with another name. For more information on the DrillDown Viewer, see your **FRx® DrillDown Viewer™ and FRx® Report Launcher 6.7 User’s Guide**.

- **HTML (Via Excel 2000)**
  This option produces report output as an HTML file. When you select this option, FRx saves the file with an .htm extension. If you do not have the Excel 2000 application on your workstation, FRx will display an error message.

  When you use this option, you must select the **Activate Browser** option under **HTML Options** to view the generated HTML report in a Web browser immediately.

- **XML**
  Use this option to export the report as an XML file. The output file is in the standard XML format and can be imported into other XML-compatible applications or displayed in a Web browser.

- **XBRL**
  Use this option to generate XBRL instance documents that include XBRL elements and syntax. XBRL output requires the row format to include XBRL Element Tags applied to **GL Link**, **CAL**, and **TOT** rows. Only the rows that are tagged with an XBRL Element tag will be passed into the instance document.
Excel 5 or above (via OLE)

Excel 5 or above (via OLE) is a feature that allows you to export your report to a Microsoft Excel 5 workbook via OLE. To use this feature, you must have Microsoft Excel 5.0 (or later) installed on your workstation or on Report Server (if you queue the report for processing). When you select this option, the following options display on the Output Options tab.

These options are described in the following table.

<table>
<thead>
<tr>
<th>Excel OLE Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Workbook</td>
<td>Use this option to open a Microsoft Excel workbook after generating a report. If you do not select this option, your report is saved as an .xls file and Microsoft Excel does not open automatically.</td>
</tr>
<tr>
<td>Format as Excel Outline</td>
<td>If you generate an account or transaction detail report, you can use Excel’s built-in outline control to allow the user to hide or show row details. Select this check box to enable this feature.</td>
</tr>
<tr>
<td>Password</td>
<td>To assign a password to your Microsoft Excel (.xls) file, and protect it from unauthorized access, type a password in this box.</td>
</tr>
<tr>
<td>Print Headings</td>
<td>Use to include your defined column and report headings in the worksheet file</td>
</tr>
<tr>
<td>Print Format Rows</td>
<td>Use to include your defined format rows (DES, LFT, RGT, and CEN rows) in the worksheet file. If you do not select this option, only amount rows export to the worksheet.</td>
</tr>
<tr>
<td>Print Underscore Rows</td>
<td>To include underscore (and double underscore) rows in the worksheet files</td>
</tr>
<tr>
<td>Export Formulas</td>
<td>Use this option only with worksheets to export formulas from the row format (TOT) and column layout to the worksheet.</td>
</tr>
</tbody>
</table>

Table 7-8: Formatted Excel Output Options
Chapter 7: Understanding the Catalog of Reports–Output Tab

- **Worksheet Options**
  The following Excel and Lotus output options are available from the **Output Options** tab:
  
  - **Export to Lotus (WK1)** to export your report to a Lotus 1-2-3 WK1 file.
  - **Export to Excel (XLS)** to export your report to a Microsoft Excel XLS file. This file can then be read (without custom fonts) by any version of Microsoft Excel.

  When you select one of these worksheet options, the following output options display on the **Output Options** tab.

  ![Worksheet Options](image)

  These options are described in the following table.

<table>
<thead>
<tr>
<th>Worksheet Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Headings</td>
<td>Use to include your defined column and report headings in the worksheet file</td>
</tr>
<tr>
<td>Print Format Rows</td>
<td>Use to include your defined format rows (DES, LFT, RGT, and CEN rows) in the worksheet file. If you do not select this option, only amount rows export to the worksheet.</td>
</tr>
<tr>
<td>Print Underscore Rows</td>
<td>To include underscore (and double underscore) rows in the worksheet files</td>
</tr>
<tr>
<td>Export Formulas</td>
<td>Use this option only with worksheets to export formulas from the row format (TOT) and column layout to the worksheet.</td>
</tr>
</tbody>
</table>

  Table 7-9: Worksheet Format Options

- **ASCII Options**
  The following ASCII output options are available from the **Output Options** tab:
  
  - **Export to ASCII (Comma Delimited)** to export your report to a comma-delimited ASCII text file.
  - **Export to ASCII (Formatted Text)** to export your report to an ASCII formatted text file. This output type displays your data in aligned columns, separated by
spaces. Use this option to display reports on non-Windows computers and terminals.

When you select one of these ASCII options, the following output options display on the **Output Options** tab.

<table>
<thead>
<tr>
<th>ASCII Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum Lines per Page</strong></td>
<td>Use only with the ASCII Formatted Text to determine the number of report lines to print per page. (The ASCII Comma Delimited option creates a continuous report without page breaks, and this option becomes unavailable or dimmed.)</td>
</tr>
<tr>
<td><strong>Print Headings</strong></td>
<td>Use to include your defined column and report headings in the worksheet file</td>
</tr>
<tr>
<td><strong>Print Format Rows</strong></td>
<td>Use to include your defined format rows (DES, LFT, RGT, and CEN rows) in the worksheet file. If you do not select this option, only amount rows export to the worksheet.</td>
</tr>
<tr>
<td><strong>Print Underscore Rows</strong></td>
<td>To include underscore (and double underscore) rows in the worksheet files</td>
</tr>
</tbody>
</table>

**Table 7-10: ASCII Format Options**

- **FRx instant!OLAP – Microsoft Server Cube Options**

  **Note** Only Administrators (users who are included in the OLAP Administrator group in the NT server) are authorized to select the **FRx instant!OLAP Microsoft Server Cube** option.
When you select this option, the following selections display under the **Output Options** tab, on the right side of the screen.

A description of these OLAP cube selections are listed in the following table.

<table>
<thead>
<tr>
<th>Microsoft Server Cube Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cube Name</td>
<td>Type the name of the FRx instant!OLAP cube file on the server.</td>
</tr>
<tr>
<td>Cube Description</td>
<td>Displays the OLAP cube description.</td>
</tr>
<tr>
<td>Use integrated NT Security</td>
<td>Use this option to use your NT network User ID and password. If you use the Integrated NT Security option, you do not need to use the User ID and Password boxes in the <strong>FRx instant!OLAP – Microsoft Server Cube Settings</strong>.</td>
</tr>
<tr>
<td>UserID</td>
<td>If you did not select the <strong>Use integrated NT Security</strong> option, type your login user ID to the OLAP cube server in this box.</td>
</tr>
<tr>
<td>Password</td>
<td>If you did not select the <strong>Use integrated NT Security</strong> option, type your login Password to the OLAP cube server in this box.</td>
</tr>
<tr>
<td>Cube Server</td>
<td>Type or select the name of the server where the OLAP cube is located.</td>
</tr>
<tr>
<td>Cube Database</td>
<td>Type or select the name of the OLAP cube database</td>
</tr>
<tr>
<td>Fact Server</td>
<td>Type or select the name of the server where the OLAP cube FACT tables are located.</td>
</tr>
</tbody>
</table>

**Note:** FACT tables are the relational representation of the XML-based report files. They are an interim compilation of the report data that supports the OLAP cube generation. For server-based cubes, the FACT tables are kept permanently in a user-defined SQL Server/Database location.

*Table 7-11: FRx instant!OLAP Microsoft Server Cube Settings*
When you select this option, the following selections display under the Output Options tab, on the right side of the screen.

A description of these selections are listed in the following table.

<table>
<thead>
<tr>
<th>Microsoft Local Cube Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cube Name</td>
<td>Type the name of the OLAP cube file.</td>
</tr>
<tr>
<td>Cube Description</td>
<td>Type the OLAP cube description.</td>
</tr>
</tbody>
</table>

Table 7-12: Microsoft Local Cube Options

- **Excel Pivot Chart**

When you select this option, the following selections display under the Output Options tab, on the right side of the screen.
A description of these selections are listed in the following table.

<table>
<thead>
<tr>
<th>Excel Pivot Chart Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cube Name</td>
<td>Type the name of the Excel Pivot Chart cube file.</td>
</tr>
<tr>
<td>Cube Description</td>
<td>Type the Excel Pivot Chart cube description.</td>
</tr>
</tbody>
</table>

Table 7-13: Excel Pivot Chart Options

- **Excel Pivot Table**

  When you select this option, the following selections display under the **Output Options** tab, on the right side of the screen.

  ![Excel Pivot Chart Options](image)

  A description of these selections are listed in the following table.

<table>
<thead>
<tr>
<th>Excel Pivot Table Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cube Name</td>
<td>Type the name of the Excel Pivot Table cube file.</td>
</tr>
<tr>
<td>Cube Description</td>
<td>Type the Excel Pivot Table cube description.</td>
</tr>
</tbody>
</table>

Table 7-14: Excel Pivot Table Options

**File Name**

The **File Name** list box displays the report file name. To change the file name or path, select a file name from the drop-down box. Using the **Output File Name** dialog box, you can select a different drive, directory, and file name for the report.

If you do **not** select a path, the file saves to the **Import/Export Path** that you selected in the **Company Information** dialog box.

The **File Name** box is dimmed if you select **Printer** from the **Output** box.

**Note:** When you select the **Send as Link to File** option from the **E-mail** tab, you must specify a shared network directory or use Uniform Naming Conventions (UNC); for example: \computer name\share name\directory name\file name.
Replace File Without Warning
When you save a new report with the same name as an existing file, a warning message appears informing you that the file already exists. To disable this warning message and have FRx automatically overwrite the existing file, select this option.

Prompt for Output Type at Run Time
If you want to receive a prompt to select the report output method before generating the report, select this check box.

Delete File After Printing/Viewing/Sending
To automatically delete the FRx report file after printing, viewing, or sending it, select this check box. This option is helpful if security or disk space is a concern. If you do not select this option, the output file remains on the disk for subsequent viewing, printing, or sending.

Print Immediately
To generate your report using the selected output method and send it directly to your default printer, select this check box. This box appears dimmed if you select Printer from the Output box.

Chain to Catalog ID
To automatically run another report whenever the current report is generated, select the catalog ID here. To do this, click the Chain to Catalog ID arrow. In the Select Catalog for Display dialog box, select the catalog ID to run after this one and click OK. You can chain many reports together using this feature.

For more information on chaining reports, see “Chaining Your Reports” on page 281.

Restart Page Numbering
To use individual report page numbering for each chained report, select this check box. For example, if Report A has page numbers 1 through 5 and Report B has page numbers 1 through 8, this option retains each report’s page numbering. If you do not select this option, the page numbers would be 1 through 5 for Report A and pages 6 through 13 for Report B.

Printing Reports
If the Report Server application is installed, this release of Report Designer lets you select a local printer or a server printer from the Catalog of Reports. This feature gives you more flexibility when you print reports. Local printer selections apply to the current Report Designer session. Valid server printer settings remain in effect until you change the settings to another valid server printer.

When Report Server is installed, and you select Printer as the output option from the Catalog of Reports, Report Designer dynamically displays a Define Printers button on the Output Options tab.

Note
If Report Server is not installed and you are generating reports locally, on the File menu click Print, and select a valid printer from the Print dialog box.
For other output options, such as the default **DrillDown Viewer (Enhanced XML)** option, Report Designer dynamically displays a **Select Printer** button when you select the **Print Immediately** check box.

**Note** When **Printer** is selected as the output option, the **Print Immediately** check box is disabled (dimmed).

This section includes information and instructions on:

- Selecting a Printer from the Catalog of Reports Output Options
- Selecting a Printer from the Print Immediately Option

**Selecting a Printer from the Catalog of Reports Output Options**

To select a printer from the Catalog of Reports output options

1. Display the report record in the Catalog of Reports.
2. Select the **Output** tab.
3. From the **Output** tab, select the **Output Options** tab.
4. Click the **Output Option** arrow and select **Printer** from the list.
   - If FRx Report Server is installed, the **Define Printers** button appears on the **Output Options** tab.
5. Click **Define Printers** to display the **Printer Selections** dialog box.
6 From the **Printer Selections** dialog box, select one of the following options:

- To select a local printer for the current session, click the **Local Printer Selection** arrow and select a valid, installed, local printer from the list.
- To select a server printer as the default for the report, click the **Server Printer Selection** arrow and select a printer from the list.

**Note:** The Server Printer Selection is saved to the catalog and affects all printer output until a different server printer is selected.

7 Click **OK** to accept the printer selection and close the **Printer Selections** dialog box.

8 Click **Save** to save the report record in the Catalog of Reports.

### Selecting a Printer from the Print Immediately Option

**To select a printer from the Print Immediately option**

1 Display the report record in the Catalog of Reports.

2 Select the **Output** tab.

3 From the **Output** tab, select the **Output Options** tab.

4 Click the **Print Immediately** check box.

**Note:** If you are generating reports locally, the report prints on the default local printer for the workstation.

If FRx Report Server is installed, the **Select Printer** button appears on the **Output Options** tab.

5 Click **Select Printer** to display the **Printer Selections** dialog box.

6 From the **Printer Selections** dialog box, select one of the following options:

- To print immediately to a local printer, click the **Local Printer Selection** arrow and select a printer from the list.
- To print immediately to a server printer, click the **Server Printer Selection** arrow and select a printer from the list.

7 Click **OK** to accept the printer selection and close the **Printer Selections** dialog box.
E-mailing Reports

You can send a report to another person via a MAPI-compliant e-mail system using the E-mail Options tab.

With the FRx e-mail options you can send any type of report output except server-based OLAP cubes.

You can enter e-mail recipients in the Reporting Tree window, in the Catalog of Reports, or both. You can select a combined catalog and tree e-mail security to send users in the catalog an e-mailed file containing only the units available to them in the tree. Recipients must have the DrillDown Viewer component to view report .frd files.

When you select the E-mail Options tab, E-mail selections displays on the Catalog of Reports window.

These E-mail selections are described below.

Enable E-mail Options

To send a report via e-mail, select this check box. Once you select this option, use one of the following report attachment options:

- **Send as Attachment**
  To attach the report to an e-mail message, select this option. Sending a DrillDown Viewer report file as an attachment automatically selects the Compress XML File check box on the Output Options tab.

- **Send as Link to File**
  When you select Send as Link to File, the report is not attached to the message. Instead a “shortcut” to the file is attached. When the user clicks on the shortcut, the DrillDown Viewer retrieves only the information the user specifically selects from the shared report file. The result is “on-demand paging” that minimizes network traffic. This is especially useful for large reports with many transaction detail records.

  When you select Send as Link to File, you must enter a shared network directory in the File Name box or use the Uniform Naming Convention (UNC); for example: \computer name\share name\directory name\file name.
Chapter 7: Understanding the Catalog of Reports–Output Tab

**Recipients Options**
Select this option to designate that recipients receive certain reports or reporting units. Once you select this option, use one of the following catalog or tree options:

- **Use Catalog**
  To send the entire report to e-mail recipients who are set up in the catalog, select this option

- **Use Tree**
  To send reports containing only the reporting units designated for recipients in the tree, select this option. E-mail recipients must be set up in the reporting tree to make this option available.

- **Combine Catalog and Tree**
  To send reports to those users set up in the catalog, but only the reporting units available to them in the tree, select this option. A recipient must be set up in both the catalog and the tree, or no report will be sent.

**Address**
This box displays the report’s recipients. This information is read from your default e-mail program. Apply any of the following functions to Address recipients:

- **Add**
  To select a name from your e-mail manager system, or to type a new name and e-mail address, click this button.

- **Remove**
  To remove an address from the Address box, click the address you want to remove, and then click this button.

- **Clear**
  To clear all addresses, click this button.

**Subject**
To add a subject title to the e-mail message, type the subject title here.

**Message**
To add a message to the e-mail message, type your message here.

**Publishing Reports to the Web**
The FRx® WebPort lets you store, manage, and render both FRx and non-FRx reports (including Microsoft® Word documents and Excel spreadsheets) for viewing in a Web browser. WebPort interface allows you to both browse reports and drill down into specific reports to the detail available.

There are two ways to add reports to the WebPort. First, authorized FRx users can send report output to the WebPort from Report Designer and from FRx® Report Launcher. Second, FRx Administrators can use the WebPort Administrator function to add, change, or delete reports, folders, and users.

For information about using the WebPort Administrator functions, see the *FRx® WebPort 6.7 User and Administrator’s Guide*. **

---
FRx Report Designer 6.7 User’s Guide   255
If you are authorized to do so in FRx Security, you can send report output to the WebPort from Report Designer Catalog of Reports or from Report Launcher Catalog Run Properties. The **Publish to Web** option is available only for **XML** and **Enhanced XML** output types.

![Web Publishing tab](image)

**Figure 7-12: Catalog of Reports Window: Web Publishing Tab**

Select the **Web Publishing** tab to publish your report to the Web. Use the following options to specify a Web location, folder name, and report name:

- **Web Location**
  To specify the Web location on your server, type the path of the WebPort in this box or click the arrow and browse to select the WebPort repository file (repository.xml).

- **Folder Name**
  To select the folder in the WebPort to which you want to save the report, type the name of the folder in this box. If you type the name of a folder that does not exist, FRx will create the new folder in the WebPort.

- **Report Name**
  To name the report as it will display in the WebPort, type the report name in this box. The Catalog ID is used as the report name, by default.
Page Options Tab

Within the Page Options tab are two sub tabs, the Page Setup tab and the Headers / Footers tab. You can use these tabs to change your report page formatting.

![Figure 7-13: Catalog of Reports Window: Page Setup Tab](image)

Page Setup Tab

The Page Setup tab contains your report page setup options. These options are described below.

### Margins

The Left, Right, Top, and Bottom Margins boxes display the report page margins. The default margin value is .75.

To change the margins, select the margin value and enter the new value.

### Orientation

This section displays the report page orientation. To change the orientation, select one of the following options:

- **Portrait**
  
  Displays the report vertically on the page.

- **Landscape**
  
  Displays the report horizontally on the page

### Scaling

This option displays the percentage of scaling in a report. To change the scaling, select one of the following options:

- **Reduce/Enlarge to**
  
  Changes the report size to the percentage you enter in the % box. The default is 100%.

- **Shrink to Page Width**
  
  Fits the report columns within the width of a single page.

- **Collate**
  
  Collates multiple report copies.
Chapter 7: Understanding the Catalog of Reports–Page Options Tab

- **Copies**
  Indicates the number of report copies to print.

**Default Font Style**

This box displays the default font used in the report. FRx uses this font where you have not selected a specific font in the row format, column layout, or Catalog of Reports headers/footers. To change the default font style, select a font from the **Default Font Style** list.

**Headers / Footers Tab**

From the **Headers / Footers** tab, you define and format the report headers and footers.

**Figure 7-14: Catalog of Reports Window: Headers / Footers Tab**

- **Headers and Footers**
  The following options allow you to add and align headers and footers in your report:
  
  - **Left, Centered, or Right**
    Type text or codes in these cells to right, center, or left-align the information in the header or footer.
  
  - **Center Headers / Footers on Page**
    Center your headers and footers horizontally on the report page. If you do not select this option, your headers and footers center over the report data.
  
  - **Page Headers**
    Use or change the report headings.
  
  - **Page Footers**
    Use or change report footers.

**Codes**

These codes pull variable information into the headers and footers of your report. Use the **Left, Center, or Right** formatting options to define the Code alignment.
Using the following table, select one of the following codes from the drop-down list:

<table>
<thead>
<tr>
<th>Code</th>
<th>FRx includes the information from the...</th>
</tr>
</thead>
<tbody>
<tr>
<td>@COMP</td>
<td>Company Information dialog box, Company Name box</td>
</tr>
<tr>
<td>@TITLE</td>
<td>Reporting Tree window, column D, Title/Description</td>
</tr>
<tr>
<td>@ROW</td>
<td>Row Format description</td>
</tr>
<tr>
<td>@COL</td>
<td>Column Layout description</td>
</tr>
<tr>
<td>@TXTDATE</td>
<td>Periods and Dates dialog box, Report Date box</td>
</tr>
<tr>
<td>@NUMDTE</td>
<td>Catalog of Reports window, Report Date box formatted as mm/dd/yy</td>
</tr>
<tr>
<td>@TXTPER</td>
<td>Periods and Dates dialog box, Period Covered text box</td>
</tr>
<tr>
<td>@TXTP+D</td>
<td>Periods and Dates dialog box, Period Covered and Report Date boxes</td>
</tr>
<tr>
<td>@TXTPER#</td>
<td>Periods and Dates dialog box, Base Period box formatted as text</td>
</tr>
<tr>
<td>@PAGE</td>
<td>Print page number</td>
</tr>
<tr>
<td>@RUNIT</td>
<td>Reporting Tree window, column B, Company and column C, Unit Code</td>
</tr>
<tr>
<td>@PDATE</td>
<td>Current computer system date at processing</td>
</tr>
<tr>
<td>@PTIME</td>
<td>Current computer system time at processing</td>
</tr>
<tr>
<td>@CAT</td>
<td>Catalog of Reports window, Catalog ID box</td>
</tr>
<tr>
<td>@BLANK</td>
<td>To force a blank line</td>
</tr>
<tr>
<td>@CATDESC</td>
<td>Catalog of Reports window, Catalog Description box</td>
</tr>
<tr>
<td>@ROUND</td>
<td>Formatting tab, Rounding of Amounts box</td>
</tr>
<tr>
<td>@FNAME</td>
<td>Output Options, File Name box</td>
</tr>
<tr>
<td>@TREE</td>
<td>To use report header from tree format</td>
</tr>
<tr>
<td>@FILTER</td>
<td>To use an account filter</td>
</tr>
<tr>
<td>@UNITT[#]</td>
<td>Additional Text entry from the reporting tree</td>
</tr>
</tbody>
</table>

Table 7-15: Header/Footer Codes
Font Styles

This option sets font styles for the selected **Headers / Footers** cells. To change the report header or footer font style, select the text. Then, select a font style from the **Font Styles** list.

You can create new font styles or edit existing ones, and then use these styles in your report.

Use this option to create and edit fonts and apply shading to the font used in your report headers and footers.

To create or edit a font style

1. On the **Headers / Footers** tab, click **Edit Font Styles...** or select **Font Styles** from the **Edit** menu to display the **Font Styles** dialog box.

2. Use one of the following font style options:

<table>
<thead>
<tr>
<th>To the font style</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new font style</td>
<td>1. Click <strong>New</strong>.&lt;br&gt;2. In the <strong>Font Style Name</strong> box, enter a name for the new style.</td>
</tr>
<tr>
<td>Edit an existing font style</td>
<td>1. In the <strong>Font Styles</strong> dialog box, select a font.&lt;br&gt;2. Click <strong>Font...</strong> to display the <strong>Font</strong> dialog box.&lt;br&gt;3. Make changes, as necessary, to Font, Font style, Size, Effects, or Color attributes and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Apply a font, font style, or size</td>
<td>1. Click <strong>Font</strong>.&lt;br&gt;2. Make your selections and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Apply shading to the style</td>
<td>1. Click <strong>Shading</strong>.&lt;br&gt;2. Select or define the background color and click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

4. Click **Close**.
Clear

Use the Clear option to clear the **Headers / Footers** text or codes from the **Left, Centered,** or **Right** cells.

**To clear text**
1. Select the text or code to remove.
2. Click **Clear.**

**Report Options Tab**

The **Report Options** tab contains options such as formatting and rounding amounts, formatting detail reports, subtotaling and filtering account detail, formatting reporting trees, generating an exception report, and currency conversion.

To access these options, you use five subtabs under the **Report Options** tab.

![Figure 7-15: Catalog of Reports Window: Reports Option Tab](image)

This section contains information and instructions on the five **Report Options** subtabs including the:

- Formatting Tab
- Acct/Tran Detail Tab
- Tree Options Tab
- Advanced Tab
- Currency Translation Tab

**Formatting Tab**

You control formatting and rounding of amounts at the report level from the Formatting tab.

**General Options**

Use the General Options to display the following formatting options:
- **Use ( ) For Negative Numbers**
  To use parentheses ( ) to indicate negative numbers, select this check box (the default). If you do not select this option, the report indicates negative numbers with a minus sign (-).

- **Display Commas in Amounts**
  To include the thousands separators in currency amounts that you entered in the 1000 Separator box of the International Formats dialog box, select this check box (the default).

- **Use % Signs on Percentages**
  To include a percentage sign (%) in all percentage-related columns, select this check box (the default).

- **Currency Symbol on 1st Row**
  To display a currency symbol in all amount columns on the first row of each page, select this check box (the default). When you select this box, you do not need to enter a CS print control in the first row of your row format. The actual format used is specified in the Amount with Currency Symbol box in the International Formats dialog box.

- **Display Blanks for Zero Amounts**
  To display blank spaces instead of zeros for all zero balances in the entire report, select this check box (the default).

- **Display Rows With No Amounts**
  To display rows with zero balances, select this check box. By default, FRx suppresses rows with zero balances in all amount columns.

- **Display Reports With No Active Rows**
  Select this check box to generate a report for every unit of a reporting tree, even if there are no amounts displayed.

  Empty reports may still display if title rows or other format rows are present. To prevent extraneous titles from printing on a report without amounts, relate each descriptive row to an amount row. For more information on relating rows, see “Relating a Format Row to an Amount Row” on page 82.

- **Allow Column Text Overflow**
  To allow text to overflow to the next empty column, select this check box (the default).

- **Extra Lines Between Rows**
  To change the number of lines that print between your report rows, enter a number here.

- **Spaces Between Columns**
  To change the default number of spaces that print between your report columns, enter that number here.

  You can also enter the number of spaces before a column in the Extra Spaces Before Col cell in the column layout.
Rounding of Amounts

Figure 7-16: Rounding Options in Formatting Tab

The options in this section of the screen allow you to select the level of rounding used in your report, to round row values before totalling a report, and to round the reporting unit values before rolling up into a summary unit.

Rounding

This box displays the type of rounding used in your report. To change the level of rounding used in your report, click the Rounding of Amounts arrow and select from the following options:

<table>
<thead>
<tr>
<th>If you select this option...</th>
<th>$1,117,691,600.48 rounds to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Rounding</td>
<td>$1,117,691,600.48</td>
</tr>
<tr>
<td>Whole Dollars</td>
<td>$1,117,691,600</td>
</tr>
<tr>
<td>Thousands (000.0)</td>
<td>$1,117,691.6</td>
</tr>
<tr>
<td>Whole Thousands (000)</td>
<td>$1,117,692</td>
</tr>
<tr>
<td>Millions</td>
<td>$1,117.7</td>
</tr>
<tr>
<td>Whole Millions</td>
<td>$1,118</td>
</tr>
<tr>
<td>Billions</td>
<td>$1.1</td>
</tr>
<tr>
<td>Whole Billions</td>
<td>$1</td>
</tr>
</tbody>
</table>

Table 7-16: Rounding Options

Although rounding by definition produces rounding differences (or “rounding errors”), you can alter how and when rounding is performed to balance your need for precision and internal integrity of reports. The following two rounding options will cause changes to totals and summary reports. For specific examples of how these options work together, see “Examples of Combining Rounding Options” on page 265.
Use Rounded Values for Calculations and Totals

To round the row values before totaling the report, select this check box (the default setting). If you prefer to perform the calculations and then round the results, clear this check box.

See Table 7-19 on page 266 and Table 7-20 on page 266 for examples of how this option affects your reports.

Roll up Rounded Values in the Tree

If the report uses a reporting tree, select this check box to round the reporting unit values and then roll up the results into the summary unit. To first roll up actual values and then round the results, clear this check box.

When you use this option, every report in your tree totals correctly (foots). However, your summary report totals may not be the same as a similar summary report that does not use a reporting tree.

When you clear this option, every report in your tree foots and there are no rounding differences in the summary unit. However, the individual reporting units may not add up (cross-foot) to the summary total.

Note: Selecting both the Use Rounded Values for Calculations and Totals and the Roll up Rounded Values in the Tree options may result in significant rounding differences.
Examples of Combining Rounding Options

When you round your reports, you can choose to round the report values before or after totaling and you can choose to round the reporting units before or after rolling up to the parent unit. The following table identifies the different rounding option combinations and the effect on rounding differences.

The term “foot” means to total down to the row calculation, the term “cross-foot” means to total across, rolling up the child units to the parent unit.

<table>
<thead>
<tr>
<th>Rounding Selections</th>
<th>Does this report foot?</th>
<th>Does this report cross-foot?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Significant</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Roll up Rounded Values in the Tree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use Rounded Values for Calculations and Totals</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Roll up Rounded Values in the Tree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use Rounded Values for Calculations and Totals</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Roll up Rounded Values in the Tree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use Rounded Values for Calculations and Totals</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Roll up Rounded Values in the Tree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>None</td>
<td>No Rounding</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 7-17: Rounding Selections and Differences

This section shows several examples of how totals and roll ups perform using the different rounding option combinations. In all cases, FRx consistently totals the parent unit rows after rolling up the child units.

The following table displays report values that are not rounded. All reports (USA and Canada) foot and cross-foot to the Combined report.

<table>
<thead>
<tr>
<th>Accounts</th>
<th>USA</th>
<th>Canada</th>
<th>Combined</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>1413.48</td>
<td>1201.20</td>
<td>2614.68</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>287.37</td>
<td>100.40</td>
<td>387.77</td>
</tr>
<tr>
<td>Prepaid Expenses</td>
<td>112.47</td>
<td>200.05</td>
<td>312.52</td>
</tr>
<tr>
<td>Total Current Assets</td>
<td>1813.32</td>
<td>1501.65</td>
<td>3314.97</td>
</tr>
</tbody>
</table>

Table 7-18: No Rounding

The following two examples use rounded values in calculations and totals. Example 1 also rolls up rounded values in the reporting tree. Example 2 does not round before rolling up.
In Table 7-19, row totaling is performed after rounding so each individual report foots correctly. If you select Roll up Rounded Values in the Tree, each row in the child unit (USA and Canada) also cross-foots to the parent (Combined) unit. If you clear the Roll up Rounded Values in the Tree option, the child units do not cross-foot to the parent (1812+1501 does not equal 3316).

The following table contains two examples that do not use rounded values in calculations and totals. Example 3 rolls up rounded values in the reporting tree. Example 4 does not round before rolling up.

<table>
<thead>
<tr>
<th>Accounts</th>
<th>Example 1</th>
<th>Example 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>USA</td>
<td>Canada</td>
</tr>
<tr>
<td>Cash</td>
<td>1413</td>
<td>1201</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>287</td>
<td>100</td>
</tr>
<tr>
<td>Prepaid Expenses</td>
<td>112</td>
<td>200</td>
</tr>
<tr>
<td>Total Current Assets</td>
<td>1812</td>
<td>1501</td>
</tr>
</tbody>
</table>

Table 7-19: Using Rounded Values in Calculations and Totals

In Table 7-19, row totaling is performed after rounding so each individual report foots correctly. If you select Roll up Rounded Values in the Tree, each row in the child unit (USA and Canada) also cross-foots to the parent (Combined) unit. If you clear the Roll up Rounded Values in the Tree option, the child units do not cross-foot to the parent (1812+1501 does not equal 3316).

The following table contains two examples that do not use rounded values in calculations and totals. Example 3 rolls up rounded values in the reporting tree. Example 4 does not round before rolling up.

<table>
<thead>
<tr>
<th>Accounts</th>
<th>Example 3</th>
<th>Example 4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>USA</td>
<td>Canada</td>
</tr>
<tr>
<td>Cash</td>
<td>1413</td>
<td>1201</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>287</td>
<td>100</td>
</tr>
<tr>
<td>Prepaid Expenses</td>
<td>112</td>
<td>200</td>
</tr>
<tr>
<td>Total Current Assets</td>
<td>1813</td>
<td>1502</td>
</tr>
</tbody>
</table>

Table 7-20: Without Using Rounded Values in Calculations and Totals

In Table 7-20, rounding is performed after totaling in each report. By doing this, report totals may appear to be incorrect. In the example 3 USA report, 1413+287+112 does not equal 1813. In example 4, the reports do not foot or cross-foot to the parent. This last example results in a report that appears to be wildly incorrect, yet the final combined summary number, 3315 (the Total Current Assets: Combined value), is the only summary number of the four rounding examples that is precise when compared with the original non-rounded number (3314.97=3315).
Acct/Tran Detail Tab

The Acct/Tran Detail tab contains a variety of options for formatting detail reports as shown in Figure 7-17.

![Figure 7-17: Catalog of Reports Window: Acct/Tran Detail Tab](image)

Options for Account Detail Reports

The following list explains the options available:

- **Display GL Account Code**
  To include the general ledger account codes in your report, select this check box. FRx places the general ledger account number into the report description (DESC) column at the account and transaction detail level.

- **Display Account Description from Chart**
  To include account descriptions from the chart of accounts in your account and transaction detail report, select this check box (the default). FRx includes as much of the account description as will fit into the report description (DESC) column.

- **Display Row Code**
  To display the row format row codes in your account and transaction detail report, select this check box (the default).

- **Combine Posted and Unposted Amounts**
  To combine posted and unposted balances in your account and transaction detail report, select this check box (the default). If you do not select this option, FRx displays the posted and unposted amounts on separate account detail line items for each account with unposted activity.

- **Display Underscore before Totals**
  To display an underscore line before each row total in account detail reports, select this check box (the default).

  For transaction detail reports, select this option to print an underscore before and after each period total, each account total and row total.

- **Mark Unposted Accounts with ***
  To flag unposted balances or transactions with an asterisk (*), select this check box (the default). If you select the Combine Posted and Unposted Amounts option, an asterisk appears at the transaction detail level for every unposted transaction. If you do not select the Combine Posted and Unposted Amounts option, an asterisk appears
at the account detail level for the unposted account balance as well as the transaction detail level for all unposted transactions.

- **Include Detail for Non-Printing Rows**
  To include non-printing rows that you defined in the row format (NP Print Ctrl), select this check box (the default).

- **Sort GL Accounts by Natural Code**
  To sort accounts by their natural account code segments, select this check box.

- **Suppress CBR Calculation**
  If you include a BASE row calculation in the column layout, you must specify a CBR row in the row format. With these in place, FRx attempts to perform the appropriate calculation on each row of the financial statement regardless of detail level. The **Suppress CBR Calculation** option determines whether the calculation is performed if you select an account or transaction detail level report. This option is selected by default because a report with many accounts can take longer to process.

**Options for Subtotal/Filtering Account Detail**

If you choose Financial Report under Detail Level, Subtotal/Filtering Account Detail options are unavailable. The following list of options are available if you choose Account Only, Financial & Account, Transaction Only, or Financial & Transaction as the Detail Level for the report:

- **Subtotal on Segment**
  To subtotal on an account segment in your account detail report, select this check box, and then type or select the account segment number in the box below this check box. Subtotaling affects only the account detail section of a report.

  When you use subtotaling from the Catalog of Reports, you can print the subtotaled account detail or export this information without using the FRx DrillDown Viewer.

- **Use Account Filter**
  To use an account filter subtotal, select this check box, and then enter the account filter in the box below this check box.

  This filter applies to every row, column, and tree intersection, and lets you run a report for specific units using a filter without changing the tree. Or, without creating a tree, you can run a report for a specific unit. When you retrieve the account detail, the application finds all children and grandchildren, and then retrieves the accounts for all these related units.

  When subtotaling from the catalog with a tree, the financial reports are exported for each level of the tree; however, instead of displaying the account detail for the lowest unit, the account detail prints or exports from the summary level.

**Note:** If you generate a report with an account filter, when you view the report in the DrillDown Viewer, the subtotal **Use Account Filter** option is unavailable.

- **Header Label**
  Type a header for your report that indicates the account filter you are using for your subtotals.
This header label is very important when you run the report using several different filters; the header label identifies which filter was used to create each report.

**Options for Transaction Detail Reports**

The following options are available for Transaction Detail Reports:

- **Subtotal By Period**
  To print the opening balance, period subtotals, and YTD total in the YTD column, select this check box (the default). If you do not select this option, only the opening balance and YTD total prints on the report.

- **Transaction Rounding**
  To apply rounding to every transaction in your transaction detail report, select this check box. To use this option, you must click **Round to Whole Dollars** on the **Formatting** tab.

**Tree Options Tab**

If your report includes a reporting tree, you can control the way your report appears using the **Tree Options** tab.

![Figure 7-18: Catalog of Reports Window: Tree Options Tab](image)

**Reporting Unit Selection**

The Reporting Unit Selection allows you to select the following options:

- **Select Units at Run Time**
  Display the reporting tree (before report generation) so that you can mark the reporting units to include in your report.

- **Include All Units**
  Use to automatically include all units of a reporting tree.
  
  If you specify a **Starting Unit** from the **Building Blocks** tab, FRx includes the starting unit and all child units. This produces the same result as marking the starting units and those units below when you select the **Select Units at Run Time** option.

- **Include Specific Number of Levels**
  Use to indicate the number of levels from the starting unit to process.
- **Levels Down From Starting Unit**
  Type the number of levels to include in your report. One level represents a parent-child relationship and two levels represent a parent-child-child relationship.

  This box does not appear dimmed, but is inaccessible unless you select the **Include Specific Number of Levels** option.

**Page Breaks**

The following options are available for page breaks:

- **Before Each Reporting Unit**
  To begin a new report page with each reporting unit, select this check box (the default).

- **No Page Breaks between Units**
  To print the reporting units without any page breaks between units, select this option.

- **Use Reporting Tree**
  To use the page breaks as defined in the reporting tree, select this option.

- **Restart Numbering with Every Unit**
  To restart the page numbering of each reporting tree unit within a report, select this option. If you want to use sequential page numbering for all of the selected reporting units, do not select this check box.

- **Allow Rollup <1%**
  To allow a roll up of less than one percent, select this check box. If you do not select this option, an entry of .25 in the **Rollup%** cell of the reporting tree indicates that 25% of each row should be rolled up to the parent. With this box selected, an entry of .25 would limit the roll up to .25% (one fourth of one percent). For additional information, see “Building Reporting Trees Manually” on page 205.

- **Disable Tree Security**
  To allow all users to drill down into all detail levels, select this check box.

**Advanced Tab**

The **Advanced** tab contains several different advanced settings. You can use the settings to:

- Generate an exception report with your report
- Roll up periods by number or date
- Change report processing priority
Chapter 7: Understanding the Catalog of Reports–Report Options Tab

- **Change calculation priority**

![Figure 7-19: Catalog of Reports Window: Advanced Tab]

**Exception Report**

The following selections are available to you:

- **Report Missing Accounts**
  
  To generate an exception report that shows the general ledger account balances that were not included in the financial report, select this check box. FRx determines missing accounts using the lowest and highest account numbers from the row format, then displays a list of those accounts that are *not* in the row format but exist in the general ledger.

  **Note:** If a missing account is higher or lower than all the accounts in the row format, it is not included in the exception report.

- **Report Duplicate Accounts**
  
  To generate an exception report that shows any accounts that were included more than once in the original report, select this check box. FRx determines the duplicate accounts from the account codes used in the row format.

**Rollup Basis**

Use the following rollup options:

- **Period Numbers**
  
  To roll up accounts by period numbers in multi-company reporting trees, select this option (the default).

- **Period Dates**
  
  To roll up accounts by period dates in multi-company reporting trees, select this option.

**Note** The **Rollup Basis** options are especially useful for companies with different start and end period dates, and fiscal year dates.
Chapter 7: Understanding the Catalog of Reports--Report Options Tab

Report Queue

Priority Level

To change the report-processing priority level on the Report Server, click the Priority Level arrow and select High, Medium, or Low.

Note

This is a Report Server feature and is not available in the Desktop edition.

Calculation Priority

The following calculation options are available:

- **Calculate Columns First**
  To perform the column calculations before the row calculations, select this option. This option might be necessary when a column calculation (CALC) intersects a total (TOT) or calculation (CAL) row, and you want the row calculation to overwrite the column calculation.

- **Calculate Rows First**
  To perform the row calculations before the column calculations, select this option (the default). This option works best in the following situations:
  - Report with a CALC column or with simple calculations
  - Row format and column layout that use only simple mathematical operands (+ and -)

Other Options

The following options are available to you:

- **Include Amounts in Future Periods**
  To include amounts in columns that specify periods beyond the base period (as defined in the Report Date box), select this option (the default). If you do not want the future period amounts to appear in your report, clear this box.


- **Display Report Processing Status**
  
  To display the FRx Reporting Engine status window during report generation, select this option (the default).

  ![FRx Reporting Engine Status Window](image)

  **Figure 7-20: FRx Reporting Engine Status Window**

- **Missing Unit Warning**
  
  With this option selected, a warning message displays during report processing when a column or row is restricted to a reporting unit and the reporting unit does not exist or was not selected in the tree (the default). If you want to use a restricted row or column in other reports and do not want to see this warning, clear this check box.

- **Exclude Inactive Accounts (If Available)**
  
  If your Open Financial System Interface (OFSI) supports the exclusion of inactive accounts, select this option to generate reports that exclude inactive accounts. By default, this option is not checked. If you check this option and your OFSI does not support inactive accounts, your reports are not affected.

- **Disable ledger refresh**
  
  This option is unavailable (dimmed) for OFSI interfaces to the general ledger.

**Currency Translation Tab**

If your report includes more than one currency, use the Currency Translation tab to establish conversion options.

![Currency Translation Tab](image)

**Figure 7-21: Catalog of Reports Window: Currency Translation Tab**

The following DAX currency options are available to you:
- **Spot Rate Source**
  This box identifies the database from which the spot (daily) currency exchange rate is taken. Select **FRx** to use the DAX Currency Conversion tables; select **OFSI** (General Ledger) to extract currency exchange rate data from the general ledger.

- **Historical Rate Source**
  This box identifies the database from which the historical currency exchange rate is taken. **FRx** is the only option available for the **Historical Rate Source**, because both historic conversion rates and base currency amounts are read from the FRx DAX rate table.

- **Change Average Calculations**
  Select this check box to calculate exchange rate averages as (Sum of Rates / Number of Rates Entered * Balance).
  Leave this check box blank to calculate averages Sum Rates/No. of Days * Amount).

---

**Reports**

When you create a new report, some of the boxes, check boxes, and options in the Catalog of Reports window are completed by default. When you generate a report using the default settings, it displays only summary information for the posted balances of the system date minus one period (**S-1**). By default, the report is generated as a **DrillDown Viewer (Enhanced XML)** file to view in the DrillDown Viewer.

This section contains information and instructions on:
- Creating a Report
- Generating a Report
- Printing Catalog Information
- Chaining Your Reports
- Cloning Your Reports
- Including Additional Text in a Report
Creating a Report

To create a report

1. From the FRx Control Panel, click Catalog of Reports to display the Select Catalog for Display dialog box.

2. Click New to display a new Catalog of Reports window.

3. In the Catalog ID box, type the report name.

4. In the box to the right of the Catalog ID box, type a report description.

5. Check the company code displayed in the Company box; this is the default company.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The displayed code is for your report company</td>
<td>Go to step 6.</td>
</tr>
</tbody>
</table>
6 Click the **Detail Level** arrow and use one of the following report detail options:

<table>
<thead>
<tr>
<th>To</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a financial report</td>
<td>Financial Report</td>
</tr>
<tr>
<td>Create a account detail report</td>
<td>Account Only</td>
</tr>
<tr>
<td>Create a financial and an account detail report</td>
<td>Financial &amp; Account</td>
</tr>
<tr>
<td>Create a transaction detail report</td>
<td>Transaction Only</td>
</tr>
<tr>
<td>Create a financial report including account and transaction details</td>
<td>Financial &amp; Transaction</td>
</tr>
</tbody>
</table>

7 Click the **Provisional** arrow and select one of the following provisional data options:

<table>
<thead>
<tr>
<th>To</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include only posted transactions and balances</td>
<td>Use Posted Balances Only</td>
</tr>
<tr>
<td>Include all posted and unposted balances and transactions</td>
<td>Provisional: Posted + Unposted Activity</td>
</tr>
<tr>
<td>Include transactions that have not been posted</td>
<td>Include Unposted Activity Only</td>
</tr>
</tbody>
</table>

8 To change the report date, click the **Report Date** arrow to display the **Periods and Dates** dialog box.
9 In the Base Period box, enter the period that you want the report to use.
   • In the Base Year box, enter the report fiscal year.
   • The Period Covered and Report Date descriptions change based on your previous selections; you can click in the boxes and edit the text as needed. This text appears in your report header.
   • If you want to save a base period with this report, click the Default Base Period arrow and select or edit the available options. For more information, see Specifying Report Periods and Dates on page 233.

10 Click OK to return to the Catalog of Reports Window.

11 On the Building Blocks tab, do the following:
   • In the Row Format list box, select a row format and click OK.
   • In the Column Layout list box, select a column layout and click OK.

12 To generate the report with a reporting tree, select a reporting tree from the Reporting Tree list box and click OK.

13 On the File menu, click Save.

Generating a Report

You can generate a report in two ways: on the Report Server or locally on a workstation.

Generating a Report with Report Server

To generate a report with Report Server

1 On the File menu, click Generate... to display the Output Selection dialog box.

2 In the Output Selection dialog box, do the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate a report on your local workstation</td>
<td>Generate Report Locally.</td>
</tr>
<tr>
<td></td>
<td>Note: This option is only available if the Report Server product is installed.</td>
</tr>
</tbody>
</table>

3 To select the generation option you selected as a default, select the Set as Default check box.

4 Click OK.
5 If your report includes a reporting tree, the **Select Reporting Unit(s) to Print** dialog box displays.

To select the reporting units to generate, do one of the following:
- Press the **Ctrl** key while you select the units.
- Click **Mark All**.

6 Click **OK**.

Report processing proceeds according to your Output Selection in step 1, as follows:
- If you selected to generate the report locally, the **Report Status** dialog box displays a summary of the report progress. To stop processing, click **Cancel**.
  When FRx finishes processing the report, the DrillDown Viewer opens and displays it.
- If you selected to generate the report on the Report Server, the **Catalog(s) queued successfully** message box appears.

9 Click **OK** to close the message window and continue processing the report on the Report Server.

For more information on the Report Server, see your *FRx® Report Server 6.7 User’s Guide*.

**Generating a Report Locally**

For more information on the Report Server, see your *FRx® Report Server 6.7 User’s Guide*.
To generate a report locally

1. On the Catalog of Reports toolbar, click **Generate Report** to display the **Output Selection** dialog box.

The **Generate Report Locally** option displays because the Report Server is not installed.

2. Click **OK**.

3. If your report includes a reporting tree, the **Select Reporting Unit(s) to Print** dialog box appears.

4. Select the reporting units that you want to generate by pressing the **Ctrl** key while you select the units or click **Mark All**.

5. Click **OK**.

6. The **Report Status** dialog box displays a summary of the report progress. To stop processing, click **Cancel**.

When FRx finishes processing the report, the DrillDown Viewer opens and displays it.
Printing Catalog Information

To print catalog information

1. On the **File** menu, click **Print Catalog**... to display the **Print Catalog Information** dialog box.

2. Do one of the following:

<table>
<thead>
<tr>
<th>To print information about</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple reports</td>
<td>Press and hold the <strong>Ctrl</strong> key while you select the reports.</td>
</tr>
<tr>
<td>All reports</td>
<td>Click <strong>Select All</strong>.</td>
</tr>
</tbody>
</table>

3. Select one of the following options

   - To print summary information, click **Print Summary**.

     Your report prints the following format:

     | Catalog Information       | Building Blocks |
     |----------------------------|-----------------|
     | Catalog Id                | Row             |
     | Catalog Description       | Row Description |
     | Company Code              | Column          |
     |                            | Column Description |
     |                            | Tree            |
     |                            | Tree Description |
To print detail information, click **Print Detail**.
Your reports prints report detail in the following format:

<table>
<thead>
<tr>
<th>Catalog Information</th>
<th>Building Blocks</th>
<th>Report Information</th>
<th>Report Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog ID</td>
<td>Row</td>
<td>Base Period</td>
<td>Left Margin</td>
</tr>
<tr>
<td>Catalog Description</td>
<td>Row Description</td>
<td>Detail Level</td>
<td>Right Margin</td>
</tr>
<tr>
<td>Company Code</td>
<td>Column</td>
<td>Provisional</td>
<td>Top Margin</td>
</tr>
<tr>
<td></td>
<td>Column Description</td>
<td>Output Type</td>
<td>Bottom Margin</td>
</tr>
<tr>
<td>Tree</td>
<td>File Name</td>
<td>Orientation</td>
<td></td>
</tr>
<tr>
<td>Tree Description</td>
<td>Chained to Catalog</td>
<td>Scaling</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exception Reporting</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calculation Priority</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rounding</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Print Selection</td>
<td></td>
</tr>
</tbody>
</table>

4 Verify the print settings.

5 Click **OK**.

**Chaining Your Reports**

When you want to generate several reports at a time, chain them together so that they generate one after the other.

**To chain reports together**

1 From the FRx **Control Panel**, click **Catalog of Reports** to display the **Select Catalog for Display** dialog box.

2 In the **Select Catalog for Display** dialog box, select the first **Catalog ID** that you want to generate and click **OK**.

3 Click the **Output** tab.

4 Click the **Chain to Catalog ID** arrow.
5 In the Select Catalog for Display dialog box, select the Catalog ID that you want to run after the current report and click OK.

The Catalog ID that you selected appears in the Chain to Catalog ID box. Whenever you run the current Catalog ID, this report runs immediately after it.

6 From the Output tab, clear the Prompt for Output Type at Run Time box. This allows the reports to process without interruption.

7 Click the Building Blocks tab and choose from the following options:

<table>
<thead>
<tr>
<th>If</th>
<th>Then do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>The current Catalog ID does not include a reporting tree</td>
<td>Go to step 8.</td>
</tr>
</tbody>
</table>
| The Catalog ID includes a reporting tree | 1 Click the Report Options tab. 2 Click the Tree Options tab. 3 In the Reporting Unit Selection section, choose from the following options:  
  - To process all units in the reporting tree, click the Include All Units check box.  
  - To process specific reporting tree levels:  
    1. Select the Include Specific Number of Levels box.  
    2. Enter a value in the Levels Down form Starting Unit box.  
    3. From the Building Blocks tab, select a Starting Unit.  
    This allows the reports to process without interruption.  
  - To select specific units before processing the report, select the Select Units at Run Time box. |

8 Click Save.
9 Click **Find**.

10 In the **Select Catalog for Display** dialog box, select the last chained report and click **OK**.

11 Choose from the following options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add another report to the chain</td>
<td>Repeat steps 3 through 10 for each report that you want to chain together.</td>
</tr>
</tbody>
</table>
| Complete the chain and run the reports  | 1 Click **Save**. 
2 Select **Generate Report**. 
3 In the confirmation message box, click **Yes**. |

The Catalog IDs run, one after the other, in the order they were chained.

### Cloning Your Reports

It takes a lot of care to set up a report the way that you want. To simplify the process, you can reuse your catalog IDs by cloning them. Cloning your catalog IDs allows you to use your own report definitions as the default for creating new definitions.

**To clone a catalog ID**

1 From the FRx **Control Panel**, click **Catalog of Reports**.

2 In the **Select Catalog for Display** dialog box, select the report that you want to clone and click **OK**.

3 In the **Catalog Records** record control box, click **Clone**.

   This clears two boxes, the **Catalog ID** and the **File Name** in the **Output** tab. All other original report settings remain.

4 In the **Catalog ID** box, type a new Catalog ID name.

   When you enter a new catalog ID, the **File Name** in the **Output** tab automatically uses the first eight characters of your new catalog ID name for the default file name.

5 In the **Catalog ID description** box, you can replace the existing description with a new one.

6 Check the company code displayed in the **Company** box; this is the default company.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The displayed code is for your report company</td>
<td>Go to step 7.</td>
</tr>
</tbody>
</table>
| The displayed code is *not* the report company | 1 Click the **Company** arrow. 
2 In the **Select a Company for this Record** dialog box, select the correct company code and click **OK**. |
7 Review your report selections and make changes, as needed.
8 Click Save.

To generate your report, see “Generating a Report” on page 277.

Including Additional Text in a Report

The Additional Text feature lets you add additional text entries from the Additional Text column in the Reporting Trees window to the header/footer section in reports. For information about creating Additional Text entries in the reporting trees, see “Adding Text to the Reporting Units in a Tree” on page 216.

To include additional text in the report header or footer

1 From the Catalog of Reports window, click the Page Options tab.
2 Click the Headers / Footers tab.
3 Select either the Page Headers or Pages Footers option.
4 Click the Left, Center, or Right cell to select the text alignment.
5 Click the Codes arrow and select Text[#] from Reporting Tree (@UNITT[#]).

Note: Select the actual unit text entry number indicated by the # symbol. For example, @UNITT4 specifies the fourth additional text entry for the reporting unit.

6 Click Save.
7 Click Close.
Scheduling Reports for Processing

If you installed the Report Server, you can use the scheduling function to schedule reports to process once or on an hourly, daily, weekly, monthly, or yearly basis. The Scheduler icon is available on the toolbars for all Report Designer windows. For complete details on using the scheduling function, refer to Chapter 2 of the *FRx® Report Server 6.7 User’s Guide*.

The Report Server, also discussed in detail in the *FRx® Report Server 6.7 User’s Guide*, is a separate product that serves as a high-performance report processor. After installing the Report Server, you can use the it to generate reports. As a result, you can continue working on your local workstation while the reports run on the Report Server instead of your own workstation.
Scheduling Reports for Processing

FRx Report Designer 6.7 User’s Guide 290
Scheduling Reports for Processing
Microsoft® Business Solutions for Analytics—FRx® supports output to XML-based financial reports using Extensible Business Reporting Language (XBRL) version 2.0 specifications and taxonomies. You can include XBRL taxonomy links in your row format and create XBRL instance documents using FRx® Report Designer.

This chapter includes an overview of XBRL and describes how to:

- Include XBRL elements in the row format
- Include XBRL Tag column types in the column layouts
- Select XBRL Output Type in the Catalog of Reports

Common XBRL terms are defined at the end of the chapter.
Extensible Business Reporting Language (XBRL) Overview

The XBRL 2.0 specification and taxonomy for financial reporting of commercial and industrial companies under US GAAP was released by the XBRL Committee on November 15, 2002. XBRL is intended to provide an XML-based framework that the global business information community will use to create, exchange, and analyze financial reporting information, including regulatory filings such as annual and quarterly financial statements, general ledger information, and audit schedules. XBRL is freely licensed and facilitates the automatic exchange and reliable extraction of financial information among various software applications and technologies, including the Internet.

With the 6.7 release of Report Designer, you can include XBRL element tags in the row format by linking to the version 2.0 XBRL taxonomy (us-gaap-ci-2003-07-07.xsd or a custom taxonomy that complies with the XBRL version 2.0 standard) and selecting the appropriate XBRL element tag for GL Link, CAL, and TOT type rows. Only rows that are tagged with an XBRL element tag will be passed into the XBRL instance document. If the row description is blank, FRx uses the XBRL element label from the taxonomy as the description.

In the column layout, the XBRL_TAG column type allows the XBRL element tags found in the row format to be presented in a column of the FRx® DrillDown Viewer™ (Enhanced XML) .frd output file. See Figure 8-1 on page 317 for an example.

There are no changes to the FRx reporting tree building block, however for reports that yield data based on reporting trees, selecting XBRL output type will create separate instance documents for each selected reporting unit in the tree. If you use the code @ANY in the Company column of the tree, Report Designer uses the Company Name specified in the Catalog of Reports as the Company entity in the XBRL report.

The Catalog of Reports includes XBRL Instance Document as an output type selection. When XBRL is selected as the output type, you have the option to enable or disable the Missing Element Tag Warning feature when the report generates. When you select XBRL as the output type, Report Designer generates instance documents that include XBRL elements and syntax.
Here is an example of XBRL instance document output.

```xml
<?xml version="1.0" encoding="utf-8"?>
    xsi:schemaLocation="C:\Program Files\FRx 6.7\IO_Data\Taxonomy Files\us-gaap-ci-2003-07-07.xsd\XBRL1"/>
- <numericContext id="P1M/2003-02-28/2" precision="18" cwa="false">
    - <entity>
        <identifier scheme="">Fabrikam Works, Inc.</identifier>
    </entity>
    - <period>
        <startDate>2003-02-01</startDate>
        <endDate>2003-02-28</endDate>
    </period>
    - <unit>
        <measure>USD</measure>
    </unit>
    - <scenario>ACTUAL</scenario>
</numericContext>
- <numericContext id="P1M/2003-02-28/3" precision="18" cwa="false">
    - <entity>
        <identifier scheme="">Fabrikam Works, Inc.</identifier>
    </entity>
    - <period>
        <startDate>2003-02-01</startDate>
        <endDate>2003-02-28</endDate>
    </period>
    - <unit>
        <measure>USD</measure>
    </unit>
    - <scenario>Budget_Best</scenario>
</numericContext>
- <numericContext id="YTD/2003-02-28/4" precision="18" cwa="false">
    - <entity>
        <identifier scheme="">Fabrikam Works, Inc.</identifier>
    </entity>
    - <period>
        <instant>2003-02-28</instant>
    </period>
    - <unit>
        <measure>USD</measure>
    </unit>
    - <scenario>ACTUAL</scenario>
</numericContext>
- <numericContext id="YTD/2003-02-28/5" precision="18" cwa="false">
    - <entity>
        <identifier scheme="">Fabrikam Works, Inc.</identifier>
    </entity>
    - <period>
        <instant>2003-02-28</instant>
    </period>
    - <unit>
```
<measure>USD</measure>
</unit>
<scenario>Budget_Best</scenario>
</numericContext>
<XBRL1:usfr-pt_SalesRevenueGross.usfr-pt_SalesRevenueGrossServices
id="P1M/2003-02-28/2">556272</XBRL1:usfr-pt_SalesRevenueGross.usfr-
pt_SalesRevenueGrossServices>
<XBRL1:usfr-pt_SalesRevenueGross.usfr-pt_SalesRevenueGrossServices
id="P1M/2003-02-28/3">486935.55</XBRL1:usfr-pt_SalesRevenueGross.usfr-
pt_SalesRevenueGrossServices>
<XBRL1:usfr-pt_SalesRevenueGross.usfr-pt_SalesRevenueGrossServices
id="YTD/2003-02-28/4">1103330</XBRL1:usfr-pt_SalesRevenueGross.usfr-
pt_SalesRevenueGrossServices>
<XBRL1:usfr-pt_SalesRevenueGross.usfr-pt_SalesRevenueGrossServices
id="YTD/2003-02-28/5">956676.22</XBRL1:usfr-pt_SalesRevenueGross.usfr-
pt_SalesRevenueGrossServices></group>
Including XBRL Elements in the Row Format

In order to build a report for XBRL output, you need to include the XBRL elements in the row format. This includes the following tasks:

- Create a Link to the XBRL taxonomy. The US GAAP CI taxonomy (us-gaap-ci-2003-07-07.xsd), a read-only taxonomy published by the XBRL Committee, is installed in the IO_Data\Taxonomy Files directory with FRx.
- Add XBRL element tags to each GL Link, CAL, and TOT type row that you want to include in the XBRL instance document. Only rows with XBRL element tags will be included in the instance document.

Remember that XBRL output does not support the use of FRx row modifiers in the row format.

Creating a Link to the XBRL Taxonomy

To create a link to the XBRL taxonomy

1. On the Row Format Link menu, click Open Link Window to display the Links dialog box.

   ![Links Dialog Box]

2. In the Links record control box, click New.

3. Click the Link Type arrow and select XBRL as the link type.

4. In the Link Name box, type a name for the link.

5. Click the XBRL Taxonomy Files arrow and select the us-gaap-ci-2003-07-07.xsd taxonomy file to use the standard taxonomy.

Note: Row formats created for XBRL version 1.0 must be updated to link to the XBRL version 2.0 taxonomy before they will run correctly. See “Updating Existing Row Formats for XBRL 2.0” on page 311.
6 Click Open.

**Note:** XBRL taxonomy files have .xsd as the file extension, and the IO_Data\Taxonomy Files directory contains a set of related taxonomy files. Be certain you select the master taxonomy file (us-gaap-ci-2003-07-07.xsd) or an XBRL version 2.0 compliant custom taxonomy. Refer to the service pack release notes to determine the most current file name if the taxonomy file has been updated since this manual was created.

7 In the Links record control box, click Save.

8 Click Close to close the Links record control box and return to the Row Format window.

The new Link column, showing the link name and taxonomy name, appears in the row format window.

9 Repeat steps 1 to 8 for each taxonomy you want to include in your row format. Each XBRL Link column corresponds to one taxonomy file.

**Note:** In addition to the standard us-gaap-ci taxonomy, you can include one or more custom taxonomies in a row format. You can only link to one taxonomy from a particular row.

10 When you have finished adding your XBRL links, click Close.

### Adding XBRL Element Tags to the Row Format

Once the necessary taxonomies are selected, you can add XBRL element tags to the rows. XBRL element tags can be applied to **GL Link**, **CAL**, and **TOT** type rows. Only the rows that are tagged with an XBRL element tag will be passed into the instance document, so it is important to tag all necessary rows.

If the **Description** cell for the row is blank, the description will be filled in with the XBRL element tag label from the taxonomy; however, if the **Description** is already populated, it will remain as is.

Double-clicking the **Link to XBRL Taxonomy** cell in the row opens the **XBRL Element Tag** zoom dialog box. The taxonomy displays in a tree that shows both the label for the XBRL element and the XBRL element tag. Click the expansion symbol (+) to expand nodes of the taxonomy tree, and drill down to the appropriate XBRL element tag. As you move from row to row within the XBRL Link column, the tree will re-zoom to the last node highlighted before the tree was closed, so you can select the next tag without having to re-drill in the taxonomy tree.

The row format will allow only one XBRL element tag per **GL Link**, **CAL**, and **TOT** row. FRx will generate a message if you attempt to enter more than one tag in a row. You can select to overwrite the existing tag with the new tag or cancel the new tag entry.

**Note:** To use an XBRL element tag in a **CAL** or **TOT** row, select the **CAL** or **TOT** format code (Fmt Code) first, then add the XBRL element tag.
To add XBRL element tags to the row format

1. In the Row Format window, double-click the cell in the Link to XBRL Taxonomy column to display the XBRL Element Tag zoom.

2. Click the expansion symbol (+) at the XBRL element label to expand the node of the tree.

3. Select the XBRL element tag for the row and click OK.

4. Repeat steps 1 to 3 for each row that requires an XBRL element tag.

**Note:** The row format allows only one XBRL element tag per row. If you attempt to add a second tag, the system displays the message: “This row already contains an XBRL tag. Would you like to overwrite this tag?” Click Yes to overwrite the old tag with a new tag. Click No or Cancel to leave the previous tag unchanged.

### Updating Existing Row Formats for XBRL 2.0

Any row formats you created in FRx® Financial Reporter 6.5 with links to the XBRL version 1.0 taxonomy need to be updated to use the new taxonomy file, element tags, and data scheme for XBRL 2.0.

**To update XBRL links in existing row formats**

1. In the Row Format window, open an existing row format that contains XBRL links.

2. On the Row Format Link menu, click Open Link Window to display the Links dialog box.
3. In the Links record control box, click Find, and locate the current XBRL link in the Find Link dialog box.

4. In the Link Name box, accept the name assigned by FRx or enter another name to identify the link.

5. Click the XBRL Taxonomy Files arrow and select the XBRL version 2.0 taxonomy file (us-gaap-ci-2003-07-07.xsd).

**Note:** XBRL taxonomy files have .xsd as the file extension, and the IO\_Data\Taxonomy Files directory contains a set of related taxonomy files. Be certain you select the master taxonomy file (us-gaap-ci-2003-07-07.xsd). Refer to the service pack release notes to determine the most current file name if the taxonomy file has been updated since this manual was created.

6. In the Links record control box, click Save.

7. Repeat steps 1 to 6 for each taxonomy you want to include in your row format. Each XBRL Link column corresponds to one taxonomy file.

8. In the row format window, double-click the cell in the Link to XBRL Taxonomy column to display the XBRL Element Tag zoom.

9. Click the expansion symbol (+) at the XBRL element label to expand the node of the tree.

10. Select the XBRL element tag for the row and click OK.

11. Repeat steps 8 to 10 for each row that requires an XBRL element tag.

**Note:** The row format allows only one XBRL element tag per row. If you attempt to add a second tag, the system displays the message: “This row already contains an XBRL tag. Would you like to overwrite this tag?” Click Yes to overwrite the old tag with a new tag.
Including XBRL Elements in the Column Layout

For XBRL reports, you can build your column layouts as described in Chapter 5, “Creating Column Layouts” on page 137 with the following constraints:

- Only GL and FRx Forecaster (Budget) columns are supported for financial data in the column layout for XBRL reports.

**Caution:** If you use Forecaster columns in an FRx report, these columns will not have valid dates in XBRL output.

- Currency settings in the **Currency Code** and **Currency Display** detail rows override the functional currency for the company you select in the Catalog of Reports. If no currency is specified in the column layout, and functional currency is not defined for the selected company, the currency unit of measure will be blank in the XBRL instance document. For information on setting the functional currency for a company, see “Entering and Editing Company Information” in your *FRx® Report Designer 6.7 Administrator’s Guide*.

In the column layout, you can include a column type **XBRL_TAG** to display the XBRL element tag found in the row format for a report that you output as an .frd file (DrillDown Viewer Enhanced XML). The XBRL_TAG will not be passed from the column layout to the XBRL instance document.

**To include XBRL_TAG column type in the column layout**

1. In the Column Layout window, double-click the **Type** Column Detail row in the column where you want the XBRL_TAG column type, to display the **Select the Type of Column** zoom.

   ![Select the Type of Column](image)

2. Select the **XBRL_TAG** column type from the list.
3 Click **OK**.

The XBRL_TAG column type is added to the column layout.

<table>
<thead>
<tr>
<th>Column Headers</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column Data</strong></td>
<td>DESC</td>
<td>GL</td>
<td>GL</td>
<td>GL</td>
<td>GL</td>
<td>GL</td>
<td>GL</td>
<td></td>
</tr>
<tr>
<td>Book Code/Website Category</td>
<td>ACTUAL</td>
<td>Base</td>
<td>Base</td>
<td>ACTUAL</td>
<td>Budget_Base</td>
<td>ACTUAL</td>
<td>Budget_Base</td>
<td></td>
</tr>
<tr>
<td>Fiscal Year</td>
<td>Base</td>
<td>Base</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Period Code</td>
<td>BASE</td>
<td>BASE</td>
<td>BASE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Currency (YTD)</td>
<td>EUR</td>
<td>EUR</td>
<td>YTD</td>
<td>YTD</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cell Format</td>
<td>4D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column Limit</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special Format Code</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Format</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4 Save the column layout with a unique name and description.
Selecting XBRL Output Type in the Catalog of Reports

In the Catalog of Reports, you can select XBRL as an output type. If the row format is properly populated with GL Link, CAL, or TOT rows and XBRL element tags, and the report yields data, FRx will generate an XBRL instance document with an .xml file extension.

The XBRL Option in the Catalog of Reports allows you to select or deselect the Missing Element Tag Warning option. When this option is selected, FRx generates a warning message each time a GL Link, CAL, or TOT row is encountered that does not contain an XBRL element tag. You can discontinue further warnings from the warning message box.

Also in the Catalog of Reports, verify that a company code and company name are displayed in the Company boxes. The default company, as set up in the Company Information dialog box, appears here unless another company is selected. If no company name is specified here, the company name (identifier entity) will be blank in the XBRL instance document.

You must select No Rounding in the Catalog of Reports Report Options, Formatting tab.

XBRL instance documents are generated differently for reports with and without trees, as described in the following scenarios:

- If a report without a tree yields data, then one instance document is created using the filename found in the File Name field of the Catalog of Reports.

- If a report with a tree yields data, then a separate instance document is created for each unit selected for reporting. The filenames for the instance documents will use the name in the File Name field of the Catalog of Reports, plus the unit title/description from the tree. If there is more than one unit with the same unit title/description in a tree, the name will be appended with a number and increased by one for every occurrence to create unique filenames. (For example, Denver-Sales, Denver-Sales1, Denver-Sales2, and so forth.)

- If a report with a tree is generated and at least one selected unit in the tree yields data, then an instance document is created for every selected unit, whether the unit yields data or not. The instance documents for the units that yield no data are generated with zero amounts written to the item tags.

- If a report with or without a tree is generated and yields no data, then no instance document will be created, and FRx displays the message, “This report yielded no data. No Instance Document will be created.”

- If a report with or without a tree is generated and yields data, any rows that have XBRL element tags, but are missing the GL Link, CAL, or TOT row types, will show a zero amount in the instance document.

This section contains information and instructions on:

- Selecting XBRL Output Type from the Catalog of Reports
- Selecting FRD Output Type For XBRL Reports
Selecting XBRL Output Type from the Catalog of Reports

To select XBRL output type from the Catalog of Reports

1. In the **Company** box, select the company code for the reporting company. The company name for the selected company appears in the box to the right of the company code. This is the company name that appears in the XBRL instance document.

2. In the Catalog of Reports window, click the **Output** tab.

3. On the **Output Options** tab, click the **Output** arrow and select **XBRL** from the list of output options.

4. From the **XBRL Options**, select **Missing Element Tag Warning** to display a warning message each time a **GL Link**, **CAL**, or **TOT** row is encountered that does not contain an XBRL element tag.

   **Note:** The **Missing Element Tag Warning** option is selected by default. Clear the check box to suppress missing element tag warnings from displaying when you run the XBRL report.

5. Click the **Report Options** tab.

6. On the **Report Options** tab, click the **Formatting** tab.

7. Under **Rounding of Amounts**, select **No Rounding**.

8. On the **File** menu, click **Save**.
Selecting FRD Output Type For XBRL Reports

Instance documents cannot be displayed in the DrillDown Viewer, however you can display the XBRL element tags from the row format in a report that you output as an .frd file (DrillDown Viewer Enhanced XML). The row format and column layout must satisfy the following requirements to successfully display the XBRL element tags in the DrillDown Viewer.

- The row format must contain GL Link, CAL, or TOT rows with XBRL element tags.
- The column layout must contain the XBRL_TAG column type.

When you select DrillDown Viewer (Enhanced XML) as the output type from the Catalog of Reports, FRx creates a file with an .frd extension that can be displayed in the DrillDown Viewer.

Show me an Example

The following example (Figure 8-1:), based on the column layout on page 314, shows Descriptions, GL amounts, and XBRL element tags as they might appear in the .frd file displayed in the DrillDown Viewer. This .frd output corresponds to the XBRL instance document output example on page 307.

```
Fabricam Works, Inc.
For the Two Months Ending February 28, 2003

<table>
<thead>
<tr>
<th></th>
<th>Actual Current</th>
<th>Budget Current</th>
<th>Actual YTD</th>
<th>Budget YTD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>$556,272.00</td>
<td>$450,905.05</td>
<td>$1,103,300.00</td>
<td>$950,670.22</td>
</tr>
</tbody>
</table>

Sales:SalesRevenueGross.xls!p_Sales_RevGrossServices
```

Figure 8-1: XBRL Element Tags Displayed in DrillDown Viewer
## XBRL Definitions

<table>
<thead>
<tr>
<th>XBRL Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>XBRL</td>
<td>Extensible Business Reporting Language (XBRL) is an open specification that uses XML-based data tags to describe financial statements for both public and private companies.</td>
</tr>
<tr>
<td><strong>XBRL Taxonomy Document</strong></td>
<td>An XBRL taxonomy document is an XML Schema file that describes a set of concepts used in preparing an XBRL instance document. A taxonomy document can be either an XBRL taxonomy, such as US GAAP CI, or a custom taxonomy created in conformance with XBRL specifications. Custom taxonomies are used to extend the XBRL taxonomies to address company and/or industry specific items not addressed in the XBRL taxonomies.</td>
</tr>
<tr>
<td><strong>Taxonomy</strong></td>
<td>The XBRL taxonomy is a classification system for business and financial reporting data elements. XBRL taxonomies can be regarded as extensions of XML Schema.</td>
</tr>
<tr>
<td><strong>Instance Documents</strong></td>
<td>Instance documents contain data. An XBRL instance document contains accounting, financial, or other business related data (for example, a financial statement issued by a company), expressed using XBRL syntax, and making use of the XBRL taxonomy. The financial statements of a company or any part thereof, expressed in XBRL, would be an instance document as would an HTML file that had various XBRL items embedded in it.</td>
</tr>
<tr>
<td><strong>Element</strong></td>
<td>Element refers to an XML element, but also a “fact” or piece of information described by this taxonomy. For example, the element with the name “nonCurrentAssets.propertyPlantAndEquipmentNet” is an element.</td>
</tr>
<tr>
<td><strong>Element Names</strong></td>
<td>Element names consist of two parts separated by a period using camel case conventions of 80 characters total or less. The logic for creating element names in this manner is discussed in the XBRL 2.0a Specification dated 2002-11-15. For example, “usfr-pt_balanceSheet.usfr-pt_assets” is an element name.</td>
</tr>
</tbody>
</table>

Table 8-1: XBRL Terms and Definitions
FRx® Currency Translation is a separately licensed function of FRx® Report Designer.

This chapter explains how to:

- Set up the Report Designer to activate the Currency Translation functionality, including specifying the file location of the DAX currency rate database
- Design Currency Translation reports
- Adjust Currency Translation settings in the catalog of reports

For information about administering Currency Translation, refer to the FRx® Report Designer 6.7 Administrator’s Guide.
FRx Currency Translation: Overview

While many host general ledgers provide for some type of currency conversion, very few provide the sophisticated currency translation needed by enterprises. Microsoft® Business Solutions for Analytics–FRx® provides a completely new method of performing currency translations automatically and dynamically across one or more entities, currencies, and general ledger systems. This new method is named DAX (Dynamic, Automatic Currency Translation System).

DAX works with a variety of host systems, all with varying degrees of sophistication. While some accounting systems may store currency exchange rates that should be used by FRx, other systems make no conversion rates available, thus requiring rates to be stored within FRx tables. DAX can alternately pull information from the general ledger (via OFSI) or from tables maintained within FRx.

Note: FRx uses an OLE server to provide standard interfaces from FRx to financial system data. The FRx Open Financial Systems Interface (OFSI) provides a common interface to financial system data regardless of the underlying financial system.

The primary purposes for currency conversion in FRx are:

- **Consolidation of Foreign Subsidiary** – If a company has a subsidiary that maintains its financial records in a currency other than the primary currency of the parent, then the subsidiary’s financial data must be converted to the parent’s currency before the amounts can be consolidated. Therefore, if a parent unit in an FRx tree uses a different currency than one of its children, every amount in the child’s report must be converted to the parent's currency before the amounts are rolled up to the parent.

- **Restatement to a Different Currency** – If a financial statement is required in a different currency than the primary currency of a reporting unit, the amounts must be converted to the alternate currency.

FRx ships a currency definition table that is fully populated with every currency defined by the ISO standard (4217:1995). This table contains the numeric precision for each currency. The default ISO code list is dated 9/10/2003. Check your FRx product release notes for information about current updates to this table.

Users can maintain currency exchange rates in the FRx Rate Maintenance tables if the appropriate information is not contained in the accounting system for a company. The Rate Maintenance tables contain the exchange rates between an unlimited number of currencies and a single base/foundation currency. This base/foundation currency is the currency in which all other currencies are stated. For U.S. based companies, this will be the US Dollar, but European companies will probably use the EURO. Many companies may want to maintain two rate tables if they use the EURO as the basis for all European conversions and the US Dollar for non-European conversions. For information about maintaining currency exchange rates, see Chapter 3, “Administering Currency Translation,” in your FRx® Report Designer 6.7 Administrator’s Guide.

You need to set up the FRx system before you can use the currency translation function to build reports.
Once you have prepared the system settings, you can activate DAX Currency Translation and then use the currency translation codes in your row formats and column layouts to build FRx reports. In the Catalog of Reports, you select these row formats and column layouts as building blocks for currency translation reports, select which DAX tables to use, and set the method for calculating currency rate averages. For more information on calculating exchange rate averages, see “Selecting the Method of Average Rate Calculation” in Chapter 3 of your FRx® Report Designer 6.7 Administrator’s Guide.
Setting Up the FRx System for Currency Translation

Your FRx System Administrator will need to set up some system parameters for the currency translation function. Ensure that the following preparations are in place before you use Currency Translation to build FRx reports:

- Set the Functional Currency in the Company Information dialog box.
- Set the path to the DAX Currency Translation file in the Company Information dialog box.
- Set the path to the DAX Currency Translation file in the System Preferences dialog box.
- Enter currency exchange rates in the FRx Currency Translation Maintenance window.

**Note**

If your FRx license includes the currency translation function, both the Company Information dialog box and the System Preferences dialog box have additional fields for selecting the path to the DAX Currency Translation file.

For detailed instructions on setting up Report Designer for currency translation, see Chapter 3 of your FRx® Report Designer 6.7 Administrator’s Guide.
Designing Currency Translation Reports

You incorporate currency translation into FRx reports by:

- Selecting currency conversion format codes in the row format window
- Identifying the currencies to display in the column layout window
- Specifying the currency exchange rate source from the **Currency Translation** tab in the Catalog of Reports window

This section explains how to use currency translation selections in each of the report building blocks.

This section contains information and instructions on:

- Activating DAX Currency Translation
- Using Currency Translation Codes in a Row Format
- Using Currency Translation in the Column Layout
- Using Currency Rate Subtype ID in Column Layouts
- Setting Currency Options in the Catalog of Reports

**Activating DAX Currency Translation**

Activate DAX Currency Translation from the Column Layout menu before you use currency translation functions in the column layout. You must also activate DAX before you run a currency translation report.

**To activate DAX currency translation in the column layout**

1. In the menu bar of the Column Layout window, select **Currency Translation**.
2. Click **Activate DAX Currency Translation** to place a check mark by **Activate DAX Currency Translation**.

**Using Currency Translation Codes in a Row Format**

As you enter row format information, you select the appropriate currency conversion codes for report rows that require conversion from the transaction currency to the reporting currency. The figure below shows the format codes that are available in the **Fmt Code** column of the Row Format window.

![Figure 9-1: Row Format Codes](image)

Figure 9-1: Row Format Codes
Once you select a currency conversion format code, FRx uses this code for all subsequent rows, until a different format code is encountered. For example, if you have 10 asset accounts that are all going to be converted using the spot rate, you only need to select CCSPOT in the first row, and all subsequent rows will apply the CCSPOT format code.

The following currency conversion row format codes are available if your FRx license includes the currency translation function:

**CCHIST** - This code tells FRx to perform currency conversion using the historic rate from the currency translation table. The historic rate is commonly used for rows that show non-monetary assets, such as fixed assets, inventory, or capital stock. When you use the CCHIST format code, you must also specify the Historic Rate ID as the related rate in Column D of the row format. The name of the Historic Rate folder in the FRx Currency Translation Maintenance window is the Historic Rate ID. When you use historic exchange rates in the row format, FRx matches sums in the Historic Conversion tables to the corresponding general ledger data for the GL account, and displays an Out of Balance error if the amounts do not match.

**CCAVG** - This code tells FRx to perform currency conversion using the average rate for a range of dates from the currency translation table. The average rate is commonly used for income rows in the report. When you use the CCAVG row format code, you must also specify an average type (AVGDAILY, AVGWEEKLY, or AVGMONTHLY) as the related rate in Column D of the row format. Your FRx Administrator must select the method for calculating exchange rate averages in the FRxRates.DAX table. For more information about calculating exchange rate averages, see “Selecting the Method for Average Rate Calculation” in Chapter 3 of your FRx® Report Designer 6.7 Administrator’s Guide.

**CCSPOT** - This code tells FRx to perform currency conversion using the spot (daily) exchange rate from the currency translation table. If there is no spot date that matches the report date, FRx uses the closest date prior to the report date. The spot rate is commonly used for cash accounts.

**CCX** - This code suppresses any currency conversion for this row and remains in effect until a different currency code is encountered.
Chapter 9: Using FRx Currency Translation–Designing Currency Translation Reports

The following figure shows an example of currency conversion format codes in a row format. Notice that the historic rate code (CCHIST) requires an historic rate ID to identify the related rate in Column D.

![Figure 9-2: Row Format Window Showing Spot and Historic Rate Codes](image)

In the following figure, the average row format code (CCAVG) in row 1540 requires the average type selection in Column D.

![Figure 9-3: Row Format Window Showing Average and Historic Rate Codes](image)
**Currency Translation Adjustments**

A currency translation adjustment is needed whenever some balances are converted at a spot rate and others are converted at an historic or average rate.

In row 1720 of Figure 9-3, the formula in the currency translation adjustment row will correct out-of-balance conditions between assets, and liabilities and equity. The formula subtracts the total of Net Fixed Asset in row 910 (shown in Figure 9-2) from sum of Stockholders’ Equity in row 1660 and Total Liabilities in row 1420.

**Using Currency Translation in the Column Layout**

You can include international currency amounts in FRx reports by specifying the currency code in your column layout. The GL amounts you display in the report could be shown in the original transaction currency or a converted currency, depending on how international currency transactions are recorded in your general ledger.

When DAX Currency Translation is active, the **Currency Display** detail row in the Column Layout can be used in two ways:

- In **GL** type columns, use **Currency Display** detail row to specify whether the originating amount or a converted amount displays on the report.
- In **TCURX** type columns, use **Currency Display** detail row to show the exchange rate for a selected currency on the report.

**Note**

The **Currency Display** detail row functions differently when DAX Currency Translation is *not* active. For normal FRx multicurrency reporting, see “Formatting Multicurrency Reports” on page 167.

The example in Figure 9-4 shows the code for euros (EUR) in the **TCURX** type Column C. The resulting report displays the *exchange rate* for euros in that column. The example uses the code for euros in the **GL** type Column D. The resulting report displays *amounts* in euros in that column.

![Figure 9-4: Currency Codes in the Column Layout Window](image)

The example in Figure 9-4 shows the code for euros (EUR) in the **TCURX** type Column C. The resulting report displays the *exchange rate* for euros in that column. The example uses the code for euros in the **GL** type Column D. The resulting report displays *amounts* in euros in that column.

![Figure 9-4: Currency Codes in the Column Layout Window](image)
Chapter 9: Using FRx Currency Translation–Designing Currency Translation Reports

To select the display currency in the column layout

1. From the Report Designer Control Panel, click the Column Layouts icon. A list of available column layouts appears in the Open Column dialog box.

2. Double-click a column layout to display the selected column layout in the Column Layout window.

3. From the Column Layout Currency Translation menu, select Activate DAX Currency Translation.

   **Note:** You must activate currency translation from the Column Layout window menu so that FRx will recognize currency codes in the column layout and row format.

4. To display GL amounts in the converted currency, double-click the cell in the Currency Display detail row of the GL type column and select the currency code from the displayed list.

5. To display currency exchange rates in the report, double-click the cell in the Currency Display detail row of the TCURX type column and select the currency code from the displayed list.

6. On the File menu, click Save to save changes to the current column layout, or click Save As to save the modified column layout with a new name.

**Using Currency Rate Subtype ID in Column Layouts**

For those accounting systems that support more than one exchange rate per currency, FRx uses the Currency Rate Subtype ID row in the Column Layout window to read the appropriate currency rate information from the general ledger.

The Currency Rate Subtype ID code can be used in conjunction with a currency display code in GL columns or in columns with transaction code TCURX.

If your accounting system supports more than one exchange rate per currency, follow the steps below to include currency rate subtype data in your column layout.

**To use a currency rate subtype ID in the column layout**

1. From the Report Designer Control Panel, click the Column Layouts icon. A list of available column layouts appears in the Open Column dialog box.
2. Double-click a column layout to display the selected column layout in the Column Layout window.

3. From the Column Layout Currency Translation menu, select Activate DAX Currency Translation.

   **Note:** You must activate currency translation from the Column Layout window menu so that FRx will recognize currency codes in the column layout and row format.

4. Select from the following options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
   | Use currency rate subtype ID in a GL type column | 1. Double-click the cell in the Currency Display detail row of the GL type column and select the currency code from the displayed list.  
   |                                                | 2. Type the currency rate subtype ID in the Currency Rate Subtype ID row.  
   |                                                | **Note:** The code identifies which currency rate subtype ID to read from the general ledger. |
   | Use the currency rate subtype ID in a TCURX transaction detail code column | 1. Double-click the cell in the Currency Display detail row of the TCURX type column and select the currency code from the displayed list.  
   |                                                | 2. Type the currency rate subtype ID in the Currency Rate Subtype ID row.  
   |                                                | **Note:** The code identifies which currency rate subtype ID to read from the general ledger to include the currency exchange rate in the column layout. |

5. On the File menu, click Save.
Setting Currency Options in the Catalog of Reports

In the Catalog of Reports window, you select the building blocks for your reports that use the currency translation function. By using row formats and column layouts that include currency translation selections, you can build a report that displays amounts in an international currency, your base reporting currency, or both. Other selections you make from the Catalog of Reports tabs affect the precision of average currency rate calculations. For detailed instructions about working with the Catalog of Reports, see Chapter 7, “Understanding the Catalog of Reports,” in the FRx® Report Designer 6.7 User’s Guide. For a detailed explanation of methods for calculating average rates, see Chapter 3, “Administering Currency Translation,” in the FRx® Report Designer 6.7 Administrator’s Guide.

Show me an example

Figure 9-5 shows the Currency Translation tab in the Catalog of Reports window.

Selecting Rate Sources

If your FRx license includes the currency translation function, the Report Options tab contains a sub-tab named Currency Translation. From the Currency Translation tab, you tell FRx which spot rate source and historic rate source to use for currency conversion. The source you select depends on your accounting system.

There could be two Spot Rate Source options: FRx and OFSI.

- If your general ledger stores conversion rates along with amounts, and the FRx interface to the general ledger can read the conversion rate data, select OFSI as the Spot Rate Source. FRx then reads the general ledger conversion rates to calculate currency conversions.
- If the general ledger does not store conversion rates or FRx cannot extract conversion rate data, select FRx as the Spot Rate Source to draw the exchange rates from the FRx DAX rate table. FRx is the only option available for the Historical Rate Source, because both historic conversion rates and base currency amounts are read from the FRx DAX rate table.

Selecting Average Rate Calculation

If the row format for your report uses CCAVG row format code, specify one of the following methods for calculating the average rate:
Chapter 9: Using FRx Currency Translation—Designing Currency Translation Reports

- To use the number of rates as the denominator for calculating averages, select the **Use (Sum of Rates / Number of Rates Entered * Balance) for monthly average calculations** check box.

- To use the number of days as the denominator for calculating averages, clear the **Use (Sum of Rates / Number of Rates Entered * Balance) for monthly average calculations** check box.

For a detailed explanation of methods for calculating average rates and the calculation results, see Chapter 3, “Administering Currency Translation,” in the *FRx® Report Designer 6.7 Administrator’s Guide*.

---

**Note**

You must activate DAX from the Column Layout menu to accurately convert international currencies to the base currency used in your general ledger. Be sure to activate DAX before you run a report that includes currency translation.

### Suppressing Rounding Adjustments

When amounts are rounded to whole dollars, thousands or millions, grand totals may be out of balance. However, currency exchange reports should *not* use rounding, because currency exchange rates are typically calculated to the fourth or fifth decimal place. Rounding would invalidate those calculations.

To turn off the rounding feature, select the option, **No Rounding**, in the **Rounding of Amounts** box on the **Report Options** tab, **Formatting** sub-tab in the Catalog of Reports window.

**To turn off rounding of amounts**

1. From the FRx Control Panel, click **Catalog of Reports**.
   
   The **Select Catalog for Display** dialog box appears.

2. Select a catalog ID from the displayed list and click **OK**.
   
   The **Catalog of Reports** dialog box appears.

3. Select the **Report Options** tab.

4. On the **Report Options** tab, select the **Formatting** sub-tab.
5 Select No Rounding in the Rounding of Amounts box.
### Appendix A

This appendix provides answers and troubleshooting help to frequently asked questions (FAQs) and to system error messages.

We also provide you overall Microsoft® Business Solutions for Analytics–FRx® system information. This information includes advice about installation, permissions, and preventing file corruption.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequently Asked Questions (FAQs)</td>
<td>333</td>
</tr>
<tr>
<td>Error Messages</td>
<td>339</td>
</tr>
<tr>
<td>FRx System Information</td>
<td>343</td>
</tr>
</tbody>
</table>
Frequently Asked Questions (FAQs)

Incomplete Report Output

Q: I created a row format with general ledger codes, but when I print a report using the row format, no numbers appear on the report. I see only headers and some title rows. What did I do wrong?

A: There are several possible reasons for the absence of numbers on a report. The most likely cause is an incorrect general ledger code. The way that you check this depends on whether or not the report uses a reporting tree.

Report Uses Reporting Tree

If the report uses a reporting tree and you use the natural account code in the row format, clear the Use Reporting Tree box and regenerate the report.

Check the following row format numbering issues.

1. If amounts appear in your report, the problem is with the reporting tree.
   - Does the account code length used in the row format match the number of hooks used in each reporting tree unit?
     If the account code mask and hooks cannot match with the account code structure, FRx® Report Designer can not return data.
   - Does the tree include detail units, and do the detail units use a complete account mask with hooks (&)?
     Without detail units and hooks in the account mask, Report Designer cannot connect to the row format and the general ledger. Hooks are necessary for the segments that will be defined by the row format. The other segments can use either numbers or wild cards.

2. If amounts do not appear, check both the row format and the column layout.
   - Are the correct general ledger codes used in the row format?
     Report Designer must have the correct codes to pull data from the general ledger.
   - Are there hooks in the row format?
     Use hooks only in the reporting tree. There is no function for hooks in the row format or the column layout.
   - Is there a GL column in the column layout?
     Report Designer must have a column to place the values from the general ledger.

Report Does Not Use a Reporting Tree

Check the following row format issues and causes.

1. Do you have one Link to General Ledger column in the row format?
   - If you have multiple Link to General Ledger columns, does a year appear in every general ledger link except the current year link?
   - If you do not have a Link to General Ledger column, Report Designer does not have a data connection. You must either use a reporting tree or add a GL column to the row format.

2. Are the correct general ledger codes used in the row format?
   Report Designer must have the correct codes to pull data from the general ledger.
3  **Is the Use Reporting Tree check box selected in the Catalog of Reports?**
   Report Designer may be searching for a reporting tree when one is not needed.

4  **Does your company use a different departmental coding structure for income statements than you do for balance sheets?**
   Create different row formats for your balance sheets and income statements. In the balance sheet row format, use the full account code.

5  **Is the row format or the column layout restricted to reporting units?**
   Without a reporting tree, Report Designer suppresses the data for the missing reporting units.

6  **Is there at least one general ledger column in the column layout?**
   A GL column is required for displaying numbers from the general ledger.

### Reports Using Reporting Tree with Overstated Numbers

**Q:** When I generate a report using a reporting tree, certain numbers are dramatically overstated. What is happening?

**A:** There are two possibilities.

- If some rows use the full account code (as opposed to only the natural account code), the related data may pull into every reporting unit (with an account mask).
- Or, if the summary units of the reporting tree use general ledger account masks, this can cause a duplication of data.

### Some Rows Use the Full Account Code in the Row Format

If some rows use the full account code (as opposed to only the natural account code), the related data may pull into every reporting unit (with an account mask). You must restrict these rows to a particular reporting unit.

**To restrict a row to a reporting unit**

1. From the row format, double-click the **Related Rates/Rows/Unit** cell of the row that uses a full account code.
2. Select a reporting tree and click **OK**.
3. Select a reporting unit and click **OK**.

Report Designer restricts this row to the selected reporting unit.

### Summary Units in the Reporting Tree have General Ledger Account Masks

If the summary units of the reporting tree use general ledger account masks, this can cause a duplication of data. Use account masks only in detail units. The higher units should not use a mask; these are used for summarization purposes only. However, using account masks in the summary units may be appropriate to represent corporate level expenses going directly into a summary unit.

Whenever you have problems with a report that includes a reporting tree, run the report again without the tree. If the numbers are correct, you know that the problem is in the tree design.
External Worksheet Data Not Displaying

**Q:** When I link a row format to both the general ledger and an external worksheet, only the general ledger information pulls into the report. Why doesn’t the data from the worksheet display?

**A:** The data path, defined in the reporting tree or row format, could be incorrect or the catalog ID may not be pulling the information from the correct resource. Report Designer must have the correct worksheet path to pull data from the external worksheet file. The correct worksheet path depends on whether you have one or two **Link** columns.

**Two Link Columns: Link to Worksheet and Link to General Ledger**

If you have two **Link** columns, **Link to Worksheet** and **Link to General Ledger**, you must define the worksheet cells in the row format and the worksheet path in the reporting tree.

**To check the worksheet path in the reporting tree**

1. In the row format, check each worksheet cell address in the **Link to Worksheet** column. Compare the address with the external worksheet cell.

2. In the reporting tree, open each reporting unit in the **Reporting Units** dialog box by selecting **View Form** from the **Tree** menu.

3. Check the following:
   - The **Wks File Name** box must contain the complete path to the worksheet. For example, `C:\123\CASHFLOW.XLS` or workbook, `C:\123\[CASHFLOW.XLS]DENVER`, where Denver is the worksheet name.
   - In the **Wks Link** box, select the worksheet column.
   - You must enter a name in the **Row Format Name** box.
   - The **GL or Row Links** box must be empty.

**Note:** If the same worksheet file (and link) is present in more than one reporting unit, the data imports multiple times, possibly overstating results.

4. In the catalog ID, the **Use Row Format from the Reporting Tree** box must be selected.

   This directs Report Designer to use the external worksheet path and row format as defined in the reporting tree for each reporting unit. If you do not select **Use Row Format from Reporting Tree**, Report Designer can not locate the external worksheet data.

**One Link Column: Link to GL + Worksheet**

If you have one **Link** column, **Link to GL + Worksheet**, you must define both the worksheet path and cells in the row format.

In the row format, compare each worksheet cell address in the **Link to Worksheet** column with the external worksheet.
Changing Report Descriptions

Q: I want to change the description For the XXX Months Ending xxx in the Catalog of Reports, but it doesn’t stay changed. How can I change it permanently?

A: The Company menu gives you access to these settings. Use the following steps to change these settings:

1. On the Catalog of Reports window, select the Company menu and click Information to display the Company Information dialog box.
2. In the Period Description and Plural Description boxes, change the text.

Specific Headings for Specific Column Layouts

Q: I want a specific heading to print whenever I use a specific column layout (for example, a Three Month Budget Report). How can I set the heading?

A: Use the following steps to create a specific report heading for a column layout:

1. On the Column Layout window, select the Edit menu and click Description to display the Column Layout dialog box.
2. In the Description box, type a new description for the column layout and click OK.
3. Click Save.
4. Open the Catalog ID window, and click the Page Options tab, and then the Headers / Footers tab.
5. Select the header position and select @COL from the Codes box.
6. Click Save.

This places the description from the column layout in the report header.

Balance Sheet: Totalling Rounded Numbers

Q: When I select the Whole Dollars rounding option, my balance sheet doesn’t total correctly. How can I fix this?

A: Any rounding technique will introduce rounding differences into your total making a true balance impossible. You can solve this problem by adding an automatic rounding adjustment to your report.

To automatically adjust rounding:

1. On the Row Format window, select the Edit menu and click Rounding Adjustments to display the Rounding Adjustments dialog box.
2. In the Total Assets row and Total Liabilities & Equity row boxes, type the row codes.
3. In the Rounding Adjustment row box, type the row code (it must contain a general ledger account) that you want to contain the adjustment.
4 In the **Adjustment Amount Limit** box, type the maximum adjustment amount to allow.

**Note:** When a rounding adjustment is necessary, Report Designer adjusts the selected row and then totals the report again to reflect the new balances.

### Restricting Income Statement Accounts in the Account Detail Report

**Q:** When I calculate my current earnings for balance sheet purposes, how can I keep all those income statement accounts from the Year-to-Date Income row out of the account detail report?

**A:** Open the Row Format window. From the row format, in each row that you want to suppress, double-click the **Print Control** column, select **XD** and click **OK**. This suppresses detail for this row when printing an account detail report. Any rounding technique will introduce rounding differences into your total making a true balance impossible. You can solve this problem by adding an automatic rounding adjustment to your report.

### Out of Balance Message when Drilling into Transaction Detail

**Q:** When drilling into transaction detail within the FRx® DrillDown Viewer™, I receive the message:

“A balance on the transaction detail report may be incorrect. The column layout used with a transaction detail report must contain a CUR column and a YTD column. This error could also indicate a problem with the transaction details not matching the period balance reports in the general ledger.”

**A:** Report Designer does not support the use of more than one YTD column in a transaction detail report. Use of more than one YTD column may cause out of balance messages when drilling into the transaction detail of the report. Reports that cross fiscal years at the transaction level are also not supported. While this message may not appear on all reports, this configuration is not guaranteed to produce reliable transaction detail reports and should not be used.

**Resolutions**

To prevent the out of balance message, use any of the following solutions:

1 Change the column layout to include only one YTD column.
2 Generate the report for Financial and Account detail only.
3 Change the additional YTD columns to CUR columns with a period code of 1 TO 12.

This message may also appear in a report that uses rounding if you did not select the Transaction Rounding option. To resolve the error in this scenario:

1 Verify that none of the solutions mentioned above resolve the error message.
2 Open the catalog for the problematic report.
3 Click the **Report Options** tab, and then click the **Acct/Tran Detail** tab.
4 Select the **Transaction Rounding** check box.
5 Re-generate the report.
Appendix A: Frequently Asked Questions (FAQs)

**Restore a Deleted or Overwritten Row, Column, or Tree**

**To restore a deleted or overwritten row, column, or tree**

1. Have all users close the Report Designer and the FRx® Report Launcher.
2. On the **Company** menu, click **Specification Sets** to display the Specification Sets dialog box.
3. Note the location of the Specification Set where the building block is stored.
4. If you have done extensive report design (for example, modifying existing reports or creating new one) since your last backup and need to preserve this work, proceed to step 5. Otherwise, skip to Step 6.

   **Note:** Deciding to restore the file from backup without completing step 5 eliminates any changes or new reports created since the backup. You could have to re-create some changes and reports that occurred after the backup.

5. Rename the file referenced in the path you noted in step 3.
6. Restore the .f32 file from your last backup.
7. Launch the Report Designer.
8. On the **Company** menu, click **Specification Sets** to display the Specification Sets dialog box.
9. Click **Export** to display the **Export Selection** dialog box.
   Tabs for Catalogs, Rows, Columns, and Trees are displayed.
10. Select the building blocks you need to restore.
11. Click **Export**.
12. Note the location of the export (.tdb) file.
14. Delete the restored .f32 file.
15. Return the file name changed in step 5 back to its original name.
17. On the **Company** menu, click **Specification Sets** to display the **Specification Sets** dialog box.
18. Click **Import** to import the deleted or overwritten building blocks.
19. If a system prompt asks if you would like to overwrite the building block with the same name, click **Yes**.

   **Note:** Use caution when restoring building blocks from backup. Make sure to select the correct catalogs, rows, columns, and trees.
Error Messages

Building Block User Error

Q: I’m receiving the error message “<Building block> is locked by <User>” or “<Building block> is in use by <User>” when opening a row, column, or tree.

In the error the <Building block> is a row format, column layout, or reporting tree; the <User> is a user name.

A: The possible causes of these errors are:

- The building block is currently open by the specified user on another computer.
- The building block was open by the specified user when an application crashed, causing Report Designer to close prior to removing the user name from the record.

Resolution

1 Verify that the building block is not open on another computer. If it is, wait for the user to finish, or have the user close the building block.
2 If the building block is not open on any workstation, have all users close Report Designer.
3 On the File menu, click Close All.
   This action closes all open rows, columns, trees, and catalogs.
4 On the File menu, point to Compact FRx Database, and then click Current Spec Set Database.
5 Do one of the following:
   - If the specification set compacts successfully, open the problematic building block again.
   - If the spec set fails to compact, verify that all users are out of Report Designer, and then try to compact the specification set again.

Disk or Network Error

Q: I received the error message “Runtime error 3043: Disk or Network Error” when launching Report Designer, building an index, or generating a report. What caused this message?

A: You can receive this error when launching Report Designer, building an index, or generating a report. The possible causes of this error are:

- Invalid work drive path, import/export path, or output path.
- Insufficient permissions to a network directory or resource.
- A network resource is unavailable.

To resolve this error use the following steps:

If you cannot open the Report Designer

1 Click Start, and then click Run.
2 Type frx.ini and then click OK.
3 Look for the LastCompany= line.
4 If this line contains a value after the equals sign, remove the text after the = (equals sign) on that line only.
5 Then, save the file and close it.
6 Launch the Report Designer.
7 If the company selection window is displayed before you receive an error, skip to “To locate the necessary paths within Report Designer” on page 340. Otherwise go to step 8.
8 Open the frx.ini file again.
9 Look for the WorkDrive= line, and then make note of the path listed after the = (equals sign).
   This is the work drive path.
10 Go to “Steps for Resolution” on page 341.

To locate the necessary paths within Report Designer
1 If you are prompted to select a company, click Cancel.

Locate the Work Drive Path
1 On the Admin menu, click Processing Options to display the Processing Options dialog box.
2 Make note of the path listed in the Optional Work Drive box.
   This is the work drive path.
3 Click Cancel to close the Processing Options window.

Locate the Import/Export Path
1 On the Company menu, click Information to display the Company Information dialog box.
2 Make note of the path listed in the Import/Export Path list box.
   This is the import/export path.
3 Click Close to close the Company Information dialog box.

Locate the Report Output Path
1 If an error occurs while generating a report, open the catalog for the problematic report.
2 Click the Output tab.
3 If a full path is listed in the File Name box, make note of it because this is the output path.
4 If only a file name is listed, the output path and import/export path are the same.
5 Close the catalog and go to “Steps for Resolution.”
Appendix A: Error Messages

Steps for Resolution

1. If one or more of the paths obtained in the above steps are located on a network server, verify that the server is up and running without errors.

2. If one or more of the paths obtained in the above steps are located on a network server, verify that the server is accessible from the computer receiving the error.

3. Verify that the work drive path is valid and correct.

4. If the work drive path is incorrect, update the path.
   The path can be updated from the Processing Options dialog box or by modifying the frx.ini file. See “To locate the necessary paths within Report Designer” on page 340.

5. Verify that the import/export and output paths are valid and correct.
   If one or more of these paths are invalid or incorrect, locate and update them accordingly. See “To locate the necessary paths within Report Designer” on page 340.
   Repeat the task that previously caused the error.

6. If the error no longer occurs, skip all remaining steps. Otherwise, continue to step 8.

7. Log in to the problematic computer with an account that has administrative rights on the domain.

8. Repeat the task that previously caused the error. If the error no longer occurs, go to step 10. Otherwise, go to step 12.

9. Log out of the machine, then log back in again as the user.
   If the error still occurs, the user has insufficient permissions for one or more of the noted paths.

10. Check the permissions for each directory, and grant permissions as needed.
    Users must have Read, Read and Execute, Write, and Modify permissions for the import/export and output paths. Once you have granted permissions, the user should no longer receive errors.

11. If the error persists, you could need to restart the server.

12. Restart the server to correct the problem.

Specification Set Database Security does not Match Current FRxSys32 Security Setting

Q: I received the error message “Spec set database security does not match current FRxSys32 security settings.” What caused this message?

A: This message occurs when setting a company as a default. The possible causes of this error are:

- Changes in the security settings stored inside the FRxSys32.mdb file.
- Incorrect regional settings.
Appendix A: Error Messages

Changes in the Security Settings

Security settings, along with other FRx configuration settings, are stored in FRxSys32.mdb, a protected database file located in your FRx SysData folder. You cannot modify the FRxSys32.mdb file directly, but configuration and setup selections you make from within the Report Designer are stored in this file, and determine how FRx functions.

If the error message is caused by security settings inside the FRxSys32.mdb file, use the following steps to remove the error.

1. Ask all other users to close Report Designer and Report Launcher.
2. On the Report Designer Admin menu, click Organization to display the Organization Information dialog box.
3. Click the FRx Security button to display the FRx Security Information dialog box.
4. Do one of the following:

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Use FRx Security</strong> check box is selected</td>
<td>Clear it.</td>
</tr>
</tbody>
</table>
| The **Use FRx Security** check box is not selected | 1. Select it.  
2. Click **OK**. |

5. Click OK to close the Organization Information dialog box.
6. Repeat steps 2-5.
   - The **Use FRx Security** check box should now be in its original state. You have effectively toggled the security between on/off or off/on.
8. Then, select the problematic company as the default.
   - The error should now be resolved for you.

Incorrect Regional Settings

If incorrect regional settings is causing the error message, change the Windows Regional Settings on the problematic workstation. Regional settings should match the settings used on functional workstations.
FRx System Information

This section contains information and instructions on:

- Client Installation Types
- Moving FRx to a New Location or Server
- Permissions Required for FRx Users
- Maintaining FRx Data Files and Preventing Corruption

Client Installation Types

FRx allows two types of client installation, fat client, also called local client installation, and thin client compact installation, also called network client installation.

Fat Client (or Local Client) Installation

When you perform a fat or local client installation, the following occurs:

- All FRx program files are installed on the computer’s local drive.
  
  Report Designer files are installed into C:\Program Files\FRx Software\FRx 6.7\ by default, but you can install them into any directory that you specify during installation.

- System files are installed in the Windows System directory.

- FRx data files are typically accessed from a shared network directory.

- Reports can be generated to the local drive, or to a shared network drive.

Advantages

This type of installation allows users to operate locally with no network access provided they access a local SysData directory, and not a shared directory. Users find this type of installation is useful for performing demos or designing reports outside of the office.

We do not recommend this type of installation for live environments.

Disadvantages

The disadvantages to this type of installation include:

- Increased IT maintenance and effort.

- Easier to make mistakes during installation (for example, users can end up looking at different or incorrect SysData directories).

- Manual installation of service packs on each computer.
  This installation effort can be time consuming if you have environments with many users.

- Requires the most hard disk space.

Thin Client (or Compact Installation or Network Client) Installation

When you perform this type of installation, you get the following results:
Appendix A: FRx System Information

- All Report Designer program files are installed in a shared network directory. Users launch most FRx applications from the shared server. During installation, shortcuts to executables on the network are created.
- System files are installed in the Windows System directory.
- FRx data files are accessed from a shared network directory.
- Reports can be generated to the local drive, or to a shared network directory.

Advantages
The advantages to this type of installation are:

- Easy maintenance.
  After the initial client install, you do not need to do anything else on client machines.
- One-time installation of service packs
  The service packs are applied against the FRx program files in the shared network directory.
- Requires a small amount of hard disk space, enough for system files.
- Easy installation
- In FRx 6.7, users can install the client on their computer using a Client Deployment executable.
  The Client Deployment executable setup is created using options specified during the first installation. When users install, they install from a shared network directory and no CD is required. Users are not prompted for any install options, they simply click Finish at the end of the installation.
- All users are accessing one file server to use FRx.
- Troubleshooting and fixing FRx issues is usually a one-time operation, so you do not need to troubleshoot multiple computers.

Disadvantages
This type of installation makes it easier for one user to bring all users down. For example, if one user deletes a file, this action affects all users.

Moving FRx to a New Location or New Server

Sometimes you need to move FRx to a new server or a different location on a network. When you perform this move, you must modify paths within Report Designer to allow use of the existing data files and to allow client workstations to continue to use FRx.

To set up a fat client
In a fat client environment, FRx does not need to be re-installed on client machines.

1. Have all users close all FRx applications.
2. Create the new SysData directory in its new location.

**Warning:** Be sure to leave the existing SysData directory intact!
3 Copy all files from the existing SysData directory to the new SysData directory.
4 Launch Report Designer on one user computer or workstation.
5 From within Report Designer, on the Admin menu, select Organization.
6 Click the SYSDATA button to display the Change SYSDATA Directory dialog box.
7 In the New Directory box, enter the new Sysdata path.
8 Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the SysData directory for each user to the new location. As each user launches the Report Designer, FRx detects this option and changes the SysData directory for the user to the new location. This option places a MOVETO entry in the System.cfg file located in the existing SysData directory.</td>
<td>Click Automatically Update All Users.</td>
</tr>
<tr>
<td>Change the SysData directory for only the current user. Select this option if you plan to change the directory for each user manually. You could do this if you want to remove the existing SysData directory immediately after completing these steps.</td>
<td>Click Update Current User Only.</td>
</tr>
</tbody>
</table>

9 Click OK. A message displays informing you that Report Designer will exit after the change is made.
10 Click OK again.
11 Launch the Report Designer.
12 If you do not need to change the Import/Export paths for companies, skip to step 17. Otherwise, on the Company menu, click Information to display the Company Information dialog box.
13 Select the first company.
14 Type or select the new Import/Export path, and then click Save.
15 Repeat step 14 for all remaining companies.
16 Click **Close** to close the Company Information dialog box.

17 On the **Company** menu, click **Specification Sets** to display the **Specification Sets** dialog box.

18 Select the first specification set.

19 In the **Location** box, enter the new location.

**Warning:** Leave the file name intact.

20 Click **Save**.

21 If a message displays saying that the spec set exists in the new location, and asking you if want to overwrite, click **No**.

22 Repeat steps 18-20 for each remaining spec set.

23 If you selected the **Update Current User Only** option in step 8, repeat steps 4-10 for all remaining computers or workstations.

**To set up a thin client**

1 Have all users close all FRx applications.

2 Install FRx to the new network location, and apply the latest service pack immediately after installation.

3 Using Microsoft Windows Explorer, browse to the new SysData directory.

4 Move all the files from the NEW SysData directory into a backup directory.

5 Copy all the files from the old SysData directory into the new SysData directory.

**Warning:** Leave the old FRx install and SysData directory intact!

6 From one user workstation, browse to the new FRx directory.

7 Double-click on the FRxReg.exe file to register all DLL files found in the FRx directory.

8 Launch the Report Designer on the user workstation.

9 If the Import/Export paths for companies do not need to be changed, skip to step 13. Otherwise, on the **Company** menu, select Information to display the **Company Information** dialog box.

10 Select the first company.

11 Type or select the new Import/Export path, and then click **Save**.

12 Repeat step 11 for all remaining companies.

13 Click **Close** to close the **Company Information** dialog box.

14 On the **Company** menu, click **Specification Sets** to display the **Specification Sets** dialog box.

15 Select the first specification set.
In the **Location** box, enter the new location.

**Warning:** Leave the filename intact.

Click **Save**.

If a message displays saying that the spec set exists in the new location, and asking you if you want to overwrite, click **No**.

Repeat steps 16-18 for each remaining spec set.

Repeat steps 6-8 for each remaining user workstation.

**Permissions Required for FRx Users**

Certain user permissions are required for each FRx module.

**Report Designer Users**

The following user permissions are required:

- All users require Read, Read & Execute, Write, and Modify permissions for the FRx program directory, IO_Data directory, and Sysdata directory.

- If you use directories other than the IO_Data directory for report output, users must also have Read, Read and Execute, Write, and Modify permissions for these additional directories.
  
  If users are restricted to specific companies, you can grant them permissions for only the company directories they use.

- If you are using the FRx® Report Server, users must also have Read, Read & Execute, Write, and Modify permissions for the Queue directory. This is typically the same as the SysData directory.

- If your company is using the FRx® WebPort, users publishing reports must have Read, Read & Execute, Write, and Modify permissions for the WebPort Data directory on the Web server.

**Report Launcher Users**

The following user permissions are required:

- All users require Read, Read & Execute, Write, and Modify permissions for the FRx program directory, IO_Data directory, and Sysdata directory.

- If you use directories other than the IO_Data directory for report output, users must have Read, Read and Execute, Write, and Modify permissions for these additional directories.
  
  If users are restricted to specific companies, you can grant them permissions for only the company directories they use.

**DrillDown Viewer Users**

- Local DrillDown Viewer users require Read and Read & Execute permissions for the FRx program directory and IO_Data directory.
If you use directories other than the IO_Data directory for report output, users must also have Read and Read & Execute permissions for these additional directories. If users are restricted to specific companies, you can grant them permissions only for the company directories they use.

To use the subtotaling functionality in the DrillDown Viewer, Read and Read & Execute permissions are also required for the SysData directory.

Remote DrillDown Viewer users (those that use the DrillDown Viewer only on their workstation) do not require any permissions for FRx directories on the network.

Report Server

The Report Server must run under a logged-on profile on a server; it cannot run as a service. The user that launches the Report Server must have Read, Read & Execute, Write, and Modify permissions for the IO_Data and SysData directories.

If you use directories other than the IO_Data directory for report output, the logged-on user must have Read, Read & Execute, Write, and Modify permissions for these additional directories.

If you use a separate Queue directory (the Queue directory and the SysData directories are typically the same), the user must have Read, Read & Execute, Write, and Modify permissions for the Queue directory.

If the Report Server publishes reports to the WebPort, the user must have Read, Read & Execute, Write, and Modify permissions for the WebPort Data directory on the Web server.

WebPort Users

Because the WebPort is a Web application, users do not require any permissions for any directory. However, the Internet Guest Account for Internet Information Services (usually IUSR_COMPUTERNAME) and the Launch IIS Process Account (usually IWAM_COMPUTERNAME) must have Read, Read & Execute, Write, and Modify permissions for the WebPort Data directory and all subdirectories.

Web Administrator Users

Users require Read, Read & Execute, Write, and Modify permissions for the WebPort Data directory on the Web server, as well as Read and Read & Execute permissions for the SysData directory.

In most cases, users also require Read and Read & Execute permissions for the IO_Data directory to publish previously-generated reports.

If you use directories other than the IO_Data directory for report output, users must have Read and Read & Execute permissions for these additional directories. If users are restricted to specific companies, you can grant them permissions only for the company directories they use.

Maintaining FRx Data Files and Preventing Corruption

To prevent corruption in FRx data files, we recommend:

- Running and keeping regular backups.
Appendix A: FRx System Information

- Frequently compacting the FRx System and Specification Set Databases.
- Always saving the Report Catalog after making changes and before generation.
- Excluding the FRx SysData directory from network virus scans.

Running and Keeping Regular Backups

This is the most important procedure you can follow for software applications such as FRx that store data. You should run backups nightly if FRx is used daily. Otherwise, you should run backups at least once a week. We recommend frequent backups of the entire FRx SysData directory.

If you do not frequently perform data backups, you can lose reports and other valuable FRx data. Although our FRx Support group can attempt to repair a corrupted file, we cannot guarantee successful file repairs.

Compacting the FRx System and Specification Set Databases

The FRx system database contains companies, registration information, FRx security information, users, font styles, and other FRx operation information. Specification sets contain report components such as row formats, column layouts, reporting trees, and catalogs.

When you compact the system or specification set databases, Report Designer creates a new file with the same structure and removes user-deleted records and other unnecessary information. The remaining information is moved into a new file. When you compact these files on a regular basis, these files remain small in size. These compacted files help reduce errors and lost data.

Depending on how frequently you use FRx, you should compact these databases weekly or bi-weekly.

**To compact the system or specification set databases**

1. Ensure all users exit Report Designer.

   **Note:** The user compacting the databases must have exclusive access to the FRx files.

2. On the **Company** menu, click **Select Default** to display the **Select Default Company** dialog box.

3. Select the appropriate company and click **OK**.

4. On the **File** menu, point to **Compact FRx Database**, and then click **FRx System Database**.

5. Click **OK** to compact the database.

   **Tip:** If all other users have exited Report Designer, the database should successfully compact.

   You are now ready to switch to a non-demo company.

6. Return to the **Company** menu, click **Select Default** to display the **Select Default Company** dialog box.

7. Select the company and click **OK**.
8 On the File menu, point to Compact FRx Database, and then click Current Spec Set Database.

9 If you are using more than one specification set, repeat steps 6-8 for each company that uses a different specification set.

Warning: If all other users are out of Report Designer, and you receive errors when compacting, contact your FRx software support provider.

Saving the Report Catalog after Making Changes and Before Generation

When you make changes to a catalog, save the catalog before you generate a report. If you do not save your changes, Report Designer must create a new record to store these changes before passing the report to the FRx reporting engine. These records accumulate over time and result in larger data files. These files are more susceptible to corruption and damage.

Excluding the FRx SysData Directory from Network Virus Scans

FRx stores reports and other information in Microsoft JET database files. Virus scan programs can corrupt these database files.
**account code**
The unique identifier for a record that holds the balance relating to any single asset, liability, owner's equity, revenue, or expense of the business.

**account filter**
A general ledger account mask used in the column layout to restrict a column to specific general ledger accounts.

**account mask**
See mask.

**account modifier**
An operator used to offset the period or year for a specific row, and also referred to as a row modifier.

**accounting period**
A period of time, such as a month, quarter, or year, for which financial statements that measure flow, such as an income statement, are prepared. At the end of each accounting period, all GL accounts must balance. Accounting periods are defined in the general ledger.

**account sets**
A group of accounts assigned a name (for example, the range of accounts from 5100 to 5600 entitled Travel and Entertainment). Account sets are created in row formats.

**alphanumeric**
A term for either alphabetic or numeric characters, usually used in reference to a code, such as a report name, row code or description.

**application**
A computer software program designed for a specific purpose. FRx is considered an application.

**apply date**
The date that determines to which GL accounting period a transaction posts. See also document date, entry date.

**attribute filer**
Additional pieces of information (financial and non-financial) that exist in the GL database. FRx supports two types of attributes: account based and transaction based.

**average rate**
The average of all currency exchange rates over the period of the financial statement. This is nearly always used for income statement accounts. The period between measurements to determine the average (daily, weekly, monthly, and quarterly) can vary by type of report. For example, internal management reports will typically use daily intervals, but some statutory reporting may require the average of the starting and ending rates during the period.

**background**
Describes a window that is open but which is not the active window in which you are working.

**base currency**
The foundation currency in which all other currencies are stated. For U.S. based companies, this will normally be the US dollar, but European companies will probably use the EURO.
base period
A code used in column layouts to represent an accounting period that is relative to an actual period that is defined when a report is generated. For example, if the column layout specifies BASE in the **Period Code** box, then the actual period is defined in the Catalog of Reports at the time the report is generated.

batch
A logical group of transactions assigned the same apply date and posted as a unit.

beginning balances
The opening balances for a period or a year.

box
A control into which you type or select information.

catalog ID
A unique code that identifies a report in the catalog of reports. The catalog ID can be up to 16 characters. The following characters are not allowed: - ' “ |

**Catalog of Reports**
The FRx component in which row formats, column layouts and reporting trees are combined to create a financial report. Report elements such as headers, footers, presentation of amounts, output formats and so forth are defined in the Catalog of Reports.

**CBR**
Change Base Row. The format code **CBR** tells FRx what row you want to use as the base row for any percent calculations. This base row remains in effect until another **CBR** format code is used within the same row format.

**chain reports**
A process that allows you to run several reports together. When you chain reports, they run one after another.

check box
A control that allows you to select an option. A check box that is selected indicates the option is active. A check box that is not selected indicates the option is not active. A group of check boxes is not mutually exclusive, meaning you can check more than one. *See also* radio button.

child unit
A unit in an FRx reporting tree that is a subsidiary to a higher level unit called a parent. FRx can roll up data from child units to parent units to create summary reports.

code
A unique name or identifier that is defined by the user and attached to a record of information for use in database management. A code is often a record key.

column layout
One of the three FRx building blocks. Column layouts contain headings for report columns as well as codes to define the type of information in a column: reporting periods, calculations, and so forth. *See also* row format, reporting tree.

company code
A unique identifier for a record that defines company information needed for processing financial reports.

control
A term for any user interface component that allows you to select choices or type information; for example, an entry box, a check box, or a radio button.

conversion currency
A currency whose value is to be converted into the base currency, using the monetary exchange rate for a given date.

**CPO**
Column Period Offset. A switch used in row formats when linking to external worksheets. If the worksheet to which you are linking has multiple columns or rows that represent different periods (such as a worksheet with a 12 month detailed
forecast), the **ICPO** (Column Period Offset) switch tells FRx to match the accounting periods in the column layout with the appropriate columns in the worksheet. You can use this technique with either combined or separate worksheet links.

**daily rate**
The current (spot) currency exchange rate. For reporting purposes, a different current rate should be available for each balance sheet date.

**database**
A collection of like sets of information, stored in tables. For example, sets of accounting ledgers. You might think of a database as similar to a filing cabinet that holds all the information for a company.

**database management system**
An application program that supports the definition, manipulation, and control of a database.

**date mask**
A format that standardizes how dates appear in the module. Date masks often vary from country to country.

**default**
Information that the system automatically enters in a box. For boxes that can be edited, the system enters the most common information. For boxes that cannot be edited, the system enters required information.

**default company**
The company currently selected for processing. The company code displays in the status bar. You can change companies from the **Company** menu.

**default printer**
The printer chosen through the **Printer Setup** dialog box as the default. When no other printer is specified, the system sends print jobs to the default printer.

**detail level**
A selection in the Catalog of Reports that refers to the level of detail in a report. The choices are financial report (typically a high level summary based on the row format), account detail report (displays the account detail balances that make up the financial report), and transaction detail report (provides the most detail—down to the transaction level).

**detail unit**
A reporting unit that draws information directly from the general ledger. See also child unit, reporting unit, summary unit.

**dialog box**
A type of window, fixed in size, that requests further information from you to continue processing. You must provide the information or respond to the query before the system continues processing.

**direction keys**
The **Up Arrow** (Up), **Down Arrow** (Down), **Right Arrow** (Right), and **Left Arrow** (Left) keys, used to move the insertion point or focus or choose from a list of options.

**disabled**
Describes a control or command that is unavailable for use. The controls and commands appear shaded, rather than solid, when disabled. The system disables commands and controls when they are illogical to use.

**document control menu**
A menu that is standard on all document windows, including forms, dialog and message boxes, that lists commands you perform on the document windows, such as maximize, minimize, size, and move. Not all commands are available in all types of document windows.

**document control menu box**
The leftmost symbol in the title bar of a document window (form, dialog or message box). When you click this box or press **Alt+hyphen**, the **Document Control** menu opens.
<table>
<thead>
<tr>
<th>Glossary Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>document date</strong></td>
<td>The date you assign to a transaction document, such as an invoice. Often, the document date is assigned the date you enter the document. <em>See also</em> apply date, entry date.</td>
</tr>
<tr>
<td><strong>DrillDown Viewer</strong></td>
<td>FRx® DrillDown Viewer™ allows you to view, print, export, save, and send reports created in FRx® Report Designer.</td>
</tr>
<tr>
<td><strong>drop-down list box</strong></td>
<td>A type of control where you can view a list of choices by dropping down a list box.</td>
</tr>
<tr>
<td><strong>effective dates</strong></td>
<td>The date or period number at which a specific row format, column layout, or reporting tree is used. These dates and periods are set in the Catalog of Reports.</td>
</tr>
<tr>
<td><strong>edit mode</strong></td>
<td>A state in which the system accepts typing, both for entering text and editing, in a box. A box is in edit mode when the insertion point is present.</td>
</tr>
<tr>
<td><strong>dynamic data exchange (DDE)</strong></td>
<td>A process that supports the linking of information between applications (for example, a direct link between a spreadsheet cell and a program box).</td>
</tr>
<tr>
<td><strong>dynamic headings</strong></td>
<td>Headings in the column layout that are set up to change based on specific data you specify when a report is generated, such as period or fiscal year.</td>
</tr>
<tr>
<td><strong>enabled</strong></td>
<td>Describes a command or control that is available to use. The command or control appears in solid text (rather than shaded) when enabled.</td>
</tr>
<tr>
<td><strong>Enterprise Server</strong></td>
<td>The FRx Enterprise Server is an enhanced FRx Report Server with up to four CPUs and reporting engines to process up to four reports simultaneously.</td>
</tr>
<tr>
<td><strong>entry date</strong></td>
<td>The date on which a record is entered. The entry date defaults to the system date and cannot be edited. <em>See also</em> apply date, document date.</td>
</tr>
<tr>
<td><strong>extranet</strong></td>
<td>A type of intranet that is partially accessible to authorized outsiders. Whereas an intranet resides behind a firewall and is accessible only to people who are members of the same company or organization, an extranet provides various levels of accessibility to outsiders. You can access an extranet only if you have a valid user ID and password, and your identity determines which parts of the extranet you can view.</td>
</tr>
<tr>
<td><strong>field</strong></td>
<td>A column of a database table or a cell of a spreadsheet in which data is entered or stored.</td>
</tr>
<tr>
<td><strong>focus</strong></td>
<td>The visual cue of a selected box or control. The focus takes many forms, such as a solid outline box around an entry box, or the dotted outline box around the label of a pushbutton, check box, or radio button.</td>
</tr>
<tr>
<td><strong>form</strong></td>
<td>A secondary window displayed in the client area of the application window which emulates a written document or data entry form. You enter and review most information through module-specific forms.</td>
</tr>
<tr>
<td><strong>format code</strong></td>
<td>Format codes control the appearance of a row. Every row is interpreted as a general ledger detail row unless a code is present in the Fmt Code column of the row format. Double-click the Fmt Code column to display the list of available codes.</td>
</tr>
</tbody>
</table>
format mask
A group of codes used in row formats, calculations, and so forth that defines how monetary amounts are shown on reports. The mask controls the symbols and placement of decimals and thousands separators, as well as the presence or absence of currency symbols and leading/trailing zeros. See also numeric mask characters.

full account code
An account code defined in the general ledger. The fully qualified account includes the natural segment, combined with the sub-segments such as departments, locations and divisions.

functional currency
The primary currency in which a company typically transacts business, also known as home currency or base currency. See base currency.

general ledger
A ledger of accounts that are reported in the financial statements.
Posting transactions updates the accounts in the general ledger.

general ledger index (G32)
The general ledger index, or G32, is a file extension for index files created and maintained by FRx. There is one G32 file maintained per FRx company and it is located in the FRx SYSDATA directory. This file contains basic information about a company, such as the account mask, account segmentation, and calendar setup. It also may contain the chart of accounts and unposted transactions depending on the accounting system and company setup.

graphical user interface (GUI)
A computer application screen interface that uses icons and pictures to represent objects or selection choices.

historic rate
The currency exchange rate that was current when the activity in an account (such as the purchase of an asset) actually took place. This is typically applied to non-monetary assets (for example, inventory, fixed assets, long-term liabilities, and equity).

hook character (&)
The hook character (&) is used in the account mask box in the reporting tree to define the report’s connection to the row format. Hooks are usually used in the natural account segment, but they are not limited to that segment.

icon
A pictorial representation of an object or a selection choice. Icons can represent minimized forms or application windows, or resident applications not currently active on the desktop.

insertion point
The vertical blinking bar that notes where text is going to be inserted.

instance document
Instance documents contain data. An XBRL instance document contains accounting, financial, or other business related data (for example, a financial statement issued by a company), expressed using XBRL syntax, and making use of the XBRL taxonomy. The financial statements of a company or any part thereof, expressed in XBRL, would be an instance document as would an HTML file that had various XBRL items embedded in it.

interface
The common program boundary between two modules or applications that allows data entered in one to be used by the other. Interfaces eliminate the need for duplicate data entry among modules.

link
An FRx feature that connects a row format to the general ledger, an external worksheet, another row format, or a specific fiscal year.

list box
A control that contains a list from which you can select available choices. Some list boxes are fixed in size on the form; others scroll to provide for variable length lists; still others drop down from a downward pointing arrow button appended to the right of a box.
**lookup box**
A box from which you can open a zoom window to view and select possible values for the box.

**mask**
A format that keeps codes or numbers uniform. The mask can require a certain type of character, such as a number or a letter, and it can require a certain number of characters or digits. Account masks are used in the general ledger to keep the format of all account numbers uniform. See also **date mask** and **numeric mask characters**.

**menu bar**
The main menu of the application; also called the action bar in some graphical user interface environments.

**menu command**
A menu selection that immediately performs an action such as sending output to a printer, opening a form, or calling up a dialog box so that you can specify additional information. Menu commands that open dialog boxes have ellipses following the command name.

**modifier**
*See* account modifier.

**module**
A subset of a software application, such as accounts receivable, general ledger, and inventory.

**Multiple Document Interface (MDI)**
An interface style in which users can work in numerous windows at the same time, or numerous instances of the same window at the same time.

**natural segment**
A typical general ledger account code contains at least one account code segment that describes the type of account (for example, cash or sales). This segment of the general ledger code is referred to as the natural account code segment in the FRx system.

**numeric mask characters**
Mask characters define the masks FRx uses for amounts.

- **0** A zero mask character inserts a zero (0) into the amount if the digit is not used. See the following example:
  
  Mask      000.00
  Amount    $010.53

- **#** A pound sign mask character does not insert a zero (0) into the amount if the digit is not used. See the following example:
  
  Mask      ##0.00
  Amount    $10.53

**OLAP**
On-Line Analytical Processing. A system for presenting summarized financial data in a business model format that facilitates online business analysis. Financial data is presented in a multidimensional structure called a cube.

**OLAP cube**
A three-dimensional data model composed of cells that represent the intersection of a report row, a report column, and a reporting unit. OLAP cubes derived from FRx reports are restricted to financial level information, and do not contain account or transactional details.

**OLE**
Object Linking and Embedding. A Windows feature that allows FRx to link directly to a Microsoft Excel 2000 or later spreadsheet.

**originating currency**
The currency of a transaction (such as an invoice) which may be different from the functional currency.

**parent unit**
A unit in an FRx reporting tree that has subsidiary, or child, units. FRx can roll up data from child units to parent units to create summary reports.
**period modifier**
Typically, when an account is specified in a row format, FRx combines the account with the periods and account types specified in the column layout. However, you can use the account modifier codes in the row format to use different information (such as different fiscal periods) for specific rows. The modifiers apply to every account in the row.

**posting**
The act of transferring financial transactions entered in journals and subledgers to the general ledger in order to update account balances. Posting updates accounts tracked in the general ledger module with financial data entered in other modules, such as inventory and accounts payable, as well as general ledger.

**print control**
An option in the column layout that enables users to indicate special printing characteristics such as non-printing and reversed credit and debit signs when reports are generated.

**provisional reporting**
The provisional reporting options in the Catalog of Reports determine whether FRx includes posted, unposted, or both posted and unposted general ledger transactions in the report. Posted transactions include activity from every module (accounts receivable, accounts payable, etc.) in which a general ledger update has been run.

**radio button**
A control that allows you to select one option among multiple options. A radio button that is selected indicates the option is active. A radio button that is not selected indicates the option is inactive. Unlike a group of check boxes, a group of radio buttons represents a mutually exclusive choice—selecting one of the buttons disables the others.

**record**
A database term for a collection of logically related fields; that is, one set of information. You might think of a record as a paper form that contains information about one subject, such as a customer or a purchase order.

**report book**
A comprehensive book containing FRx reports and other documents that can be published for viewing in DrillDown Viewer, WebPort, and a Windows directory, and in e-mail.

**report building blocks**
FRx uses three basic building blocks for a report: a row format, a column layout, and a reporting tree.

**Report Designer**
Report Designer extracts information from your general ledger and optionally combines it with information from Lotus 1-2-3 or Microsoft® Excel spreadsheets. Then, it uses your customized report formats and your customized management reporting hierarchy to produce reports.

**Report Launcher**
FRx® Report Launcher allows you to generate reports previously saved in the Report Designer Catalog of Reports.

**Report Manager**
FRx® Report Manager is an optional module that pulls together FRx reports and other files such as Microsoft Office documents for easy viewing, printing, and distribution.

**Report Server**
The FRx® Report Server is a separate FRx product that runs on a server platform dedicated to report generation and report scheduling. With the Report Server installed and configured on the network, FRx users can continue working at their workstations while the reports generate on the Report Server.

**reporting currency**
A currency used for financial reporting purposes. This could be the functional currency or is typically the currency of the parent company.

**reporting tree**
One of the three FRx building blocks. Reporting trees are visual representations of an organization’s structure, showing levels in the corporate hierarchy such as companies, divisions, departments, projects and tasks. See also column layout, row format.
reporting unit
A level within an FRx reporting tree that represents either an individual department that draws data directly from the general ledger or a summary unit. A company can create multiple reporting trees to facilitate different financial reports without affecting the general ledger. See also detail unit, summary unit.

responsibility segment
The segment or segments of the general ledger account code that refer to the overall structure of an organization. Examples are departments, divisions, projects, tasks, and so forth.

row code
A code, either a word or a number, which identifies a row in the first column of a row format.

row format
One of the three FRx building blocks. Row formats contain links to the general ledger and/or external worksheets and other row formats. They also contain report row descriptions and calculations. See also column layout, reporting tree.

row modifier
See account modifier.

row period offset
A switch used in row formats when linking to external worksheets. Use the /RPO switch if the worksheet to which you are linking has multiple rows that represent different periods. When this code is used, FRx matches the accounting periods in the column layout with the appropriate rows in the worksheet. You can use this technique with either combined or separate worksheet links.

scroll bar
A window component that informs users that more of the window can be viewed. You manipulate the scroll bar to view more of the window contents.

segment code
A section of an account code that represents a type of entity for which you are accounting. For example, you may have segmented your account codes into natural accounts, divisions and departments. In this example, you would define a segment code for each natural account, division, and department.

select
To choose an option or choice. Selecting is most often accomplished either by clicking on the option, or highlighting the option and pressing the spacebar.

shortcut keys
A keystroke (for example, F3) or keystroke combination (Alt+H) that provides a quick method for issuing a command, without opening a menu.

specification set
A database that stores row formats, column layouts, reporting trees, and catalog IDs. Each FRx company can have its own specification set or several FRx companies can share the same specification set.

spot rate
The current (daily) currency exchange rate. For reporting purposes, a different current rate should be available for each balance sheet date.

summary unit
A reporting unit that summarizes data from lower-level units. The lower-level units can be either detail units or other summary units. See also reporting unit, detail unit.

suite
Any report or group of reports that are defined using a reporting tree. The suite can encompass from one to the total number of reporting units in the tree.

SYSDATA
The SYSDATA button on the Organization Information dialog box, accessed from the Admin menu, defines the path and directory where you store FRx system files.
**table**  
A database term for the structure that holds a collection of related records. Tables consist of columns and rows of information.

**taxonomy**  
The XBRL taxonomy is a classification system for business and financial reporting data elements. XBRL taxonomies can be regarded as extensions of XML Schema.

**toggle**  
An option that can be turned on or off. For example, the **Status Bar** command on the **Options** menu can be checked on or off.

**transaction**  
In general, a business event which can be measured in currency and can be entered in the accounting records.

**triangulation currency**  
A currency whose exchange rates are maintained in FRx for both the base currency and the conversion currency. If an exchange rate table is not maintained between two currencies, but a third, common currency is available with exchange rates for both currencies, the first currency can be converted into the common (triangulation) currency, and then the common currency can be converted into the second currency.

**tree**  
*See* reporting tree.

**WebPort**  
The FRx® WebPort product lets users publish FRx reports in Web repository environment that supports both FRx reports and non-FRx objects such as Word documents, Excel spreadsheets, or OLAP cube files. This product makes files viewable with your internet or intranet.

**wildcard character (?)**  
A special character that stands for any one or more possible characters; a placeholder. For example, the ? is a wildcard in account mask boxes.

**XBRL**  
Extensible Business Reporting Language (XBRL) is an open specification that uses XML-based data tags to describe financial statements for both public and private companies.

**XBRL taxonomy document**  
An XML Schema file that describes a set of concepts that are used in preparing an XBRL instance document. A taxonomy document can be either an XBRL taxonomy (e.g. US GAAP CI), or a custom taxonomy created in conformance with XBRL specifications. Custom taxonomies are used to extend the XBRL taxonomies to address company and/or industry specific items not addressed in the XBRL taxonomies.

**XML**  
eXtensible Markup Language. XML provides a generalized markup scheme for representing the logical structure of documents in a system-independent and platform-independent manner. XML files can be published on the World Wide Web or a server-based Web repository and can be displayed in a Web browser.
Symbols

% Allocation to Parent box 207
& character
  reporting trees 201
  using hooks 185
+ character in reporting trees 201
./A code 102
/ functions
  /CPO 127
  account modifiers 104
? character
  reporting trees 201
  using wildcards 169
@ character
  @UNIT code 73
  @UNITT# code 73, 284
  using 88

A

account code
  including in report 149
mask
  building a row format 96
  defining in tree 183
natural segment
  defining 95
  using in reporting tree 215
using full account 96
using in FRx 10
account detail, suppressing 83
account filters, using 169
account mask
  defining 183
Account Mask box 69
account modifiers
  entering 105
  linking to worksheets 127, 128

Account Only option 52, 232
Account Range End box 28, 70
Account Range Start box 28, 70
account range, entering in row format 98
account sets
  creating 102
  editing 104
Account Type option 101
account types, using 101
Accounting System box 24
Acct Column type 149
Acct/Trans Detail tab 236, 267
Add Reporting Units from Chart of Accounts dialog box 197, 198
Add Reporting Units from Chart of Accts command 192
Add Rows From Chart of Accounts dialog box 69
adding the OLAP description to the column layout 173
additional text
  entering in reporting trees 216
  in report headers and footers 284
  in the row format 73
Additional Text code 284
  in row format 73
Address box 255
Adjustment Amount Limit box 114
Advanced tab 236, 270
Allow Column Text Overflow box 262
Allow Rollup 1% box 207, 270
Amount & Date Format box 24
Amount with Currency Symbol box 262
ASCII, exporting reports 246
asdfsadf 333
asdfsdf 333
asdfsadfasf 333
asdfsadfsdf 333
asdfsadfsdf 333
base period
  concept 11
  entering column layout 152
Base Period box
  about 233, 235
  entering 277
base row, changing or using in calculations 156
base year
  entering column layout 151
Base Year box 53
  entering 277
Before Each Reporting Unit option 270
Book Code Description box 173
Book Codes
  restricting rows 107
budget data, including in column layout 151
Building Blocks tab 236

CAL Format Code 75
Calc Formula box 156
Calculate Columns First option 272
Calculate Rows First option 272
calculations
  applying to specific columns 88
column layout
    CALC 149
    IF/THEN/ELSE statements 157
multiplying and dividing 155
row format
  CAL 88
  IF/THEN/ELSE statements 91
point and click functionality 93
  TOT and CAL 87
using operators 88
Catalog ID
  chaining 281
  cloning 283
  creating 51
Catalog ID box 51, 275
Catalog of Reports
  Catalog menu 226
  Edit menu 226
  File menu 225
  Window menu 227
Catalog of Reports icon 8
CBR format code 75
CCAVG currency code 324
CCHIST currency code 324
CCSPOT currency code 324
CCX currency code 324
Chain to Catalog ID box 251, 281
chart of accounts, building row format 68
Choose a Reporting Tree dialog box 241
Choose a Row Format dialog box 134, 238
Clear box
  headers/footers 261
Clear command 17, 191
Clone button, record control box 19, 283
Codes box 258
Collapse Branch command 189
column
  defining placement 85
  defining width 65
  editing 143
  entering details 147
  entering headers 145
  headings
    codes, mixing with text 146
    formatting 145
  matching placement with worksheet (/CPO) 127
  restricting to specific dates 171
  using in calculations 155
Column Layout box 54
Column Layout command 226
column layouts
  creating 45
  menus
    File 140
    opening 138
    pulling data 151
Column Period Offset option 127
Column Restriction code 176
Column Width command 193
Column Width dialog box 65
Combine button 214
Combine Posted and Unposted Amounts option 267
comma method, column placement 126
company
  entering 23
  Company box 52, 208
  Company Information dialog box 23
Company Name box 24
configuring FRx 12
Copy command 16, 191
credits
  restricting column to credit 164
  using the normal balance 83
Currency Code cell 168
currency codes, assigning in row format 112
currency conversion
  historical rate source 274
  spot rate source 274
currency rate source 329
Currency Rate Subtype ID in column layout 327
Currency Symbol on 1st Row option 262
Currency Translation tab 323, 329
currency translation, purpose 320
currency translation, reports 323
currency, defining in the row format 112
Current Per/YTD cell 174
Current/YTD period 154
Cut command 16, 191

date
  including in column header 144
  restricting a column 171
Date Period cell 239, 240, 242
date, setting the report 276
DAX (Dynamic Automatic Currency Translation) 320
debit amount
  including the normal balance 83
  restricting a column 164
debit/credit reports, creating 175
Default Base Period box 233, 234
default base period codes 234
Default Font Style box 258
Delete button, record control box 19
Delete Column command 141
Delete command 140, 191
Delete File After Printing/Viewing/Sending box 251
Delete Unit command 192
deleting
  column layout 140
  columns from column layout 141
  reporting tree 191
reporting units 191

description box 24
configuring FRx 12
Copy command 16, 191
credits
  restricting column to credit 164
  using the normal balance 83
Currency Code cell 168
currency codes, assigning in row format 112
currency conversion
  historical rate source 274
  spot rate source 274
currency rate source 329
Currency Rate Subtype ID in column layout 327
Currency Symbol on 1st Row option 262
Currency Translation tab 323, 329
currency translation, purpose 320
currency translation, reports 323
currency, defining in the row format 112
Current Per/YTD cell 174
Current/YTD period 154
Cut command 16, 191

date
  including in column header 144
  restricting a column 171
Date Period cell 239, 240, 242
date, setting the report 276
DAX (Dynamic Automatic Currency Translation) 320
debit amount
  including the normal balance 83
  restricting a column 164
debit/credit reports, creating 175
Default Base Period box 233, 234
default base period codes 234
Default Font Style box 258
Delete button, record control box 19
Delete Column command 141
Delete command 140, 191
Delete File After Printing/Viewing/Sending box 251
Delete Unit command 192
deleting
  column layout 140
  columns from column layout 141
  reporting tree 191
reporting units 191

descriptions
  assigning in the row 75
  assigning multiple 89
  defining in column layout 149
  entering 73
  suppressing 75, 77
Detail Level box 52
details
  suppressing in column 164
  suppressing in row 83
direct column placement 126
direct reference column placement 125
Display Account Description from Chart option 267
Display Blanks for Zero Amounts option 262
Display Commas in Amounts option 262
Display GL Account Code option 267
Display Report Processing Status option 273
Display Reports With No Active Rows option 262
Display Row Code option 267
Display Rows With No Amounts option 262
Display Underscore before Totals option 267
DrillDown Viewer (Enhanced XML) option 244
DrillDown Viewer (Enhanced XML) output for XBRL reports 317

e-mail
  reporting tree addresses 217
  sending 254
E-mail Options tab 236, 243, 254
Enable E-mail box 254
exception reports, generating 271

Exclude Inactive Accounts (If Available) option 273
Expand All command 195, 196
Expand Branch command 189, 195
Extra Lines Between Rows option 262

F

File menu commands
  catalog of reports 225
  column layout 140
  reporting tree 190
  row format 59
File Name box 250
Financial & Account option 52, 232
Financial & Transaction option 52, 232
Financial Report option 52, 232
Find button, record control box 19
Find command 17, 192
Find dialog box 62
Find What box 18, 62
fiscal year
  assigning in the column layout 151
  column header codes 144
  linking year-to-year 121
  using the base 151
Fmt Code, selecting 74
Font Style Name box 64, 260
Font Styles command 226
Font Styles dialog box 64
tfont styles, creating and editing 260
Format Name box 239, 240, 242
formatting
  amounts
    display 83
    international 209
    negative values 157, 262
    row-by-row 91
  combined worksheet link 129
  fonts and shading. See font styles, creating and editing.
    reports 261
    row formats
      Fmt Codes 74
      placing values in columns 85
      related rows 82
Formatting tab 236, 261
FRD output type for XBRL reports 317
Freeze at Description command 196

FRx instant!OLAP-Microsoft Server Cube option 247
FRx Reporting Engine status window 273
full account code
  combining with natural 96
  entering in row format 96
  restricting row to reporting unit 82
Functional Currency box 24

G
general ledger
  connecting to the reporting tree 181
  displaying in the column layout 148
  entering codes in the row format 95
  links
    creating GL/worksheet link 124
    using combined GL/worksheet 128
General Ledger Year box 123
Generate Report dialog box 229
Generate Report icon 55
Generate... command 225
GL Account Links dialog box 97
GL Column option 148, 169

H

Header Label option 268
Header Options dialog box 45, 145
headers
  creating dynamic columns 146
  entering column 145
  using multiple codes 145
Headers / Footers tab 236, 258
headings
  combining codes in column 143
Help, opening 14
historical rate source 274
hooks (&)
  using in a reporting tree 185
  using in a row format 69, 98
  using in an account mask 183
How to
Add XBRL Element tags to the row format 311
Create a link to the XBRL taxonomy 309
Include XBRL_TAG column type in the column layout 313
Select a printer from the Catalog of Reports output options 252
Select a printer from the Print Immediately option 253
Select XBRL output type from the Catalog of Reports 316
Use a currency rate subtype ID in the column layout 327
HTML (Via Excel 2000) option 244

I
IF/THEN/ELSE statements
using in column layouts 157
using in row formats 91
Import WKS Format command 59
Import/Export Path box 24
importing
external worksheet
creating a GL and WKS link 128
creating a link 130
Include All Units check box 269, 282
Include Amounts in Future Periods option 272
Include Detail for Non-Printing Rows option 268
Include Specific Number of Levels option 269
Include Unposted Accounts Only option 233
Include Unposted Activity Only option 52
Increment Each Row By box 70
Informal Desc box 208
Insert Column command 142
Insert command 17
Insert Unit command 192
inserting
columns 142
reporting units 192
rows 61
Installing Report Designer 6
Instance documents (XBRL) 318
Int’l Format box 209
international formatting, applying to reporting units 209

K
kjhjkhklj 332

L
Levels Down From Starting Unit option 270
Link Menu commands 65
Link Name box 122
Link to General Ledger cell 97
Link to General Ledger column, entering 95
Link Type box 122, 129, 131
linking
account types 101
column placement methods 125
combined GL and external worksheet 128
to external worksheets 124
to other row formats 116
to separate worksheet 124
links
entering
separate worksheet 130
formatting combined links 129
identifying
worksheet cells 125
worksheets in reporting tree 133
referencing external worksheets 125
Lotus 1-2-3
exporting reports 246
linking to 125

M
main account code segment 67
margins, changing 257
Mark Unposted Accounts with * option 267
mask, defining an account mask 183
master row format, creating 68
Maximum Digits Left of Decimal option 267
menus
available commands 19
Catalog 226
column layout 140
Edit
Catalog of Reports 226
reporting tree 191
row format 60, 61
File
Catalog of Reports 225
reporting tree 190
Index

Format
  reporting tree 193
  row format 64
Link 65
  reporting tree 190
  row format 59
Tree 194
Window 227
Message box 255
Microsoft Excel
  exporting reports 245
  linking to 125
Missing Element Tag Warning 315, 316
Missing Unit Warning option 273
modifiers, using account modifiers 104
Multicurrency Formatting 167

natural account code
  combining with full account code 96
  entering in row format 95
  using in FRx 11, 67
New button, record control box 19
No Page Breaks between Units option 270
Norm Bal cell, entering 83

OLAP Descriptions dialog box 173
Open Column dialog box 45, 138
Open Row dialog box 71
Open Tree dialog box 48
Optional Description box 123, 129, 131
orientation, changing report 257
Outline Style command 193
Output box 244
Output File Name dialog box 250
Output Options tab 236, 243

Page Break Before Unit box 209
Page Options tab 236, 257
Page Setup command 225
Page Setup tab 236, 257
parent reporting unit
  defining account mask 183
  overview 181
Paste command 17, 191
period
  assigning a range 152
  using account modifiers 104
Period Code 152
Period Code cell 174
Period Dates option 271
Period Description box 24
Period Numbers option 271
Period/Year Description box 173
Periods and Dates dialog box 235, 276
Pictures and Text command 194
Plural Description box 25, 234
Plus/Minus, Picture and Text command 193, 194
point and click totaling 93
Posted + Unposted Activity option 52, 233
posted transactions, restricting column 164
Print Catalog Information dialog box 280
Print Control cell, column layout 159
Print Ctrl cell, using 83
Print Detail option 281
Print Immediately box 251
Printer option 244
printing
  blank rows with zero balances 83
  Catalog of Reports 225
  column layout 140
  reporting tree 191
  reports 244
  row format 59
Priority Level box 272
Promote Unit command 195, 212
Prompt for Output Type at Run Time box 251, 282
Provisional box 52

range of periods, entering 152
README.TXT file 6
Record Control box, using 19
Related Rows/Unit cell
  entering calculations 88
  entering conditional statements 91
  formatting 74
  restricting to a reporting unit 81
  using 81
Rename command 140, 191
Renumber Rows dialog box 62
Replace command 17, 192

FRx Report Designer 6.7 User's Guide 365
Replace File Without Warning box 251
Replace With box 18, 62
report date, setting 276
Report Duplicate Accts option 271
Report Missing Accts option 271
Report Options tab 236, 261
Report Server Status command 228
report specification sets 9
Reporting Tree box 241
Reporting Tree command 226
reporting trees
 &, +, ? characters, using 201
adding e-mail addresses 217
building
 from chart of accounts 48
 manually 206
changing
 moving units 204
 rolling up to parent unit 207
connecting with general ledger 183
menus
 Edit 191
 File 190
 Format 193
 Tree 194
opening 188
planning structure 197
reporting units
child
 defining account mask 183
 parent relationship 203
 structure 181
definition 181
editing 188, 207
inserting 192
promoting/demoting 204
restricting
 columns 165
 rows 81
Reporting Units dialog box 134
reports
 chaining 281
 cloning 283
 creating 275
generating
 exceptions 271
 multiple 281
 scheduling 285
responsibility account code
combining with full account code 96
how FRx uses 11
segment 67
Restart Numbering with Every Unit option 270
Restart Page Numbering box 251
restricting rows with book codes 107
rolling up allocation percentage 207
Rollup Rounded Values in the Tree option 264
rounding
 automatic for balance sheets 113
 CAL row format code 91
 combining options 265
 managing differences 263
 reporting units 264
Rounding Adjustment row box, row format 113
Rounding Adjustments dialog box 113
Rounding of Amounts options 114
row codes
 entering 72
 renumbering 72
 specifying in column layout 149
Row Format command 226
Row Format Description box 238, 239, 241
Row Format dialog box 63
Row Format Name box 134
row formats
 additional text 73
 currency conversion codes 323
 editing account codes 69
 entering calculations 88
 entering totals 87
linking
 another row format 116
 combined GL and worksheet 124
 external worksheet 124
 general ledger 85, 95, 128
 year-to-year 121
making a master 68
making flexible 67
menus
 Edit 60
 File 59
 Format 64
 Link 65
opening 71
toolbar buttons 13
Row Period Offset option 128
rows
 deleting and inserting 61
renumbering 62

S

Save button, record control box 19
saving
  column layout 47, 50
  reporting tree 215, 220, 222
  reports 277
Scheduler command 228
Search Options section 62
security
  user 9
Segment Hierarchy section 214
Select a Company for this Record dialog box 276, 283
Select a Company to Work With dialog box 6
Select Catalog for Display dialog box 51, 275, 281, 282
Select Column Heading dialog box 45
Select Font Style dialog box 64, 260
Select General Ledger Account dialog box 97, 98, 102
Select Import File dialog box 135
Select Reporting Unit(s) to Print dialog box 55, 279
Select Units at Run Time check box 282
Select Units at Run Time option 269
Selecting a local printer from the Catalog of Reports 251
Send as Link to File option 250
Shading options 260
Sort GL Accounts by Natural Code option 268
Source Row Format box 123
Spaces Between Columns option 262
special formatting options, column layout 157
Split button (Cleaver) 214
Split icon 200
spot rate source 274
Starting Date cell 239, 240, 242
Starting Row Code box 70
statistical data, including in column layout 151
style, creating and editing font styles 64
Subject box 255
Subtotal By Period option 269
Subtotal on Segment option 268
summary reporting unit
  overview 181
Suppress CBR Calculation option 268
suppressing
  account/transaction detail 83
  details in columns 164
  row printing 83
  totals in columns 164
system requirements for installing FRx 5
System Specific Information tab 25

T
tabular report, creating 177
Taxonomy 318
text, mixing with codes in column header 146
Title/Desc box 208
toolbar
  Catalog of Reports 229
  main 13
  reporting tree 196
  row format 66
TOT row format code 75, 87
Total Assets row box 113
Total Liabilities & Equity row box 113
totaling
  point and click 93
  using in row formats 87
totals, suppressing in column 164
transaction detail reports
  available codes 150
  creating debit/credit 175
  customizing 173
  including multiple periods 174
  options 267
  year-to-date 175
Transaction Only option 52, 232
Transaction Rounding option 269
Tree Form button 134, 212
Tree Lines and Text command 193
Tree Lines, Picture and Text command 193, 194
Tree Options tab 236, 269
Tree Unit Security and E-mail dialog box 218

U
Unit Code box 207
Units for Tree dialog box 242
unposted transactions, including in reports 164
Use % Signs on Percentages option 262
Use ( ) For Negative Numbers option 262
Use Account Filter option 268
Use Dates option 239, 240, 242
Use Period Numbers option 239, 240, 242
Use Posted Balances Only option 52, 233
Use Reporting Tree box 209
Use Reporting Tree option 270
Use Rounded Values for Calculations and Totals option 264, 266
Use Row Format(s) and Worksheet Links from Reporting Tree box 238

V
value placement method, column placement 126
View Form command 195

W
Web Publishing tab 243, 255
width, assigning column 157
wildcards
  entering in row format 98
  in reporting tree account mask 183
  using in column layout 169
Wks File Name (Ext File) box 210
Wks File Name box 135
Wks Link box 134
Wks link, combined with GL link 124, 128
WKS, column type 149
worksheet
  combining links 128
  using a separate link 130
Worksheet File Name box 123, 129

X
XBRL Definitions 318
XBRL Element names 318
XBRL Element tags 310
XBRL Elements
  definition 318
    in the column layout 313
    in the row format 309, 310
XBRL instance documents
  Rules for reporting trees 315
XBRL Output type in the Catalog of Reports 315
XBRL Taxonomy Document 318
XBRL_TAG column type 313
XML option 244

Y
year, including in column header 144
YTD/Current cell 154

Z
zero, suppressing rows 83
Zoom command 16, 141, 192, 226
ZXczxcZxcZxc 333